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Summary by Version

This table provides quick access to what’s new in each version. For
clarification, see “About Release Notes” on page 2.

Version
(Release)

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Latest Version
V7.5 (R2007b)

Yes
Details

Yes
Summary

Bug Reports
Includes fixes

Printable
Release Notes:
PDF

Current product
documentation

V7.4 (R2007a) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V7.3 (R2006b) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V7.2 (R2006a) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V7.1 (R14SP3) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V7.0.4 (R14SP2) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

No

V7.0.1 (R14SP1) Yes
Details

Yes
Summary

Fixed bugs No

V7 (R14) Yes
Details

Yes
Summary

Fixed bugs No

1

http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R2007b
http://www.mathworks.com/access/helpdesk/help/pdf_doc/matlab/rn.pdf
http://www.mathworks.com/access/helpdesk/help/techdoc/matlab.html
http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R2007a
http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R2006b
http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R2006a
http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R14SP3
http://www.mathworks.com/support/bugreports/?product=ML&amp;release=R14SP2


Summary by Version

About Release Notes
Use release notes when upgrading to a newer version to learn about new
features and changes, and the potential impact on your existing files and
practices. Release notes are also beneficial if you use or support multiple
versions.

If you are not upgrading from the most recent previous version, review release
notes for all interim versions, not just for the version you are installing. For
example, when upgrading from V1.0 to V1.2, review the New Features and
Changes, Version Compatibility Considerations, and Bug Reports for V1.1
and V1.2.

New Features and Changes
These include

• New functionality

• Changes to existing functionality

• Changes to system requirements (complete system requirements for the
current version are at the MathWorks Web site)

• Any version compatibility considerations associated with each new feature
or change

Version Compatibility Considerations
When a new feature or change introduces a reported incompatibility
between versions, its description includes a Compatibility Considerations
subsection that details the impact. For a list of all new features and changes
that have reported compatibility impact, see Chapter 9, “Compatibility
Summary for MATLAB”.

Compatibility issues that are reported after the product has been released
are added to Bug Reports at the MathWorks Web site. Because bug fixes can
sometimes result in incompatibilities, also review fixed bugs in Bug Reports
for any compatibility impact.
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About Release Notes

Fixed Bugs and Known Problems
MathWorks Bug Reports is a user-searchable database of known problems,
workarounds, and fixes. The MathWorks updates the Bug Reports database
as new problems and resolutions become known, so check it as needed for
the latest information.

Access Bug Reports at the MathWorks Web site using your MathWorks
Account. If you are not logged in to your MathWorks Account when you link
to Bug Reports, you are prompted to log in or create an account. You then can
view bug fixes and known problems for R14SP2 and more recent releases.

The Bug Reports database was introduced for R14SP2 and does not include
information for prior releases. You can access a list of bug fixes made in prior
versions via the links in the summary table.

Related Documentation at Web Site

Printable Release Notes (PDF)
You can print release notes from the PDF version, located at the MathWorks
Web site. The PDF version does not support links to other documents or to the
Web site, such as to Bug Reports. Use the browser-based version of release
notes for access to all information.

Product Documentation
At the MathWorks Web site, you can access complete product documentation
for the current version and some previous versions, as noted in the summary
table.
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Version 7.5 (R2007b)
MATLAB

This table summarizes what’s new in Version 7.5 (R2007b):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports
Includes fixes

Printable
Release Notes:
PDF

Current product
documentation

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.5
(R2007b)” on page 7

• “Mathematics, MATLAB Version 7.5 (R2007b)” on page 27

• “Data Analysis, MATLAB Version 7.5 (R2007b)” on page 31

• “Programming, MATLAB Version 7.5 (R2007b)” on page 32

• “Graphics and 3-D Visualization, MATLAB Version 7.5 (R2007b)” on page
41
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• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.5
(R2007b)” on page 46

• “External Interfaces/API, MATLAB Version 7.5 (R2007b)” on page 50
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Desktop Tools and Development Environment, MATLAB
Version 7.5 (R2007b)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 7

• “Desktop” on page 8

• “Running Functions — Command Window and History” on page 11

• “Help” on page 12

• “Editing and Debugging M-Files” on page 17

• “Publishing Results” on page 25

Startup and Shutdown

Windows Startup Changes
You can now change the startup directory for MATLAB on Windows platforms
using the standard shortcut Start in field. The My Documents\MATLAB
subfolder (or Documents\MATLAB on Vista) is the default startup directory.
Upon startup, MATLAB automatically creates a My Documents\MATLAB
subfolder (or Documents\MATLAB on Vista) if it does not exist, and adds it to
the top of the MATLAB search path. To change the startup directory:

1 Right-click the MATLAB shortcut icon and select Properties from the
context menu. The Properties dialog box for MATLAB opens to the
Shortcut pane.

2 In the Start in field, specify the directory in which you want MATLAB to
start, for example, C:\My MATLAB Place.

You can specify the directory via a UNC path (that is, the path can begin
with \\).

The Target field specifies the full path to the file to start MATLAB,
matlab.exe, located in the bin folder (for example, C:\Program
Files\MATLAB\R2007b\bin\matlab.exe). Use the bin\matlab.exe to

7
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start MATLAB instead of matlab.bat or matlab.exe located in a platform
directory such as bin\win32. The bin\matlab.exe detects the Windows
platform and ensures required runtime files are installed.

Compatibility Considerations. The Target field no longer contains the -sd
$documents startup option. In MATLAB Version 7.4 (R2007a), the startup
directory was specified via the -sd startup option in the Target field. You
had to specify the directory via a mapped drive. Any value in the Start in
field was ignored.

The file to start MATLAB, as specified in the Target field, was matlab.bat.

Change any scripts you use to start MATLAB to specify the full path to
bin\matlab.exe. If you use matlab.bat in R2007b, MATLAB issues a
warning message instructing you to use matlab.exe instead.

If scripts include the -sd startup option to specify the startup directory, that
will be the startup directory, even if a directory is specified in the Start in
field.

Desktop
New features and changes introduced in Version 7.5 (R2007b) are:

• “Minimizing Tools in the Desktop Now Supported on Macintosh Platforms”
on page 9

• “Double-Click to Maximize or Restore Minimized Tools in Desktop” on page
9

• “New Desktop Layout — All but Command Minimized” on page 9

• “Start Button Now Includes New Category for Links and Targets” on page
10

• “Start Button — View Source Files Renamed” on page 11

• “Changes to Look of Buttons in Desktop and Other Tools” on page 11

• “Antialiasing Option No Longer Necessary on Windows and Mac” on page
11

8
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Minimizing Tools in the Desktop Now Supported on Macintosh
Platforms
You can now minimize tools in the desktop on Macintosh platforms. It was
introduced for other platforms in a previous version.

Double-Click to Maximize or Restore Minimized Tools in
Desktop
After you minimize a tool within the desktop, you can now:

• Restore the tool to its former position by double-clicking the button.

• Drag a button to move its position—drag it to another edge of the desktop
or to a new position within the edge where it’s currently located.

• Restore the tool by dragging the button to a location within the desktop, or
outside the desktop to undock the tool.

Similarly, you can double-click a tool’s title bar to maximize the tool in the
desktop; then double-click the title bar again to restore it to its former
position. (The capability was introduced in R2007a, MATLAB 7.4).

For more information, see “Opening and Arranging Tools” and “Minimized
Tools in Desktop Example”.

New Desktop Layout — All but Command Minimized
Select Desktop > Desktop Layout > All but Command Minimized to
arrange the desktop as shown here. The Command Window is open in the
desktop, and all other desktop tools are open, but minimized.

9
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Start Button Now Includes New Category for Links and Targets
In the Start button, there is a new category for Link and Target products.
Select Start > Links and Targets, and then select one of the products.
In previous versions, you accessed these products from the Toolboxes or
Simulink® categories.

You also use this new category when running demos, or accessing Demos
or Contents in the Help browser. For more information, see “Demos and
Help Browser Contents Now Include New Category for Links and Targets”
on page 12.

10
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Start Button — View Source Files Renamed
To add your own toolboxes to the Start button, select Start > Desktop
Tools > View Start Button Configuration Files. In previous versions,
this menu item was View Source Files. There has been no change in
functionality or features.

Changes to Look of Buttons in Desktop and Other Tools
Some icons on toolbar buttons have changed slightly. In addition,
standard desktop icon image files are no longer provided in the
matlabroot/toolbox/matlab/icons directory.

Compatibility Considerations. If your code relied on icon files in the
matlabroot/toolbox/matlab/icons directory (for example, for adding your
entries to the Start button or the Help browser), you might need to use other
image files.

Antialiasing Option No Longer Necessary on Windows and
Mac
MATLAB now follows the operating system’s font settings on Windows and
Mac. This provides smooth fonts without the need for antialiasing within
MATLAB.

Running Functions — Command Window and History
New features and changes introduced in Version 7.5 (R2007b) are:

• “Command History — Find Entry by Letter Now Looks in Collapsed
Sessions” on page 11

• “Pop-Up Help for a Function in the Command Window” on page 12

Command History — Find Entry by Letter Now Looks in
Collapsed Sessions
When you type letters in the Command History, it finds and selects the next
entry that begins with the letters you typed. Now, if the entry is in a session
that was collapsed, MATLAB automatically expands the session and selects
the matching entry in it. In previous versions, MATLAB did not find matching
entries in collapsed sessions.

11
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If you do not want to find entries in collapsed sessions (the previous behavior),
you can instead select Edit > Find, which finds text in the Command History,
but not in collapsed sessions. For more information, see “Finding Next Entry
By Letter”.

Pop-Up Help for a Function in the Command Window
For more information, see “Help on Selection Enhanced in Command Window
and Editor” on page 15.

Help
New features and changes introduced in Version 7.5 (R2007b) are:

• “Minor Visual Changes to Help Browser” on page 12

• “Demos and Help Browser Contents Now Include New Category for Links
and Targets” on page 12

• “Help on Selection Enhanced in Command Window and Editor” on page 15

Minor Visual Changes to Help Browser

• To open the Help browser from a tool’s Help menu, select Product Help.
In previous versions you selected Full Product Family Help.

• When the Help browser first opens, it displays help for MATLAB. In
previous versions, it displayed a Begin Here page. The information
previously available on the Begin Here page has been incorporated into
the MATLAB roadmap page.

• When you close and reopen the Help browser, it maintains the list of pages
you previously viewed, but does not open to the page you last viewed. In
previous versions, upon reopening, the Help browser displayed the page
you last viewed.

Demos and Help Browser Contents Now Include New Category
for Links and Targets
When you run the demo function or access Demos or Contents in the Help
browser, there is a new category for Link and Target products.

12
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To use the demo function to access a demo that is now in the Links and
Targets category, you specify the new subtopic ’links and targets’, followed
by the category. For example

demo('links and targets', 'link for modelsim')

displays the Demos pane, and expands the Link for ModelSim® demos listing.

In the Help Demos, Link and Target products appear together in their own
category, and are identifiable by the new Links and Targets icon, .

In the Help Contents, Link and Target products appear together after any
installed Simulink and Blockset products, and are identifiable by the new
Links and Targets green book icon, .

13
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This new category is also used in the Start button in the MATLAB
desktop—for more information, see “Start Button Now Includes New Category
for Links and Targets” on page 10.

If you add help or demos to the Help browser for your own toolbox or list
your own toolbox in the Start button and you want to take advantage of the

14
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new Links and Targets category, use the new type, links_targets, in the
info.xml file for your toolbox.

Compatibility Considerations. In previous versions, when you used the
demo function to access a demo that is now in the Links and Targets category,
you specified a different subtopic and category. If you have any code that
relies on the demo function for accessing Links and Targets demos, you will
need to replace the subtopic and category in the code.

In previous versions, you accessed the products in the Help browser Demos
from the Toolbox or Simulink categories.

In previous versions, you accessed the products in the Help browser Contents
from within the list of toolbox products (orange book icon) or Simulink
products (blue book icon).

Help on Selection Enhanced in Command Window and Editor
To get help for a function in the Command Window or the Editor, click the
pointer in the function name and press F1. The reference page for that
function appears in a small, temporary (pop-up) window. To close the window,
press Escape. You can also access the feature by choosing Help on Selection
from the context menu. For details, see “Getting Pop-Up Help for Functions”.
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Compatibility Considerations. In the previous version, you could select the
function name, right-click, and select Help on Selection. The documentation
appeared in the Help browser. Now if you want to see the documentation for
the function in the Help browser, first access the pop-up help and then click
the Open Help Browser link.

Editing and Debugging M-Files
New features and changes introduced in Version 7.5 (R2007b) are:

• “Run Your Function M-Files in the Editor/Debugger Using Configurations”
on page 17

• “Run/Continue Button Changes” on page 18

• “Code Folding Feature for Collapsing and Expanding Code” on page 19

• “Pop-Up Help for a Function in the Editor” on page 21

• “Line Endings Removed for Files Provided with MATLAB for Windows;
Impacts Viewing in Notepad” on page 21

• “Stand-Alone Editor Will Not Be Included in Next Version” on page 24

• “Determine the McCabe (Cyclomatic) Complexity of an M-File” on page 25

Run Your Function M-Files in the Editor/Debugger Using
Configurations
In the Editor/Debugger, you can provide values for a function’s input
arguments using a configuration, and then run that configuration to use the
assigned values. Use a configuration as an alternative to running the function
in the Command Window. You can associate multiple configurations with an
M-file, each for different input values. MATLAB saves the configurations
between sessions.

To create a configuration, first open an M-file in the Editor/Debugger. Then,
from the down arrow on the Run button in the toolbar select Edit
Configurations for filename. In the resulting Edit M-File Configurations
dialog box, add statements and name the configuration. For more information,
see “Using Configurations — Running M-Files with Input Arguments in the
Editor/Debugger”.
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Run/Continue Button Changes
The Run/Continue button has a new look and new location on the
Editor/Debugger toolbar.
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Compatibility Considerations. The button performs the same as it did in
previous versions, but you need to access it in the new position.

Code Folding Feature for Collapsing and Expanding Code
To improve the readability of files containing several subfunctions, the Editor
includes a code folding feature, which is enabled by default. Using this
feature you can collapse and expand subfunctions and their associated help.
The following figure shows the collatzplot_new function collapsed, such
that only the function definition is displayed. The figure shows the collatz
function expanded, revealing both the help code and the function code. If you
collapse just the help code, only the H1 help line displays.
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• To expand code that is collapsed, click the plus sign (+) to the left of the
code you want to expand.

• To collapse code that is expanded, click the minus sign (-) to the left of the
code you want to collapse.

• To expand or collapse all of the code in an M-file, place your cursor
anywhere within the M-file, right-click, and then select Code Folding >
Expand All or Code Folding > Collapse All from the context menu.

For more information, see Code Folding—Expanding and Collapsing M-File
Constructs

Pop-Up Help for a Function in the Editor
For more information, see “Help on Selection Enhanced in Command Window
and Editor” on page 15.

Line Endings Removed for Files Provided with MATLAB for
Windows; Impacts Viewing in Notepad
In previous versions, text files provided with MATLAB for Windows platforms
included a carriage return and line feed at the end of each line. Starting in
R2007b, the text files MATLAB provides do not include a carriage return
and line feed at the end of each line.

File types affected are:

• .asc

• .bat

• .c

• .cc

• .cdr

• .cpp

• .def

• .for

• gs.rights

21



Version 7.5 (R2007b) MATLAB

• .h

• .ini

• .m

• .mdl

• .pl

• readme

• .tlc

• .tmf

• .txt

There is no impact if you view the files in MATLAB and other common text
editors, with the known exception of Windows Notepad.

Compatibility Considerations. If you use Windows Notepad to view files
provided with MATLAB, you see carriage return and line feed symbols
instead of line endings. This makes the files less readable in Notepad. Other
text editors might display the symbols instead of line endings, but of the
common text editors tested, none have been found that do so.

As an alternative to Notepad, use Microsoft WordPad, provided with Windows,
or another text editor to view the files.

If your Windows file associations are set to associate any of the listed file types
with Notepad, change the associations to use WordPad or another text editor.

The following illustration shows how the ver M-file included with MATLAB
Version 7.5 looks when opened in Notepad.
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The following illustration shows how the ver M-file included with MATLAB
Version 7.5 looks when opened in WordPad.
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There are no problems with files you create or edit in Notepad, and then view
or edit in MATLAB. The files have line endings in the MATLAB Editor, and
continue to have line endings when you open them in Notebook.

(Microsoft product screen shot(s) reprinted with permission from Microsoft
Corporation.)

Stand-Alone Editor Will Not Be Included in Next Version
The MATLAB stand-alone Editor (meditor.exe) will no longer be provided,
starting in the next version of MATLAB. Instead of the stand-alone Editor,
you can use the MATLAB Editor/Debugger. It provides all the features of the
stand-alone Editor, plus the following:

• Tab completion
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• Debugging M-files

• Evaluating selections

• Accessing source control features

• Docking the tool in the MATLAB desktop

• Using cell features for rapid code iteration or publishing

Compatibility Considerations. Some users have preferred the stand-alone
Editor to the MATLAB Editor/Debugger because of slightly better startup
performance and because it does not require a MATLAB license. For those
situations, you can use any text editor you have, such as UltraEdit or Emacs.

Determine the McCabe (Cyclomatic) Complexity of an M-File
The cyc option to the mlint function enables you to determine the McCabe
complexity (also referred to as the cyclomatic complexity) of an M-file. Higher
McCabe complexity values indicate higher complexity, and there is some
evidence to suggest that programs with higher complexity values are more
likely to contain errors. Frequently, you can lower the complexity of a function
by dividing it into smaller, simpler functions. In general, smaller complexity
values indicate programs that are easier to understand and modify. Some
people advocate splitting up programs that have a complexity rating over 10.
See mlint for syntax and an example.

Publishing Results
New features and changes introduced in Version 7.5 (R2007b) are:

• “Notebook and Word for Office 2007” on page 25

• “Text Markup in Cells for Publishing” on page 26

• “Preference to Restrict Lines of Output” on page 26

Notebook and Word for Office 2007
Notebook now supports Word for Office 2007. For details, see Notebook for
Publishing to Word
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Text Markup in Cells for Publishing
The following Editor/Debugger menu items are added to assist you in marking
up cells in the Editor/Debugger for publishing. Access the menu items
presented in the following list from Cell > Insert Text Markup . When
you select the menu item, the Editor inserts code to assist you in adding the
text markup for the specified item.

• Document Title and Introduction

• Section Title with Cell Break

• Hyperlinked Text

• Image

• Numbered List

• HTML Markup

• LaTeX Markup

The first two list items are provided instead of the Cell Title and Descriptive
Text menu items that were offered in Version 7.4 (R2007a).

As an alternative to using the Cell menu items, you can manually insert code
to mark up cells in your M-file for publishing. For details on the Cell menu
items and the resulting code see Marking Up Text in Cells for Publishing

Preference to Restrict Lines of Output
You can now specify options to restrict the number of lines included in the
output of a published M-file. To access this option from the Editor/Debugger,
follow these steps:

1 Select File > Preferences > Editor/Debugger > Publishing

2 In the Editor/Debugger Publishing Preferences pane, select the Evaluate
code and Restrict output to options.

3 Specify the maximum number of lines that you want to include in the
output.

26



Mathematics, MATLAB Version 7.5 (R2007b)

Mathematics, MATLAB Version 7.5 (R2007b)
New features and changes introduced in this version are:

• “New Functions” on page 27

• “finite Function Deprecated” on page 27

• “dmperm Function Gives Coarse Decomposition” on page 28

• “ldl Function Supports Real Sparse Symmetric Matrices” on page 28

• “Upgrade to LAPACK Library” on page 28

• “Upgrade to BLAS Libraries” on page 28

• “Library for LAPACK and BLAS Symbols Separated” on page 28

• “Colon Operations on Characters Return Character Type Data” on page 29

• “Matrix Generating Functions No Longer Accept Complex Inputs” on page
29

New Functions
Function Description

quadgk Numerically evaluates the integral, adaptive
Gauss-Kronrod quadrature

bvp5c Solves boundary value problems for ordinary
differential equations, notably useful for small
error tolerances

maxNumCompThreads Gets and sets the maximum number of
computational threads

finite Function Deprecated
In this release, the finite function displays a warning message that the
function is now deprecated. Support for finite will be removed in a future
release of MATLAB.
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Compatibility Considerations
It is recommended that you replace all calls to finite with the isfinite
function.

dmperm Function Gives Coarse Decomposition
The dmperm function now provides two additional output arguments for the
indices of the Dulmage-Mendelsohn coarse decomposition.

ldl Function Supports Real Sparse Symmetric Matrices
The ldl function now provides factorization and solving for an additional
output argument, the scaling matrix, when the input matrix is real sparse
and symmetric.

Upgrade to LAPACK Library
MATLAB now uses Version 3.1 of the Linear Algebra Package (LAPACK)
library.

Upgrade to BLAS Libraries
For AMD processors, MATLAB now uses Version 3.6 of the AMD Core Math
Library (ACML) for the Basic Linear Algebra Subroutine (BLAS) libraries.

Library for LAPACK and BLAS Symbols Separated
The binder library, libmwlapack.lib, containing both LAPACK and BLAS
symbols is now two separate library files: libmwlapack.lib for LAPACK
symbols and libmwblas.lib for BLAS symbols. For more information and
syntax, see “Using LAPACK and BLAS Functions”.

Compatibility Considerations
If you previously linked to the libmwlapack.lib library to use the BLAS
symbols, you will need to update your code to link to the libmwblas.lib
library.
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Colon Operations on Characters Return Character
Type Data
Using a colon with characters to iterate a for-loop now returns data of type
character. For example,

for x='a':'b',x,end

results in

x =
a

x =
b

Compatibility Considerations
Previously, colon operations with characters iterating a for-loop returned data
of type double. In previous releases the above example returned:

for x='a':'b',x,end

x =
97

x =
98

Existing program code that relies on the colon operations of character arrays
returning a double, needs to be updated to expect a character data type.

Matrix Generating Functions No Longer Accept
Complex Inputs
Calling matrix generating functions, such as ones, zeros, rand, randn, true,
and false, with a complex number as dimensions input now returns the error:

true([1 i])
??? Error using ==> true
Size vector must be a row vector with real elements.
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Compatibility Considerations
In previous releases, if you supplied a complex number as a dimension input,
MATLAB returned:

true([1 i])
Warning: Size vector should be a row vector with integer elements.

Complex inputs will cause an error in a future release.

ans =

Empty matrix: 1-by-0

Existing program code that relies on entering complex numbers as dimension
input to a matrix generating function should be modified.
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Data Analysis, MATLAB Version 7.5 (R2007b)
There were no new features or changes in this version.
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Programming, MATLAB Version 7.5 (R2007b)
New features and changes introduced in this version are

• “Increased Size for Large Arrays” on page 32

• “Documentation for Multiprocessing in MATLAB” on page 32

• “Setting Number of Threads Programmatically” on page 33

• “New Internal Format for P-code” on page 33

• “New Split String Functionality in regexp” on page 33

• “Changes Related to Error Handling” on page 34

• “Results From tempname Are More Unique” on page 36

• “iptcheckstrs and iptcheckinput Functionality Now Available with
MATLAB” on page 37

• “Windows Current Working Directory Corrected” on page 37

• “New Multimedia Functionality” on page 38

• “Compressed AVI Video Files in Windows Vista and Windows XP x64”
on page 39

• “mmfileinfo Reads Files on MATLAB Path” on page 39

• “Changes to imread Support of TIFF Format” on page 39

• “Removal of freeserial Function” on page 40

Increased Size for Large Arrays
On 64-bit platforms, MATLAB arrays are no longer limited to 231 elements.
The limit in MATLAB 7.5 is 248-1. For example, given sufficient memory,
many numeric and low-level file I/O functions now support real double arrays
greater than 16 GB.

Documentation for Multiprocessing in MATLAB
Documentation for “Multiprocessing in MATLAB” has moved from Desktop
Tools and Development Environment to the “Improving Performance and
Memory Usage” section of MATLAB Programming.
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Setting Number of Threads Programmatically
In this release, MATLAB provides a way to set or retrieve the maximum
number of computational threads from within an M-file program. With the
maxNumCompThreads function, you can either set the maximum number of
computational threads to a specific number, or indicate that you want the
setting to be done automatically by MATLAB

New Internal Format for P-code
P-code files have a new internal format in MATLAB Version 7.5. The new
P-code files are smaller and more secure than those built with MATLAB 7.4
and earlier, and provide a more robust solution to protect your intellectual
property.

Any P-code files that were built using MATLAB 7.4 or earlier also work in
7.5. However, support for these older files will at some point be removed
from MATLAB.

P-code files built with MATLAB 7.5 only work on 7.5 or later. They cannot be
used with MATLAB 7.4 or earlier versions.

Compatibility Considerations
Rebuild any P-code files using MATLAB 7.5 that you expect to need in the
future.

New Split String Functionality in regexp
Using the regular expressions function regexp, you can now split an input
string into sections by specifying the new 'split' option when calling regexp:

s1 = ['Use REGEXP to split ^this string into ' ...
'several ^individual pieces'];

s2 = regexp(s1, '\^', 'split');

s2(:)
ans =

'Use REGEXP to split '
'this string into several '
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'individual pieces'

The split option returns those parts of the input string that are delimited by
those substrings returned when using the regexp 'match' option.

Changes Related to Error Handling

New Error Handling Mechanism
MATLAB extends its error-handling capabilities with the new MException
class to provide you with a more secure and extensible system for throwing
and responding to errors. Read about this new feature in the “Error Handling”
section of the MATLAB Programming documentation and in related function
reference pages such as MException.

This feature extends the error-handling capabilities available in earlier
releases, but does not replace that functionality. Your M-file programs will
continue to function the same when using Version 7.5.

New Syntax for catch Function
As part of new error-handling mechanism, the catch function has a new,
optional syntax:

catch ME

ME is an object of the MException class. This command gives you access to the
MException object that represents the error being caught.

Warning and Error Messages Now Wrap
In previous versions of MATLAB, warning and error messages that were
longer than the width of your terminal screen extended beyond the visible
portion of your screen. These messages now wrap onto succeeding lines so
that the entire text of the warning or error is visible.

Change to Error Message from Anonymous Function
The error message and M-file line number that MATLAB displays when
encountering an error in an anonymous function defined within a script
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file or at the MATLAB Command Line has changed in this release. In
MATLAB Version 7.4, the error message included the line number (set to 1 for
anonymous functions), and the stack information returned by the lasterror
function also showed the line number as 1. In MATLAB 7.5, the line number
is not displayed in the error message and is set to 0 in the returned stack
information.

For example, when you enter the following two lines at the command line,
MATLAB generates an error from the anonymous function:

X = @() error('* Error *');
X()

This example shows the difference between MATLAB Versions 7.4 and 7.5:

e = lasterror;

e.message
ans =
Error using ==> @()error('Error') at 1 % V7.4 response
Error using ==> @()error('Error') % V7.5 response
* Error *

e.stack
ans =

file: ''
name: '@()error('* Error *')'
line: 1 % V7.4 response
line: 0 % V7.5 response

Compatibility Considerations. If you have programs that rely on the line
number returned in response to an error in an anonymous function, these
programs may not work as expected. Remove dependencies on the returned
error message and line number, or update your program code to use the new
string and value.

New Message In Response to Ctrl+C
MATLAB now displays a more user-friendly message when you press Ctrl+C.
The previous response to Ctrl+C was
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Error in ==> testctrlc>waitawhile at 5
pause(100);

Error in ==> testctrlc at 2
waitawhile

In this and future releases, pressing Ctrl+C still halts program execution,
but now displays the response

??? Operation terminated by user during ==> testctrlc>
waitawhile at 5

In ==> testctrlc at 2
waitawhile

Compatibility Considerations. You only need to be aware that the change
in the text of this message is intentional and does not signify any error on
your part.

hdfread Errors Instead of Warns on I/O Failures
In previous releases, hdfread issued a warning when a requested I/O
operation failed. In addition, hdfread created an empty variable in the
workspace. In this release, hdfread now errors when a requested I/O
operation fails and does not create an empty variable in the workspace.

Compatibility Considerations. If you call hdfread in a script to perform
an I/O operation and that operation fails, your script will now terminate.
Previously, because hdfread only warned when an I/O operation failed, your
script would continue processing.

Results From tempname Are More Unique
The tempname function now produces a string such as

C:\Temp\tpe51f2ba3_9ad3_490f_8142_58359c98f4a5

when Java is present, or a string like

C:\Temp\tp346976948758473

36



Programming, MATLAB Version 7.5 (R2007b)

when nojvm is selected. Underscores are included in the name so you can use
the filename portion of it as a valid M-function name. If a string row vector is
passed in as an argument, that string is used instead of tempdir as the root.

Compatibility Considerations
Because the new string generated by tempname is generally longer than the
string constructed in earlier versions, there is a possibility of exceeding length
restrictions, especially if your program code passes a string to the tempname
function. If you consider this to be a potential problem, verify that the strings
you pass to tempname will not result in an overly long string being returned.

Windows Current Working Directory Corrected
On Windows, you can define a current working directory, cwd, for each drive
letter. For example, entering the command cd D:\work at the DOS prompt
defines your D current working directory as D:\work. All references to D: are
then relative to this directory.
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The term . . . Represents the directory . . .

D: D:\work

D:matlab D:\work\matlab

D:\matlab D:\matlab

(Note the difference between D:\ and D:, where the former is the drive D, and
the latter is a user-defined working directory that may or may not be equal
to D:\.)

Previous versions of MATLAB have been inconsistent in the way that
volume-relative path specification is handled. For example, in MATLAB
7.4 and earlier, if D: were defined as the directory D:\work, the following
commands on the left and right returned identical results:

dir D: dir D:\
dir D:matlab dir D:\work\matlab
fileparts('D:myfile.m') fileparts('D:\myfile.m')

This has been fixed in MATLAB 7.5 so that the following are now equivalent:

dir D: dir D:\work
dir D:matlab dir D:\work\matlab
fileparts('D:myfile.m') fileparts('D:\work\myfile.m')

Compatibility Considerations
Some MATLAB commands may fail or return unexpected results if you use
Windows current working directories on MATLAB. You might have to update
hard-coded paths if you have been relying on the incorrect behavior exhibited
in earlier versions.

New Multimedia Functionality
A new mmreader video file reader object for Windows platforms supports
formats such as AVI, MPEG, and WMV, and adds the ability to read additional
video codecs that aviread does not support. For more information, see the
mmreader and read reference pages.
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Compressed AVI Video Files in Windows Vista and
Windows XP x64
Because Windows Vista, Windows Vista 64-bit, and Windows XP x64
operating systems do not ship with the Indeo5 codec, which is the default
codec used by MATLAB Audio-Video functions for file compression, the
functions movie2avi and avifile now generate uncompressed AVI files on
these platforms. Also, aviread on these platforms cannot read files that were
compressed using the Indeo5 codec.

Compatibility Considerations
If you have upgraded your Windows operating system to Windows
Vista, Windows Vista 64-bit, or Windows XP x64, you need to install
the Indeo5 codec to read or create Indeo5 compressed AVI files
with aviread, avifile, or movie2avi. You can learn more about
downloading the Indeo5 codec from the Ligos Corporation Web site at
http://ligos.com/index.php/home/products/indeo/

mmfileinfo Reads Files on MATLAB Path
The mmfileinfo function now reads files on the MATLAB path, not only those
in the current directory. The mmfileinfo output struct contains a field called
Path, which indicates the directory where the file exists.

Compatibility Considerations
The Filename field of the output struct from mmfileinfo now contains only
the filename itself without any path information, while the path information
is contained in the Path field. In previous releases, the Filename field
contained both path and filename information.

Changes to imread Support of TIFF Format
The imread function includes several updates to its TIFF support:

• imread reads TIFF files that use JPEG, LZW, and Deflate compression.

• imread reads image data from TIFF files in any arbitrary samples-per-pixel
and bits-per-sample combination.
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• imread provides increased performance when reading large images, when
used with the ’PixelRegion’ parameter.

Removal of freeserial Function
The freeserial function is now obsolete. Use fclose to release the serial
port.

Compatibility Considerations
If your program code still makes use of the freeserial function, replace each
instance with the fclose function instead.
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Graphics and 3-D Visualization, MATLAB Version 7.5
(R2007b)

New features and changes introduced in this version are:

• “Datatips Are Now Saved to FIG-Files” on page 41

• “New Options for Displaying Groups of Lines in Legends” on page 41

• “Drawnow Update Option Now Updates Uicontrols Only” on page 42

• “Annotation Textboxes Can Automatically Resize to Fit their Contents”
on page 42

• “Property Inspector Now Has Context-Sensitive Help” on page 44

• “The “v6” Option for Creating Plot Objects is Obsolete” on page 44

Datatips Are Now Saved to FIG-Files
When you save a figure, all datatips existing in it are saved along with other
annotations. When you open the FIG-file, the datatips are displayed and can
be manipulated or deleted in the same ways they could in the original figure.

Compatibility Considerations
If you open a FIG-file containing datatips while using a previous version of
MATLAB (V7.4 or earlier), no error results, but the datatips do not display.

New Options for Displaying Groups of Lines in
Legends
You can now customize how legends for figures display groups of lines, such as
contours. Previously, legends displayed groups of lines such as contourgroups
with a glyph that represented the entire group; now users have the flexibility
to designate a single legend entry, a legend entry for each child of the group,
or no legend entries for the group.

By default, a legend entry for an hggroup now consists of the DisplayName of
its first child and a glyph representing it (previously, no glyph appeared, only
the DisplayName). This is what you now see after clicking the legend tool icon
in the figure’s toolbar. However, you can set the new Annotation property
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of hggroups to control how the group is represented in a legend. For details
and examples of its use in customizing legends, see “Controlling Legends” in
the Graphics documentation.

Drawnow Update Option Now Updates Uicontrols
Only
The drawnow command can now selectively update the display of UI
components. The update option enables you to update only uicontrol objects
without allowing callbacks to execute or processing other events in the queue.

Annotation Textboxes Can Automatically Resize to
Fit their Contents
In previous releases, textboxes had fixed sizes that users needed to adjust to
fit the size of their contents. Now, if you create a textbox annotation using
a GUI or the annotation function, it can grow or shrink to just fit the text
you type into it. This behavior is controlled by the Annotation Textbox object’s
FitBoxToText property, which can be 'on' or 'off'. When you create a

textbox with the Annotation toolbar (using the tool), this property is set to
'on' if you create a textbox without dragging; however, if you drag to make
the new textbox have a certain size, the property is initially 'off'. When you
create a textbox with the annotation function, for example,

htb = annotation('textbox')

without specifying a position and size, the textbox is created with
FitBoxToText set to 'on'. If you specify a position vector in the command,
for example,

htb = annotation('textbox', [.1 .8 .4 .1])

the textbox is created with FitBoxToText set to 'off'.

Similarly, if you resize a textbox in plot edit mode or change the width or
height of its position property directly, its FitBoxToText property is set to
'off'. You can toggle this property with set, with the Property Inspector,
or more conveniently, via the object’s context menu, as the illustration below
shows.
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If you edit a textbox that has FitBoxToText set to 'on', the textbox resizes to
accommodate the number of characters and lines in the text as you type. You
can reposition the textbox without changing the FitBoxToText property, but
as soon as you resize it, the property becomes (or remains) 'off'.
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Property Inspector Now Has Context-Sensitive Help
When you use the Property Inspector (the inspect command), you can now
ask for a description of any property it shows. The descriptions come from
the property reference page for the type of object being inspected (e.g., axes,
lineseries, annotations, uicontrols, etc.). To get a description of a property,
right-click its name in the left-hand column of the Property Inspector and
select What’s This? from the context menu that appears. A mini-help
window opens to show the property’s description from the object’s property
reference page. If you need an overview of all properties pertaining to
particular kinds of objects and how these objects relate, scroll through the
entries in the mini-help window or open the Handle Graphics® Property
Browser from the Help Browser.

The “v6” Option for Creating Plot Objects is Obsolete
Prior to Version 7 of MATLAB, handles returned by high-level plotting
functions referenced graphic primitives, such as lines and patches. In Version
7, MATLAB began bundling the primitives into “series” objects, for example,
lineseries, barseries, and contourgroups. At that time, the v6 option was
added to plotting functions to enables users of Version 7.x of MATLAB to
create FIG-files that previous versions can open. The v6 option is now
obsolete. It will be removed in a future version of MATLAB. The following
functions include the option in their syntax and now warn when it is used:

• area

• bar

• barh

• colorbar

• contour

• contourf

• errorbar

• legend

• loglog

• mesh

• meshc
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• meshz

• plot

• quiver

• scatter

• scatter3

• semilogx

• semilogy

• stairs

• stem

• stem3

• subplot

• surf

• surfc

Compatibility Considerations
Specifying the v6 flag to any plotting function now results in a warning that
the option is being removed, but the option still functions. To generate a
FIG-file for a plot created with the v6 option, you still need to use the -v6
option to the hgsave command in order to save it in a form that a previous
version of MATLAB can read. Figures containing annotations (such as
textboxes, arrows, ovals, and rectangles) that are saved this way open in
previous versions, but the annotations do not display because different objects
are used to contain them in Version 7 than before. That is, the annotation
objects have never been backward compatible.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.5 (R2007b)

New features and changes introduced in this version are:

• “New Editors for Creating Custom Toolbars within GUIDE” on page 46

• “Coordinate Readouts in Layout Editor” on page 47

• “Documentation for Making GUIDE GUIs Interact” on page 47

• “Functions Being Removed” on page 48

New Editors for Creating Custom Toolbars within
GUIDE
In previous releases, adding toolbars to a GUI had to be done
programmatically, by writing code for the uitoolbar, uipushtool and
uitoggletool functions. GUIDE now has a Toolbar Editor and an associated
Icon Editor that allow you to lay out a toolbar for a GUI and populate it with
standard predefined tools for printing, saving, panning, zooming, annotating,
etc. or with custom tools that you design yourself. You can draw or modify
an icon for any tool on your toolbar with the Icon Editor or import one from
an image file.

The Toolbar Editor
When you run GUIDE to create a new GUI or edit an existing one, click the
Toolbar Editor icon in the Layout Editor Toolbar or choose Toolbar Editor
from the Tools menu to open the Toolbar Editor. To add tools to the toolbar of
your GUI, you drag standard or custom tool icons to the toolbar layout area
at the top. You can modify a tool’s properties using the Toolbar Editor and
Property Inspector. You can also create and customize icons for tools using
the new Icon Editor, described next. You control the behavior of a tool in your
toolbar with its ClickedCallback (and for toggle tools, their OnCallback
and OffCallback) in the GUI’s associated M-file. If you use an existing tool,
such as Print or Save, you do not need to modify its callback; it is predefined
as %default.
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The Icon Editor
The Icon Editor lets you customize the icons for existing tools or create
entirely new icons. Icons are stored as CData for each tool, and can also be
read from and saved to .icn files. The Icon Editor also includes a Color Editor,
a palette you can use for picking predefined colors and defining new ones.

Coordinate Readouts in Layout Editor
The GUIDE Layout Editor now has two fields in its lower left corner that
continuously provide numeric feedback for:

• Current Point — The cursor location within the layout window

• Position — The Position property of the currently selected object(s) in
the layout window

Both measurements are given in pixels, regardless of the current Units
settings for GUI objects. When multiple objects are selected, any elements of
their Position properties that are not identical are read out as MULTI. The
readouts help you to precisely size and align GUI components.

Documentation for Making GUIDE GUIs Interact
A new documentation section, “Making Multiple GUIs Work Together”,
has been added to illustrate how multiple GUIDE GUIs can work together
by sharing data to create a more complicated GUI. It first summarizes the
techniques that GUIDE GUIs can use to share data with one another. It then
steps through two examples, accompanied by their M-files and FIG-files, to
show how to use those techniques for specific tasks.
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Functions Being Removed

Function
Name

What
Happens
When You
Run the
Function?

Use This Function
Instead

Compatibility
Considerations

axlimdlg Errors None No replacement

cbedit Errors guide Use the guide
command instead

clruprop Errors rmappdata Replace existing
instances of
clruprop with
rmappdata

ctlpanel Errors guide Use the guide
command instead

edtext Errors Set the editing
property on the text
object

No replacement

extent Errors Get the extent
property of the text
object

No replacement

getuprop Errors getappdata Replace existing
instances of
getuprop with
getappdata

hthelp Errors web Replace existing
instances of hthelp
with web

layout Errors None No replacement

matq2ws Errors None No replacement

matqdlg Errors None No replacement

matqparse Errors None No replacement
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Function
Name

What
Happens
When You
Run the
Function?

Use This Function
Instead

Compatibility
Considerations

matqueue Errors None No replacement

menubar Errors Set the menubar
property of the figure
to none

No differences

menuedit Errors guide Use the guide
command instead

pagedlg Errors pagesetupdlg Replace existing
instances of pagedlg
with pagesetupdlg

setuprop Errors setappdata Replace existing
instances of
setuprop with
setappdata

umtoggle Errors Set the Checked
property of uimenu
objects

No differences

wizard Errors guide Use the guide
command instead

ws2matq Errors None No replacement
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External Interfaces/API, MATLAB Version 7.5 (R2007b)
• “Support for 64-bit mxArrays” on page 50

• “Fortran MEX-Files Will Require mwSize and mwIndex” on page 51

• “Changes to the MATLAB Locale Setting” on page 51

• “Changes to MEX Error-Handling Functions mexErrMsgTxt and
mexErrMsgIdAndTxt” on page 52

• “Rebuild MEX-Files Created with MATLAB Versions Earlier Than V7
(R14)” on page 52

• “Changes to Compiler Support” on page 52

• “Changes to Applications Built with Borland 5.5 or 5.6 C Compilers” on
page 54

• “Environment Variable Required for mex with Microsoft Platform SDK
Compiler” on page 54

• “Environment Variables Required for mex with Intel Visual Fortran 9.0”
on page 54

• “Changes to Handling ActiveX Methods” on page 55

• “Changes to Dynamic Data Exchange (DDE) Documentation” on page 55

Support for 64-bit mxArrays
MATLAB Version 7.5 (R2007b) supports 64-bit mxArrays. This change allows
C/C++ and Fortran files built on 64-bit platforms to handle large data arrays.

In earlier versions of MATLAB, mxArrays are limited to 231-1 elements. In
Version 7.5 (R2007b) your mxArray can have up to 248-1 elements.

The mex command option, -largeArrayDims, uses the large-array-handling
mxArray API. Use mwSize to represents size values, such as array dimensions
and number of elements. Use mwIndex to represent index values, such as
indices into arrays.
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Compatibility Considerations
MEX-files that built properly in previous versions of MATLAB continue to
build in Version 7.5 (R2007b).

The default option for mex is -compatibleArrayDims. If you use this option,
mex builds the files using the 32-bit array-handling API.

To work with 64-bit mxArrays, your C, C++ and Fortran source code must
comply with the 64-bit array-handling API. To use the API to create C/C++
MEX-files, see “Handling Large mxArrays” . To use the API to create Fortran
MEX-files, see “Handling Large mxArrays” .

Fortran MEX-Files Will Require mwSize and mwIndex
In a future version of MATLAB, the default mex command option will change
to -largeArrayDims. Fortran MEX-files will be required to use the mwSize
and mwIndex preprocessor macros

Compatibility Considerations
To make your Fortran MEX-file compatible with the -largeArrayDims option,
and to create platform-independent code, you need to include the fintrf.h
header file in your Fortran source files, and you need to name your source files
with an uppercase .F file extension. For information on creating MEX-files,
see the “Gateway Routine” in the Fortran MEX-Files topic.

Changes to the MATLAB Locale Setting
Retrieving and using the proper locale setting is a mandatory operation in
creating and using applications for international audiences. In R2007b,
MATLAB Version 7.5 standardizes the way it initializes the locale setting
across platforms. As a result, on Windows platforms, MEX-files that use
C/C++ locale-dependent standard library functions should note that MATLAB
now sets the locale using the setlocale function.

Because of changes to Microsoft Visual Studio, MEX-Files created on Windows
with Microsoft Visual Studio 2003 will not have the same locale setting as
MATLAB Version 7.5 (R2007b).
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Note C/C++ users must not change the locale setting using the setlocale
function. This is true for all versions of MATLAB on all platforms.

Changes to MEX Error-Handling Functions
mexErrMsgTxt and mexErrMsgIdAndTxt
In MATLAB Version 7.5 (R2007b). the mexErrMsgTxt and mexErrMsgIdAndTxt
functions determine where the error occurred, and display the function name.
In previous versions, these functions only display the error message.

For example, if an error occurs in the function foo, mexErrMsgTxt and
mexErrMsgIdAndTxt display the following information before the error
message:

??? Error using ==> foo

Rebuild MEX-Files Created with MATLAB Versions
Earlier Than V7 (R14)
To work with MATLAB V7.5 (R2007b), MEX-files compiled on any platform
with MATLAB versions earlier than V7 (R14) no longer load correctly and
must be rebuilt.

Changes to Compiler Support
The set of compilers that MATLAB supports has changed in MATLAB Version
7.5 (R2007b). For an up-to-date list of supported compilers, see Technical Note
1601: http://www.mathworks.com/support/tech-notes/1600/1601.html.

• “New Compiler Support” on page 52

• “Discontinued Compiler Support” on page 53

• “Compiler Support to Be Phased Out” on page 53

New Compiler Support
MATLAB V7.5 (R2007b) supports new compilers for building MEX-files.
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Windows platforms.

• Microsoft Visual Studio 2005 SP1

Solaris SPARC (64-bit) platform.

• gcc / g++ Version 4.1.2

Discontinued Compiler Support
The following compilers are no longer supported.

Windows platforms.

• Microsoft Visual Studio 2005 without SP1

Solaris SPARC (64-bit) platform.

• gcc / g++ Version 3.2.3

Compatibility Considerations. To ensure continued support for building
your C/C++ programs, consider upgrading to another supported compiler.
For an up-to-date list of supported compilers, see Technical Note 1601:
http://www.mathworks.com/support/tech-notes/1600/1601.html.

Compiler Support to Be Phased Out
The following compilers are supported in Version 7.5 (R2007b), but will not be
supported in a future version of MATLAB.

Windows (32-bit) platform.

• Intel Visual Fortran Version 9.0

• Borland C++ Builder 6 Version 5.6

• Compaq Visual Fortran Version 6.6

• Intel C++ Version 7.1

• Borland C++ Builder 5 Version 5.5

• Borland C++ Compiler Version 5.5
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• Compaq Visual Fortran Version 6.1

Changes to Applications Built with Borland 5.5 or
5.6 C Compilers
MATLAB applications built with Borland Version 5.5 or 5.6 C compilers have
changed in MATLAB Version 7.5 (R2007b). MATLAB applications that run
under Windows are now implemented as console applications, not Windows
applications.

Compatibility Considerations
If you have customized the build process based on one of the
bcc*engmatopts.bat options files, you must edit this file making changes to
the appropriate LINKFLAGS statement, as described in the .bat file comments.

Environment Variable Required for mex with
Microsoft Platform SDK Compiler
When you build a MEX-file, an engine application, or a MAT application
on a Windows 64-bit platform using the Microsoft Platform SDK compiler,
MATLAB requires that you define the environment variable MSSdk. The
value of this environment variable is the path to the installation directory for
Microsoft Platform SDK. The Microsoft Platform SDK installation program
does not commonly define this environment variable. For example, you might
set the environment variable as follows:

C:\Program Files\Microsoft Platform SDK

Environment Variables Required for mex with Intel
Visual Fortran 9.0
When you build a MEX-file, an engine application, or a MAT application using
Intel Visual Fortran 9.0, MATLAB requires that you define an environment
variable for the Windows platform you are using.

Windows (32-bit) platform
Define the environment variable VS71COMNTOOLS. The value of this
environment variable is the path to the Common7\Tools directory of the Visual
Studio .NET 2002 or 2003 installation directory. (Intel Visual Fortran requires
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Visual Studio .NET 2002 or 2003 on 32-bit Windows platforms.) The Visual
Studio .NET 2003 installation program commonly defines this environment
variable. For example, you might set the environment variable as follows:

C:\Program Files\Microsoft Visual Studio .NET 2003\Common7\Tools

Windows x64 platform
Define the environment variable MSSdk. The value of this environment
variable is the path to the installation directory for Microsoft Platform SDK for
Windows Server 2003. (Intel Visual Fortran requires Microsoft Platform SDK
for Windows Server 2003 on Windows x64 platforms.) The Microsoft Platform
SDK installation program does not commonly define this environment
variable. For example, the environment variable might have the value

C:\Program Files\Microsoft Platform SDK

Changes to Handling ActiveX Methods
In MATLAB Version 7.4 (R2007a), a change was made to ActiveX methods
which was not documented in the release notes. This change is described in
“Changes to Handling ActiveX Methods” on page 107 in the MATLAB Release
Notes, Version 7.4 (R2007a).

Changes to Dynamic Data Exchange (DDE)
Documentation
In MATLAB V5.1, all development work for the Dynamic Data Exchange
(DDE) server and client was stopped. This functionality is no longer
documented in V7.5 (R2007b). The MathWorks provides, instead, a MATLAB
interface to COM technology that is documented in COM Support in MATLAB
(Windows Only).

Obsolete Functionality No Longer Documented
Documentation for Dynamic Data Exchange (DDE) is no longer included in
External Interfaces.
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Compatibility Considerations. If you must support this obsolete
functionality, we suggest you print a copy of the External Interfaces chapter
“COM and DDE Support (Windows Only)” from MATLAB V7.4 (R2007a)
or earlier.

Documentation for Obsolete Functions To Be Phased Out
Documentation for the following functions is included in the MATLAB
Function Reference documentation for MATLAB V7.5 (R2007b), but will not
be included in a future version of MATLAB.

Obsolete Functions

ddeadv

ddeexec

ddeinit

ddepoke

ddereq

ddeterm

ddeunadv

The following syntax for enableservice, included in the MATLAB Function
Reference documentation for MATLAB V7.5 (R2007b), will be removed from
the documentation.

enableservice('DDEServer',enable)

Compatibility Considerations. If you must support this obsolete
functionality, we suggest you print and keep a copy of the relevant MATLAB
function reference pages from V7.5 (R2007b) or earlier.
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This table summarizes what’s new in Version 7.4 (R2007a):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports
Includes fixes

No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.4
(R2007a)” on page 59

• “Mathematics, MATLAB Version 7.4 (R2007a)” on page 81

• “Data Analysis, MATLAB Version 7.4 (R2007a)” on page 85

• “Programming, MATLAB Version 7.4 (R2007a)” on page 86

• “Graphics and 3-D Visualization, MATLAB Version 7.4 (R2007a)” on page
94
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• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.4
(R2007a)” on page 98

• “External Interfaces/API, MATLAB Version 7.4 (R2007a)” on page 101
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Desktop Tools and Development Environment, MATLAB
Version 7.4 (R2007a)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 59

• “Desktop” on page 64

• “Running Functions—Command Window and History” on page 72

• “Help” on page 73

• “Workspace, Search Path, and File Operations” on page 75

• “Editing and Debugging M-Files” on page 76

• “Tuning and Managing M-Files” on page 79

• “Publishing Results” on page 79

Startup and Shutdown
New features and changes introduced in Version 7.4 (R2007a) are

• “Double-Clicking Associated File Type in Windows Explorer Now Opens
File in Existing MATLAB Session” on page 59

• “Changes to Startup Directory (Folder) and Startup Options for MATLAB
on Windows” on page 60

• “JVM for Windows Updated” on page 63

• “New Version of Java Access Bridge” on page 64

• “Confirm Exit Preference to be Enabled by Default in Future Version” on
page 64

Double-Clicking Associated File Type in Windows Explorer
Now Opens File in Existing MATLAB Session
When you open a file from Windows Explorer whose type is associated with
MATLAB®, the file opens in the appropriate tool in the existing MATLAB
session if MATLAB is already running, or starts MATLAB. This assumes
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you associated the file types with MATLAB by accepting the defaults during
MATLAB installation, or by changing the associations. For example, in
Windows Explorer, double-click an M-file to open the file in the MATLAB
Editor/Debugger, or a MAT-file to open the Import Wizard and load the
data into the MATLAB workspace. For details, including how to change
file associations, see “Starting MATLAB from an M-File or Other File Type
in Windows”.

Compatibility Considerations. In previous versions, when you
double-clicked a file in Windows Explorer whose type was associated with
MATLAB, the file opened in a new MATLAB session. The change made in
MATLAB Version 7.4 (R2007a) to open the file in an existing session was
based on many user requests.

In previous versions, double-clicking a MAT-file associated with MATLAB in
Windows Explorer opened a new MATLAB session and loaded the data into
the workspace. In the Macintosh Finder, it loaded the data into the existing
MATLAB session. Now on Windows and Macintosh platforms, the Import
Wizard opens in the existing MATLAB session, with which you can load the
data into the workspace.

By default, in previous versions, double-clicking an M-file in Windows
Explorer opened it in the MATLAB stand-alone Editor. For more information
about that change, see “Stand-Alone Editor No Longer Opens By Default; To
Be Removed in a Future Version” on page 76.

Changes to Startup Directory (Folder) and Startup Options for
MATLAB on Windows
The default MATLAB startup directory on Windows platforms is now My
Documents\MATLAB, or Documents\MATLAB on Vista. Upon startup, MATLAB
automatically locates this MATLAB folder (creating it if it does not exist),
and adds it to the top of the search path. This utilizes Windows and Vista
standard folders to provide a unique startup directory for each user. As
such, the folder is part of the user’s profile in Windows (or Vista), and will
be accessible when the user runs MATLAB from other machines, when the
profile is set up to roam.

By default, the Target field for the MATLAB shortcut icon Properties dialog
box includes a new startup option -sd (for startup directory), followed by
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$documents\MATLAB, where MATLAB interprets $documents as the My
Documents folder for the current user (or Documents for Vista). If the path
for $documents is specified by Windows via a UNC pathname, MATLAB
automatically assigns it a mapped drive, creating one if necessary. The -sd
startup option overrides anything in the Start in field, which is now empty
by default.

For more information, see “Changing the Startup Directory”.
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Compatibility Considerations. In previous releases, the default startup
directory was \Work, located in the directory in which MATLAB was installed.
For example, in R2006b, if you installed MATLAB in C:\Program Files, the
default startup directory was C:\Program Files\MATLAB\R2006b\Work.
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Vista User Account Control (UAC) security features restrict access to Program
Files. To accommodate this enhanced security model, the MATLAB default
startup directory has been moved outside of Program Files.

These are the differences between the startup directory for R2007a and
previous releases:

• In previous releases, upon installation, the default startup directory was
specified in the Start in field of the MATLAB shortcut icon Properties
dialog box. You could change the startup directory by replacing the
pathname in that field. In R2007a, if you want to specify the startup
directory using the Start in field, you must also remove from the Target
field the -sd startup option and the pathname that follows it.

• The default startup directory is no longer specific to a release. When you
upgrade from R2007a to a future release, files you created and saved in My
Documents\MATLAB (or Documents\MATLAB on Vista) will automatically be
in the startup directory for the new release. Previously, you had to move
files you created and saved in the Work folder for a release, for example,
R2006a\Work, to the default startup directory for the new release, for
example, R2006b\Work.

• In previous releases, the default startup directory, Work, was shared by all
users running that MATLAB executable. The default startup directory in
R2007a, My Documents\MATLAB (or Documents\MATLAB on Vista), provides
each user with a unique startup directory.

• In previous releases, MATLAB added the default startup directory, Work,
to the bottom of the search path. In R2007a, MATLAB adds the default
startup directory, My Documents\MATLAB (or Documents\MATLAB on Vista),
to the top of the search path. In R2007a, for consistency with previous
releases, MATLAB adds ...\MATLAB\R2007a\Work to the bottom of the
search path. However, we encourage you to stop using the Work folder
because support for it might be removed in a future release.

JVM for Windows Updated
MATLAB is now using Java (JVM) 1.5.0_07 on Windows platforms. Java is
supplied with MATLAB for Windows platforms, so this change requires no
action on your part.
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Compatibility Considerations. If you use a specific version of Java with
MATLAB on Windows platforms, this change might impact you.

New Version of Java Access Bridge
MATLAB now installs Java Access Bridge Version 2.0, which is used by JAWS
for accessibility support.

Confirm Exit Preference to be Enabled by Default in Future
Version
When you exit from MATLAB, MATLAB terminates without displaying a
confirmation dialog box that asks if you are sure you want to quit. This is the
default behavior but you can set a preference to display a confirmation dialog
box. In a future version, the confirmation dialog box will appear by default
when you quit MATLAB.

Compatibility Considerations. When the confirmation dialog appears
by default, you will be able to disable it using preferences. If you have files
that include exit statements, you might need to ensure the preference for the
confirmation dialog box is disabled.

Desktop
New features and changes introduced in Version 7.4 (R2007a) are

• “Minimize, Temporarily Display, and Restore Tools in the Desktop” on
page 64

• “Maximize Tools in the Desktop” on page 68

• “Tabs for Tools Replaced by Title Bars” on page 70

• “Multithreaded Computation Support Added; Enable Via New Preference”
on page 72

Minimize, Temporarily Display, and Restore Tools in the
Desktop
On Windows and UNIX platforms, you can minimize any tool in the desktop.
Minimizing a tool creates a button for it along the specified edge. When you
want to view the tool, hover over or click the button to temporarily show
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it in the desktop. Right-click the button and select Restore toolname to
return the tool to the desktop. Perform these tasks for the selected tool using
items in the Desktop menu, equivalent mnemonics (for example Alt+D, N to
minimize), or buttons on the tool’s titlebar.

The following illustrations show how to use these features, using the example
of the Command History window in the default desktop layout.
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For more information, see “Opening and Arranging Tools” and “Minimized
Tools in Desktop Example”.

Maximize Tools in the Desktop
On Windows and UNIX platforms, you can maximize a tool so it occupies the
entire MATLAB desktop tool area, then restore it to return it to its previous
location. Perform these tasks for the selected tool using items in the Desktop
menu, equivalent mnemonics (for example Alt+D, X to maximize), or buttons
on the tool’s titlebar.
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For more information, see “Opening and Arranging Tools” and “Maximized
Tool in Desktop Example”.

Tabs for Tools Replaced by Title Bars
In the desktop, when you tab tools together, that is, arrange them so they
occupy the same position, the tools’ title bars share the title bar area. To
make a tool active, select its name in the title bar.
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For more information, see and “Tool Outside of Desktop and Other Tools
Grouped Inside Desktop Example” and “Grouping Tools Together”.

Compatibility Considerations. In previous versions, tools tabbed together
each had a tab at the bottom of the area they occupied. The tabs have been
removed in favor of tools sharing the titlebar area.
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Multithreaded Computation Support Added; Enable Via New
Preference
If you run MATLAB on a multiple-CPU system (multiprocessor or multicore),
use a new preference to enable multithreaded computation. This can increase
MATLAB performance for element-wise and BLAS library computations.

By default the preference is not set, so you must set it to enable multithreaded
computation. With the preference enabled, MATLAB automatically specifies
the recommended number of computational threads, although you can
change that value. On AMD-based Linux platforms, MATLAB supports
multithreaded computation, but requires an extra step to change the default
BLAS.

If you are using a multiple-CPU system, you can run a demo to see the
performance impact—see Multithreaded Computation in the Help browser.
For more information, see “Multithreading Preferences”.

Running Functions—Command Window and History
New features and changes introduced in Version 7.4 (R2007a) are

• “Startup Message Bar Replaces Startup Message in Command Window”
on page 72

• “Command History Searching Enhanced” on page 73

• “Macintosh—Some Key Bindings in Command Window Changed” on page
73

Startup Message Bar Replaces Startup Message in Command
Window
When you start MATLAB, a getting started message bar appears at the top
of the Command Window, that provides links to information that is helpful
for new users. You can dismiss the message bar by using the close box in it.
Use Command Window preferences to specify whether or not the message
bar should appear.
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Command History Searching Enhanced
You can now find entries in the Command History window by typing the first
few letters of an entry; the previous entry that begins with those letters is
selected. Then use up and down arrow keys to extend the find to the next and
previous instances. Use the Ctrl key with an arrow key to select the current
as well as next or previous instances. Use Ctrl+A to find and highlight all
instances at once. The search does not look at entries in sessions that are
collapsed. For more information about this search feature, see “Finding Next
Entry By Letter”.

Macintosh—Some Key Bindings in Command Window Changed
On Macintosh platforms, some key bindings were changed to make them more
consistent with Macintosh standard behaviors.

Compatibility Considerations. Because key bindings you have been used to
in the Command Window might have changed, peruse the list of all Macintosh
key bindings, documented at “Keyboard Shortcuts in the Command Window”

Help
New features and changes introduced in Version 7.4 (R2007a) are

• “Demos Now Included in Search Results and Product Filtering” on page 73

• “Get URL of Displayed Page for Viewing on Web” on page 74

• “Include Search Database for Your Own Help Files” on page 74

• “Video Tutorials Now Accessed Via Web Site” on page 74

Demos Now Included in Search Results and Product Filtering
When you perform a search in the Help browser, the results now include code
and text found in Demos. Also, the Demos listing in the Help Navigator
pane now synchronizes with the demo currently open when you have
the synchronization preference for the Help browser selected. For more
information, see “Search Documentation and Demos with the Help Browser”.

When you select File > Preferences > Help and enable the Product Filter,
only demos for selected products are shown in the Demos pane, and searched
via the Search for field.
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Get URL of Displayed Page for Viewing on Web
When viewing a page in the Help browser, select View > Page Locations.
A window appears providing the location of the current Help page you are
viewing. The window provides the page location on both your local system
and the MathWorks Web site. Use this feature to

• Send the URL to someone else who wants to view that information and
might not have MATLAB or the same version of MATLAB, for example, a
colleague or technical support.

• More easily see if this same documentation page has been updated for
the latest product version.

Include Search Database for Your Own Help Files
If you create your own HTML Help files for use with the MATLAB Help
browser, the Help browser can now search the content of your files. First
create a search database for your help files using the new builddocsearchdb
function. The function creates a helpsearch directory that contains the
search database files. For information on this process, see “Creating a
Searchable Database”.

Compatibility Considerations. In previous versions of MATLAB, some
users created help search databases for their own help files via assistance
from MathWorks Technical Support. If you created a help search database for
use with R2006b, it might work in R2007a, but it is recommended that you
recreate it for R2007a, even if no content has changed. If you created a help
search database prior to R2006b, you must recreate it for R2007a.

Help search databases in prior releases were built from a help jar file rather
than html files. The builddocsearchdb function only supports html files.
However, it is expected to support jar files in a future release. If you used a
jar file for a prior version and want to use a jar file in R2007a, build your
R2007a help search database using the same technique you used in R2006b.

Video Tutorials Now Accessed Via Web Site
Previously video tutorials were installed when you installed MATLAB. Now
the tutorials are on the MathWorks Web site.
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Compatibility Considerations. You can still link to and play video tutorials
from within the Help browser Demos listings or other links to them in the
product and documentation, however this now requires an active Internet
connection.

Workspace, Search Path, and File Operations
New features and changes introduced in Version 7.4 (R2007a) are described
here.

Current Directory Browser Enhancements

• When you double-click a Windows shortcut in the Current Directory
browser, it runs the shortcut.

• When you double-click a prj file in the Current Directory browser, it opens
in the Deployment Tool.

• You can now find entries in the Current Directory browser by typing the
first few letters of an entry; the entry that begins with those letters is
selected. For more information, see “Searching in the Current Directory
Browser”

Workspace Browser
When you double-click an object, it opens in the Property Inspector.

Array Editor Enhancements
You can now undo and redo the last operation you performed in the Array
Editor. This applies to cut, paste, insert, delete, and clear contents features.

Search Path Changes
On Windows platforms, MATLAB now adds the default startup directory, My
Documents\MATLAB (or Documents\MATLAB on Vista), to the top of the search
path upon startup.
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Compatibility Considerations. In previous releases, MATLAB added the
default startup directory, Work, to the bottom of the search path on Windows
platforms. For example, in R2006b, it added ...\MATLAB\R2006b\Work to the
bottom of the search path. In R2007a, for consistency with previous releases,
MATLAB adds ...\MATLAB\R2007a\Work to the bottom of the search path.
However, we encourage you to stop using the Work folder because support for
it might be removed in a future release. For more information, see “Changes
to Startup Directory (Folder) and Startup Options for MATLAB on Windows”
on page 60.

Editing and Debugging M-Files
New features and changes introduced in Version 7.4 (R2007a) are

• “Stand-Alone Editor No Longer Opens By Default; To Be Removed in a
Future Version” on page 76

• “Delimiter Matching Extended to Include Language Keyword Pairs” on
page 77

• “M-Lint Automatic Correction Feature” on page 77

• “M-Lint Detection of Missing End-of-Line Semicolons Enhanced” on page 78

• “Macintosh—Some Key Bindings in Editor/Debugger Changed” on page 79

• “Other Changes in the Editor/Debugger” on page 79

Stand-Alone Editor No Longer Opens By Default; To Be
Removed in a Future Version
Starting in this release, by default, double-clicking an M-file in Windows
Explorer opens the file in the MATLAB Editor/Debugger rather than in the
MATLAB stand-alone Editor. In a future version, the stand-alone Editor
will not be provided with MATLAB.

Compatibility Considerations. The change to open M-files in the MATLAB
Editor/Debugger rather than the stand-alone Editor was made based on many
user requests. You can still use the MATLAB stand-alone Editor in this release
by starting the application located at: matlabroot\bin\win##\meditor.exe.

Starting MATLAB by double-clicking an M-file requires a MATLAB license,
while starting the stand-alone Editor does not require a MATLAB license.
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If you want to associate M-files so that when you double-click them they
open in the MATLAB stand-alone Editor rather than in the MATLAB
Editor/Debugger, follow the instructions in “Changing File Associations for
MATLAB from Windows”; rather than specifying the MATLAB executable,
matlab.exe, specify meditor.exe, which is in the same folder.

Instead of the stand-alone Editor, you can use the MATLAB Editor/Debugger.
It provides all the features of the stand-alone Editor plus some not found in
the stand-alone Editor, such as debugging and tab completion; for a full list,
see “Stand-Alone Editor Will Not Be Included in Next Version” on page 24.

Some users have preferred the stand-alone Editor to the MATLAB
Editor/Debugger because of slightly better startup performance and because
it does not require a MATLAB license. For those situations, you can use
any text editor you have, such as UltraEdit or Emacs. If you have concerns
about the pending removal of the stand-alone Editor, please contact us at
editor-feedback@mathworks.com, so we can plan to minimize transition
issues.

Delimiter Matching Extended to Include Language Keyword
Pairs
You can now see the match to language keyword pairs using delimiter
matching features that previously existed for parentheses and brackets.
For example, when you type end, the Editor/Debugger highlights
the matching if. To set delimiter matching preferences, select
File > Preferences > Keyboard > Delimiter Matching; click Help for
more information.

M-Lint Automatic Correction Feature
For some types of warnings or errors, M-Lint can apply an automatic fix to
the code. Code that can be automatically corrected appears with a different
background color. To perform the fix, right-click the code that is highlighted
(for a single single-button mouse, use Ctrl+click); from the resulting context
menu, select the auto-fix action.
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For more information, see step 7 in the example at “M-Lint Automatic Code
Analyzer in the Editor/Debugger”.

M-Lint Detection of Missing End-of-Line Semicolons Enhanced
In previous versions, there was a single output message generated by a line
with a missing terminating semicolon:

Terminate statement with semicolon to suppress output.

However, M-Lint suppressed displaying the message for files with three or
more cells (a cell being indicated by a line with an initial %%). This was done
based on the assumption that such files were demo programs, and therefore
display of the output was intentional.

In MATLAB Version 7.4 (R2007a), M-Lint no longer makes a distinction for
files with three or more cells. Instead, M-Lint displays one message for scripts
and a different message for functions:

Terminate statement with semicolon to suppress output (in functions).

Terminate statement with semicolon to suppress output (in scripts).
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The corresponding M-Lint tags to suppress display of such messages within a
line are %#ok<NOPRT> for functions, and %#ok<NOPTS> for scripts.

By default, both of the messages are initially selected in Preferences.

Compatibility Considerations. In MATLAB Version 7.3 (R2006b),
%#ok<NOPRT> was the only tag used to suppress the missing terminating
semicolon. The tag will remain valid for function files, but will not be valid
for script files. If you added any %#ok<NOPRT> tags in script files in R2006b,
change those tags to the new tag %#ok<NOPTS>.

Macintosh—Some Key Bindings in Editor/Debugger Changed
On Macintosh platforms, some key bindings were changed to make them more
consistent with Macintosh standard behaviors.

Compatibility Considerations. Because key bindings you have been used to
in the Editor/Debugger might have changed, peruse the list of all Macintosh
key bindings documented at “Keyboard Shortcuts in the Editor/Debugger”.

Other Changes in the Editor/Debugger

• There is a new confirmation preference for displaying a warning about
exiting debug mode in order to save a file.

Tuning and Managing M-Files
There was a minor change in M-Lint behavior—for details, see “M-Lint
Detection of Missing End-of-Line Semicolons Enhanced” on page 78.

Compatibility Considerations
See the compatibility considerations associated with “M-Lint Detection of
Missing End-of-Line Semicolons Enhanced” on page 78.

Publishing Results
New features and changes introduced in Version 7.4 (R2007a) are

• “Publishing Function M-Files Now Supported” on page 80
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• “Specify Maximum Number of Output Lines in Published File” on page 80

• “New Publishing Options” on page 80

Publishing Function M-Files Now Supported
You can now publish an M-file function. When publishing an M-file function,
you cannot evaluate the code. This feature effectively allows you to save M-file
functions to output formats such as HTML or Microsoft Word documents,
with formatting. To publish an M-file function, first clear the Evaluate
code preference in Editor/Debugger Publishing Preferences, or run the
publish function with the evalCode option set to false.

Specify Maximum Number of Output Lines in Published File
Using the publish function, you can specify the maximum number of lines in
a published file. Set the new maxOutputLines field to a nonnegative value.
The default value is Inf.

New Publishing Options
New publishing options provide increased flexibility and control over the
appearance of the published document. The added options are for adding
inline links, inline links with link text, graphics, and HTML markup. See
“Marking Up Text in Cells for Publishing” for more information.
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Mathematics, MATLAB Version 7.4 (R2007a)
New features and changes introduced in this version are:

• “New Functions” on page 81

• “More Efficient Matrix Multiplication for Sparse Matrices” on page 81

• “rand Function Uses the Mersenne Twister Algorithm as Default” on page
81

• “Upgrade to BLAS Libraries” on page 83

• “Divide By Zero and Log Of Zero Warnings Off By Default” on page 83

• “mode of Empty Array Now Returns NaN” on page 83

• “Change to Syntax for Setting BLAS Library Version on Linux” on page 84

New Functions
Function Description

bsxfun Applies an element-by-element binary operation to
two full arrays with singleton expansion enabled

ilu Performs the sparse incomplete LU factorization

More Efficient Matrix Multiplication for Sparse
Matrices
Matrix multiplication for A'*b now handles sparse matrices more efficiently.

rand Function Uses the Mersenne Twister Algorithm
as Default
The rand function now uses the Mersenne Twister algorithm as default
generator algorithm. This method generates double precision values in the
closed interval [2^(-53), 1-2^(-53)], with a period of (2^19937-1)/2. Prior to
this release, MATLAB used an algorithm known as the Subtract-with-Borrow
(SWB) algorithm.
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The rand function now produces different results than in previous releases.
However, the results returned are still pseudorandom values drawn from a
standard uniform distribution. Because the values returned by rand are
intended to be random, this change should not affect your code.

Compatibility Considerations
There are several things to keep in mind regarding this change:

• If your code requires the exact values returned by rand in previous releases,
you should use the statement

rand('state',0);

to reset rand to use the SWB algorithm. The new default algorithm’s
internal state at startup is equivalent to using the statement

rand('twister',5489);

Note that the 'state' keyword corresponds specifically to the SWB
algorithm; it cannot be used generally to refer to the internal state of the
currently active algorithm.

• Existing code that uses the 'state' keyword to reinitialize rand in a
statement such as

rand('state',sum(100*clock))

causes rand to switch to using the SWB algorithm. You may want to use
the 'twister' keyword, which resets rand but does not switch algorithms.

• Existing code that uses the 'state' keyword to save and restore the
internal state of rand in statements such as

savedState = rand('state');
... % code that uses rand

rand('state',savedState);

may no longer work as intended. Specifically, the first line of code saves
the state of the SWB generator algorithm (see the rand documentation for
details). If the default Mersenne Twister algorithm was the active one at
that time, then using the saved state in the last line does not restore the
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rand internal state to its original conditions. Instead, it switches the rand
algorithm to SWB. To save and restore the internal state of the Mersenne
Twister algorithm, use the 'twister' keyword.

Upgrade to BLAS Libraries
MATLAB now uses new versions of the Basic Linear Algebra Subroutine
(BLAS) libraries. For Windows, Intel Mac, and Intel processors on Linux
platforms, MATLAB supports the Intel Math Kernel Library (MKL) version
9.0. For AMD processors on Linux platforms, MATLAB uses the AMD Core
Math Library (ACML) version 3.5. For the Solaris platform, MATLAB uses
the Sun Performance Library from Sun Studio 11.

Divide By Zero and Log Of Zero Warnings Off By
Default
MATLAB no longer displays Divide by zero and Log of zero warnings
unless you explicitly enable them with the following commands:

warning on MATLAB:divideByZero
warning on MATLAB:log:LogOfZero

This only affects the display of the warning message on the screen; the
warning status is still updated as usual.

Compatibility Considerations
This change should not cause any incompatibility with your existing code in
this release. In future releases, in which internal MATLAB code will not
necessarily disable these warning messages, you may see messages displayed
that are currently suppressed.

mode of Empty Array Now Returns NaN
The mode function, when operating on an empty array ([]), returns a 1-by-0
array in previous releases, while related functions mean, median, std, and var
return NaN when given the same input. In this release, mode returns NaN for
an empty array input.
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Compatibility Considerations
Existing program code that relies on mode of an empty array to return an
empty array should be modified.

Change to Syntax for Setting BLAS Library Version
on Linux
If you change the BLAS library used by MATLAB on Linux platforms,
MATLAB now loads libraries in the left-to-right order specified in the syntax.
For example, to load the Intel MKL BLAS, from a system prompt, run

setenv BLAS_VERSION mkl.so:mklcompat.so

MATLAB loads mkl.so first, and then loads mklcompat.so.

This also applies if you edit bin\$(ARCH)\blas.spec directly.

Compatibility Considerations
This syntax differs from that used for Linux platforms in prior versions.
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Data Analysis, MATLAB Version 7.4 (R2007a)
There were no new features or changes in this version.
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Programming, MATLAB Version 7.4 (R2007a)
New features and changes introduced in this version are:

• “New Functions” on page 86

• “Multithreading with MATLAB” on page 87

• “Parse Inputs with Consistently Implemented Mechanism” on page 87

• “textscan Returns Like Values in Same Cell Array” on page 87

• “Numbered Arguments for Formatted String Functions” on page 88

• “The dir Function Returns Additional datenum Field” on page 89

• “Using whos -file on Objects with Overloaded size or class Methods” on
page 89

• “mat2str Returns Correct Output for Strings” on page 90

• “Warning Generated by try-catch” on page 90

• “save -regexp Saves to Correct Filename” on page 92

• “Functions Not Callable If in Directory Under Class Directory” on page 92

• “Improved Performance on Certain Platforms and Operations” on page 92

• “Technique to Conserve Memory on Windows Vista” on page 93

• “ispuma Function Deprecated” on page 93

New Functions
New Functions in this release are

Function Description

assert Generates an error when a specified condition is violated.
Displays either the default error message or one that you
have written.
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Function Description

ismac Returns true if you are currently running one of the Mac
OS X versions of MATLAB.

verLessThan Compares the specified version number and toolbox name
with the version of that same toolbox that is currently
running. Use verLessThan in your functions when you
want to write code that can run across multiple versions
of MATLAB.

Multithreading with MATLAB
You can improve the performance of MATLAB on multicore or multiprocessor
systems by taking advantage of the multithreaded computational capabilities
available in MATLAB in this release. See the following release note under
Desktop Tools and Development Environment for more information:
“Multithreaded Computation Support Added; Enable Via New Preference” on
page 72

Parse Inputs with Consistently Implemented
Mechanism
The new inputParser class provides a consistent mechanism for parsing
and validating input arguments in the M-file functions you write. Using
inputParser methods in the body of your function, you build a schema that
represents each valid input argument to the function. In the schema, you
can specify whether arguments are required or optional, and if they are to
be passed as single values or as parameter-value pairs. The schema also
provides a means of validating each incoming argument. The properties of
the inputParser class give you additional information about arguments that
are passed to the function.

For more information, see “Parsing Inputs with inputParser” in the MATLAB
Programming documentation.

textscan Returns Like Values in Same Cell Array
In previous versions of MATLAB, the textscan function always returned each
output value in a separate cell array, even if those values were of the same
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data type. In this release, if you call textscan with the new CollectOutput
switch, MATLAB returns all consecutive data that is of the same type in the
same cell array. This can save you the extra task of sorting through the output
and merging like data types together in your own code.

For more information, see the textscan function reference page.

Numbered Arguments for Formatted String Functions
Using numbered argument specification with MATLAB functions that employ
format specifiers such as %d or %s (e.g., sprintf, error), you can pass the
numeric and character string values that correspond to these format specifiers
in a varying order. This can be useful when translating format strings in a
different sentence structure.

In addition to identifying the values, you can also use numbered arguments to
specify the field width and precision of the format specifiers. In the following
example, the first format specifier in the sprintf command is %1$*4$f (quite
different from the usual %f specifier). The 1$ tells MATLAB that the value
that is to replace this format specifier is in the first argument following the
format string; that is, 123.45678. The *4$ indicates that the field width for
this specifier is being passed in the fourth argument following the format
string: 15.

In the second and third arguments (%2$.*5$f and %3$*6$.*7$f), the symbols
2$ and 3$ represent the values, *5$ and *7$ represent precisions, and *6$
represents field width:

sprintf('%1$*4$f %2$.*5$f %3$*6$.*7$f', ...
123.45678, 16.42837, pi, 15, 3, 6, 4)

ans =
123.456780 16.428 3.1416

For more information, see “Formatting Strings” in the MATLAB Programming
documentation.
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The dir Function Returns Additional datenum Field
The dir function now returns the date the file or directory was last modified
in two formats: string and numeric. The numeric date value is not specific to
any particular locale, and thus is compatible for international use:

fileinfo = dir('myfile.txt')

fileinfo =
name: 'myfile.txt'
date: '16-Mar-2006 13:34:01'

bytes: 251
isdir: 0

datenum: 7.3275e+005

This new output is also returned when running dir on an FTP server.

Using whos -file on Objects with Overloaded size or
class Methods
MATLAB is unable to determine the true size of an object stored in a MAT-file
if the class of this object overloads the MATLAB size function. Likewise,
MATLAB cannot determine the true class name of an object if it overloads the
MATLAB class function. For these reasons, in previous versions of MATLAB,
the command whos -file does not return or display object size and class
accurately if the class of that object overloads these methods, but instead
always returns 1x1 for the size and a default name for the class.

In this release, whos -file returns the empty matrix ([]) or displays a
hyphen (-) for objects that overload size, and returns and displays unknown
for objects that overload class.

Compatibility Considerations
If you use whos -file on objects in any of your programs, and if any of these
objects overloads the size function, then you need to be aware that MATLAB
now returns [] instead of a 2–element vector of ones in the size field of the
output structure.
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mat2str Returns Correct Output for Strings
The documentation for the mat2str function states that the str output of
this function “is suitable for input to the eval function such that eval(str)
produces the original matrix to within 15 digits of precision.” The behavior of
mat2str when given a character array as input, however, did not abide by this
rule. This inconsistency has been fixed in this release.

In MATLAB Version 7.3, the eval command below generated an error.

s = mat2str('MATLAB')
s =

'MATLAB'

eval(s)
ans =

MATLAB

Compatibility Considerations
You might have to modify M-file programs that expect the previous behavior
from mat2str.

Warning Generated by try-catch
To accommodate future changes in the MATLAB error-handling capabilities,
there is a new restriction to the syntax of the try-catch block. When the first
MATLAB statement that follows the try keyword consists of just a single
term (e.g., A as opposed to A+B) occurring on the same line as the try, then
that statement and the try keyword should be separated by a comma. For
example, the line

try A

should be written as either

try, A

or on two lines as

try
A
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This affects only single-term statements. For example, the following
statement continues to be valid:

try A+B

The same holds true for the catch keyword and a single-term statement
following the keyword on the same line. A valid try-catch statement of this
type should be composed as follows:

try, A, catch, B, end

If you omit the commas following try and/or catch, your code will continue to
operate correctly. However, MATLAB will issue a warning:

try statements, catch statements, end

Warning: This try-catch syntax will continue to work in R2007a,
but may be illegal or may mean something different in future
releases of MATLAB.

As with previous releases, the recommended syntax for a try-catch block
is as follows:

try
try_statements

catch
catch_statements

end

Note Due to a bug in the R2007a release, the warning for a catch followed
immediately by a single term is thrown as an error, even though the text of
the message says that it is a warning.

Compatibility Considerations
Your M-file programs may generate the warning shown above if the correct
syntax for try and catch is not used.
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save -regexp Saves to Correct Filename
In previous releases, the following command mistook the -regexp argument
([ab] in the case shown below) to be the name of the file to save to:

save -regexp [ab]

In this release, the filename is correctly understood to be the default save
filename, matlab.mat, and any arguments that follow the -regexp flag and
precede the next flag are interpreted as patterns to be matched.

Functions Not Callable If in Directory Under Class
Directory
M-files placed in a directory that is one or more levels beneath a MATLAB
class directory are not callable from that same directory. A MATLAB class
directory contains methods of a class and has a filename that begins with
the @ character.

In the following example, function myfun1 is not callable if the current
working directory is set to dir1. The same holds true for myfun2 if the current
working directory is set to dir2.

\home\matlab\@myobj\dir1\myfun1.m
\home\matlab\@myobj\dir1\dir2\myfun2.m

This behavior existed in the R2006b release, as well as in this release.

Compatibility Considerations
You will no longer be able to call a file that is one or more levels beneath a
MATLAB class directory if your current working directory is set to that same
directory.

Improved Performance on Certain Platforms and
Operations
As of release R2006b, MATLAB offers improved performance in the following
areas:
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• Improved performance on 64-bit Windows XP and Linux platforms. This is
independent of the size of data set in use.

• Faster scalar indexing into cell arrays.

• Faster assignment of cell array data to variables.

Technique to Conserve Memory on Windows Vista
To conserve memory on machines running Windows Vista, you can reduce
the amount of virtual memory space reserved by the operating system by
using the command:

BCDEdit /set increaseuserva 3072

More documentation on this option can be found at the following URL:

http://msdn2.microsoft.com/en-us/library/aa906211.aspx

ispuma Function Deprecated
Because MATLAB no longer supports OSX 10.1, the ispuma function always
returns false in this release, and also displays a warning message that the
function is now deprecated. Support for ispuma will be removed in a future
release of MATLAB.

Compatibility Considerations
It is recommended that you remove calls to ispuma from your M-file functions.
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Graphics and 3-D Visualization, MATLAB Version 7.4
(R2007a)

New features and changes introduced in this version are:

• “Nudging Annotations with Arrow Keys” on page 94

• “Movies No Longer Play During Loading” on page 94

• “Ghostscript Printing Software Upgraded” on page 95

• “Property Inspector Now Categorizes Graphic Object Properties” on page 95

• “Figure WindowScrollWheelFcn Property Programs Scrollwheel Events”
on page 97

• “Figure KeyReleaseFcn Property Programs Key Release Events” on page 97

Nudging Annotations with Arrow Keys
In plot edit mode, annotations such as textboxes, lines, arrows, doublearrows,
and text now respond to pressing directional arrow keys. Each keypress will
move the selected annotation(s) one or more pixels in the indicated direction.
If you select multiple objects, they all move together in response to arrow key
strokes. Normally, selected objects move one pixel with each press of an arrow
key. If you have selected Snap to Layout Grid from the Tools menu, each
keypress makes objects move to the next grid position.

Movies No Longer Play During Loading
The movie function no longer plays each frame one extra time. Previously, it
would show frames as they were loaded into memory to speed up display. This
behavior is no longer required and has been eliminated.

Compatibility Considerations
If you have code that calls movie in a loop a certain number of times and want
that number to remain the same, you need to add one iteration to the loop.
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Ghostscript Printing Software Upgraded
The Ghostscript software used by some print devices has been upgraded from
an older version to Version 8.54. Starting in this release, the MathWorks is no
longer shipping a separate, standalone Ghostscript executable program.

Compatibility Considerations
If you have written M-code based on undocumented functions that called the
old version of Ghostscript, your code will no longer work.

As a consequence of this upgrade, support for printing on DEC LN03 printers
(print dln03) has been removed from MATLAB.

Property Inspector Now Categorizes Graphic Object
Properties
The Property Inspector (accessed via the Property Editor, GUIDE, and
the inspect function) now provides tree views of groups of graphic object
properties as well as an alphabetical list of all properties. You can switch
between views via the two buttons at the top of the window, as shown in the
following picture of the tree view of the Printing category:
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In addition, the type of object currently being inspected is now shown in the
title bar of the Property Inspector window. Formerly it was shown in the gray
area below the title bar, which now contains the view manipulation buttons.

To change view, click a button without the blue background (the collapse
and expand buttons at right are disabled in alphabetic list view). When you
change views, the selected property stays the same. To inspect properties of
graphic objects in the tree view, click the + icon next to a category of interest.
Do the same to open properties within a category that have multiple elements.
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Note that only Handle Graphics® objects have categories; annotation and
most other MATLAB objects can be displayed only in alphabetic list view.

The functionality of the Property Inspector has not changed; only its GUI has.
As previously, if you select a set or array of objects and inspect them, the
Property Inspector only displays those properties that all the objects share.

For details on using the Property Inspector, see “Accessing Object Properties
with the Property Inspector” in the MATLAB Graphics documentation and
the inspect MATLAB reference page.

Compatibility Considerations
Text that you type or delete after clicking a text field that has a text widget
icon (for example, XTickLabel), will not persist unless you press Return
before clicking elsewhere. This mimics the behavior of clicking the text widget
icon to open a text entry dialog box, typing into it, and accepting the result by
clicking OK. This behavior differs from that which existed prior to R2006b
(MATLAB 7.3).

Figure WindowScrollWheelFcn Property Programs
Scrollwheel Events
The new figure property WindowScrollWheelFcn enables you to write a
callback function that handles mouse wheel scrolling events while the figure
has focus. See the documentation for the figure WindowScrollWheelFcn for
more information.

Figure KeyReleaseFcn Property Programs Key
Release Events
The new figure property KeyReleaseFcn enables you to write a callback
function that handles key release events (analogous to KeyPressFcn). See the
documentation for the figure KeyReleaseFcn for more information.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.4 (R2007a)

New features and changes introduced in this version are:

• “GUIDE No Longer Copies Callbacks When You Duplicate Components”
on page 98

• “GUIDE M-File-Defined handles Structure Fields No Longer Become
Permanent” on page 98

• “UNIX: File Dialog ’Location’ Property Is Obsolete” on page 99

• “Functions Becoming Obsolete” on page 99

GUIDE No Longer Copies Callbacks When You
Duplicate Components
In GUIDE, when you copy a component for which one or more of its callback
properties are defined, the callback properties of the newly created component
are now set to their default values, the ones you get when adding a component
directly from the Component Palette. Previously, their values were copied
from the corresponding callback properties of the original component. New
callback subfunctions can be generated in the GUI M-file for the new
component in the same way as for any component in the GUIDE layout.

Compatibility Considerations
If you have relied on the old behavior, in which the callbacks properties of the
new component point to the callbacks of the original component, you will
now have to explicitly change the callback properties, using the Property
Inspector, to do that.

GUIDE M-File-Defined handles Structure Fields No
Longer Become Permanent

The handles structure that is provided to every GUIDE generated callback
subfunction in the GUI M-file is constructed at runtime every time the GUI
runs. When the GUI is fully initialized, the handles structure contains
only handles to all the components in the GUI and custom data added in
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any CreatedFcn callbacks and/or the OpeningFcn. Previously, fields that
the M-file had added to the handles structure could sometimes become a
permanent part of the structure.

Compatibility Considerations
If your GUI runs well but displays error messages about missing fields in the
handles structure when starting up, you may have to update the code in the
GUI M-file where those fields are accessed. You may need to initialize those
handles fields properly in a CreateFcn callback and/or in the OpeningFcn.

UNIX: File Dialog ’Location’ Property Is Obsolete
For UNIX platforms, the Location property of uigetfile and uiputfile is
obsolete. Previously, for UNIX platforms only, you could use the Location
property to specify the screen location at which the dialog box would originally
be displayed.

Compatibility Considerations
Since the UNIX uigetfile and uiputfile Location property is now obsolete,
MATLAB ignores any occurrences in existing code of the Location property

uigetfile(...,'Location',[X Y])

or the older use of X and Y arguments to specify location

uigetfile(...,X,Y)

A warning is displayed for either syntax, on all platforms.

Functions Becoming Obsolete
The following functions are either obsolete or grandfathered in MATLAB 7.4
(R2007a): cshelp, figflag, getstatus, menulabel, popupstr,setstatus,
hidegui, uigettoolbar.

Compatibility Considerations
The functions shown in the following table will continue to work but their
use may generate a warning message. As soon as possible, replace any
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occurrences you may have of these functions with the function(s) shown in the
following table, if any, or with other suitable code.

Function Replacement

cshelp, figflag,
getstatus,
menulabel,
popupstr,
setstatus

Grandfathered. There are no replacements. No
enhancements will be made and only critical bugs
will be fixed. No warnings will be displayed. These
functions may become obsolete if replacements become
available.

hidegui Obsoleted. Now issues warnings. Set the figure
HandleVisibility property instead.

uigettoolbar Obsoleted. No warnings will be displayed until a
replacement is available in a future release.
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External Interfaces/API, MATLAB Version 7.4 (R2007a)
New features and changes introduced in this version are:

• “New File Extensions for MEX-Files” on page 101

• “MEX-Files Built in MATLAB R11 or Earlier Must Be Rebuilt” on page 102

• “Changes to Compiler Support” on page 102

• “New COM Features” on page 106

• “Changes to Handling ActiveX Methods” on page 107

New File Extensions for MEX-Files

MEX-Files in MATLAB for Intel-based Macintosh
With the introduction of MATLAB for Intel-based Macintosh, the MEX-files
you build have the extension .mexmaci. The mexext command in MATLAB
returns mexmaci for Macintosh (Intel).

Compatibility Considerations. MEX-files built using MATLAB for
Macintosh PowerPC, which have.mexmac extensions, cannot be used in
MATLAB for Intel-based Macintosh.

Note All MEX-files on Macintosh platforms need to be recompiled for
R2007a.

MEX-Files in MATLAB for 64–bit Solaris SPARC
With the introduction of MATLAB for 64–bit Solaris SPARC, you can now
build 64-bit MEX-files for the Solaris platform. These MEX-files have the
extension .mexs64. The mexext command in MATLAB returns mexs64 for
Solaris SPARC.

Compatibility Considerations. MEX-files built using MATLAB for Solaris
32, which have.mexsol extensions, cannot be used in MATLAB for Solaris
SPARC.
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Note All MEX-files on Solaris 64 platforms need to be recompiled for R2007a.

MEX-Files Built in MATLAB R11 or Earlier Must Be
Rebuilt
In order to work with MATLAB V7.4 (R2007a), MEX-files compiled on
Windows (32–bit) platforms with MATLAB R11 or earlier will no longer load
correctly and must be recompiled. These files can be compiled with MATLAB
R12 or later.

Changes to Compiler Support
The set of compilers that MATLAB supports has changed in MATLAB Version
7.4 (R2007a). For an up-to-date list of supported compilers, see Technical Note
1601: http://www.mathworks.com/support/tech-notes/1600/1601.html.

• “New Compiler Support” on page 102

• “Fortran Compatibility Considerations” on page 104

• “Discontinued Compiler Support” on page 104

• “Compiler Support To Be Phased Out” on page 105

• “Additional Linker Support for Intel Fortran” on page 105

New Compiler Support
MATLAB V7.4 (R2007a) supports new compilers for building MEX-files.

Windows (64-bit) platform.

• Intel C++ version 9.1

• Intel Visual Fortran version 9.1

Windows (32-bit) platform.

• Intel C++ version 9.1

• Intel Visual Fortran version 9.1
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• Microsoft Visual C++ 2005 version 8.0 Express Edition

Note If you use the mex -f
matlabroot/bin/$ARCH/mexopts/msvc80freeopts.bat
switch to build a MEX-file using Microsoft Visual C++ 2005 Express Edition,
the environment variable MSSdk must be defined. The value of this
environment variable is the path to the installation directory for Microsoft
Platform SDK for Windows Server 2003. (Microsoft Visual C++ 2005 Express
Edition requires Microsoft Platform SDK for Windows Server 2003.)

Macintosh PowerPC and Intel-based platforms.

• Apple Xcode 2.4.1 (gcc / g++ version 4.0.1)

• g95 version 0.90

Note All MEX-files on Macintosh platforms need to be recompiled for
R2007a.

Linux (64-bit) platform.

• gcc / g++ version 4.1.1

• g95 version 0.90

Linux (32-bit) platform.

• gcc / g++ version 4.1.1

• g95 version 0.90

Note All Fortran MEX-files compiled on Linux platforms need to be
recompiled for R2007a.
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Solaris SPARC (64-bit) platform.

• cc / CC version 5.8

• gcc / g++ version 3.2.3

• f90 version 8.2

Fortran Compatibility Considerations
In R2007a we have added support for a new Fortran compiler g95 on the
Linux and Macintosh platforms. This compiler implements the Fortran 95
language standard. It replaces previously supported Fortran compilers which
implemented a previous language standard.

This may cause incompatibilities in your Fortran source code for MEX-files.
Refer to the IBM XL Fortran V10.1 for Linux Language standards Web
site http://publib.boulder.ibm.com/infocenter/lnxpcomp/v8v101
/index.jsp?topic=/com.ibm.xlf101l.doc/xlflr/languagestandards.htm
for information about incompatibilities between language standards.

Discontinued Compiler Support
The following compilers are no longer supported.

Linux (64–bit) platform.

• gcc / g++ version 3.4.5

• g77 version 3.4.5

Linux (32–bit) platform.

• gcc / g++ version 3.4.5

• g77 version 3.4.5

Macintosh PowerPC platform.

• gcc / g++ version 3.3

• Absoft f77 / f90 version 8.2a

104

%20http://publib.boulder.ibm.com/infocenter/lnxpcomp/v8v101/index.jsp?topic=/com.ibm.xlf101l.doc/xlflr/languagestandards.htm


External Interfaces/API, MATLAB Version 7.4 (R2007a)

Compatibility Considerations. To ensure continued support for building
your C/C++ programs, consider upgrading to another supported compiler.
For an up-to-date list of supported compilers, see Technical Note 1601:
http://www.mathworks.com/support/tech-notes/1600/1601.html.

Compiler Support To Be Phased Out
The following compilers are supported in Version 7.4 (R2007a) but will not be
supported in a future version of MATLAB.

Windows (32-bit) platform.

• Intel C++ version 7.1

• Intel Visual Fortran 9.0

• Borland C++ Builder 6 version 5.6

• Borland C++ Builder 5 version 5.5

• Borland C++ Compiler version 5.5

• Compaq Visual Fortran version 6.6

• Compaq Visual Fortran version 6.1

Additional Linker Support for Intel Fortran
MATLAB V7.4 (R2007a) supports new linkers for building MEX-files with
Intel Visual Fortran 9.0.

Windows (32-bit) platform.

• Microsoft Visual Studio .NET 2003

• Microsoft Visual Studio 2005

Windows (64-bit) platform.

• Microsoft Visual Studio 2005

• Microsoft Platform SDK for Windows Server 2003 (Build 1289 or later)
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New COM Features

Programmatically Connect to Instances of a COM Automation
Server
MATLAB can now programmatically connect to an instance of a COM
Automation server using the new actxGetRunningServer function.

Improve the Custom Interface API
Changes to the actxserver function allow you to create a COM Automation
server using a custom interface.

New COM Data Type Support
Additional COM data type support has been added. See “Handling COM Data
in MATLAB” for a description of supported data types.

Enhanced Support for COM Interface Events
MATLAB users can take full advantage of event interfaces provided by
COM Automation servers. This change is implemented in the events,
eventlisteners, isevent, registerevent, unregisterevent, and
unregisterallevents functions.

For an example of this feature, see “Responding to Interface Events from an
Automation Server”.

Get the Status of a MATLAB Automation Server
Using the enableservice function you can learn the current state of a
MATLAB Automation server. The function returns a logical value, where
logical 1 (true) means MATLAB is an Automation server and logical 0 (false)
means MATLAB is not an Automation server.

For example, if you type

enableservice('AutomationServer')

and MATLAB displays
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ans =

1

then MATLAB is currently an Automation server.

Changes to MATLAB Version-Specific ProgID
A programmatic identifier, or ProgID, is used to create a COM component.
MATLAB’s version-specific ProgID Matlab.Application.N.M now let’s you
specify both a major and minor version number.

For example, to specify MATLAB version 7.4, use the ProgID
Matlab.Application.7.4.

Changes to Handling ActiveX Methods
Beginning in MATLAB Version 7.4 (R2007a), an ActiveX method with the
same name as a class is treated as a constructor and cannot be called in the
same way as an ordinary method.

In the following example:

Excel = actxserver('Excel.Application');
op = invoke(Excel.Workbooks, 'open', 'MyFile.xls');
Sheets = Excel.ActiveWorkBook.Sheets;
target_sheet = get(Sheets, 'item','Sheet1');
invoke(target_sheet, 'Activate');
Activesheet = Excel.Activesheet;
cellname = 'B2';
Range = Activesheet.cells.Range(cellname,cellname);

the term Range is both a function on the MATLAB path and a constructor
of the class Range. MATLAB tries to execute the function range, which
generates the error:

??? Error using ==> range
Too many input arguments.

Error in ==> MyScript at 8
Range = Activesheet.cells.Range(cellname,cellname);
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To get the property value, use the get function.

For example:

Range = get(Activesheet.cells, 'Range', cellname, cellname);
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This table summarizes what’s new in Version 7.3 (R2006b):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports
Includes fixes

No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.3
(R2006b)” on page 111

• “Mathematics, MATLAB Version 7.3 (R2006b)” on page 124

• “Data Analysis, MATLAB Version 7.3 (R2006b)” on page 130

• “Programming, MATLAB Version 7.3 (R2006b)” on page 131

• “Graphics and 3-D Visualization, MATLAB Version 7.3 (R2006b)” on page
140
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• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.3
(R2006b)” on page 144

• “External Interfaces/API, MATLAB Version 7.3 (R2006b)” on page 146
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Desktop Tools and Development Environment, MATLAB
Version 7.3 (R2006b)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 111

• “Desktop” on page 112

• “Help” on page 115

• “Workspace, Search Path, and File Operations” on page 116

• “Editing and Debugging M-Files” on page 117

• “Tuning and Managing M-Files” on page 121

• “Publishing Results” on page 123

Startup and Shutdown
New features and changes introduced in Version 7.3 (R2006b) are described
here.

Associate MATLAB Files with Windows Using New Utility
You can run a utility from the Help browser to associate .m, .mat, .fig, .p,
and .mdl files with MATLAB® in Windows. After running the utility, you will
be able to start MATLAB by double-clicking any of those file types in Windows
Explorer. You can still use Windows Explorer Folder Options to perform these
file associations, but the utility makes the task more convenient. For details,
see “Starting MATLAB from an M-File or Other File Type in Windows”.

Redirect Output on UNIX Now Sends Errors to Shell
When you start MATLAB on UNIX platforms using the -nodesktop startup
option and redirect output, for example to a file, MATLAB now sends any
errors to the shell, while normal output goes to the redirect target. This
change was made so that MATLAB redirection follows standard UNIX
behavior.

For example:
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matlab -nodesktop -"r magic(3), magi(5)" > test.txt

starts MATLAB in nodesktop mode, runs the statement magic(3) and writes
the output to test.txt. When MATLAB runs magi(5), execution fails and
MATLAB displays the error message in the shell.

Compatibility Considerations. In previous versions, MATLAB redirected
both output and error messages, so in the above example, MATLAB wrote the
output of magic(3) as well as the error message from magi(5) to test.txt.

If you have shell scripts that use > to redirect output, and you rely on errors
appearing in the output target, you need to modify the matlab startup
statements in those scripts.

To achieve the former behavior, that is, to redirect both output and errors
to the specified target, use that specific redirect syntax for your shell. For
example, in tcsh, use >&, as in

matlab -nodesktop -"r magic(3), magi(5)" >& test.txt

Desktop
New features and changes introduced in Version 7.3 (R2006b) are described
here.

M-Lint Preferences Added and Now Appear on M-Lint Panel
M-Lint preferences now appear on a new M-Lint panel. There are new M-Lint
preferences to disable specific messages or categories of messages, as well as
to save the settings for use in a later session. In addition, you can choose
to show or hide MATLAB® Compiler messages if the MATLAB Compiler is
installed. These new M-Lint preferences apply to the M-Lint code analyzer
operating automatically in the Editor/Debugger as well as to the M-Lint Code
Check Report you run via the Current Directory browser Directory Reports or
Tools > M-Lint > Show M-Lint Report.
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Compatibility Considerations. M-Lint preferences were previously
accessed via the Editor/Debugger Language settings for M.
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Close All Documents and Close Selected Documents Feature
Added
When you have multiple documents open within a tool, such as M-files in the
Editor/Debugger, select File > Close to readily close selected files in that tool.
Alternatively, right-click the document bar to close all open documents or all
open documents except the selected document in that tool.

Accessibility Documentation Included
Accessibility features and assistive technologies are now part of the Desktop
documentation. In prior versions, they were documented in the general
Release Notes.

New Look and Feel on Linux and Solaris Platforms
MATLAB has a new look and feel on Linux and Solaris platforms affecting
windows, decorations, color schemes, and responsiveness of the MATLAB
interface.

Compatibility Considerations. All of the changes are cosmetic, except
for file dialog boxes, like Open file. The new file dialog boxes are more
conventional and easier to use than in previous versions, and there is no
loss in functionality.

Invalid info.xml File on Path Now Generates an Error
When MATLAB finds an info.xml file on the search path or in the current
directory, it assumes the file is intended to add information to the Start
button or the Help browser, and automatically validates the file against
the supported schema. If there is an invalid construct in the info.xml file,
MATLAB displays an error in the Command Window. The error is typically of
the form

XML-file failed validation against schema located in
...
XML-file name: full path to...\info.xml

and might appear when you start MATLAB, press the Start button, or in
other situations. For more information about the error and how to eliminate
it, see “Adding Your Own Toolboxes to the Start Button”.
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Compatibility Considerations. In previous versions, MATLAB displayed a
warning when it encountered an invalid info.xml file.

Help
New features and changes introduced in Version 7.3 (R2006b) are described
here.

Exact Phrase and Wildcard Searching Added; Change to
Search Database
These improvements were made to the Help browser search feature. Note
that they are not supported on Japanese systems.

• Search Field Always Shown — The Search for field is now always in view
when the Help browser is open. The list of pages found appears in the
Search Results tab.

• Exact Phrase Searches for More Relevant Results — Find an exact phrase
by typing quotation marks around the search term. For example, "plot
tools" finds only pages that include plot tools together, but does not
find pages that include plot in one part of the page and tools in another
part of the page. You can specify more than one exact phrase in a search
term, such as "plot tools" "figure pallette".

• Wildcards (*) in Search Terms for Variations of a Word (Partial Word
Search) — Use the wildcard character (*) in place of letters or digits in your
search terms. For example, plot* finds various forms of the word plot,
such as plot, plots, and plotting, while p*t find those variations as
well as variations of print and part, among others. You can use multiple
wildcards in a word or search term.

• Boolean Operator Evaluation Order Changed — Boolean NOT operators in
search terms are now evaluated first, followed by ORs, and then ANDs. In
prior versions, Boolean operators were evaluated in left to right order.

Compatibility Considerations. The search enhancements were facilitated
by changing to a new type of database. As a result, any existing Help search
databases for non-Mathworks products will not work in R2006b and beyond.
The documentation still displays in the Help browser, but it is not included
in searches.
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If you use Help browser documentation for non-MathWorks products with a
pre-R2006b search database, a message will display in the Help browser to
notify you that the documentation will not be included in searches. If you
want search to work for that documentation, contact the product provider to
request an R2006b-compatible search database.

If you provide documentation for the Help browser and want the
documentation to be included in the searches, you need to update the
helpsearch.db entry in the info.xml file to the helpsearch directory, and
prepare an R2006b-compatible help search database. This process is much
easier than in the past. For instructions, contact Technical Support.

Workspace, Search Path, and File Operations
New features and changes introduced in Version 7.3 (R2006b) are described
here.

Statistical Results in Workspace Browser
The Workspace browser includes new columns that automatically display
results of common statistical calculations: Minimum, Maximum, Range,
Mean, Median, Mode, Variance, and Standard Deviation. Use View > Choose
Columns to specify the columns to show.

See also File > Preferences > Workspace for associated preferences.

Open Larger Arrays in Array Editor
You can open larger arrays in the Array Editor. In previous versions, large
arrays would fail to open in the Array Editor.
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Editing and Debugging M-Files
New features and changes introduced in Version 7.3 (R2006b) are

• “File Comparisons Tool Added” on page 117

• “M-Lint Enhancements for Suppressing Messages, and Showing MATLAB
Compiler Messages” on page 119

• “Restore Breakpoints Using New dbstop Feature” on page 120

• “End Debugging Completely Using New dbquit(’all’) Option” on page 120

File Comparisons Tool Added
Use the new File Comparisons tool to highlight the differences between two
files. Open a file, select Tools > Compare Against, and then browse to select
the second file or drag it into the tool from the Current Directory browser or
Windows Explorer. The two files appear aligned in a window with highlights
and indicators for any lines that differ, as shown in this example. For more
information, see “Comparing Files”.
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Use elements in the toolbar to exchange the left-right positions of the two files
and to specify the number of columns shown.
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You can also run the File Comparisons tool from the desktop by selecting
Desktop > File Comparisons. Drag a file from the Current Directory
browser or Windows Explorer into the tool. Then drag the second file into
the tool.

M-Lint Enhancements for Suppressing Messages, and Showing
MATLAB Compiler Messages
These are the new features and changes to M-Lint:

• “General Enhancements—Japanese Messages, and Line Number in
Indicator Bar” on page 119

• “Suppressing M-Lint Messages” on page 119

• “Deployment Messages in M-Lint” on page 120

• “Compatibility Considerations” on page 120

General Enhancements—Japanese Messages, and Line Number in
Indicator Bar.

• On Japanese systems, messages now appear in Japanese.

• The messages that appear at the indicator bar now includes the line
number.

Suppressing M-Lint Messages. The M-Lint automatic code analyzer in
the Editor/Debugger now provides a few ways for you to suppress specific
messages and categories of messages:

• Ignore Specific Instance — Right-click at the underline for an M-Lint
message, and from the context menu, suppress just that instance. M-Lint
adds %#ok and a new message ID tag to the end of the line, which is the
MATLAB syntax for suppressing an M-Lint message.

• Disable All Instances — Right-click at the underline for an M-Lint message,
and from the context menu, disable all instances of that message in all files.
This changes the preference setting for that message.

• Use Preferences to Disable All Instances — Select
File > Preferences > M-Lint, and disable specific messages or categories
of messages, which applies to all instances in all files. You can save the
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settings to an M-Lint preference file. From the Editor/Debugger, you can
select the M-Lint preference file from the Tools > M-Lint menu.

The M-Lint Code Check report also uses the preferences and suppresses the
display of specific messages and categories of messages, per the preference
settings.

Deployment Messages in M-Lint. M-Lint now displays MATLAB Compiler
deployment messages, such as MCC does not permit the CD function,
which appear if the MATLAB Compiler is installed and you select the M-Lint
preference to Show MATLAB Compiler deployment messages. You can
also disable or enable all deployment messages via the Editor/Debugger
Tools > M-Lint menu. You can suppress specific messages using the same
methods as for other M-Lint messages.

Compatibility Considerations. M-Lint preferences were previously
accessed via the Editor/Debugger Language settings for M. See also “mlint
Message IDs Changed and %#ok Syntax Enhanced” on page 121

Restore Breakpoints Using New dbstop Feature
You can save the status of breakpoints to a MAT-file using s=dbstatus and
restore the breakpoint status at a later time by loading the MAT-file using
the new dbstop(s) option. For example, set breakpoints in collatz. Run
s=dbstatus to assign the breakpoint status to s; use the 'completenames'
option to save absolute pathnames and breakpoint function nesting sequence.
Save s to a MAT-file by running, for example, save mydebugsession s. At a
later time, run load mydebugsession to restore s, and then run dbstop(s)
to restore the breakpoints.

End Debugging Completely Using New dbquit(’all’) Option
If you debug multiple files at once, you can exit debug mode for all files by
running dbquit('all'). If you debug file1 and step into file2, running
dbquit terminates debugging for both files. However, if you debug file3 and
also debug file4, running dbquit terminates debugging for file4, but file3
remains in debug mode until you run dbquit again. The new dbquit('all')
option ends debugging for both file3 and file4, and as dbquit does, ends
debugging for file1 and file2.
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Tuning and Managing M-Files
New features and changes introduced in Version 7.3 (R2006b) are described
here.

File Comparison Directory Report Removed; Replaced by File
Comparison Tool
The File Comparison Report, one of the directory reports available in the
Current Directory browser, was removed.

Compatibility Considerations. The new File Comparisons tool replaces the
File Comparison Report. The tool provides the same functionality as the
report did, and adds new features. For details, see “File Comparisons Tool
Added” on page 117.

M-Lint Code Check Report Enhancements and Changes
You can indicate specific messages or categories of messages you want M-Lint
to report. For details, see “M-Lint Enhancements for Suppressing Messages,
and Showing MATLAB Compiler Messages” on page 119.

Compatibility Considerations. In previous versions, the M-Lint Code
Check report showed all messages except those suppressed via a %#ok at the
end of a line. Now, the M-Lint Code Check report will show only the messages
that are enabled via M-Lint preferences.

mlint Message IDs Changed and %#ok Syntax Enhanced
The mlint function with the -id option returns message IDs using a new
form. For example, when you run

mlint('filename.m', '-id')

MATLAB Version 7.2 (R2006a) returns

L 22 (C 1-9) 2:AssignmentNotUsed : The value ...

whereas MATLAB Version 7.3 (R2006b) returns

L 22 (C 1-9): NASGU: The value ...
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The %#ok syntax used in M-files to suppress the display of M-Lint messages
for a line has been enhanced to support multiple messages per line. For
example, given this line in an M-file,

data{nd} = getfield(flds,fdata{nd});

two M-Lint messages result:

34: 'data' might be growing inside a loop; ...
consider preallocating for speed.

34: Use dynamic fieldnames with structures instead of GETFIELD...

Type 'doc struct' for more information.

In MATLAB Version 7.2 (R2006a), M-Lint messages could only be suppressed
for the entire line:

data{nd} = getfield(flds,fdata{nd}); %#ok

In MATLAB Version 7.3 (R2006b), you can still use %#ok to suppress all
messages for the line, or you can add an ID tag to indicate the exact messages
to suppress. For example, this suppresses only the first message about data
growing inside a loop:

data{nd} = getfield(flds,fdata{nd}); %#ok<GFLD>

To suppress more than one message per line, separate the ID tags with a
comma. For example, this suppresses both messages:

data{nd} = getfield(flds,fdata{nd}); %#ok<GFLD,AGROW>

Compatibility Considerations. In previous versions, the message IDs
returned from mlint with the -id option, were of a form that included a
numeric identifier, followed by the category. If you rely on the exact ID values,
you will need to make modifications to use the new form.

If you use M-Lint in MATLAB Version 7.3 (R2006b) and then run those files a
previous version, M-Lint in the previous version ignores the tag and IDs that
follow the %#ok, and therefore suppresses all messages for that line, which
is the expected behavior for the previous version.
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mlintrpt Option Added to Use Preference Settings File
The mlintrpt function now accepts a new option that applies the preferences
saved to an M-Lint settings file. It works with the file or dir syntax:

mlintrpt('fullpath_to_file', 'file', 'fullpath_to_configfile.txt')

mlintrpt('fullpath_to_dir', 'dir', 'fullpath_to_configfile.txt')

For example, create the file NoSemiSetting.txt by saving settings in
File > Preferences > M-Lint. Later, use the settings via preferences or
M-Lint in the Editor/Debugger, or via mlintrpt as in this example:

mlintrpt('lengthofline.m', 'file', 'I:\MATLABFiles\NoSemiSettings.txt')

which displays an M-Lint report in the MATLAB Web browser for the
lengthofline file in the current directory using the M-Lint settings in
I:\MATLABFiles\NoSemiSettings.txt.

Toolbar Refresh Button Removed
The Profiler included a refresh button on the toolbar. This button has been
removed. It performed an action similar to the Refresh button that appears
in many of the Profiler reports, so use that button instead.

Publishing Results

notebook Setup Arguments Removed
In MATLAB 7.1 (R14SP3), the notebook function was enhanced to
automatically detect the version of Microsoft Word and other required
information. This feature changed the notebook -setup syntax—arguments
to specify the version of Microsoft Word (wordversion, wordlocation,
templatelocation) were no longer supported. If you used those arguments,
MATLAB ignored them and issued a warning. Now in MATLAB 7.3 (R2006b),
if you use those arguments, MATLAB errors.

Compatibility Considerations. If you use notebook with the wordversion,
wordlocation, and templatelocation arguments in any of your files (for
example, startup.m), remove them to prevent errors.
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Mathematics, MATLAB Version 7.3 (R2006b)
New features and changes introduced in this version are:

• “New Functions” on page 124

• “max and min Now Use Magnitudes and Phase Angle for Complex Input”
on page 125

• “Additional Output from lu” on page 125

• “Upper and Lower Factors for chol and ldl” on page 125

• “Permutation Vectors with lu, luinc, ldl” on page 125

• “Two-Element Threshold for lu, spparms” on page 125

• “Lower Triangular Factors from symbfact” on page 126

• “Support for New Versions of AMD, COLAMD, CHOLMOD, UMFPACK”
on page 126

• “Sparse Arrays on 64-Bit Systems” on page 126

• “FFTW Upgraded to Version 3.1.1 in MATLAB” on page 127

• “Future Obsolete Functions” on page 128

• “Obsolete Functions” on page 128

• “max and min No Longer Return Warning Messages for Inputs with
Different Data Types” on page 129

New Functions
Function Description

amd Interface to the amd algorithm. This interface is
similar to that used in symamd, but is typically faster
than symamd.

bvpxtend Forms a guess structure for extending the boundary
value problem solution

ldl Full ldl factorization and solving for Hermitian
matrices
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max and min Now Use Magnitudes and Phase Angle
for Complex Input
For complex input, min and max are computed using the magnitude,
min(abs(x)) and max(abs(x)) respectively. In the case of equal magnitude
elements, the phase angle, min(angle(x)) and max(angle(x)), is now used.

Compatibility Considerations
In previous versions, min and max were computed using the magnitude, and
in the case of equal magnitude elements, the first element was used. This
behavior was indeterministic and not consistent with the sort function.

Code in previous releases that relied on the output of this functionality for the
case described above should be updated.

Additional Output from lu
The lu function returns an additional output that helps improve numerical
stability of sparse lu factorization.

Upper and Lower Factors for chol and ldl
Upper and lower triangular factors for chol and ldl improve performance
for sparse chol. Referencing the lower triangle and returning the lower
triangular factor is more memory efficient in the case of sparse chol.

Permutation Vectors with lu, luinc, ldl
Permutation vectors for lu, luinc, and ldl provide memory savings and,
for large data, a noticeable performance improvement. You can now store
permutation information in a single 1-by-N vector instead of an n-by-n matrix,

Two-Element Threshold for lu, spparms
A new two-element threshold for lu and spparms gives you more control over
sparse lu and sparse \ behavior.
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Lower Triangular Factors from symbfact
Extra arguments exported for symbfact allow the return of the lower
triangular symbolic factor.

Support for New Versions of AMD, COLAMD,
CHOLMOD, UMFPACK
MATLAB 7.3 supports new versions of the following libraries:

Library Name Version Supported in MATLAB 7.3

AMD 2.0

COLAMD 2.5

CHOLMOD 1.1

UMFPACK 5.0
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Sparse Arrays on 64-Bit Systems
The internal storage of sparse arrays on 64-bit systems has changed in the
R2006b release. This change should be invisible to most MATLAB users.
However, MEX-file programs that run on a 64-bit system and access sparse
arrays must be modified and recompiled in order to run on MATLAB Version
7.3. This applies to existing MEX-files and to any new MEX-files that you
write.

If you are affected by this change, you will need to take the following steps to
make your code compatible with the new sparse array format:

• Modify all sparse array declaration statements in MEX-files that are to run
on a 64–bit system so that they now use the mwSize and mwIndex types
instead of more specific type declarations such as int or INTEGER*4.

• Change any MEX code that assigns a negative value to a variable used
to hold a sparse array index or size. An example of this would be code
that temporarily uses an array index as a flag, assigning a -1 to it to mark
the index as unset. Do not try to cast negative int values to mwSize or
mwIndex. Instead, change your code to avoid using negative values.

• Recompile these MEX-files using the -largeArrayDims option

For a full description of what you will need to do, please read the section
“Sparse Arrays on 64-bit Systems” on page 147 in the MATLAB External
Interfaces release notes.

Compatibility Considerations
Existing MEX-files that run on 64-bit systems and access sparse arrays in
MATLAB will not operate correctly in MATLAB 7.3 unless the required
changes outlined above are made and the files are recompiled with the
-largeArrayDims option. New MEX-files that you create must also adhere to
these guidelines.

FFTW Upgraded to Version 3.1.1 in MATLAB
The version of FFTW used in MATLAB has been upgraded from 3.0.2 to 3.1.1
Please read the “Compatibility Considerations” on page 128 section, below.

Other changes in MATLAB FFTW support are:
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• The default planner method is now estimate. Previously, hybrid was
the default.

• There are new syntaxes for importing from and exporting to the library’s
internal single- and double-precision wisdom databases. These are as
follows and are documented in the reference page for the MATLAB fftw
function:

- str = fftw('dwisdom')

- str = fftw('swisdom')

- fftw('dwisdom', str)

- fftw('swisdom', str)

Compatibility Considerations
FFTW version 3.1.1 does not support wisdom produced by previous versions
of the FFTW library. For this reason, FFTW wisdom that has been exported
from a previous version of MATLAB cannot be imported successfully in
MATLAB R2006b. Trying to import “old” wisdom results in a warning.

Future Obsolete Functions
The betacore function generates a warning message in R2006b but completes
successfully. This function will be made obsolete in a future release.

Compatibility Considerations
You should remove all instances of the betacore function from your M-file
program code. This function will not be supported in a future release of
MATLAB.

Obsolete Functions
The following uses of MATLAB functions are obsolete as of this release.
Attempts to use this functionality in the R2006a release generate a warning
message but complete successfully. In R2006b, these operations fail and
generate an error message.

• The following functions in their entirety: bvpval, quad8, table1, table8,
bessela
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• The sort function, when used with complex integer inputs

• The gt, ge, lt, and le functions, when used with complex integer inputs

• The beta function, when used with 3 inputs

• The gamma function, when used with 2 inputs

• The opts.cheb and opts.stagtol fields in the options structure of eigs

Compatibility Considerations
You will need to remove all instances that reference these functions at this
time. These functions are no longer supported in MATLAB.

max and min No Longer Return Warning Messages
for Inputs with Different Data Types
In MATLAB version 7.0 (Release 14), the functions max and min were changed
to return results of a different data type than in previous releases. This
behavior is described in “max and min Now Have Restrictions on Inputs of
Different Data Types” on page 321. This change in behavior produced warning
messages to assist you with diagnosing any resulting issues. In R2006b, these
warning messages no longer exist.

Compatibility Considerations
The warning messages for mixed-type inputs to the functions max and min are
no longer produced. Turning warning messages on will no longer display
messages for this behavior, and you will no longer be able to depend on the
messages for the diagnosis of problems.
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Data Analysis, MATLAB Version 7.3 (R2006b)
New features and changes introduced in this version are:

• “Generate M-File Now Supports Basic Fitting and Data Statistics” on page
130

• “New Options for Working with Time Series Objects” on page 130

Generate M-File Now Supports Basic Fitting and
Data Statistics
The Generate M-File option on the File menu of MATLAB figure windows
now generates code that reproduces plot objects created with the Basic Fitting
Tool or the Data Statistics Tool. The generated M-file function accepts new
data as input and creates plot objects with the same graphics properties as
those in the generating figure. In addition, the M-file recomputes fits and
statistics for the new data. The code shows you how to program what you do
interactively with the Basic Fitting Tool or the Data Statistics Tool.

New Options for Working with Time Series Objects
• Time Series Tools are now easier to find. From the MATLAB Start button,

select MATLAB > Time Series Tools.

• Time series objects are now fully supported by the Array Editor. When
you open a timeseries object (using open or the Workspace browser), the
editor from Time Series Tools appears in the Array Editor.

• Time series objects can now be opened directly in Time Series Tools. Select
a timeseries object in the Workspace browser, right click, and choose
Open in Time Series Tools from the context menu.

• In Time Series Tools, you can now change subplot indices interactively.
Click on a plotted line in a time series view and drag and drop it from one
subplot to another. To create a new subplot, drag and drop the plotted
line below the bottom axes.
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Programming, MATLAB Version 7.3 (R2006b)
New features and changes introduced in this version are:

• “Saving to MAT-Files Larger than 2 GB” on page 131

• “Import Wizard Generates Import M-Code” on page 133

• “New Dynamic Regular Expression Syntax” on page 133

• “New Reserved MATLAB Keywords” on page 133

• “Enhancements to Display Generated by whos” on page 133

• “unique Function Returns First and Last Indices” on page 134

• “save Compression and Unicode Options Removed” on page 135

• “Warning Generated by try-catch” on page 136

• “Case-Sensitivity Warning Removed” on page 137

• “fprintf(0,...) Now Throws an Error” on page 137

• “Assigning Nonscalar Structure Array Fields to a Single Variable” on page
138

• “Comma Separators Not Required in Function Declaration” on page 139

• “Improved Performance on Certain Platforms and Operations” on page 139

Saving to MAT-Files Larger than 2 GB
With MATLAB R2006b, you can save data that is over 2 gigabytes in size.
This capability is implemented in MATLAB using a new HDF5-based format
for MAT-files.

To save to a MAT-file in this format, specify the new -v7.3 option with the
save function:

save -v7.3 myfile v1 v2

Note MATLAB Version 7.3 does not write MAT-files in HDF5 format by
default in this release; you must explicitly specify the -v7.3 switch.
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In this release,

• The default MAT-file format employed by save is the standard MAT-file
format used in the R14, R14SP, and R2006a releases. You can explicitly
specify this format with the command save -v7.

• To write an HDF5-based MAT-file, you must use save -v7.3.

In a future release,

• The default MAT-file format will be the HDF5-based format. You can
explicitly specify the HDF5-based format with the command save -v7.3.

• To write the standard MAT-file format, you must use save -v7.

Here is a summary of the version options that you can use with save:

save
Option

Description Available
In
Versions

Is the
Default In
Versionssave -v4 Save to a MAT-file you can open in

MATLAB version 4
V5 and
later

V4, V5

save -v6 Save to a MAT-file you can open in
MATLAB versions 5 or 6

V7 and
later

V6

save -v7 Save to a MAT-file you can open in
MATLAB version 7

V7.3 and
later

V7.3

save
-v7.3

Save to a MAT-file that supports data
items ≥2 GB

V7.3 and
later

post V7.3

Compatibility Considerations
If you are running MATLAB on a 64-bit computer system and you attempt to
save a variable that is too large for a version 7 (or earlier) MAT-file, that is,
you save without using the -v7.3 option, MATLAB skips that variable during
the save operation and issues a warning message to that effect.

If you are running MATLAB on a 32-bit computer system and attempt to load
a variable from a -v7.3 MAT-file that is too large to fit in 32–bit address space,
MATLAB skips that variable and issues a warning message to that effect.
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Import Wizard Generates Import M-Code
The Import Wizard now includes an automated M-code generation option.
Click the Generate M-code button located in the lower right of the Import
Wizard window and MATLAB generates an M-file that you can use to import
additional files that are similar in type to the file you are currently importing.
This simplifies the process of importing multiple files into MATLAB.

New Dynamic Regular Expression Syntax
The new (?@cmd) operator specifies a MATLAB command that regexp or
regexp is to run while parsing the overall match expression. Unlike the other
dynamic expressions in MATLAB, this operator does not alter the contents
of the expression it is used in. Instead, you can use this functionality to get
MATLAB to report just what steps it’s taking as it parses the contents of
one of your regular expressions. This can be helpful in debugging regular
expressions, for example.

New Reserved MATLAB Keywords
Two new reserved keywords have been added to the MATLAB language in
this release:

• parfor – designates a for loop in the Distributing Computing Toolbox

• classdef – signals the beginning of an MCOS class definition

The iskeyword function returns true for each of these functions, thus
identifying them as reserved keywords in MATLAB:

Compatibility Considerations
MATLAB keywords are reserved for use internal to MATLAB, and should not
be used in your own program code as identifiers or function names. If your
code uses either of these two new keywords in this manner, you should modify
your code and use words that are not reserved.

Enhancements to Display Generated by whos
The visual output of the information returned by whos looks slightly different
in R2006b than in previous releases. Changes are as follows:
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• There is a new column in the output called Attributes that identifies
values that are sparse, complex, global, or persistent.

• The words “array” and “object” have been dropped from items under the
Class heading. Items formerly listed as double array or timer object ,
for example, are now displayed as double, and timer.

• MATLAB no longer includes summary information showing the “Grand
total” of elements and bytes at the bottom of the whos output display.

• There is an additional field in the structure returned by whos. This new
field is 'persistent' and is set to logical 1 for those variables that are
persistent, or logical 0 otherwise.

Here is an example of the information displayed by whos in MATLAB 7.3:

whos

Name Size Bytes Class Attributes

vCell 5x7 2380 cell

vComplex 6x2 192 double complex

vDouble 6x5x9 2160 double

vFuncHdl 1x1 16 function_handle

vGlobal 0x0 0 double global

vObject 1x1 248 timer

vPersist 0x0 0 double persistent

vSparse 15x15 244 double sparse

vStruct 1x3 804 struct

Compatibility Considerations
If any of your programs depend on the displayed output of whos, specifically in
relation to the changes listed above, you might have to modify your program
code. Also, if your code relies on a specific number of fields for the output
structure, you should be aware that this release adds a new field: persistent.

unique Function Returns First and Last Indices
Using the new first option with the unique function returns a vector with
elements that represent the lowest indices of unique elements in the input
vector.
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Given the following vector A

A = [16 7 5 41 2 16 8 2 6 3 16 6 2 5 2 5];

Get a sorted vector of the unique elements of A:

v = unique(A)
v =

2 3 5 6 7 8 16 41

Use the first and last options to get indices of the first and last elements in
A that make up the sorted vector v:

[v, m1] = unique(A, 'first');
m1
m1 =

5 10 3 9 2 7 1 4

[v, m2] = unique(A, 'last');
m2
m2 =

15 10 16 12 2 7 11 4

save Compression and Unicode Options Removed
In MATLAB Versions 7.0 through 7.2, you could use the switches compress,
nocompress, unicode, and nounicode with the save function to enable or

disable compression and Unicode character encoding in the MAT-file being
generated. In MATLAB Version 7.3, the save function no longer supports
these switches. Instead, save now creates a MAT-file with compression and
Unicode character encoding by default, or with the following command:

save -v7 filename

You can still save to a MAT-file without using compression or Unicode
encoding. In fact, you will have to do this in order to create MAT-files that you
can load into a MATLAB Version 6 or earlier. To save to a MAT-file without
compression or Unicode encoding, type

save -v6 filename
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To disable compression and Unicode encoding for all save operations in a
MATLAB session, open the MATLAB Preferences dialog, select General
and then MAT-Files, and then click the button labelled Ensure backward
compatibility (-v6).

Compatibility Considerations
If you have code that uses any of these option switches with the save function,
you will need to modify that code to use the v6 option instead.

Warning Generated by try-catch
To accommodate future changes in the MATLAB error handling capabilities,
MathWorks has added a new restriction to the single-line syntax of the
try-catch block. In this release, the following syntax operates as it did in
previous releases, but now it also generates the following warning message:

try try_statements, catch catch_statements, end

Warning: This try-catch syntax will continue to work in R2006b,
but may be illegal or may mean something different in future
releases of MATLAB.

To make this single-line try-catch work without warning in R2006b, you
must insert a separator character (comma, semicolon, or newline) immediately
after the word catch

try try_statements, catch, catch_statements, end

As with previous releases, the recommended syntax for a try-catch block
is as follows:

try
try_statements

catch
catch_statements

end
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Compatibility Considerations
Your M-file programs may generate this warning if correct syntax for try
and catch is not used.

Case-Sensitivity Warning Removed
The following warning has been removed from MATLAB in release R2006b:

"Function call foo invokes /somewhere/on/the/path/foo.m,
however, function /somewhere/ahead/on/the/path/FOO.m that
differs only in case precedes it on the path."

In previous versions of MATLAB, this warning message was triggered when
you called a function such as foo, and all of the following were true:

• There was more than one MATLAB file of this name on the MATLAB path

• The names of these files differed only in letter case, and

• A MATLAB file of this name but with different case (e.g., FOO.m) preceded
a file of matching case (e.g., foo.m) on the path

Earlier versions of MATLAB displayed this warning for the purpose of helping
users cope with newly-introduced case sensitive dispatching changes. The
warning is being removed at this time under the assumption that users
are now sufficiently well-acquainted with the way MATLAB handles case
sensitivity in function calls.

Compatibility Considerations
The dispatching behavior regarding to the case sensitivity is NOT changed
with the removal of this warning message. If both an exact match and
inexact match are present on the path, the exact match is always the one to
be invoked.

fprintf(0,...) Now Throws an Error
Commands such as fprintf(0, ...) and fwrite(0, ...), in which the file
identifier is zero (the same as stdin) now result in an error being thrown.
In previous releases, MATLAB did not throw an error in response to these
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commands, even though printing or writing to stdin is clearly not a valid
option.

Compatibility Considerations
If any of your programs use lower-level MATLAB file I/O functions that
send output to stdin, because these functions no longer ignore this type of
operation, your code will now generate an error. You should modify your
program code to use a file identifier other than zero.

Assigning Nonscalar Structure Array Fields to a
Single Variable
In the R14 and R14 service pack releases of MATLAB, assigning a nonscalar
structure array field to a single variable incorrectly resulted in an error.
For example, in the following code, you should be able to assign S.A to one,
two, three, or four output variables. However, if you assign to just a single
variable, MATLAB throws an error:

% Create a 1-by-4 structure array S with field A.
S(1).A = 1; S(2).A = 2; S(3).A = 3; S(4).A = 4;

% Assigning S(1).A and S(2).A works as expected.
[x y] = S.A
x =

1
y =

2

% Assigning only S(1).A should work, but does not.
x = S.A;
??? Illegal right hand side in assignment. Too many elements.

This has been fixed in MATLAB 7.3.

Compatibility Considerations
If any of your programs rely on this error being thrown, you will need to
modify those programs.
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Comma Separators Not Required in Function
Declaration
As of Release 14, the function definition line in a function M-file no longer
requires commas separating output variables. This now makes the function
definition syntax the same as the syntax used when calling an M-file function:

function [A B C] = myfun(x, y)

Compatibility Considerations
This new syntax is not valid in MATLAB versions earlier than Release 14.
When writing an M-file that you expect to run on versions both earlier and
later than R14, be sure to separate any output variables in the function
definition line with commas:

function [A, B, C] = myfun(x, y)

Improved Performance on Certain Platforms and
Operations
In this release, MATLAB offers improved performance in the following areas:

• Improved performance on 64-bit Windows XP and Linux platforms. This is
independent of the size of data set in use.

• Faster scalar indexing into cell arrays.

• Faster assignment of cell array data to variables.
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Graphics and 3-D Visualization, MATLAB Version 7.3
(R2006b)

New features and changes introduced in this version are:

• “Plotting Tools Are Now Modular Desktop Components” on page 140

• “Version 6 Property Editor Has Been Removed” on page 140

• “New Desktop Printing GUI” on page 141

• “Zoom Mode Now Supports Mouse Scroll Wheel” on page 141

• “Data Cursor Text Can Now Be Programmatically Modified” on page 142

• “Customizing Zoom, Pan, and Rotate3D Data Explore Modes” on page 142

• “Improvements to MATLAB Graphics Documentation” on page 143

Plotting Tools Are Now Modular Desktop Components
The three MATLAB plotting tools (Figure Palette, Property Editor, and Plot
Browser) now function as desktop components like the Workspace Browser
and the Array Editor. They dock, however, not to the MATLAB desktop but
to a Figures window. Figures windows contain one or more figures, each of
which is accessible by a tab. Turning on any plotting tool changes your figure
group into a mini-desktop. You can undock, rearrange, tab, and resize the plot
tools within the mini-desktop, and their state will persist across MATLAB
invocations. There are just one set of plot tools for all your figures, but they
only operate on figures contained in the group; undocked figures are free of
the plotting tools until you redock them.

For more information see Plotting Tools – Interactive Plotting in the MATLAB
Graphics documentation.

Version 6 Property Editor Has Been Removed
The Version 6 Property Editor, one of the Plotting Tools, is no longer available
in MATLAB. this means that the 'v6' switch for the propedit function
now produces an error instead of starting the version 6 property editor. The
error message is

??? Error using ==> propedit
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The Version 6 property editor is no longer available. Sorry!

Compatibility Considerations
If you have code that calls the version 6 property editor, you will need to
modify it to use the modular plotting tools described above in “Plotting Tools
Are Now Modular Desktop Components” on page 140. The propedit function
remain otherwise the same.

New Desktop Printing GUI
Printing MATLAB figures has become easier as a result of combining the
Page Setup, Print Setup, and Print Preview dialogs into one tabbed Print
Preview dialog. You can now specify paper size, plot size and layout, color
and line weight, header text, rendering, and other printing characteristics in
this new dialog. The Page Setup and Print Setup dialogs still exist, and
the Print dialog that you call from File —> Print remains the same. The
Page Setup dialog is available on all platforms.

For more information, see Using Print Preview in the MATLAB Graphics
documentation and printpreview in the MATLAB function reference
documentation.

Compatibility Considerations
The Page Setup dialog no longer is available from the figure window
File menu. However, it does continue to exist; you can raise it using the
pagesetupdlg command. The old Print Preview dialog has been removed,
however. The old Print Setup dialog can be raised using the command

print -dsetup

When you dismiss the Print Setup dialog with OK, the settings you made
with it are saved, but nothing is printed at that time.

Zoom Mode Now Supports Mouse Scroll Wheel
If your mouse has a center scroll wheel, you can use it to zoom in and out of
axes, as well as by clicking and/or dragging.
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You can zoom in by positioning the mouse cursor where you want the center of
the plot to be and either press the mouse button or rotate the mouse scroll
wheel away from you (upward). Zoom out by positioning the mouse cursor
where you want the center of the plot to be and either simultaneously press
Shift and the mouse button, or rotate the mouse scroll wheel toward you
(downward). Each mouse click or scroll wheel click zooms in or out by a factor
of 2.

Data Cursor Text Can Now Be Programmatically
Modified
You can now easily customize the text of datatips. The datacursormode
function lets you specify the contents and formatting of text displayed by
the data cursor tool. When the data cursor tool is active, you can use its
context (right-click) menu to edit or specify the text update function that
MATLAB executes to display datatips. For more information, see Data
Cursor — Displaying Data Values Interactively in the MATLAB Graphics
documentation and datacursormode in the MATLAB Function Reference
documentation.

Customizing Zoom, Pan, and Rotate3D Data Explore
Modes
You can now customize the behavior of data explore modes by modifying the
zoom, pan and rotate3d objects that are dereferenced as follows:

h = pan(figure_handle)
h = rotate3d(figure_handle)
h = zoom(figure_handle)

These syntaxes create mode objects that you can use to control the behaviors
of the explore tools. Among the effects you can achieve using these explore
mode objects are

• Allow, change, or inhibit a mode for a specified axes

• Create callbacks for pre- and post-buttonDown events

• Change callbacks dynamically
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See pan, rotate3d, and zoom in the MATLAB Function Reference
documentation for details and examples.

Compatibility Consideration
Using mode objects can cause a forward incompatibility. In prior releases,
explore modes did not return an argument. Therefore, code such as the above
examples that you write to take advantage of the new API will not run in
versions of MATLAB previous to R2006b. zoom, pan, and rotate3d code
written for previous versions of MATLAB, however, will run as before (there is
no backward incompatibility).

Improvements to MATLAB Graphics Documentation
A new section in the Graphics User Guide, “Types of Plots Available in
MATLAB”, now includes a gallery of graphs that catalogs the kinds of plots
that you can create using MATLAB graphics functions. There are two tables
containing labeled icons, one for “Two-Dimensional Plotting Functions”,
and one for “Three-Dimensional Plotting Functions”, classified by plot type.
Clicking the function name above any thumbnail plot in the gallery opens the
reference documentation for that function.

Reference pages for functions that create, edit, annotate, and save plots have
been enhanced in several ways:

• Thumbnail figures at the top of plotting functions and related GUI
reference pages illustrate what you see when you invoke these functions.

• GUI Alternatives sections above syntax descriptions describe how to invoke
a function (or similar capability) from a GUI, and provide links to relevant
topics in the Graphics and Desktop Tools User Guides.

• Revised printing documentation in user guides and reference pages (see
“New Desktop Printing GUI” on page 141, above)

• Numerous corrections and clarifications of details in user guides and
reference pages
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.3 (R2006b)

New features and changes introduced in this version are:

• “Functions Are Now Obsolete” on page 144

• “Colored Buttons on Windows XP” on page 144

• “Documentation Enhancement” on page 145

Functions Are Now Obsolete
The following functions are obsolete in MATLAB 7.3 (R2006b): axlimdlg,
edtext, menubar, pagedlg, umtoggle.

Compatibility Considerations
The functions shown in the following table will continue to work but their use
will generate a warning message. As soon as possible, replace any occurrences
you may have of these functions with the function(s) shown in the following
table, if any, or with other suitable code.

Function Replacement

axlimdlg None

edtext Set the Editing property of the text object.

menubar Set the MenuBar property of the figure to none.

pagedlg pagesetupdlg

umtoggle Set the Checked property of the uimenu object.

Colored Buttons on Windows XP
Setting the background color of user interface control (uicontrol) push buttons
and toggle buttons on Windows XP now results in flat, colored buttons.

Compatibility Considerations
Prior to this release, if you set the background color of a push button or toggle
button to any color other than the factory color on Windows XP, the color
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displayed only as a border around the button. With this release, any such
buttons will display as flat, colored buttons with a simple border.

Documentation Enhancement
The Creating GUIs Programmatically section of the documentation now
contains information commensurate with information in the Creating GUIs
with GUIDE section. It adds, in workflow order, information and many basic
examples about:

• Adding components, menus, and toolbars to your GUI. Placing and aligning
components.

• Designing for cross-platform compatibility.

• Initializing the GUI and creating callbacks.

• Callback examples for the different components.
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External Interfaces/API, MATLAB Version 7.3 (R2006b)
New features and changes introduced in this version are:

• “New Types for Declaring Size and Index Values” on page 146

• “Sparse Arrays on 64-bit Systems” on page 147

• “New MAT-File Format Based on HDF5” on page 148

• “-V5 Option to MEX to Be Removed” on page 149

• “Location of mex.bat File Changed” on page 149

• “Changes to Compiler Support” on page 149

• “Actxcontrol Command Now Validates ProgID” on page 149

New Types for Declaring Size and Index Values
Version 7.3 (R2006b) defines two new types for API arguments and return
values. These are

• mwSize — represents size values, such as array dimensions and number
of elements.

• mwIndex — represents index values, such as indices into arrays.

Using these types in array declarations replaces more specific type
declarations such as int or INTEGER*4. In general, using these types
consistently in your C or Fortran source files can insulate your code from
changes in the API implementation that might take place between different
versions of MATLAB.

The mwSize and mwIndex types are required when working with functions
that access sparse arrays on a 64-bit system. This is described in the release
note on “Sparse Arrays on 64-bit Systems” on page 147, below.

Note In Fortran, mwSize and mwIndex are implemented as preprocessor
macros. To use these types in Fortran code, add the declaration #include
"fintrf.h" in your source file and build your MEX-files using the Fortran
preprocessor.
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Sparse Arrays on 64-bit Systems
The internal storage of sparse arrays on 64-bit systems has changed in the
R2006b release. Due to this change, you will need to

• Change declaration statements in your source code so that you use the new
types mwSize and mwIndex in place of specific type declarations such as int
or INTEGER*4. This is described in the section “New Types for Declaring
Size and Index Values” on page 146, above.

• Recompile all MEX-files that interact with sparse arrays using
the new -largeArrayDims switch. For more information about the
-largeArrayDims switch, see the section “New MEX Switch” on page
147, below.

See the section on “Compatibility Considerations” on page 148 to find out
if you will need to make any modifications to your existing MEX code to
accommodate these changes.

Sparse API Functions Affected By This Change
You will need to recompile any MEX-files that use the following sparse
functions on a 64-bit system:

• mxGetIr

• mxGetJc

• mxSetIr

• mxSetJc

New MEX Switch
In order to build MEX-files that use any of the sparse array functions listed
above, you need to compile these files with the -largeArrayDims switch, as
shown here:

mex -largeArrayDims filename

Also, any existing MEX-files that interact with sparse arrays in MATLAB
Version 7.3 must be recompiled using the -largeArrayDims switch.
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Note The -largeArrayDims option is likely to become the default in a future
version of MATLAB.

Compatibility Considerations
If you are using any of the functions listed above, then you should be aware
of the following potential compatibility issues if your MEX code uses sparse
arrays on a 64-bit system:

• In release R2006b, you must rebuild all MEX-files that use sparse arrays
using the new -largeArrayDims switch.

• Before building your MEX-files, change your C or Fortran sources to use
the mwSize or mwIndex types introduced in this release. See the mxArray
reference pages for the types to use for each function.

• MEX-files that compiled properly in Version 7.2 (R2006a) and do not use
sparse arrays should build and execute correctly in Version 7.3 (R2006b)
without changes.

• For more information on how the sparse API is affected, see the Sparse
Arrays on 64-Bit Systems section in the MATLAB Mathematics release
notes.

New MAT-File Format Based on HDF5
In Version 7.3 (R2006b), you can save MAT-files in a format based on HDF5.
Unlike earlier MAT-file formats, the HDF5-based format is capable of saving
variables that occupy more than 2 GB of storage, including large arrays
created on 64-bit systems.

To save a MAT-file in the HDF5-based format, use the -v7.3 option to the
MATLAB save function or the "w7.3" mode argument to the C or Fortran
matOpen function. The default MAT-file format is the same as that in Version
7.2 (R2006a).

Compatibility Considerations
Earlier versions of MATLAB cannot read MAT-files written in the
HDF5-based format.
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MAT-files written with MATLAB Version 7.3 (R2006b) on a 64-bit system can
be read back into MATLAB 7.3 on a 32-bit system, provided that none of the
values stored in the MAT-file require more than 32 bits to store.

-V5 Option to MEX to Be Removed
The -V5 option to mex is not supported in this and future versions of MATLAB.

Compatibility Considerations
You will no longer be able to build a MEX-file that is compatible with
MATLAB Version 5.

Location of mex.bat File Changed
In MATLAB Version 7.3, the Windows script mex.bat is located in the
directory $MATLAB\bin.

Compatibility Considerations
You may need to change any scripts or environment variables that relied
on the previous location of mex.bat.

Changes to Compiler Support
Compaq Visual Fortran version 6.1 is supported in Version 7.3 (R2006b) but
will not be supported in a future version of MATLAB.

Compatibility Considerations
To ensure continued support for building your Fortran programs,
consider upgrading to another supported compiler. For an
up-to-date list of supported compilers, see Technical Note 1601:
http://www.mathworks.com/support/tech-notes/1600/1601.html.

Actxcontrol Command Now Validates ProgID
Attempting to insert a COM server into a MATLAB figure can result in
unpredictable behaviors. To prevent this condition, the actxcontrol command
now checks the ProgID by looking at the registry’s HKR/CLSID/Control
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keyword and throws an error if the ProgID does not belong to an ActiveX
control.

Compatibility Considerations
Before the validation check was added, some server ProgIDs worked with
actxcontrol , probably because there are cases where Microsoft points
the server GUID to a control GUID underneath. An example of a ProgID
that might not work with actxcontrol is the Mediaplayer server ProgID
Mediaplayer.mediaplayer.1. Therefore, depending on how Microsoft
registers the control, the following command might now return an error:

h = actxcontrol('Mediaplayer.mediaplayer.1'); % Returns an error

The correct ProgID to use for Mediaplayer is the ActiveX control ProgID:

h = actxcontrol('WMPlayer.OCX.7'); % Use control ProgID

Note that methods and properties to open and play files are different when
using the control ProgID.

You can disable the validation check with the following command:

feature('COM_ActxProgidCheck',0)

Or reenable it with:

feature('COM_ActxProgidCheck',1)

By default, ProgID checking is on.
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This table summarizes what’s new in Version 7.2 (R2006a):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports at
Web site

No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.2
(R2006a)” on page 153

• “Mathematics, MATLAB Version 7.2 (R2006a)” on page 167

• “Data Analysis, MATLAB Version 7.2 (R2006a)” on page 169

• “Programming, MATLAB Version 7.2 (R2006a)” on page 170

• “Graphics and 3-D Visualization, MATLAB Version 7.2 (R2006a)” on page
177
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• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.2
(R2006a)” on page 179

• “External Interfaces/API, MATLAB Version 7.2 (R2006a)” on page 181
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Desktop Tools and Development Environment, MATLAB
Version 7.2 (R2006a)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 153

• “Desktop” on page 154

• “Running Functions — Command Window and Command History” on page
155

• “Help” on page 156

• “Workspace, Search Path, and File Operations” on page 156

• “Editing and Debugging M-Files” on page 157

• “Tuning and Managing M-Files” on page 164

• “Publishing Results” on page 166

• “Source Control Interface” on page 166

Startup and Shutdown
New features and changes introduced in Version 7.2 (R2006a) are described
here.

Installation Directory Structure on Windows
The installation directory structure on Windows platforms is slightly different
than in previous versions. By default, the structure now includes a general
MATLAB top level directory, with a subdirectory for R2006a. The MATLAB®

root directory, as returned by the matlabroot function, is now of the form
in this example:

D:\Applications\MATLAB\R2006a

In previous versions, the top-level directory included the version number, so
the MATLAB root directory, as returned by the matlabroot function, was
of the form in this example:

D:\Applications\MATLAB 7.1
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Compatibility Considerations. If you relied on the explicit MATLAB
root directory structure in your code, change it to reflect the new structure
including the top-level MATLAB directory. The matlabroot function might
be useful.

Error Log Reporting
If MATLAB experiences a segmentation violation, it generates an error log.
Upon the next startup, MATLAB prompts you to e-mail the error log to The
MathWorks. The MathWorks uses the log to work on resolving the problem.
When you send a log, you receive a confirmation e-mail and will only receive
further e-mails if The MathWorks develops a fix or workaround for the
problem.

There are some situations where the Error Log Reporter does not open, for
example, when you start MATLAB with a -r option or run in deployed
mode. If you experience segmentation violations but do not see the Error Log
Reporter on subsequent startups, you can instead e-mail logs by following
the instructions at the end of the segmentation violation message in the
Command Window.

JVM Updated for 64-Bit Linux Platforms
The Java Virtual Machine (JVM) version for 64-bit Linux platforms that
MATLAB uses is now Sun 1.5.0_04.

Desktop
New features and changes introduced in Version 7.2 (R2006a) are described
here.

Preferences Reorganized and New Keyboard Pane Added to
Support Command Window and Editor/Debugger
Preferences includes a new pane, Keyboard, for setting key bindings, tab
completion, and delimiter-matching preferences for the Command Window
and Editor/Debugger. Most of these preferences were previously located in the
preference panes for the Command Window or Editor/Debugger.
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Compatibility Considerations. You no longer access keyboard and
indenting preferences for the Command Window and Editor/Debugger from
the component preferences, but rather from the new Keyboard preferences.
In addition, some preferences that were set separately for these components
are now shared. For details about the changes, see “Keyboard and Indenting
Command Window Preferences Reorganized” on page 155, and “Keyboard and
Indenting Editor/Debugger Preferences Reorganized” on page 159.

Open All Desktop Tools from Desktop Menu
You can now open (and close) all desktop tools from the Desktop menu.
In previous versions, you could not access document-based tools from the
Desktop menu. The document-based desktop tools are: Editor/Debugger,
Figures, Array Editor, and Web Browser.

Access Login Renamed to MathWorks Account
Use Help > Web Resources > MathWorks Account menu items to go
to your MathWorks Account if you are registered, or to register online.
MathWorks Account was previously called Access Login.

Running Functions — Command Window and
Command History
New features and changes introduced in Version 7.2 (R2006a) are described
here.

Keyboard and Indenting Command Window Preferences
Reorganized
The Command Window Keyboard and Indenting preferences pane was
removed. The tab size preference is now on the Command Window
preferences pane. The tab completion, keybinding, and parentheses
matching preferences were moved to the new Keyboard preferences pane.
The parentheses-matching preferences are now called delimiter-matching
preferences and are shared with the Editor/Debugger.
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Help
New features and changes introduced in Version 7.2 (R2006a) are described
here.

help for Model Files
You can now use the help function to get the complete description for
MDL-files. For example, run

help f14_dap.mdl

MATLAB displays the description of the Simulink® F-14 Digital Autopilot
High Angle of Attack Mode model, as defined in its Model Properties
> Description:

Multirate digital pitch loop control for F-14 control design
demonstration.

Workspace, Search Path, and File Operations
New features and changes introduced in Version 7.2 (R2006a) are described
here.

toolboxdir function added
The toolboxdir function returns the absolute pathname to the specified
toolbox. It is particularly useful with MATLAB Compiler because the toolbox
root directory is different than in MATLAB.

Visual Directory View Removed
The Visual Directory view was removed from the Current Directory browser.
Most of the features it provided are accessible from the Current Directory
browser standard view.
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Editing and Debugging M-Files
New features and changes introduced in Version 7.2 (R2006a) are

• “Tab Completion — Tab Now Completes Function and Variable Names”
on page 157

• “Go Menu Added; Bookmark and Go To Items Moved from Edit Menu to Go
Menu” on page 158

• “Navigate Back and Forward in Files” on page 159

• “Keyboard and Indenting Editor/Debugger Preferences Reorganized” on
page 159

• “M-Lint Automatic Code Analyzer Checks for Problems and Suggests
Improvements” on page 159

• “Debugging Changes” on page 160

• “Cell Mode On by Default — Shows Cell Toolbar and Possibly Horizontal
Lines and Yellow Highlighting; Cell Information Bar and Button Added”
on page 161

• “Lines Between Cells” on page 163

• “Cell Titles in Bold Preference Removed” on page 163

Tab Completion — Tab Now Completes Function and Variable
Names
You can now use tab completion in the Editor/Debugger to complete function
names and variable names that are in the current workspace. When you type
the first few characters of a function or variable name and press the Tab key,
the Editor/Debugger displays a list of all function and variable names that
begin with those letters, from which you choose one.

It operates essentially the same way as the existing tab completion feature
in the Command Window, with the exception that Editor/Debugger tab
completion does not support completion of file and path names.

To enable tab completion in the Editor/Debugger, select File > Preferences
> Keyboard, and then under Tab completion, select Tab key narrows
completions. By default, the preference is selected.
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With tab completion enabled in the Editor/Debugger, you can still include
tab spacing, for example, to include a comment at the end of a line. To add
tab spacing, include a space after the last character you type and then press
Tab. Instead of showing possible completions, the Editor/Debugger moves the
cursor to the right where you can continue typing.

Compatibility Considerations. If you press the Tab key to add spacing
within your statements, you might instead get a completion for a function
or see a list of possible completions. For example, if the preference for tab
completion is on and you want to create this statement

if a=mate %test input value

where you press Tab after mate to achieve the spacing, the following happens
instead

if a=material

This is because the tab completion preference completes mate, automatically
supplying the material function.

To achieve the spacing with Tab (as in previous versions), either add a space
after mate and then press Tab, or turn off the preference Tab key narrows
completions in Keyboard Preferences.

Go Menu Added; Bookmark and Go To Items Moved from Edit
Menu to Go Menu

• To set, clear, and navigate to bookmarks, use the menu items in the new
Go menu, which were previously located in the Edit menu.

• The Go To feature for navigating to line numbers, functions in M-files,
and cells has moved to the new Go menu. It was previously located in
the Edit menu.

Compatibility Considerations. Use the new Go menu items instead of
Edit > Bookmark features and Edit > Go To.
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Navigate Back and Forward in Files
Use Go > Back (and Go > Forward) to go to lines you previously edited or
navigated to in a file, in the sequence you accessed them. The main benefit of
this feature is going directly to lines of interest. As an alternative to the menu
items, use the Back and Forward buttons on the toolbar.

Keyboard and Indenting Editor/Debugger Preferences
Reorganized
The Editor/Debugger Keyboard and Indenting preferences pane was
renamed to Tab preferences, and keybinding and parentheses-matching
preferences were moved to the new Keyboard preferences pane. The
parentheses-matching preferences are now called delimiter-matching
preferences and are shared with the Command Window.

M-Lint Automatic Code Analyzer Checks for Problems and
Suggests Improvements
The M-Lint code analyzer, now built into the Editor/Debugger, continuously
checks your code for problems and recommends modifications to maximize
performance and maintainability. It performs the same analysis as the
existing M-Lint Code Check report, but also provides these features:

• Indicates the problem lines and associated M-Lint messages directly in the
M-file rather than in a separate report.

• Identifies (underlines) code fragments within a line that result in M-Lint
messages.

• Distinguishes messages that report errors (red) from warnings and
suggestions (orange).

• Continually analyzes and updates messages as your work so you can see
the effect of your changes without having to save the M-file or rerun an
M-Lint report.
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To use or turn off M-Lint in the Editor/Debugger, select
File > Preferences > Editor/Debugger > Language, and for
Language, select M. Under Syntax, select Enable M-Lint messages, or
clear the check box to turn it off. Use the associated drop-down list to specify
the types of code fragments that you want M-Lint to underline, for example,
Underline warnings and errors.

Debugging Changes

• The dbstop function now allows you to stop at, (not in), a non M-file,
allowing you to view code and variables near it in your M-file. For example,
if you want to stop at the point in your M-file myfile.m where the built-in
clear function is called, run dbstop in clear; mymfile. Use this feature
with caution because the debugger stops in M-files it uses for running and
debugging if they contain the non M-file, and then some debugging features
do not operate as expected, such as typing help functionname at the K>>
prompt.
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Cell Mode On by Default — Shows Cell Toolbar and Possibly
Horizontal Lines and Yellow Highlighting; Cell Information Bar
and Button Added
Cell mode, a useful feature in the Editor/Debugger for publishing results
and rapid code iteration, is now enabled by default. An M-file cell is denoted
by a %% at the start of a line. Any M-file that contains %% at the start of a
line is interpreted as including cells. The Editor/Debugger reflects the cell
toolbar state and the cell display preferences, such as yellow highlighting of
the current cell and gray horizontal lines between cells.

For quick access to information about using cells in M-files, use the new
information button on the cell toolbar.

161



Version 7.2 (R2006a) MATLAB

162



Desktop Tools and Development Environment, MATLAB Version 7.2 (R2006a)

If you do not want cell mode enabled, select Cell > Disable Cell Mode.

MATLAB remembers the cell mode between sessions. If cell mode is disabled
when you quit MATLAB, it will be disabled the next time you start MATLAB,
and the converse is true.

In MATLAB Version 7.2, the first time you open an M-file in the
Editor/Debugger, the cell toolbar appears. If the M-file contains a line
beginning with %%, an information bar appears below the cell toolbar,
providing links for details about cell mode. To dismiss the information bar,
click the close box on the right side of the bar. To hide the cell toolbar,
right-click the toolbar and select Cell Toolbar from the context menu.

Compatibility Considerations. In previous versions, cell mode was off by
default. The cell toolbar and yellow highlighting or horizontal rules in M-files
that contain %% at the start of a line might be unexpected. If you used the %%
symbols at the start of a line in M-files for a purpose other than denoting
M-file cells, consider replacing the %% symbols with a different indicator, or
keep cell mode disabled.

Lines Between Cells
You can set an Editor/Debugger display preference, Show lines between
cells, to add a faint gray rule above each cell in an M-file. The line does not
print or appear in the published M-file.

Cell Titles in Bold Preference Removed
Previous versions included an Editor/Debugger display preference to Show
bold cell titles. When cleared, cell titles appeared in plain text, rather than
bold text. This is no longer a preference you can set — all cell titles now
appear in bold text.
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Tuning and Managing M-Files
New features and changes introduced in Version 7.2 (R2006a) are

• “M-Lint and mlint Enhancements and Changes” on page 164

• “Profiling Enhancements” on page 165

• “Visual Directory View Removed from Current Directory Browser” on page
165

M-Lint and mlint Enhancements and Changes
The M-Lint code analyzer is now built into the Editor/Debugger where it
continuously checks your code for problems and recommends modifications
to maximize performance and maintainability. For details, see “M-Lint
Automatic Code Analyzer Checks for Problems and Suggests Improvements”
on page 159.

Compatibility Considerations. The mlint function has changed slightly to
support its use in the Editor/Debugger. Specifically, the results returned from
mlint with the -id option are of a different form than for previous versions. If
you rely on the exact values, you need to make modifications.

For example, this is the form of a message returned in R2006a: L 22 (C
1-9) 2:AssignmentNotUsed : The value assigned here to variable
'nothandle' might never be used.

This is the form of the message from R14SP3: 22 (C 1-9)
InefficientUsage:AssignmentNotUsed : The value assigned here to
variable 'nothandle' might never be used.

There is now a numeric identifier, followed by the category, for example:
2:AssignmentNotUsed

If you do rely on the exact values, note that there have been very few changes
to the message text itself. For example, both R14SP3 and R2006a use the
same text: The value assigned here to variable 'nothandle' might
never be used.

Because of improvements being made to mlint, the values returned using the
-id option are expected to change in the next version as well, particularly
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the numeric identifier and category form. Do not rely on the exact values
returned using mlint with the -id option or you will probably need to make
modifications.

Profiling Enhancements

nohistory Option Added to profile Function. Use the new profile
-nohistory option after having previously set the -history option to disable
further recording of history (exact sequence of function calls). All other
profiling statistics continue to accumulate.

Accuracy Improved. The Profiler provides more accurate accounting.
The total time you see with the Profiler GUI now matches total wall clock
time from when you started profiling until you stopped profiling. Overhead
associated with the Profiler itself is now applied evenly.

Statistics for Recursive Functions. The profile function now gathers
and reports time for recursive functions in the FunctionTable’s TotalTime
for the function. In previous versions, profile attempted to break out
TotalRecursiveTime, which was not always accounted for accurately. The
value for TotalRecursiveTime in FunctionTable is no longer used.

This change is also reflected in the Profiler GUI reports.

PartialData Reported in Results, AcceleratorMessages Removed. The
FunctionTable now includes the PartialData value. A value of 1 indicates
the function was modified during profiling, for example, by being edited or
cleared, so data was only collected up until the point it was modified.

In previous versions, FunctionTable included AcceleratorMessages
although it was not used. AcceleratorMessages is no longer included.

Visual Directory View Removed from Current Directory
Browser
The Visual Directory view was removed from the Current Directory browser.

Compatibility Considerations. Most of the features it provided are
accessible from the Current Directory browser standard view.

165



Version 7.2 (R2006a) MATLAB

Publishing Results
New features and changes introduced in Version 7.2 (R2006a) are described
here.

Insert Italic Text Markup
You can now make designated text comments in cells appear italicized in the
published output. Use Cell > Insert Text Markup > Italic Text, or use the
equivalent markup symbols, underscores, as in _SAMPLE ITALIC TEXT_.

publish Function has New catchError Option
The publish function has a new catchError option that allows you to
continue or stop publishing if the M-file contains an error.

Source Control Interface
New features and changes introduced in Version 7.2 (R2006a) are described
here.

PVCS Source Control System Name Change
The PVCS source control system (from Merant) now has a new name,
ChangeMan (from Serena), and the MATLAB source control interface on
UNIX platforms reflects this change.

If you use ChangeMan on UNIX platforms, the cmopts value returned for it is
pvcs. If you use PVCS, select ChangeMan in the Source Control Preferences
pane.

Compatibility Considerations. PVCS users on UNIX platforms formerly
selected PVCS in the Source Control Preferences pane. Now, PVCS users select
ChangeMan instead.
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Mathematics, MATLAB Version 7.2 (R2006a)
New features and changes introduced in this version are

• “New Library CHOLMOD for Sparse Cholesky Factorization” on page 167

• “New Solver for State-Dependent DDEs” on page 167

• “Upgrade to BLAS Libraries” on page 167

• “New Function for Integer Division” on page 168

• “New Input to gallery Function” on page 168

• “Improved Algorithm for expm” on page 168

• “More Efficient condest for Sparse Matrices” on page 168

• “accumarray Accepts Cell Vector Input” on page 168

New Library CHOLMOD for Sparse Cholesky
Factorization
For sparse matrices, MATLAB now uses CHOLMOD version 1.0 to compute
the Cholesky factor. CHOLMOD is a set of routines offering improved
performance in factorizing sparse symmetric positive definite matrices. See
the function reference pages for chol, spparms, and mldivide for more
information on how CHOLMOD is used by MATLAB.

New Solver for State-Dependent DDEs
In this release, MATLAB provides a second solver function, ddesd, in addition
to the existing dde23 function, for delay differential equations (DDEs). This
new solver is for use on equations that have general delays. You supply a
function in the input argument list that returns the vector of delays to be
used by the solver. See the function reference page for ddesd, and “Initial
Value Problems for DDEs” in the MATLAB Mathematics documentation for
more information.

Upgrade to BLAS Libraries
MATLAB now uses new versions of the Basic Linear Algebra Subroutine
(BLAS) libraries. For Intel processors on Windows and Linux platforms,

167



Version 7.2 (R2006a) MATLAB

MATLAB supports the Math Kernel Library (MKL) version 8.0.1. For AMD
processors on Linux platforms, MATLAB uses the AMD Core Math Library
(ACML) version 2.7.

New Function for Integer Division
The new idivide function provides division similar to A./B on integers except
that fractional quotients are rounded to integers according to a specified
rounding mode.

New Input to gallery Function
The gallery function has a new, optional input argument called classname.
The classname input is a quoted string that must be either 'single' or
'double'. When you specify a classname argument in the call to gallery,
MATLAB produces a matrix of that class.

Improved Algorithm for expm
The expm function now uses an improved algorithm to compute a matrix
exponential. This algorithm often requires fewer matrix multiplications.

More Efficient condest for Sparse Matrices
The condest function handles sparse matrices more efficiently when
estimating a 1-norm condition number.

accumarray Accepts Cell Vector Input
The accumarray function now accepts a cell vector as the subs input. This
vector can have one or more elements, each element a vector of positive
integers. All the vectors must have the same length. In this case, subs is
treated as if the vectors formed columns of an index matrix.
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Data Analysis, MATLAB Version 7.2 (R2006a)
New features and changes introduced in this version are

• “Data Analysis Collection Revised and Expanded” on page 169

• “Reference Pages for timeseries and tscollection Objects” on page 169

• “Text Files Can Be Imported In Time Series Tools” on page 169

• “Linux 64 Platform Fully Enabled for Time Series Tools” on page 169

Data Analysis Collection Revised and Expanded
In this release, the MATLAB Data Analysis collection has been thoroughly
revised to improve content organization and flow. In addition, most examples
have been updated and streamlined.

Reference Pages for timeseries and tscollection
Objects
Detailed reference pages are now available for timeseries and tscollection
objects, properties, and methods. You can access these reference pages in the
Help contents, under MATLAB Functions — By Category.

Text Files Can Be Imported In Time Series Tools
In Time Series Tools, you can now use the Import Wizard to import data from
text files, such as .csv, .dat, and .txt.

Linux 64 Platform Fully Enabled for Time Series Tools
Time Series Tools is now fully enabled on the Linux 64 platform.

Compatibility Considerations
On the Linux 64 platform, you no longer need to manually enable the Time
Series Tools feature before starting Time Series Tools (as in MATLAB 7.1).
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Programming, MATLAB Version 7.2 (R2006a)
New features and changes introduced in this version are

• “Larger Data Sets with 64-Bit Windows XP” on page 170

• “Using avifile and movie2avi on Windows XP 64” on page 170

• “Regular Expressions” on page 171

• “Setting Environment Variables” on page 172

• “issorted Support for Cell Arrays” on page 172

• “XLS Functions Support More Formats” on page 172

• “Archiving Functions Accept Files on Path and ~/” on page 172

• “sendmail No Longer Requires ASCII Messages” on page 173

• “MATLAB Warns on Invalid Input to str2func” on page 173

• “Changes to Character Encoding in File I/O” on page 173

Larger Data Sets with 64-Bit Windows XP
MATLAB support for Windows XP 64-bit edition enables you to handle much
larger data sets. There remains a 2 GB limit on each variable, but you can
store many more such variables in memory at one time.

Using avifile and movie2avi on Windows XP 64

Note You must change the compression setting if you use the avifile or
movie2avi function on Windows XP 64.

MATLAB currently defaults to using Indeo codecs to compress video frames
when using avifile/addframe or movie2avi. If you attempt to use avifile
and addframe, or movie2avi on a Windows XP 64-bit platform without
specifying the compression type, an error message appears indicating the
codec was not found. Nondefault settings must be explicitly passed in when
using these functions on Windows XP 64 because Microsoft does not provide
Indeo codecs on this platform.
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This issue does not affect 32-bit Windows XP installations.

Compatibility Considerations
To work around this issue, do the following:

1 Explicitly specify no compression when creating the avifile object or when
calling movie2avi. Two examples of this are

aviobj = avifile('myvideo.avi', 'compression', 'none');
movie2avi(mov, 'myvideo.avi', 'compression', 'none');

2 Specify a codec for a compression that is installed. The ones that are
included with Windows XP 64 are

• IYUV — Intel YUV codec (c:\winnt\system32\iyuv_32.dll)

• MRLE — Microsoft RLE codec (c:\winnt\system32\msrle32.dll)

• MSVC — Microsoft Video 1 codec (c:\winnt\system32\msvidc32.dll)

For example, to use the Intel YUV codec, use the four-CC code:

aviobj = avifile('myvideo.avi', 'compression', 'IYUV');

Other codecs can be found at http://fourcc.org.

Note there are restrictions with some codecs. For example, some codecs can
only be used with grayscale images.

Regular Expressions
MATLAB 7.2 introduces the following new features for regular expressions in
MATLAB. For more information on these features, see “Regular Expressions”
in the MATLAB Programming documentation.

New Features

• Dynamic regular expressions — You can now insert MATLAB expressions
or commands into regular expressions or replacement strings. The dynamic
part of the expression is then evaluated at runtime.
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• Generating literals in expressions — Use the new regexptranslate
function when you want any of the MATLAB regular expression functions
to interpret a string containing metacharacters or wildcard characters
literally.

• New parsing modes — Four matching modes (case-sensitive, single-line,
multiline, and freespacing) extend the parsing capabilities of the MATLAB
regular expression functions.

• Warnings display — Use the new 'warnings' option with the regular
expression functions to enable the display of warnings that are otherwise
hidden.

Compatibility Considerations
Calling regexp or regexpi with the 'tokenExtents' and 'once' options
specified now returns a double array instead of a cell array. You may need to
change your code to accommodate the new return type.

Setting Environment Variables
Use the new setenv function to set the value of an environment variable
belonging to the underlying operating system.

issorted Support for Cell Arrays
You can now use the issorted function on a cell array of strings.

XLS Functions Support More Formats
xlsread now supports Excel files having formats other than XLS (e.g., HTML)
as long as the COM server is available. Also, xlsfinfo now returns this
file format information.

Archiving Functions Accept Files on Path and ~/
Files specified as arguments to gzip, gunzip, tar, and zip can now be
specified as partial path names. On UNIX machines, directories can start
with ~/ or ~username/, which expands to the current user’s home directory
or the specified user’s home directory, respectively. The wildcard character *
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can be used when specifying files or directories, except when relying on the
MATLAB path to resolve a filename or partial pathname.

sendmail No Longer Requires ASCII Messages
E-mail messages that you send using sendmail are no longer restricted to
ASCII character encoding schemes.

MATLAB Warns on Invalid Input to str2func
Due to a bug introduced in MATLAB R14, the str2func function failed to
issue a warning or error when called with an invalid function name or a
function name that includes a path specification. In the R2006a release,
str2func now generates a warning under these conditions. In a future
version of MATLAB, str2func will generate an error under these conditions.

Compatibility Considerations
Any existing code that calls str2func with an invalid function name or a
function name that includes the path now generates a warning message from
MATLAB. In a future version, this will cause an error. You should note any
such warnings when using R2006a, and fix the input strings to str2func so
that they specify a valid function name.

Changes to Character Encoding in File I/O
The fopen function has a new optional argument, a string that specifies a
name or alias for the character encoding scheme associated with the file. If
this argument is omitted or is the empty string (’’), the MATLAB default
encoding scheme is used. Given a file identifier as the only argument, fopen
now returns an additional output value, a string that identifies the character
encoding scheme associated with the file.

Low-level file I/O functions that read data from files, including fread, fscanf,
fgetl, and fgets, read characters using the encoding scheme associated with
the file during the call to fopen. Low-level file I/O functions that write data,
including fwrite and fprintf, write characters using the encoding scheme
associated with the file during the call to fopen.

Support for character encoding schemes has these limitations:
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• Surrogate pairs are not supported. Each surrogate pair is read as a
replacement character, the equivalent of char(26).

• Stateful character encoding schemes are not supported.

• Byte order marks are not interpreted in any special way. Your code must
skip them if necessary.

• Scanning numbers, using fscanf, is supported only for character encoding
schemes that are supersets of ASCII. (Most popular character encoding
schemes, with the exception of UTF-16, are such supersets.)

Compatibility Considerations
In V7.1 (R14SP3), low-level file I/O functions that read and write data treated
characters as unsigned bytes. Programs using such functions as fread may
have called native2unicode to convert input to MATLAB characters using a
particular encoding scheme. Programs using such functions as fwrite may
have called unicode2native to convert output from MATLAB characters
using a particular encoding scheme.

For example, on a Japanese Windows platform, where the default character
encoding scheme is Shift-JIS, a program may have used native2unicode and
unicode2native to read and write Japanese text in this way:

fid = fopen(file);
data = fread(fid, '*char')';
fclose(fid);
dataU = native2unicode(data);
% operate on data
outData = unicode2native(dataU);
fid = fopen(file, 'w');
fwrite(fid, outData, 'char');
fclose(fid);

Such a program would produce different and possibly incorrect results in V7.2
(R2006a). The calls to native2unicode and unicode2native are no longer
necessary, because the fread and fwrite functions now convert data to and
from MATLAB characters using the character encoding scheme specified in
the calls to fopen. In V7.2 (R2006a), the example code can be simplified to
produce correct results:
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fid = fopen(file);
dataU = fread(fid, '*char')';
fclose(fid);
% operate on data
fid = fopen(file, 'w');
fwrite(fid, dataU, 'char');
fclose(fid);

Changes to code using fread, fgets, fgetl, and fscanf. If your code calls
native2unicode to convert input to MATLAB characters using a specified
(or default) encoding scheme, you can, but do not have to, remove the calls to
native2unicode.

This applies to reading from an encoded file using any of the following:

• fread with precision set to '*char' or 'char=>char'

• fgets or fgetl

• fscanf with the format specifier set to either '%s' or '%c'

When you remove a call to native2unicode, be sure that the call to fopen
supplies the same encoding argument (if any) as the call to native2unicode.

You may have used code like these examples in V7.1 (R14SP3):

indata = native2unicode(fread(fid, '*char')');
indata = native2unicode(fread(fid, 'char=>char')');
indata = native2unicode(fgets(fid));
indata = native2unicode(fgetl(fid));
indata = native2unicode(fscanf(fid, '%s'));
indata = native2unicode(fscanf(fid, '%c'));

You can, but do not have to, remove the calls to native2unicode in V7.2
(R2006a):

indata = fread(fid, '*char')';
indata = fread(fid, 'char=>char')';
indata = fgets(fid);
indata = fgetl(fid);
indata = fscanf(fid, '%s');
indata = fscanf(fid, '%c');
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Changes to code using fwrite. If your code calls unicode2native to
convert output from MATLAB characters using a specified (or default)
encoding scheme, in most cases you must remove the calls to unicode2native.
This is especially important if the encoding represents multibyte characters.

This applies to writing an encoded file using fwrite with precision set to
either 'char' or 'char*1'.

When you remove a call to unicode2native, be sure that the call to fopen
supplies the same encoding argument (if any) as the call to unicode2native.

You may have used code like these examples in V7.1 (R14SP3):

fwrite(fid, unicode2native(outbuff), 'char');
fwrite(fid, unicode2native(outbuff), 'char*1');

You must remove the calls to unicode2native in V7.2 (R2006a):

fwrite(fid, outbuff, 'char');
fwrite(fid, outbuff, 'char*1');
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Graphics and 3-D Visualization, MATLAB Version 7.2
(R2006a)

Two changes have been introduced in this version:

Pasting Cut or Copied Graphic Objects Can Create
an Axes
The way in which MATLAB handles copying (or cutting) and pasting children
of axes such as lineseries, barseries, or contourgroup objects has changed
slightly. In previous releases, if no destination axes was selected prior to
pasting one or more such objects, MATLAB would paste them into the
current axes (returned by the gca function). MATLAB no longer makes this
assumption; if no axes is currently selected when you paste graphic objects, a
new axes is created in the destination figure to contain them.

To avoid creating a new axes where you do not want to do so, you should
be in plot edit mode and have selected a destination axes before using Edit
-> Paste or typing CTRL-V. You can use the Plot Browser to conveniently
select objects to copy and to paste into.

Inspector Has New Look
The Property Inspector (the GUI summoned by the MATLAB inspect
command) has a new look, but no changed functionality. The inspector
enables you to view and change the most commonly used object properties.
The figure below compares the previous version (7.1, left) of the Property
Inspector with the new version (7.2, right):
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Note that in addition to having a smaller font and wider line spacing, the new
inspector locates pop-up menus at the right margin instead of between the
two columns. Also, some icons have been redesigned.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.2 (R2006a)

New features and changes introduced in this version are:

• “Treatment of & in Menu Label Is Changed” on page 179

• “Major Documentation Revision” on page 179

Treatment of & in Menu Label Is Changed
The use of '&' (ampersand) in the uimenu 'Label' property string is changed
for cases that use the constructs 'A& B' and 'A&&B'. The changes bring these
constructs in line with the way '&' is used in other 'Label' constructs. See
“Compatibility Considerations” below for specific information.

Compatibility Considerations
Interpretation of 'Label' property strings that use the following constructs
is changed:

• The string 'A& B' now produces the menu label A& B with no underlined
mnemonic. Previously, 'A& B' produced the label A_B, in which the space
is a mnemonic.

• The string 'A&&B' now produces the menu label A & B with no underlined
mnemonic. Previously, 'A&&B' produced the label A&B with no mnemonic.

If you use either construct, 'A& B' or 'A&&B', in your menu labels, verify
that the new resulting label is acceptable or change the 'Label' property
to a new string.

Major Documentation Revision
The MATLAB document Creating Graphical User Interfaces is reorganized
and rewritten. It now consists of three sections:

• Getting Started—Leads you through the steps needed to create a simple
GUI, both programmatically and using GUIDE.

179



Version 7.2 (R2006a) MATLAB

• Creating GUIs with GUIDE—Contains the information, previously
included in Creating Graphical User Interfaces, that you need to create a
GUI using GUIDE. This section is organized in workflow order with many
small examples of the various steps. A final chapter provides advanced
examples.

• Creating GUIs Programmatically—For now, this section contains a
summary of the available functions and complete code examples for three
GUIs.

One GUI uses a variety of user interface controls to enable a user to
calculate the mass of an object after specifying the object’s density and
volume.

Two other GUIs work together as an icon editor. One GUI, a color palette,
is embedded in the other GUI, an icon editor. The color palette passes data
to the icon editor whenever the GUI user selects a new color.

Note Following the release of MATLAB version 7.2, Creating Graphical
User Interfaces will be further updated and expanded. The PDF and HTML
versions of this document will be updated on The MathWorks Web site some
time after the release. Check the top page of the HTML document and the
title page of the PDF to determine if they have been updated.
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External Interfaces/API, MATLAB Version 7.2 (R2006a)
New features and changes introduced in this version are:

• “MEX-Files Built with gcc on Linux Must Be Rebuilt” on page 181

• “MEX-Files in MATLAB for Windows x64” on page 182

• “New Microsoft and Intel Compilers Supported” on page 182

• “MWPOINTER Macro for Platform-Independent Fortran Code” on page 183

• “Compaq Visual Fortran Engine and MAT Options File Renamed” on page
183

• “Options Files Removed for Unsupported Compilers” on page 183

• “Obsolete Functions No Longer Documented” on page 184

• “Support for Licensed ActiveX Controls” on page 188

• “Support for VT_Date Type” on page 189

• “Dynamic Linking of External Libraries” on page 189

MEX-Files Built with gcc on Linux Must Be Rebuilt
In MATLAB V7.2 (R2006a) on Linux and Linux x86-64 platforms, MEX-files
built with gcc must be recompiled and relinked using gcc version 3.4 or later.
Rebuilding is required because MATLAB V7.2 (R2006a) on Linux and Linux
x86-64 platforms is built with gcc version 3.4.

Compatibility Considerations
Changes in gcc version 3.4 have caused incompatibilities between MATLAB
V7.2 (R2006a) and MEX-files built with gcc versions earlier than 3.4.

On Linux and Linux x86-64 platforms, MEX-files built with gcc versions
earlier than 3.4 cannot be used in MATLAB V7.2 (R2006a).

On Linux and Linux x86-64 platforms, MEX-files built with gcc version 3.4 or
later cannot be used in versions of MATLAB earlier than V7.2 (R2006a).

181



Version 7.2 (R2006a) MATLAB

MEX-Files in MATLAB for Windows x64
With the introduction of MATLAB for Windows x64, you can now build
64-bit MEX-files. These MEX-files have the extension .mexw64. The mexext
command returns mexw64 in MATLAB for Windows x64.

Compatibility Considerations
MEX-files built using MATLAB for Windows (32-bit), which have.mexw32
extensions by default, cannot be used in MATLAB for Windows x64.

By default, when MATLAB for Windows x64 is installed, the mex.pl and
mex.bat scripts build MEX-files for a Windows x64 platform (with .mexw64
extensions).

New Microsoft and Intel Compilers Supported
MATLAB V7.2 (R2006a) supports new compilers for building MEX-files on
Windows and Windows x64 platforms:

• Microsoft Visual C++ 2005, also informally called Visual C++ 8.0, part
of Visual Studio 2005

• Intel Visual Fortran 9.0

Environment Variables Needed for Intel Visual Fortran
When you build a MEX-file or an Engine or MAT application using Intel
Visual Fortran 9.0, MATLAB requires an environment variable to be defined,
depending on whether you are building in MATLAB for Windows (32-bit) or
MATLAB for Windows x64:

• MATLAB for Windows (32-bit): The environment variable VS71COMNTOOLS
must be defined. The value of this environment variable is the path to
the Common7\Tools directory of the Visual Studio .NET 2002 or 2003
installation directory. (Intel Visual Fortran requires Visual Studio .NET
2002 or 2003 on 32-bit Windows platforms.) This environment variable is
commonly defined by the Visual Studio .NET 2003 installation program.

• MATLAB for Windows x64: The environment variable MSSdk must
be defined. The value of this environment variable is the path to the
installation directory for Microsoft Platform SDK for Windows Server
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2003. (Intel Visual Fortran requires Microsoft Platform SDK for Windows
Server 2003 on Windows x64 platforms.) This environment variable is not
commonly defined by the Microsoft Platform SDK installation program.

MWPOINTER Macro for Platform-Independent
Fortran Code
MATLAB provides a preprocessor macro, mwPointer , that declares the
appropriate Fortran type representing a pointer to an mxArray or to other
data that is not of a native Fortran type, such as memory allocated by
mxMalloc. On 32-bit platforms, the Fortran type that represents a pointer is
INTEGER*4; on 64-bit platforms, it is INTEGER*8. The Fortran preprocessor
translates MWPOINTER to the Fortran declaration that is appropriate for the
platform on which you compile your file.

Compaq Visual Fortran Engine and MAT Options File
Renamed
MATLAB V7.1 (R14SP3) included a Windows Engine and MAT options file
named df66engmatopts.bat. This file contained options for Compaq Visual
Fortran version 6.6 for use in building Fortran engine or MAT stand-alone
programs. The file name df66engmatopts.bat originated with an earlier
version of the Fortran compiler, named Digital Fortran.

In V7.2 (R2006a), this file has been renamed cvf66engmatopts.bat to match
the Compaq Visual Fortran product name.

Compatibility Considerations
You may need to change any scripts that depend on the earlier name for the
options file.

Options Files Removed for Unsupported Compilers
MATLAB V7.1 (R14SP3) included MEX, Engine, and MAT options files for
a number of Windows C and Fortran compilers that were untested. These
options files are not included in V7.2 (R2006a). The unsupported compilers,
and the supported compilers that replace them, are:
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Unsupported Compiler Supported Replacement

Borland 5.0, 5.2, 5.3, 5.4 Borland 5.5, Borland 5.5 Free,
Borland 5.6

Digital Visual Fortran 5.0, 6.0 Compaq Visual Fortran 6.1, Compaq
Visual Fortran 6.6, Intel Visual
Fortran 9.0

Microsoft Visual C++ 5.0, Visual
C++ .NET 2002 (7.0)

Microsoft Visual C++ 6.0, Visual
C++ .NET 2003 (7.1), Visual C++
2005 (8.0)

Watcom 10.6, 11 Open Watcom 1.3

Compatibility Considerations
If you were using an untested compiler with a previous version of MATLAB,
replace it with a supported compiler. You may need to recompile your
MEX-files or applications.

Obsolete Functions No Longer Documented
In V7.1 (R14SP3), many MAT-file access, MX array manipulation, MEX-files,
and MATLAB engine functions were declared obsolete in the External
Interfaces Reference documentation. These functions are no longer
documented in V7.2 (R2006a).

This section lists the obsolete functions removed from the documentation,
along with replacement functions, if any.

Obsolete Functions: MAT-File Access

Obsolete Function Replacement

matDeleteArray (C and
Fortran)

matDeleteVariable

matDeleteMatrix (C
and Fortran)

matDeleteVariable
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Obsolete Function Replacement

matGetArray (C and
Fortran)

matGetVariable

matGetArrayHeader (C
and Fortran)

matGetVariableInfo

matGetFull (C and
Fortran)

matGetVariable followed by mxGetM, mxGetN,
mxGetPr, mxGetPi

matGetMatrix (C and
Fortran)

matGetVariable

matGetNextArray (C
and Fortran)

matGetNextVariable

matGetNextArrayHeader
(C and Fortran)

matGetNextVariableInfo

matGetNextMatrix (C
and Fortran)

matGetNextVariable

matGetString (C and
Fortran)

matGetVariable followed by mxGetString

matPutArray (C and
Fortran)

matPutVariable

matPutArrayAsGlobal
(C and Fortran)

matPutVariableAsGlobal

matPutFull (C and
Fortran)

mxCreateDoubleMatrix followed by mxSetPr,
mxSetPi, matPutVariable

matPutMatrix (C and
Fortran)

matPutVariable

matPutString (C and
Fortran)

mxCreateString followed by matPutVariable
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Obsolete Functions: MX Array Manipulation

Obsolete Function Replacement

mxClearLogical (C and
Fortran)

None

mxCreateFull (C and
Fortran)

mxCreateDoubleMatrix

mxCreateScalarDouble
(C and Fortran)

mxCreateDoubleScalar

mxFreeMatrix (C and
Fortran)

mxDestroyArray

mxGetName (C and
Fortran)

matGetVariable, mexGetVariable, or
engGetVariable

mxIsFull (C and
Fortran)

mxIsSparse

mxIsString (C and
Fortran)

mxIsChar

mxSetLogical (C and
Fortran)

None

mxSetName (C and
Fortran)

matPutVariable, mexPutVariable, or
engPutVariable

Obsolete Functions: MEX-Files

Obsolete Function Replacement

mexAddFlops (C) None

mexGetArray (C and
Fortran)

mexGetVariable

mexGetArrayPtr (C and
Fortran)

mexGetVariablePtr

mexGetEps (C and
Fortran)

mxGetEps
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Obsolete Function Replacement

mexGetFull (C and
Fortran)

mexGetVariable followed by mxGetM, mxGetN,
mxGetPr, mxGetPi

mexGetGlobal (C and
Fortran)

mexGetVariablePtr

mexGetInf (C and
Fortran)

mxGetInf

mexGetMatrix (C and
Fortran)

mexGetVariable

mexGetMatrixPtr (C and
Fortran)

mexGetVariablePtr

mexGetNaN (C and
Fortran)

mxGetNaN

mexIsFinite (C and
Fortran)

mxIsFinite

mexIsInf (C and
Fortran)

mxIsInf

mexIsNaN (C and
Fortran)

mxIsNaN

mexPutArray (C and
Fortran)

mexPutVariable

mexPutFull (C and
Fortran)

mxCreateDoubleMatrix followed by mxSetPr,
mxSetPi, mexPutVariable

mexPutMatrix (C and
Fortran)

mexPutVariable

Obsolete Functions: MATLAB Engine

Obsolete Function Replacement

engGetArray (C and
Fortran)

engGetVariable
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Obsolete Function Replacement

engGetFull (C and
Fortran)

engGetVariable followed by mxGetM, mxGetN,
mxGetPr, mxGetPi

engGetMatrix (C and
Fortran)

engGetVariable

engPutArray (C and
Fortran)

engPutVariable

engPutFull (C and
Fortran)

mxCreateDoubleMatrix followed by mxSetPr,
mxSetPi, engPutVariable

engPutMatrix (C and
Fortran)

engPutVariable

engSetEvalCallback (C) None

engSetEvalTimeout (C) None

engWinInit (C) None

Compatibility Considerations
Most of the functions listed as obsolete in this section are unsupported in
V6.5 (R13) and later versions. Some obsolete functions are unsupported in
earlier versions.

If this section lists a replacement for an obsolete function, change any code
that refers to the obsolete function to use the replacement instead.

If you must use an obsolete function in a MEX-file or application, use the -V5
option to mex when you build the file.

Support for Licensed ActiveX Controls
MATLAB supports the use of ActiveX controls that require licensing at both
design time and runtime.

See the actxcontrol function for information on how to specify a design-time
license key.

188



External Interfaces/API, MATLAB Version 7.2 (R2006a)

See “Deploying ActiveX Controls Requiring Run-Time Licenses” for
information on how to use ActiveX Controls that require runtime licenses in
your MATLAB application.

Support for VT_Date Type
MATLAB defines a data type to be used with controls requiring input defined
as type VT_DATE. See “Date Data Type” for more information.

Dynamic Linking of External Libraries
MATLAB supports dynamic linking of external libraries only on 32-bit
MS-Windows systems and 32-bit Linux systems. See “MATLAB Interface to
Generic DLLs” for more information.
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This table summarizes what’s new in Version 7.1 (R14SP3):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports at
Web site

No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.1
(R14SP3)” on page 193

• “Mathematics, MATLAB Version 7.1 (R14SP3)” on page 207

• “Data Analysis, MATLAB Version 7.1 (R14SP3)” on page 211

• “Programming, MATLAB Version 7.1 (R14SP3)” on page 213

• “Graphics and 3-D Visualization, MATLAB Version 7.1 (R14SP3)” on page
220
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• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.1
(R14SP3)” on page 221

• “External Interfaces/API, MATLAB Version 7.1 (R14SP3)” on page 223
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Desktop Tools and Development Environment, MATLAB
Version 7.1 (R14SP3)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 193

• “Desktop” on page 194

• “Running Functions — Command Window and Command History” on page
197

• “Help” on page 198

• “Workspace, Search Path, and File Operations” on page 200

• “Editing and Debugging M-Files” on page 201

• “Tuning and Managing M-Files” on page 204

• “Publishing Results” on page 205

Startup and Shutdown
New features and changes introduced in this version are described here.

Windows -nodesktop No Longer has Menu Bar and Toolbar;
Use Function Equivalents Instead
The behavior of MATLAB when started on a Windows platform with the
-nodesktop option has changed. The MATLAB Command Window no longer
displays a menu bar or toolbar. This change resolves a number of problems
that occurred in previous versions when running MATLAB in -nodesktop
mode on Windows.

Compatibility Considerations. Use equivalent functions instead of the
menu and toolbar.

Instead of using the File > Preferences menu to modify the font or colors
used in the Command Window, run preferences -nodesktop. For more
information, see “preferences Function Now Supports -nodesktop Option”
on page 196.
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Desktop
New features and changes introduced in this version are organized by these
topics:

• “Arranging Windows and Documents” on page 194

• “Preferences Directory Added for R14SP3; Supplements R14 Directory”
on page 195

• “Preferences Changes for Fonts, Hyperlinks, and -nodesktop” on page 196

• “info.xml File Automatic Validation; Shows Warnings for Invalid
Constructs” on page 197

• “Other Desktop Changes” on page 197

Arranging Windows and Documents

Figure Windows Now Dockable on Macintosh. On Macintosh platforms,
figure windows are now dockable.

Resize Multiple Tools at Once. You can now position the pointer at the
intersection of three or four tools or documents to resize all of them at once.

Resize and Move Desktop Tools Using the Keyboard. There are now
menu items you can select to move and resize the active tool in the desktop.
Use the menu item mnemonics to perform those action with the keyboard.
For example, if the Command Window is in the desktop along with other
tools, press Ctrl+0 (or click in it) to make the Command Window the active
tool. Then press Alt+D, V, which is the mnemonic equivalent for selecting
Desktop > Move Command Window. The pointer becomes an arrow. Use
the arrow keys to move an outline of the Command Window to a new dockable
location. Press Enter to dock it there, or press Esc to return the Command
Window to its original position.

Resize Names in the Document Bar. You can now adjust the width of a
name in the document bar when the bar is at the top or bottom of the window.
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Positioning Document Bar Menu Item Name Changed. In previous
versions, selecting Desktop > Document Bar displayed only menu
items for positioning the document bar. Now, there are additional menu
items. The same change was made to the context menu for the document
bar. To access the menu items for positioning the document bar, select
Desktop > Document Bar > Bar Position.

Keyboard Access Added for Document Bar Options. The
Desktop > Document Bar now includes these items: Alphabetize, Width,
and Move documentname On Bar. With their inclusion in the menu, you
can use the keyboard to access these features via mnemonics. For example,
on Windows, press Alt+D, M, A as a shortcut to for Desktop > Document
Bar > Alphabetize.

Left/Right and Top/Bottom Split for Document Arrangements Name
Changed. When arranging documents in desktop tools, you can choose
Window > Left/Right Split or Window > Top/Bottom Split to show two
documents at once in the tool. Those menu items are now called Left/Right
Tile and Top/Bottom Tile. This change was made to avoid any confusion
with the Editor/Debugger’s new split screen feature.

Preferences Directory Added for R14SP3; Supplements R14
Directory
There is a new preferences directory, R14SP3. This is the directory name
returned when you run the prefdir function. When you install R14SP3,
MATLAB migrates files from your existing preference directory, R14, to the
new directory, R14SP3. Changes made to files in the directory when you run
R14SP3 are not used when you run previous R14 releases.

This represents a change in the preference directory MATLAB uses for a
minor release, and was done to prevent serious backwards compatibility
problems. It is primarily relevant if you use R14SP3 and previous R14
releases. If you only run R14SP3, or run R14SP3 with R13 or R12 releases,
you will not be affected by this change.

In the past, minor releases and the associated major release used the
same preferences directory. For example, R13 and R13SP1 shared the R13
preferences directory. That continues to be true for all previous releases, but
is not true for R14SP3 and beyond. The R14 preferences directory will be
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shared by the R14 through R14SP2 releases, but the new R14SP3 preferences
directory is only used by R14SP3. This means that changes made to files in
the directory while running R14SP3 re not used when you run a previous
R14 releases, and the reverse is true. For example, statements added to the
Command History when you run R14SP3 are not in the Command History
when you run R14SP2.

For more information, see the reference page for prefdir.

Compatibility Considerations. This change was made to prevent major
backwards compatibility problems. Use the R14SP3 preferences directory
instead of the R14 directory. If you use the prefdir function and have code
that relies on the result being R14, you will need to modify that code.

Preferences Changes for Fonts, Hyperlinks, and -nodesktop

Font Antialiasing Preference Added. In Preferences > Fonts, select the
new antialiasing preference to provide a smoother appearance to desktop
fonts.

Hyperlink Color Preference Changed. There is a new Colors preference
for specifying the color of hyperlinks in the Command Window and the Help
browser Index pane. In previous releases, this preference only applied to
the Command Window hyperlinks and was accessed via Command Window
preferences.

preferences Function Now Supports -nodesktop Option. Run
preferences -nodesktop after starting MATLAB on Windows with the
-nodesktop option to change Command Window font and colors via a special
Preferences dialog box.

To set other available preferences for the Command Window after starting
MATLAB with the -nodesktop option, run preferences and use the resulting
Preferences dialog box for all tools and products. Note that changes you
make to font and color preferences in this dialog box do not apply to the
Command Window.
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info.xml File Automatic Validation; Shows Warnings for
Invalid Constructs
If you add your own toolbox to the Start button, you can use the schema file for
its info.xml file, matlabroot/sys/namespace/info/v1/info.xsd. MATLAB
now automatically validates your info.xml file against this schema when you
click the Start button after updating and refreshing your info.xml file.

Compatibility Considerations. If your info.xml contains invalid
constructs, you will see warnings in the Command Window until you correct
the problems.

Other Desktop Changes

Paste Special Menu Item Renamed. In the Edit menu, the name of the
Paste Special item has been replaced by Paste to Workspace, but the
functionality remains the same. It opens the Import Wizard so you can paste
the clipboard contents to the MATLAB workspace.

Rename Shortcut Categories. You can now rename shortcut categories.

Running Functions — Command Window and
Command History
New features and changes introduced in this version are

• “Tab Completion Preference Added” on page 197

• “Tab Completion No Longer Shows Entries Twice” on page 198

• “Incremental Search Now Supports Removing Characters” on page 198

• “Hyperlink Color Preference Moved” on page 198

Tab Completion Preference Added
There is a new Command Window preference, Tab key narrows
completion. When selected, with a list of possible completions in view, type
another character and press Tab to further narrow the list shown. Repeat
to continue narrowing the list. This behavior is similar to tab completion
behavior in releases prior to R14.
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Tab Completion No Longer Shows Entries Twice
In previous versions, when completing filenames or function names, a name
sometimes appeared twice in the completion list, once with the file extension
and once without. Now the entry appears only once.

Incremental Search Now Supports Removing Characters
In incremental search, use Ctrl+G to remove characters back to the previous
successful string of characters found. For example, when searching for the
term plode, the text is not found and Failing appears in the incremental
search field. Ctrl+G automatically removes the de from the search term
because plo does exist in the file.

Hyperlink Color Preference Moved
The preference for specifying the hyperlink color has moved from the
Command Windows preferences pane to the Colors preferences pane. The
hyperlink color now also applies to links in the Help browser Index pane.

Compatibility Considerations. Use the Colors preference pane to specify
the hyperlink color, and be aware that it also impacts the Help browser Index
pane color.

Help
New features and changes introduced in this version are

• “Hyperlink Color in the Index Pane Preference Added” on page 199

• “New Look for Demos, Including Thumbnails and Categories” on page 199

• “Demos Run in Command Window as Scripts and Their Variables Now
Created in Base Workspace” on page 199

• “echodemo Function Added to Replace playshow function” on page 200

• “Add Demos to Favorites” on page 200

• “Adding Your Own Demos Type Tag Now Supported” on page 200

• “Bug Reporting System Introduced” on page 200
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Hyperlink Color in the Index Pane Preference Added
You can now specify the color for links in the Help browser Index pane using
the Colors preferences pane. The hyperlink color also applies to links in the
Command Window, so changes you make to the preference apply to both tools.

New Look for Demos, Including Thumbnails and Categories
Stylistic changes were made to the Demos interface in the Help browser. On
the summary page for a product, each demo appears with a thumbnail image
that provides an indication of the type of output it creates, as well as an icon
representing the type of demo (M-file, M-GUI, model, or video).

Demos Run in Command Window as Scripts and Their
Variables Now Created in Base Workspace
In this release, all M-file demos include the Run in the Command Window
link, which executes the demo via echodemo.

In previous releases, some M-file demos provided a Run hyperlink in the
display pane. When you clicked Run, the M-file demo executed in a GUI
via the playshow function. An example of this type of demo is the MATLAB
Mathematics Basic Matrix Operations demo, intro.m. In this release, the
Run hyperlink for these M-file demos has been replaced by Run in the
Command Window. It executes the demo step by step in the Command
Window via the echodemo function. Double-clicking this type of M-file demo
in the Navigator pane no longer runs the M-file demo, but opens the M-file in
the Editor/Debugger where you can run it step by step using Cell > Evaluate
Current Cell and Advance.

Compatibility Considerations. The new Run in Command Window
hyperlink represent a change in the way demos run.

The echodemo function MATLAB uses to run M-file demos in the Command
Window runs the demos as scripts. The playshow function MATLAB used
to run M-file demos in previous releases ran the demos as a function. This
means that now the demo’s variables are created in the base workspace. If
you have variables in the base workspace when you run an M-file demo, and
the demo uses an identical variable name, there could problems with variable
name conflicts. For example, your variable could be overwritten. The demo’s
variables remain in the base workspace after the demo finishes running until
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you clear them or quit MATLAB. Another change is that figures are not
automatically closed when you end the demo.

echodemo Function Added to Replace playshow function
There is a new echodemo function that replaces playshow. The Demos
browser uses echodemo to execute M-file demos when you click the Run in
the Command Window link.

Compatibility Considerations. The playshow function is deprecated in
favor of the echodemo function. In a future release, the playshow function will
be removed. In practice, both echodemo and playshow are helper functions
for running demos. It is unlikely you would ever call either playshow or
echodemo directly, and especially not in M-files.

Add Demos to Favorites
You now can add published M-file demos to favorites.

Adding Your Own Demos Type Tag Now Supported
If you add demos for your own toolbox, you can use the new <type> tag for a
<demoitem> to identify the type of demo in your toolbox’s demos.xml file.

Bug Reporting System Introduced
You now can view bugs fixed with this release, as well as any known bugs
using the Bug Reports database in the Support section of the MathWorks
Web site. The MathWorks continuously updates the database to add any
newly found bugs and compatibility issues, as well as any new workarounds
and solutions. The system includes bugs found and fixed in R14SP2 and
later releases.

Workspace, Search Path, and File Operations
New features and changes introduced in this version are described here.

Find Files Offers Additional Filtering
The Find Files tool has been enhanced. It now allows you to search all file
types except those specified. It also lets you ignore files larger than a specified
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size. Along with enhancements to the Find Files tool, some minor feature
changes were made, including the removal of the Restore Defaults button.

Visual Directory View to be Removed
In the next release, the Current Directory browser will no longer support the
Visual Directory view (accessed using the toolbar button).

Compatibility Considerations. Some features currently available using
the Visual Directory view will not be available in the next release when the
feature is removed.

Editing and Debugging M-Files
New features and changes introduced in this version are

• “Split Screen Display Added” on page 201

• “Highlight Current Line Added” on page 202

• “Comment Lines in Java and C/C++ Files Now Supported” on page 203

• “HTML File Indenting Feature Added as the Default” on page 203

• “Incremental Search Now Supports Removing Characters” on page 204

• “Emacs Key Binding for Select All” on page 204

• “Change Case Added to Menu” on page 204

• “Nested Function Name No Longer in Status Bar” on page 204

Split Screen Display Added
The Editor/Debugger now supports a horizontal or vertical split screen for
displaying two different parts of the same document at once. To split the
screen, select Window > Split Screen and the splitting action you want, for
example, Top/Bottom. Alternatively, drag the splitter bar that appears above
the vertical scroll bar or to the left of the horizontal scroll bar. To remove the
splitter, drag it to an edge of the window.
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Highlight Current Line Added
You can set a preference to highlight the current line, that is, the line with
the caret (also called the blinking cursor). This is useful, for example, to help
you see where copied text will be inserted when you paste. To highlight
the current line, select Preferences > Editor/Debugger > Display and
under General Display Options, select the check box for Show caret row
highlighting. You can also specify the color used to highlight the line.
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Comment Lines in Java and C/C++ Files Now Supported
You can now use the Text > Comment feature to comment selected lines in
Java and C/C++ files. This adds the // symbols at the front of the selected
lines. Similarly, Text > Uncomment removes the // symbols from the front of
selected lines in Java and C/C++ files.

HTML File Indenting Feature Added as the Default
There is a new Editor/Debugger language preference for HTML files to specify
block indenting. By default, the preference is selected so block indenting
applies when typing text in HTML files.

In addition, you now can select Text > Smart Indent to apply smart
indenting to selected text in HTML files.

Compatibility Considerations. When typing text in HTML files, you will
automatically see block indenting because the preference is selected by
default.
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Incremental Search Now Supports Removing Characters
In incremental search, use Ctrl+G to remove characters back to the previous
successful string of characters found. For example, when searching for the
term plode, the text is not found and Failing appears in the incremental
search field. Ctrl+G automatically removes the de from the search term
because plo does exist in the file.

Emacs Key Binding for Select All
With the Emacs key bindings preference selected, use Ctrl+X, H to select all.

Change Case Added to Menu
Use new items in the Text menu to change the case of selected text. You can
also use the keyboard equivalents for changing case that existed in previous
versions—these are shown in the menu next to each item.

Nested Function Name No Longer in Status Bar
The Editor/Debugger no longer displays the current nested function name in
the status bar. Look in the M-file to view the current nested function name.

Tuning and Managing M-Files
New features and changes introduced in this version are described here.

Directory Reports Uses New Run Buttons
With Directory Reports displayed in the Web browser, you can use these two
new buttons:

• Rerun This Report — This updates the currently displayed report after
you have made changes to the report options or to any files in the current
directory.

• Run Report on Current Directory — Use this after changing the current
directory to run the same type of report for the new current directory.

These new buttons replace the Refresh button.
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Override %#ok with the New mlint -notok Option
There is a new option for the mlint function, '-notok' you can use to override
any statements that include %#ok (the symbol you add to the end of a line
instructing mlint to ignore the line). That is, mlint will run for all lines in
the file and will not ignore any statements.

Hyperlink Now Part of Messages Displayed by mlint
When you run the mlint function, the line number in the messages displayed
is a hyperlink that when clicked, opens the file in the Editor/Debugger scrolled
to that line number.

Profiler Button Added to Toolbar
There is now a button on the MATLAB desktop toolbar to open the Profiler.

Publishing Results
New features and changes introduced in this version are described here.

Notebook Setup Changes; Some Arguments Removed
The notebook function setup behavior and syntax have changed.

When you run notebook('-setup'), MATLAB automatically obtains all the
Word information from the Windows system registry and you are no longer
prompted to supply the information.

In previous versions, when you configured Notebook, you ran

notebook ('-setup')

Notebook then prompted you to specify the version of Microsoft Word you were
using, and if needed, the location of Word and its template directory. You could
supply the information using optional arguments to the notebook function:

notebook('-setup', wordversion, wordlocation, templatelocation)

Now, when you run notebook('-setup'), MATLAB automatically obtains all
the Word information from the Windows system registry.
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Compatibility Considerations. If you use notebook with the wordversion,
wordlocation, and templatelocation arguments in any of your files (for
example, startup.m), remove those arguments in your files. If you specify the
optional arguments, the notebook function runs and issues a warning, but
ignores the values. In a future release, MATLAB will issue an error when it
encounters notebook with these arguments.

Word Versions Supported by Notebook; Word 97 No Longer
Supported
MATLAB Notebook supports Word versions 2000, and supports Word 2002
and 2003, both for XP.

Compatibility Considerations. As of MATLAB 7.1 (R14SP3), Notebook no
longer supports Microsoft Word 97.
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Mathematics, MATLAB Version 7.1 (R14SP3)
New features and changes introduced in this version are organized by these
topics:

• “New Functions” on page 207

• “Modified Functions” on page 208

• “Changes to accumarray” on page 208

• “Imposing Nonnegativity Constraints on Computed ODE Solution” on page
209

• “Mersenne Twister Support in rand” on page 209

• “svd Returns Economy Decomposition” on page 209

• “New Location for LAPACK Libraries” on page 210

• “Documentation on Data Analysis” on page 210

New Functions
The following functions are new in R14SP3:

Function Description

hypot Square root of sum of squares

mode Finds most frequent values in sample

Compatibility Considerations
A new function name can potentially introduce a backward incompatibility
since it can, under certain circumstances, override a variable with the
same name as the new function. This is especially true for names that are
commonly used as variable names in program code.

An example of such a function name is the mode function, introduced in this
release. If you have M-file programs that use mode as a variable name, it is
possible under certain conditions for MATLAB to interpret these variable
names as function names by mistake. Read the section “Potential Conflict
with Function Names” in the MATLAB Programming documentation to find
out how to avoid having these variables misinterpreted.
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If your program code uses a user-written function named mode, you may find
that MATLAB calls the new MATLAB mode function instead of your own mode
function. To correct this, modify your MATLAB path by placing the location of
your own mode function closer to the beginning of the path string than the
location of the MATLAB mode.m file. The help for the addpath and rmpath
functions explains how to modify your MATLAB path.

Modified Functions
The following functions have been modified in MATLAB 7.1:

Function Modified Behavior

accumarray Allows more flexibility for input/output classes and
functions to be called

odeset New NonNegative integration property to impose
nonnegativity constraints on an ODE solution

rand Supports the Mersenne Twister algorithm in generating
random numbers

svd Returns economy decomposition

Changes to accumarray
MATLAB Version 7.1 adds the following new features to the accumarray
function:

• The data type for the val input can be any numeric type, or logical, or
character.

• The data type for the subs input can be any numeric type.

• You can use a cell array of separate index vectors for the subs input.

• When you specify a function input argument, the value returned by
accumarray is given the same class as the values returned by that function.

• You can control the sparsity of the value returned by accumarray by
specifying the new input argument issparse.

208



Mathematics, MATLAB Version 7.1 (R14SP3)

Imposing Nonnegativity Constraints on Computed
ODE Solution
There is a new integration property called NonNegative that you can use
when applying ODE initial value problem solvers. If you need to solve a
problem in which certain components of the solution must be nonnegative,
use the NonNegative property to impose nonnegativity constraints on the
computed solutions.

See “Example: Computing Nonnegative Solutions” under “Differential
Equations” in the MATLAB Mathematics documentation for more information
on this feature.

Mersenne Twister Support in rand
The rand function now supports a method of random number generation
called the Mersenne Twister. The algorithm used by this method, developed
by Nishimura and Matsumoto, generates double precision values in the closed
interval [2^(-53), 1-2^(-53)], with a period of (2^19937-1)/2.

For a full description of the Mersenne twister algorithm, see
http://www.math.sci.hiroshima-u.ac.jp/~m-mat/MT/emt.html.

svd Returns Economy Decomposition
The following feature was released in MATLAB 7.0, but was undocumented
until this release.

The command svd(A,'econ') returns economy decomposition on matrices
having few rows and many columns as well as those with many rows and
few columns. svd(A,0) continues to behave as it always has, namely to only
return economy-sized decomposition on matrices having many rows and few
columns.

Note that this does not carry over to the qr function as there is no valid way of
cutting out any of the information returned by qr to make an economy-sized
decomposition of matrices having few rows and many columns.
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New Location for LAPACK Libraries
The location of the LAPACK libraries has been changed. These libraries are
now located in

extern/lib/win32/microsoft/libdflapack.lib
extern/lib/win32/microsoft/libmwlapack.lib

This change impacts you only if you build MEX-files that call LAPACK and
BLAS functions.

Documentation on Data Analysis
The section of the MATLAB Mathematics documentation on “Data Analysis
and Statistics” has been moved to a new MATLAB Data Analysis book.
This book documents MATLAB functions and tools that support basic data
analysis, including plotting, descriptive statistics, correlation, interpolation,
filtering, and Fourier analysis. It also documents the new object-oriented
command-line API for analyzing time-series data.
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Data Analysis, MATLAB Version 7.1 (R14SP3)
New features and changes introduced in this version are described in this
section:

Data Analysis Documentation
The MATLAB 7.1 documentation includes a new Data Analysis book that
describes how to use MATLAB functions and tools for common data-analysis
tasks:

• Plotting

• Filtering

• Interpolation

• Descriptive statistics

• Correlation

• Data fitting using linear regression

• Fourier analysis

• Time-series analysis

Some of the content in Data Analysis is incorporated from the Mathematics
and Graphics books, such as data plotting, descriptive statistics, data fitting,
and Fourier analysis. All information about time-series analysis is new.

Time-Series Analysis
You can analyze time-series data using the new timeseries and
tscollection objects and methods, as well as the Time Series Tools graphical
user interface. This new functionality supports the following:

• Representation for univariate or multivariate time series from MATLAB
and Simulink® logged-signals data

• Built-in management of time units

• Removal or interpolation of missing data

• Resampling of data
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• Arithmetic operations for timeseries objects

• Synchronization of time series

Note Due to reported instabilities on the Linux 64 platform, you must
manually enable the Time Series Tools feature before starting Time Series
Tools.

To manually enable Time Series Tools on the Linux 64 platform, type the
following at the MATLAB prompt:

rehash toolboxcache
feature('TimeSeriesTools',1)
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Programming, MATLAB Version 7.1 (R14SP3)
New features and changes are organized by these topics:

• “New Functions” on page 213

• “Modified Functions” on page 214

• “Evaluation Functions for Arrays, Structures, Cells” on page 215

• “Using who and whos with Nested Functions” on page 215

• “Date and Time Functions Support Milliseconds” on page 215

• “Stack Trace Provided for lasterror” on page 215

• “isfield Function Supports Cell Arrays; Results Might Differ from Previous
Version” on page 215

• “Support for Reading EXIF Data from Image Files” on page 216

• “Performance Improvements to the MATLAB JIT/Accelerator on
Macintosh” on page 217

• “Specifying fread Precision as Number of Bits” on page 217

• “Seconds Field Now Truncated; Results Might Differ” on page 218

• “Built-in Functions No Longer Use .bi; Impacts Output of which Function”
on page 218

• “New Warning About Potential Naming Conflict” on page 219

New Functions
This version introduces the following new functions:

Function Description

arrayfun Applies a given function to each element of an array.
This is especially useful for arrays of structures.

exifread Reads EXIF information from JPEG and TIFF
image files

structfun Applies a given function to each field of a structure
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Function Description

swapbytes Swaps byte ordering

typecast Converts data types without changing underlying
data

Compatibility Considerations
A new function name can potentially introduce a backward incompatibility
since it can, under certain circumstances, override a variable with the same
name as the new function. This is especially true for names that are commonly
used as variable names in program code. Read the section “Potential Conflict
with Function Names” in the MATLAB Programming documentation to find
out how to avoid having these variables misinterpreted.

Modified Functions
The following functions were modified in this version:

Function Modified Behavior

cellfun Applies a given function to each cell of a cell array

datestr Seconds field truncates instead of rounding

error Saves stack information that you can retrieve using
lasterror

isfield Supports cell array input

lasterror Returns stack information on last error

rethrow Accepts stack information as input

who, whos Displays information separately for nested functions

Compatibility Considerations
The following functions might, under certain circumstances, return a different
value than what was returned in MATLAB 7.0.4 (R14SP2):

• datestr: Output might differ by 1 second from what was returned in a
previous version.
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• isfield: Output might differ if you used this feature in a release in which
it was not officially supported.

Evaluation Functions for Arrays, Structures, Cells
MATLAB offers the capability to apply a given function to each element of
an array, each field of a structure, or each cell of a cell array. See the help on
arrayfun, structfun, and cellfun for more information.

Using who and whos with Nested Functions
When you use who or whos inside of a nested function, MATLAB returns or
displays all variables in the workspace of that function, and in the workspaces
of all functions in which that function is nested. This applies whether you
include calls to who or whos in your M-file code or if you call who or whos from
the MATLAB debugger. See thewho reference page for more information.

Date and Time Functions Support Milliseconds
The datestr, datenum, and datevec functions now support time specification
in milliseconds. Use the symbol .FFF to represent milliseconds in any of these
three functions. See the table labeled Free-Form Date Format Specifiers on
the datestr reference page for more information.

Stack Trace Provided for lasterror
The lasterror function now returns an additional field in the structure that
it returns. The new stack field contains information from the stack on the
M-file, function, and line in which the error occurred.

You can use this stack information to track down the source of an error, or as
an input to the rethrow function. When used with rethrow, MATLAB sets
the stack of the rethrown error to the value contained in the stack input.

isfield Function Supports Cell Arrays; Results Might
Differ from Previous Version
The isfield function now supports cell array input as shown in this example.
Check structure S for any of four possible field names. In this case, only the
first is found, so the first element of the return value is set to true:
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S = struct('one', 1, 'two', 2);

fields = isfield(S, {'two', 'pi', 'One', 3.14})
fields =

1 0 0 0

Compatibility Considerations
There might be backward compatibility issues associated with this change
if you used isfield with cell array input in a previous release. In previous
releases, although isfield might have worked with this type of input in
certain cases, it was not officially a supported feature. If you used this
previously unsupported syntax in previous releases, you may see a change in
the content and/or size of the return values in this release.

For example, create a structure s with three fields a, b, and c created in that
order. In MATLAB 7.0.4, isfield called with a cell array input returns
true if any of the elements of the cell array matches a field name, and if
that element is in the same position in the cell array as the field is in the
structure. This is true for 'c':

isfield(s, {'b'; 'a'; 'c'})
ans =

1

In MATLAB 7.1, isfield returns true for each element in the cell array that
matches a field name, regardless of where the string is positioned in the cell
array. This is true for 'a', 'b', and 'c':

isfield(s, {'b'; 'a'; 'c'})
ans =

1
1
1

Support for Reading EXIF Data from Image Files
You can now read EXIF (Exchangeable Image File Format) data from JPEG
and TIFF graphics files using the new exifread function. EXIF is a standard
used by digital camera manufacturers to store information in the image file,
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such as the make and model of a camera, the time the picture was taken and
digitized, the resolution of the image, exposure time, and focal length.

Performance Improvements to the MATLAB
JIT/Accelerator on Macintosh
The JIT/Accelerator for MATLAB, introduced in MATLAB Version 6.5 for
Windows and UNIX, is now also supported on Macintosh systems. The
JIT/Accelerator affects the performance of MATLAB and can give you a
substantial performance increase over earlier MATLAB versions for many
MATLAB applications.

Specifying fread Precision as Number of Bits
The following information on the fread function applies to MATLAB 7.1
and also to earlier versions.

MATLAB provides the following method of specifying a precision argument
in a call to fread:

input_format=>output_format

For example, to read 50 8-bit unsigned integers from a file and convert them
to characters, you can use

c = fread(fid, 50, 'uint8=>char')'

If the input format and output format are the same, you can abbreviate the
precision specifier by using

*input_format

For example, you can replace

c = fread(fid, 50, 'uint8=>uint8')'

with

c = fread(fid, 50, '*uint8')'

You can also use this notation with an input stream that is specified as a
number of bits (e.g., bit4 or ubit18). MATLAB translates this into an
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output type that is a signed or unsigned integer (depending on the input
type), and which is large enough to hold all of the bits in the source format.
For example, *ubit18 does not translate to ubit18=>ubit18, but instead to
ubit18=>uint32.

Seconds Field Now Truncated; Results Might Differ
When handling time data, MATLAB now truncates the seconds field instead
of rounding it. This is consistent with the way that MATLAB handles hours
and minutes.

For example, using MATLAB 7.0.4 (R14SP2), datestr returns

t = datestr('11:30:01.666')
t =

01-Jan-2005 11:30:02

while MATLAB 7.1 (R14SP3) returns

t = datestr('11:30:01.666')
t =

01-Jan-2005 11:30:01

Compatibility Considerations
If your M-files relied on the previous behavior, you might get different results.

Built-in Functions No Longer Use .bi; Impacts Output
of which Function
In previous releases, MATLAB function dispatching located built-in functions
by means of special files having a .bi file extension. MATLAB no longer uses
this mechanism to locate built-in functions. All .bi files have been removed
in MATLAB 7.1.

Compatibility Considerations
If you have M-files that relied on built-in files having a .bi extension, your
files need to accommodate this change.

There are changes in how MATLAB displays built-in functions using which:
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In MATLAB 7.0.4 (R14SP2),

which -all int32
\\matlab\toolbox\symbolic\@sym\int32.m % sym method
\\matlab\toolbox\matlab\datatypes\int32.bi % Shadowed
\\matlab\toolbox\matlab\datatypes\int32.m % Shadowed

In MATLAB 7.1 (R14SP3),

which -all int32
built-in (\\matlab\toolbox\matlab\datatypes\int32)
\\matlab\toolbox\symbolic\@sym\int32.m % sym method

New Warning About Potential Naming Conflict
If you change directories (cd) or add a new directory to your current MATLAB
path, and the new directory contains an M-file having the same name as a
MATLAB built-in function, MATLAB now displays a warning alerting you to
the potential naming conflict. For example,

Warning: Function D:\test\matlab\disp.m has the same name as a
MATLAB builtin. We suggest you rename the function to avoid a
potential name conflict.

In general, any file system event that leads to path refreshing in MATLAB
can trigger this warning if the directory involved in this event has such a
user function under it.

Compatibility Considerations
MATLAB might generate warnings about naming conflicts that did not
appear in previous versions. To avoid this warning, renaming your M-files
that have name conflicts with built-in functions.
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Graphics and 3-D Visualization, MATLAB Version 7.1
(R14SP3)

This version introduces the new features and changes described below.

Plot Tools Now Available on Mac Platform
As a consequence of enabling Java figures on Macintosh, the Plot Tools user
interface is now available to Mac users, enabling them to interactively add
data to plots, change plot symbology, and otherwise customize their data plots.

Documentation for Data Analysis Reorganized
Documentation explaining techniques for analyzing graphical data has been
shifted from the Graphics book of the MATLAB documentation to a new book
called Data Analysis.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.1 (R14SP3)

Plans for Obsolete Functions
The table below indicates functions that were designated as obsolete prior to
R14SP3 and that will be removed in a future version.

Compatibility Considerations
If you use these functions, you should use replacement functions instead.

Obsolete
Function

Removed from
Version Replacement

clruprop Future version rmappdata

ctlpanel Future version guide

extent Future version get(txtobj,'extent')

figflag Future version findobj to determine if
figure exists.

figure(fighandle) to bring
figure to front and give it
focus.

getuprop Future version getappdata

hthelp Future version web

layout Future version None provided

matq2ws Future version None provided

matqdlg Future version None provided

matqparse Future version None provided

matqueue Future version None provided

menuedit Future version guide

menulabel Future version Use '&' to specify mnemonics
and 'Accelerator' property
to define accelerator keys.
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Obsolete
Function

Removed from
Version Replacement

setuprop Future version setappdata

wizard Future version None provided

ws2matq Future version None provided
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External Interfaces/API, MATLAB Version 7.1 (R14SP3)
New features and changes introduced in this version are:

• “mex Switches Now Supported on Windows” on page 223

• “New COM Programmatic Identifier” on page 224

• “New File Extension for MEX-Files on Windows” on page 224

• “New Preferences Directory and MEX Options” on page 226

• “Compiler Support” on page 227

• “Import Libraries Moved” on page 227

• “MEX Perl Script Moved” on page 228

• “Linking to System Libraries” on page 228

• “COM Automation Server Now Displays Figure” on page 228

mex Switches Now Supported on Windows
MATLAB now supports the -l and -L options to the mex command on
Windows. In previous releases of MATLAB, these options were supported
only on UNIX.

Switch Description

-l Specifies additional libraries to link against.

Note On Windows, the -l option can specify libraries
of two forms. For example, specifying -l name matches
either name.lib or libname.lib, whereas on UNIX it
matches only libname.lib.

-L Specifies a path to use when MATLAB searches for
library files specified with the -l option. The -L option
must precede the -l option.

For the switches you can use with the mex command, see the “MEX Script
Switches” table in the “Custom Building MEX-Files” section of “Calling C
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and Fortran Programs from MATLAB” in the MATLAB External Interfaces
documentation.

New COM Programmatic Identifier
There is now a ProgID that enables you to use the full desktop version of
MATLAB as an automation server.

Matlab.Desktop.Application starts an automation server using the most
recent version of MATLAB that is installed on your system.

New File Extension for MEX-Files on Windows
MATLAB now uses the extension .mexw32 for MEX-files on 32-bit versions of
Windows. In previous versions, MATLAB used the extension .dll.

The MathWorks recommends that you recompile all MEX-files after installing
MATLAB 7.1. MEX-files compiled in MATLAB 7.0.4 with .dll extensions
should still work in MATLAB 7.1.

There may be two MEX-files with the same name, except that one has a
.mexw32 extension and the other has a .dll extension. When these files are
both on the MATLAB search path:

• If the two files are in the same directory, MATLAB uses the .mexw32 file.

• If the two files are in different directories, MATLAB uses the file in the
directory that is higher on the search path.

If you want one of these two files to take precedence over the other, ensure
that the directory that contains the file you want MATLAB to use is higher
on the search path than the directory that contains the file you do not want
MATLAB to use.

Compatibility Considerations
Previous versions of MATLAB do not recognize MEX-files compiled in
MATLAB 7.1 with .mexw32 extensions. However, you can use the mex -output
option in MATLAB 7.1 to build a MEX-file with a .dll extension that earlier
versions of MATLAB can recognize.
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You may need to update any M-files or makefiles that explicitly expect .dll
extensions for compiled MEX-files. You can use the mexext function in
MATLAB to obtain the extension for the platform and version you are working
on. A new mexext script obtains the appropriate extension when executed
from outside MATLAB, as in a makefile.

On Windows, MATLAB issues warnings at MEX setup time, compile time,
and run-time to notify you of possible incompatibilities resulting from the
change in MEX-file extension from .dll to .mexw32.

New mex–output Behavior for Compatibility
The -output option to mex specifies the filename of the compiled MEX-file.
In general, mex ignores any filename extension supplied in the -output
argument and uses the extension for the compiled file that is appropriate for
the architecture. However, on Windows, if the -output argument specifies
a .dll extension, the compiled file has this extension instead of .mexw32.
Previous versions of MATLAB can recognize the resulting compiled file.

Conflicting MEX-Files Renamed Automatically
If two files with the same name but with .mexw32 and .dll extensions exist
in the same directory, MATLAB uses the .mexw32 file. To avoid unintended
shadowing, MATLAB automatically renames compiled MEX-files under the
following circumstances:

• When you build a MEX-file with a .mexw32 extension and the directory
contains an existing file with the same name, but with a .dll extension,
the extension of the .dll file is changed to .dll.old.

• When you build a MEX-file with a .dll extension (using the mex -output
option) and the directory contains an existing file with the same name, but
with a .mexw32 extension, the extension of the .mexw32 file is changed
to .mexw32.old.

New Return Value for mexext on Windows
On 32-bit Windows platforms, the mexext function now returns mexw32. In
MATLAB 7.0.4 it returned dll.
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New mexext Script to Obtain MEX-File Extension in Makefiles
A new script displays the MEX-file extension in the current version of
MATLAB that corresponds to the platform on which the script is executed.
It is intended to be used outside MATLAB, in makefiles or scripts, to obtain
the appropriate filename extension for compiled MEX-files. Use this script
instead of explicitly specifying the MEX-file extension in a makefile.

The script is named mexext.bat on Windows and mexext.sh on UNIX. It is
located in the directory $matlab/bin, where $matlab represents the string
returned from the matlabroot command.

The script displays the MEX-file extension without a leading period. For
example, on 32-bit Windows platforms, it returns mexw32.

Following is a fragment of a GNU makefile that uses the mexext script to
obtain the MEX-file extension:

ext = $(shell mexext)

yprime.$(ext) : yprime.c
mex yprime.c

New Preferences Directory and MEX Options
The MATLAB preferences directory has changed. In MATLAB 7.1, the
preferences directory is named R14SP3. In previous R14 releases, the
preferences directory was named R14. For more information, see the
documentation for prefdir, which returns the preferences directory.

Compatibility Considerations
When you install MATLAB 7.1, MATLAB migrates some files from any
existing R14 preferences directory to the new R14SP3 directory. However,
MATLAB does not migrate the MEX options file, mexopts.bat. If you want to
preserve any MEX options that you have customized in an earlier R14 release,
you need to migrate your options to the new R14SP3 preferences directory.

You can migrate your MEX options in either of two ways:
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• If you have customized only a few options: Invoke mex with the -setup
option to create a new mexopts.bat file in the R14SP3 preferences directory.
Edit the new mexopts.bat file to customize the MEX options there.

• If you have customized many options: Copy your customized mexopts.bat
file from the old R14 preferences directory to the new R14SP3 directory.
Edit at least the settings of the LIBLOC and NAME_OUTPUT linker
parameters in the mexopts.bat file. These lines should look as follows on
Windows when Microsoft is the compiler vendor:

set LIBLOC=%MATLAB%\extern\lib\win32\microsoft
set NAME_OUTPUT=/out:"%OUTDIR%%MEX_NAME%%MEX_EXT%"

The LIBLOC parameter has changed because import libraries have moved; see
“Import Libraries Moved” on page 227. The value of this parameter depends
on the platform you are running MATLAB on and the vendor of the compiler
you are using.

The NAME_OUTPUT parameter has changed because the extension for compiled
MEX-Files has changed on Windows; see “New File Extension for MEX-Files
on Windows” on page 224.

Compiler Support
The set of compilers that MATLAB supports has changed in MATLAB 7.1.
For a complete, up-to-date list of supported compilers, see the following
location on the Web:

http://www.mathworks.com/support/tech-notes/1600/1601.shtml

Compatibility Considerations
You may need to recompile code compiled with an earlier compiler that is
no longer supported.

Import Libraries Moved
The import libraries (.lib files) for the MATLAB dll files have been moved
up a directory level and are no longer specific to the compiler version. The
new location for these files is
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$matlab/extern/lib/$arch/$vendor

where the terms $matlab, $arch, and $vendor respectively represent the
string returned from the matlabroot command, the platform you are running
MATLAB on, and the vendor of the compiler you are using.

Compatibility Considerations
You may need to change any code that depends on the previous library
locations.

MEX Perl Script Moved
The MEX Perl script used in building MEX-files is now located in
$matlab/bin, rather than $matlab/bin/win32. (The term $matlab
represents the string returned by the matlabroot function.) You should not
notice any difference, however, as a batch file located in $matlab/bin/win32
provides backward compatibility.

Linking to System Libraries
MATLAB now links with the system libraries by default. You no longer need
to specify them explicitly.

COM Automation Server Now Displays Figure
When using MATLAB as an Automation server, executing MATLAB
commands that create figures now displays the figure window.

Previous releases of MATLAB created the figure in the background. To
duplicate the old behavior, create a figure with its Visible property set to
off, then set the property to on when you want the figure to be visible:

h = actxserver('matlab.application');
h.Execute('figure visible off');
h.Execute('plot(1:10)');
h.Execute('set(gcf,''visible'',''on'')');
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This table summarizes what’s new in Version 7.0.4 (R14SP2):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Bug Reports at
Web site

No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.0.4
(R14SP2)” on page 231

• “Mathematics, MATLAB Version 7.0.4 (R14SP2)” on page 238

• “Programming, MATLAB Version 7.0.4 (R14SP2)” on page 239

• “Graphics and 3-D Visualization, MATLAB Version 7.0.4 (R14SP2)” on
page 245

• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.0.4
(R14SP2)” on page 246
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• “External Interfaces/API, MATLAB Version 7.0.4 (R14SP2)” on page 247
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Desktop Tools and Development Environment, MATLAB
Version 7.0.4 (R14SP2)

New features and changes are organized by these topics:

• “Installation Folder with Spaces” on page 231

• “Startup and Shutdown” on page 232

• “Desktop” on page 232

• “Running Functions — Command Window and History” on page 233

• “Help” on page 233

• “Workspace, Search Path, and File Operations” on page 234

• “Editing and Debugging M-Files” on page 235

• “Source Control Interface” on page 236

• “Publishing Results” on page 236

Installation Folder with Spaces
In MATLAB 7.0.4 (R14SP2) the following two changes have been made to the
MathWorks Installer on Windows systems:

• The Installer now allows a folder name with spaces in the installation path.

• The Installer honors the Windows default installation folder, which on
most machines is Program Files.

These changes were made in response to many customer requests and the
desire to conform to a widely established industry practice for the PC platform.

Note MathWorks products are used and integrated into many software
environments. If you use MathWorks products in conjunction with other third
party applications (compilers, other numerical analysis packages, etc.) you
might want to continue installing into a folder that does not have spaces in
the path until you have tested that those applications work with MathWorks
products.

231



Version 7.0.4 (R14SP2) MATLAB

Startup and Shutdown

Confirmation Dialog Box for Quitting Added
When quitting MATLAB, a confirmation dialog box appears if you set a new
preference for that purpose. By default, the confirm quitting preference is
not set, so the dialog box will not appear. To change the preference, see
the instructions for “Confirmation Dialogs Preferences” in the desktop
documentation.

JVM Updated
MATLAB is now using Java (JVM) 1.5 on Windows, Linux (32-bit), and
Solaris platforms. Java is supplied with MATLAB, so this change requires
no action on your part.

Compatibility Considerations
If you use a specific version of Java with MATLAB on Windows, Linux 32-bit,
or Solaris platforms, this change might affect you.

Desktop

Confirmation Dialog Boxes Preference Introduced
There are new preferences for displaying or not displaying confirmation
dialog boxes for desktop tools. In previous versions, some of these preferences
existed but were located with other preferences for the associated desktop
tool. They are now organized in one preference panel for all desktop tools.
Access them by selecting File > Preferences > General > Confirmation
Dialogs. These preferences work in conjunction with the Do not show this
prompt again check boxes that appears on various desktop confirmation
dialog boxes. For more information, see “Confirmation Dialogs Preferences” in
the desktop documentation.
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Running Functions — Command Window and History

Overwrite Mode Now Supported
The Command Window now supports overwrite mode. Press the Insert key to
enter text in overwrite mode. Press the Insert key again to return to entering
text in insert mode. View the current state at the far right end of the status
bar of the Command Window when it is undocked, or in the desktop when
the Command Window is docked and has focus. In insert mode, OVR in the
status bar is gray and the cursor has a wide block shape.

Hyperlink Color Preference Added
Set the color of hyperlinks that display in the Command Window. Select
File > Preferences > Command Window, and under Display, select
Hyperlink color.

Help

Subfunction Help Syntax Changed
To get help for a subfunction, use

help functionname>subfunctionname

Compatibility Considerations
In previous versions, the syntax was help functionname/subfunctionname.
This change was introduced in R14 (MATLAB 7.0) but was not documented.

Bug Fixes and Known Problems Now on Web; No Longer
Found Via Help Search
The Release Notes sections “Major Bug Fixes” and “Known Software and
Documentation Problems” no longer include the content in the installed help
files. Instead, the sections provide links to these lists on the MathWorks
Web site. The lists on the Web site can be updated after the release date to
reflect the latest information.
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Compatibility Considerations
As a result of this change, the Help browser Search feature will not find
search terms that are in the content of those reports. Use the MathWorks Web
site search features to look for search terms in those reports.

Workspace, Search Path, and File Operations

Formatting Decimal Separator when Copying From the Array
Editor
You can now specify how you want decimal numbers to be formatted when
you cut or copy cells from the Array Editor and paste them into text files or
other applications. You can specify a separator for this purpose in the Array
Editor panel of the Preferences dialog. The Decimal separator to use
when copying edit field is by default "." (period). If you are working in or
providing data to a locale that uses a different character to delimit decimals,
type that character in this edit field and click OK or Apply.

Workspace Browser Preference Panel Removed
The Workspace browser preferences panel was removed. The entry on that
panel was for confirming deletion of variables. That preference is now part of
General > Confirmation Dialogs preferences.

Compatibility Considerations

Use File > Preferences > General > Confirmation Dialogs instead of
File > Preferences > Workspace Browser.

Current Directory Browser Preferences Added
There are new Current Directory browser preferences you can access by
selecting File > Preferences > Current Directory Browser, Browser
display options:

• View the file size by selecting the Show file sizes check box. (This is
selected by default.)

• View brief Simulink model descriptions in the Description column when
Show M and MDL file descriptions is selected.
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• View the complete Simulink model description in the lower pane when the
preference for Show M, MDL and MAT file contents is selected. This
allows you to view information about a model without running Simulink.

Editing and Debugging M-Files

Go To Subfunction or Nested Function
Go directly to a subfunction or nested function within an M-file using the
enhanced Go To dialog box. Access the dialog box by selected Edit > Go To.
Click the Name column header to arrange the list of functions alphabetically,
or click the Line column header to arrange the list by the position of the
functions in the file.

Help Browser Now Accessible from MATLAB Stand-Alone Editor
You can now access the MATLAB Help browser from the MATLAB stand-alone
Editor. This provides you with documentation for MATLAB, including using
Editor features and MATLAB functions.

Preference for Editor/Debugger Dialog Moved
The Show dialog prompt preference has been moved to
Preferences > General > Confirmation Dialogs. For more information,
see “Confirmation Dialogs Preferences” in the desktop documentation.

Compatibility Considerations
Use File > Preferences > General > Confirmation Dialogs instead of
File > Preferences > Editor/Debugger to set this preference.

Dragging Text Maintains Font and Highlighting
Now, when you drag text from the Editor/Debugger to another application, it
maintains the syntax highlighting and font characteristics.
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Source Control Interface

Register Project Feature Added; Add to Source Control
Behavior Changed
There is a new source control interface feature for Windows platforms,
Register Project with MATLAB. Use this to associate all files in a directory
with a source control project. You perform this for any file in a directory,
which registers the directory and all files in that directory. You only perform
this once in a directory, and must perform it before you perform any other
source control actions for files in that directory.

Access the feature in the Current Directory browser by right-clicking a file
and selecting Source Control > Register Your Source Control System
Project with MATLAB from the context menu. You can also access it
from the Editor/Debugger File menu. To access the feature for Simulink or
Stateflow® files, use the Current Directory browser.

For a summary of the process, see the topic “Source Control Interface on
Windows” in the desktop documentation.

Compatibility Considerations
In previous releases, this feature was part of the Add to Source Control
feature. You still need to add each file to source control, but you do this after
first registering the directory that contains the file.

Project Name Exact Match No Longer Required
The name of the project in the source control system is no longer required to
exactly match the name of the directory on disk containing the files.

Publishing Results

Cell Publishing: File Extension Changes
The files created when publishing using cells now have more natural
extensions. JPEG files now have a .jpg instead of a .jpeg extension, and
EPSC2 files now have an .eps instead of an .epsc2 extension.
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Compatibility Consideration
If you relied on the formerly used file extensions, you need to accommodate
the changes.

Cell Publishing: LaTeX Image File Type Changes
Publishing to LaTeX now respects the image file type you specify in
preferences rather than always using EPSC2 files.

Cell Publishing: Image Options More Restrictive
The Publish image options in Editor/Debugger preferences for Publishing
Images have changed slightly. The changes prevent you from choosing
invalid formats.

Notebook Support for Word 97 to be Discontinued
Notebook will no longer support Microsoft Word 97 starting in the next
release of MATLAB.

Compatibility Considerations
If you use Word 97 with Notebook, you will need to migrate to a more recent
version.
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Mathematics, MATLAB Version 7.0.4 (R14SP2)
This version introduces the following new features and changes:

• “New Vendor BLAS Used for Linear Algebra in MATLAB” on page 238

• “max and min on Complex Integers Not Supported” on page 238

New Vendor BLAS Used for Linear Algebra in MATLAB
MATLAB uses Basic Linear Algebra Subprograms (BLAS) for its vector inner
product, matrix-vector product, matrix-matrix product, and triangular solvers
in \. MATLAB also uses BLAS behind its core numerical linear algebra
routines from Linear Algebra Package (LAPACK), which are used in functions
like chol, lu, qr, and within the linear system solver \.

Starting in this release

• On Macintosh, MATLAB now uses the Accelerate framework.

• On 64-bit Linux, MATLAB uses Intel® Math Kernel Library (MKL) 7.0.1 on
Intel chips, and AMD Core Math Library (ACML) 2.0 on AMD chips.

max and min on Complex Integers Not Supported
Using the max and min functions on complex integer inputs (as shown in the
example below) is no longer supported. This operation had been supported
from release R11 through R14SP1, but now returns an error.

max(int8([3-4i 3+4i]))

Compatibility Considerations
Any code that calls max or min on complex integers should be removed from
your program files.
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Programming, MATLAB Version 7.0.4 (R14SP2)
This version introduces the following new features and changes:

• “Memory-Mapping” on page 239

• “textscan Enhancements” on page 240

• “xlsread Enhancements” on page 240

• “xlsread Imported Date Format Changes” on page 240

• “format Options Added” on page 240

• “Nonscalar Arrays of Function Handles to Become Invalid” on page 241

• “Assigning Nonstructure Variables As Structures Displays Warning” on
page 241

• “Function Declaration Compatibililty with Pre-R14 M-Files” on page 243

Memory-Mapping
Memory-mapping is a mechanism that maps a portion of a file, or an entire
file, on disk to a range of addresses within an application’s address space. The
application can then access files on disk in the same way it accesses dynamic
memory. This makes file reads and writes faster in comparison with using
functions such as fread and fwrite.

Another advantage of using memory-mapping in MATLAB is that it enables
you to access file data using standard MATLAB indexing operations. Once
you have mapped a file to memory, you can read the contents of that file
using the same type of MATLAB statements used to read variables from the
MATLAB workspace. The contents of the mapped file appear as if they were
an array in the currently active workspace. You simply index into this array
to read or write the desired data from the file.

Memory-mapped files also provide a mechanism for sharing data between
applications. This is achieved by having each application map sections of
the same file. This feature can be used to transfer large data sets between
MATLAB and other applications.
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textscan Enhancements
The textscan function originally read data only from files. As of this release,
you can use textscan to read from strings as well.

xlsread Enhancements
In this release, you can write a function and pass a handle to this function to
xlsread. When xlsread executes, it reads from the spreadsheet, executes
your function on the data read from the spreadsheet, and returns the final
results to you.

You can use either of the following syntaxes:

num = xlsread('filename', ..., functionhandle)
[num, txt, raw, X] = xlsread('filename', ..., functionhandle)

See Example 5 — Passing a Function Handle on the xlsread reference page.

xlsread Imported Date Format Changes
In MATLAB versions prior to R14, date values read into MATLAB from an
Excel spreadsheet using xlsread were always imported as numeric date
values. The R14 and later releases of MATLAB import dates in the format in
which they were stored in the Excel file. Dates stored in string or date format
are now imported as strings by xlsread. Dates stored in numeric format
are imported as numeric date values.

Compatibility Considerations
Because of a difference in the way Excel and MATLAB compute numeric
date values, any numeric dates imported from Excel into MATLAB must
be converted to the MATLAB format before being used in the MATLAB
application. See Handling Excel Date Values on the xlsread function
reference for information on how to do this.

format Options Added
You can display MATLAB output using two new formats: short eng and long
eng. See the format reference page for more information.
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• short eng — Displays output in an engineering format that has at least
5 digits and a power that is a multiple of three.

• long eng — Displays output in an engineering format that has exactly 16
significant digits and a power that is a multiple of three.

format short eng
pi
ans =

3.1416e+000

format long eng
pi
ans =

3.14159265358979e+000

Nonscalar Arrays of Function Handles to Become
Invalid
Creation of nonscalar arrays of function handles by str2func may be invalid
or may return different results in future versions of MATLAB, but will
continue to work in R14.

Compatibility Considerations
To avoid this warning and prepare for this change, convert the cell array of
strings to a cell array of function handles.

For more information, type help function_handle and see the section
entitled Note on Backward Compatibility.

Assigning Nonstructure Variables As Structures
Displays Warning
Assigning to a nonstructure variable as if it were a structure is not
recommended in MATLAB. For example, if variable x holds a double (as
shown below), then attempting to add a fieldname to it, thus converting x to a
structure, is not good programming practice and should generate an error.

x = 10;
x.name = magic(3);
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Note that if x were empty (i.e., x == []), then assigning a field to it as if it
were already a structure is acceptable.

Behavior Prior to Release R14
Because of a bug in releases of MATLAB prior to R14, you can assign a field
to a nonempty, nonstructure variable in those releases without MATLAB
generating a warning message or error. The result is that MATLAB quietly
converts the variable to a structure:

x = 10;
class(x)
ans =

double

x.name = magic(3); % Invalid expression completes
% without warning or error.

class(x)
ans =

struct

Behavior In R14 and Later
In the MATLAB R14 and R14 service pack releases, you can still perform this
type of operation, but MATLAB now displays a warning message:

x = 10;
x.name = magic(3);

Warning: Struct field assignment overwrites a value with class
"double".

In a future release of MATLAB, attempting this type of operation will throw
an error instead of just displaying a warning message.

Compatibility Considerations
You are encouraged to modify any code that generates this warning. The
section “Making a Valid Assignment” on page 243 gives instructions on how to
do this.
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Another Case — Extending the Depth of a Structure
The same rules apply when extending the depth of a structure by adding
additional, lower-level fields. The first line of the example shown below
creates a structure named handle and assigns to it a field of type double
named output. The line after that treats this double as if it were a structure
by attempting to assign a field named time to it. The second line is an invalid
expression:

handle.output = 5;
handle.output.time = 13;

As in the case discussed earlier, this assignment does not generate a warning
or error in MATLAB releases prior to R14. In the R14 and R14 service pack
releases of MATLAB, you get the warning shown in the previous example.
Beginning in a future release of MATLAB, this assignment will throw an error.

Making a Valid Assignment
To avoid this warning and future errors, first make x an empty structure or
empty array as shown here. Once a variable is established as a structure or
empty array, you can assign fields to it without getting an error:

x = struct; or x = [];
x.name = magic(3);

In the case of extending the depth of an existing structure, you can perform
this type of assignment without generating a warning or error using the
struct function as shown here:

handle.output = struct('time', 13);

Function Declaration Compatibililty with Pre-R14
M-Files
As of Release 14, the function definition line in a function M-file no longer
requires commas separating output variables. However, because this syntax
is not compatible with earlier releases, you should always include the comma
separators when writing an M-file function that you intend to run on releases
both earlier and later than Release 14.

243



Version 7.0.4 (R14SP2) MATLAB

Compatibility Considerations
See “Comma Separators Not Required in Function Declaration” on page 352
in the Release 14 release notes.
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Graphics and 3-D Visualization, MATLAB Version 7.0.4
(R14SP2)

This version introduces the following new feature:

imwrite Now Supports GIF Export
The imwrite function now supports exporting image data in Graphics
Interchange Format (GIF).

Compatibility Considerations
The MATLAB 7.0.4 graphics features have the following platform limitations:

Cannot Dock Figures on Macintosh
You cannot dock figures in the Desktop, because MATLAB uses native figure
windows on the Macintosh platform.

Plotting Tools Not Working on Macintosh
The plotting tools are not supported on the Macintosh platform. This means
the Figure Palette, Plot Browser, and Property Editor do not work these
platforms. To use the MATLAB 6 Property Editor, see the propedit command.

Not All Macintosh System Fonts Are Available
MATLAB figures do not support the same fonts as native Macintosh
applications. Use the uisetfont functions to see which fonts are available
in MATLAB.

XDisplay Property Setable on Motif-Based Systems
You can specify the value of the figure XDisplay property only on systems
using Motif-Based figure windows.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.0.4 (R14SP2)

New Callbacks Chapter
The Creating Graphical User Interfaces documentation offers a new chapter,
in draft form, that attempts to bring information regarding callbacks into one
place. It introduces the concepts and mechanisms with which you work, and
explains some basic techniques for programming your GUI’s behavior. This
chapter is not yet complete, but you may find it useful, even in its current
state, particularly if you are new to creating GUIs.

Temporarily, this new chapter appears as Appendix A, “Working with
Callbacks (Draft).” It contains some new information, but also duplicates
information that can be found in various places throughout the rest of the
book. In cases where information has not yet been included in the new
chapter, links take you to the main part of the book.
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External Interfaces/API, MATLAB Version 7.0.4 (R14SP2)
New features and changes introduced in this version are described here.

New File Archiving Functions and Functionality
In addition to being able to zip and unzip compressed file archives, MATLAB
now supports the following archiving functions:

• gzip/gunzip — Compress/uncompress files in gzip format.

gunzip reads archives from both file systems and URLs.

• tar/untar — Compress/extract files in a tar-file.

untar reads archives from both file systems and URLs.

• The unzip function can now also open a zip archive from a URL.
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This table summarizes what’s new in Version 7.0.1 (R14SP1):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Fixed bugs No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7.0.1
(R14SP1)” on page 251

• “Mathematics, MATLAB Version 7.0.1 (R14SP1)” on page 257

• “Programming, MATLAB Version 7.0.1 (R14SP1)” on page 261

• “Graphics, MATLAB Version 7.0.1 (R14SP1)” on page 267

• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7.0.1
(R14SP1)” on page 268
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• “External Interfaces/API, MATLAB Version 7.0.1 (R14SP1)” on page 271

250



Desktop Tools and Development Environment, MATLAB Version 7.0.1 (R14SP1)

Desktop Tools and Development Environment, MATLAB
Version 7.0.1 (R14SP1)

New features and changes are organized by these topics:

• “Startup and Shutdown” on page 251

• “Desktop” on page 251

• “Running Functions — Command Window and Command History” on page
252

• “Help” on page 253

• “Workspace, Search Path, and File Operations” on page 253

• “Editing and Debugging M-Files” on page 254

• “Source Control Interface” on page 255

• “Publishing Results” on page 255

Startup and Shutdown

Constructing Java Classpath Now Uses librarypath
When MATLAB starts, it now uses librarypath.txt as well as
classpath.txt to construct the Java classpath.

Compatibility Considerations. If you call Java from MATLAB, refer to
“Locating Native Method Libraries” in the MATLAB External Interfaces
documentation for details. This change was part of MATLAB 7.0.

Desktop

System Web Browser Used for Large Files
The MATLAB Web browser displays files up to 1.5 MB. When the Web browser
tries to open a file greater than 1.5 MB, MATLAB instead automatically
displays the file in the system default browser.
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Keyboard Access Added for More Desktop Tools
Additional desktop tools provide keyboard access to toolbar buttons and fields
via mnemonics. For example, Alt+K moves the cursor to the Stack field in
the Editor/Debugger toolbar. In the Profiler, the R in the Run this code
toolbar field is underlined, indicating that Alt+R moves the cursor to this
field. You might need to hold down the Alt key while the tool is selected in
order to see the mnemonics on the menus and buttons.

Macintosh Menus
On the Macintosh, the location of MATLAB menus has changed. In this
version, MATLAB menus are not located at the top of the screen with other
Macintosh screen menus. Instead, MATLAB menus appear within the
MATLAB desktop and MATLAB tools. This change was made because of a
problem with screen menus that caused MATLAB on the Macintosh to crash.

Running Functions — Command Window and
Command History

Preferences for Parentheses Matching Added
There are now Command Window preferences you can set to perform
parenthesis matching. Select File > Preferences > Command
Window > Keyboard and Indenting to set them. With the preference
Match parentheses while typing selected, when you type a parenthesis
or another delimiter, MATLAB highlights the matched parenthesis or other
delimiter in the pair. With the preference Match parentheses on arrow key
or mouse movement selected, when you move over a parenthesis or another
delimiter, MATLAB highlights the matched parenthesis or other delimiter
in the pair. MATLAB also alerts you to mismatches. These preferences also
allow you to specify how MATLAB notifies you of matches and mismatches.

Clear Command Window Now Available from Context Menu
You can now select Clear Command Window from the context menu in
the Command Window. A confirmation dialog box does not appear and the
Command Window clears immediately. If you want a confirmation dialog box
to appear before the Command Window clears, use Edit > Clear Command
Window instead.
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End Key Behavior Changes
With the Display preference for Wrap lines selected, pressing End moves
the cursor to the end of the current statement. When the Command line
key bindings preference is set to Emacs (MATLAB standard), you can also
do this using Ctrl+E. In the previous version, End (and Ctrl+E) moved the
cursor to the end of the current line.

Help

Own Help Files Now Allow Special Icons
When you supply your own help files, you can now specify the type of icon that
appears in the Help browser Contents pane via the <help_contents_icon>
tag in the info.xml file. For details, see “Adding Help Files”.

Workspace, Search Path, and File Operations

Array Editor: F2 Keyboard Shortcut Added to Edit Current
Element
A keyboard shortcut to use instead of double-clicking a cell is F2 (or Ctrl+U
on Macintosh), which allows you to edit the current element, positioning the
cursor at the end of the element.

Array Editor: Single Quotation Marks Now Supplied for
Strings During Paste from Excel
When you copy data from Microsoft Excel and paste it into a cell array in
the Array Editor using the menu item Edit > Paste Excel Data, MATLAB
assumes the values are strings and automatically supplies the single
quotation marks if they cannot be interpreted as numeric values.

Current Directory Browser Comments Now Include First Line
When you select the Current Directory preference Show M-file comments
and MAT-file contents, the help shown now includes the first comment
line (also called the H1 line).
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Current Directory Browser Auto-Refresh Rate Now Specifiable
The Current Directory browser preference for auto-refresh now allows you to
specify the update time. By default, every 2 seconds the Current Directory
browser checks for and reflects any changes you made to files and directories
in the current directory using other applications.

In some cases when the current directory is on a network and the Current
Directory browser is open, MATLAB becomes slow because of the auto-refresh
feature. If you experience general slowness in MATLAB and have the
Current Directory browser open, increase the default update time to improve
responsiveness. If increases do not alleviate the slowness enough, clear the
check box in preferences to turn auto-refresh off. Then you can manually
refresh the display selecting Refresh from the context menu in the Current
Directory browser.

Find Files Field Now Uses Selected Text
You can now select text in the Command Window or Editor and the Find
Files dialog box enters that text in its Find files containing text field.

Editing and Debugging M-Files

Breakpoints Supported in Anonymous Functions
The Editor/Debugger supports breakpoints in anonymous functions. Lines
containing anonymous functions can have more than one breakpoint in a line:
one for the start of the line and one for each anonymous function in the line. A
line that contains multiple breakpoints has a blue breakpoint icon.

dbstatus Supports Anonymous and Nested Functions
The dbstatus function now supports anonymous and nested
functions, including a new '-completenames' argument. Running
dbstatus('-completenames') displays, for each breakpoint, the absolute
filename and the sequence of functions that nest the function containing
the breakpoint.
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Colors Now Maintained when Copying From Editor
When you paste a selection from the Editor into another application, such as
Word, the Editor now maintains the syntax highlighting colors in the file in
the other application. MATLAB pastes the selection to the clipboard in RTF
format, which many Windows and Macintosh applications support.

Open Selection Now Works for Current Cursor Position
In an M-file, position the cursor within a subfunction, function, file, variable,
or Simulink model, and press Ctrl+D (or right-click and select Open
Selection). The item opens in the appropriate tool. In the previous version
of MATLAB, you had to select the complete name in the M-file to use this
feature. See “Opening a Selection in an M-File” for more information.

Source Control Interface

verctrl Function Does Not Support Handle
The verctrl function, available for Windows platforms only, was documented
incorrectly. The documentation stated that you could create a handle, and
showed the handle argument in the function syntax. You cannot create a
handle, but must instead use a value of 0 for that field.

Publishing Results

Notebook Causes MATLAB to Become Automation Server
If you run Notebook from MATLAB and MATLAB is not an automation server,
MATLAB will become an automation server. This is a change from Release 14,
where MATLAB spawned a second instance that was an automation server.

Notebook Now Supports Office 2003
Notebook now supports Office 2003 (for XP); it is one of the notebook -setup
options.
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Notebook Support for Word 97 to Be Discontinued
Word 97 is supported in this release, but will not be supported in future
releases.

Compatibility Considerations. If you use Word 97 with Notebook, move to
a newer version of Word before moving to the next version of MATLAB.
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Mathematics, MATLAB Version 7.0.1 (R14SP1)
This version introduces the following new features and changes:

• “New Function — ordeig” on page 257

• “More Functions Accept Single-Precision Data Inputs” on page 257

• “New Vendor BLAS Used for Linear Algebra in MATLAB” on page 258

• “Overriding the Default BLAS Library on Sun/Solaris Systems” on page 258

• “FDLIBM Version Upgraded” on page 259

• “Different Results When Solving Singular Linear Systems on Intel
Systems; Inconsistent NaN Propagation” on page 259

• “funm Returns Status Information; New Output Might Result In Error”
on page 260

New Function — ordeig
The new function ordeig takes a quasitriangular matrix T or matrix pair
(A,B) and returns the vector of eigenvalues in the same order that they
appear down the diagonal of T or (A,B). You can use ordeig with the
functions ordschur and ordqz, which reorder the eigenvalues of a Schur
factorization or a QZ factorization, respectively.

More Functions Accept Single-Precision Data Inputs
More MATLAB functions now accept single-precision data inputs in addition
to the usual double-precision inputs. To determine whether a function works
on single precision inputs, look for the Class support line in the M-file help
for the function. For example, to determine whether the function mean accepts
single-precision inputs, type

help mean

The Class support line is

float: double, single

which tells you that mean does accept single-precision inputs.
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New Vendor BLAS Used for Linear Algebra in MATLAB
MATLAB uses Basic Linear Algebra Subprograms (BLAS) for its vector inner
product, matrix-vector product, matrix-matrix product, and triangular solvers
in \. MATLAB also uses BLAS behind its core numerical linear algebra
routines from Linear Algebra Package (LAPACK), which are used in functions
like chol, lu, qr, and within the linear system solver \.

On some platforms, MATLAB continues to use ATLAS BLAS.

Starting in Release 14, MATLAB 7.0 uses vendor BLAS from the vecLib
library on the Mac.

Starting in Release 14 with Service Pack 1, MATLAB 7.0.1 uses vendor BLAS
from

• The Intel® Math Kernel Library (MKL) Version 7.0 on Intel chips running
both Windows and Linux. See the MATLAB 7.0 Release Notes for how to
use the multi-threaded capabilities of MKL.

• The AMD Core Math Library (ACML) Version 2.0 library on AMD chips,
native 64 bit application

Overriding the Default BLAS Library on Sun/Solaris
Systems
MATLAB uses the Basic Linear Algebra Subroutines (BLAS) libraries to
speed up matrix multiplication and LAPACK-based functions like eig, svd,
and \ (mldivide). At start-up, MATLAB selects the BLAS library to use.

For Release 14 with Service Pack 1, MATLAB still uses the ATLAS BLAS
libraries on the Sun Microsystems Solaris Operating System. However, you
can switch the BLAS library that MATLAB uses to the Sun Performance
Library (Sunperf) BLAS, provided by Sun Microsystems.

If you want to take advantage of the potential performance enhancements
provided by the Sun BLAS, you can set the value of the environment variable
BLAS_VERSION to the name of the Sun Performance Library, libsunperf.so.4.
MATLAB uses the BLAS specified by this environment variable, if it exists.
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To set the BLAS_VERSION environment variable, enter the following
command at the at the UNIX prompt.

% setenv BLAS_VERSION libsunperf.so.4

Then start MATLAB as usual.

To get visual feedback that the BLAS version has changed, also type at the
UNIX prompt

% setenv LAPACK_VERBOSITY 1

before starting MATLAB. This will display diagnostic information while
MATLAB is starting up, for example:

cpu_id: sun4u
libmwlapack: loading libsunperf.so.4
libmwlapack: loading lapack.so

FDLIBM Version Upgraded
In Release 14, MATLAB used FDLIBM Version 5.2. In R14SP1, MATLAB has
been upgraded to use FDLIBM Version 5.3.

Different Results When Solving Singular Linear
Systems on Intel Systems; Inconsistent NaN
Propagation
In previous releases, when you solved n-by-n linear systems Ax=b using
x = A\b, where A is singular or contains NaN, the computed result x often
contained NaN. In Version 7.0.1, the same command might return 0 in x, due
to the way the Intel® Math Kernel Library (MKL) implementation of the
BLAS handles this operation.

Compatibility Considerations
Code that relies on the result containing NaN should check for the following
warnings instead:

• For singular A, an existing warning is issued.

x = [1 2; 0 0]\[1; 0]
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Warning: Matrix is singular to working precision.
x =

1
0

• For A that contains NaN, a new warning message is issued.

x = [1 2; 0 NaN]\[1; 0]
Warning: Matrix is singular, close to singular or badly scaled.
Results may be inaccurate. RCOND = NaN.
x =

1
0

funm Returns Status Information; New Output Might
Result In Error
Prior to Release 14, the second output of the function funm was an error
estimate that was sometimes inaccurate. In Release 14, Version 7.0, the
second output was replaced by an exit flag that indicates whether the
computation was successful.

Compatibility Considerations
Code that was created prior to Release 14 and that uses the second output of
funm, might not work correctly in Version 7.0 or later.
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Programming, MATLAB Version 7.0.1 (R14SP1)
This version introduces the following new features and changes:

• “Character Set Conversion Functions Added” on page 261

• “datevec Support of Empty String Argument” on page 262

• “depfun Function Supports New Options” on page 262

• “ftell Returning Invalid Position in Rare Cases” on page 262

• “fwrite Saves uint64 and int64 Types” on page 263

• “mat2str Enhanced to Work with Non-double Types” on page 263

• “nargin, nargout Operate on Function Handles” on page 263

• “regexprep Now Supports Character Representations in Replacement
String” on page 264

• “Logical OR Operator | in regexp Expressions Might Yield Different
Results from Previous Version” on page 264

• “Multiple Declarations of Persistent Variables No Longer Supported” on
page 265

• “Function Declaration Compatibililty with Pre-R14 M-Files” on page 266

Character Set Conversion Functions Added
Unicode is becoming the preferred internal presentation of characters in
MATLAB. For example, MATLAB functions such as disp require an input
string in Unicode to display properly. To facilitate the use of different
character sets, MATLAB provides two new functions to convert characters
from a native character set to Unicode and back.

The native2unicode function converts from either a default, or user specified,
native character set to Unicode. The unicode2native function does the
opposite, converting from Unicode to either a default, or user specified, native
character set. Note that any MATLAB string containing only US-ASCII
characters does not require any conversion.

Type doc native2unicode or doc unicode2native for more information on
these functions.
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datevec Support of Empty String Argument
For the purpose of backwards compatibility, invoking the command
datevec('') now returns an empty vector.

Compatibility Considerations
This behavior was not intentional in previous versions of MATLAB, and it is
subject to change in future releases.

depfun Function Supports New Options
The depfun function now supports these options:

Option Description

'-all' Computes all possible left-side arguments and
displays the results in the report(s). Only the
specified arguments are returned.

'-calltree' Returns a call list in place of a called_from
list. This is derived from the called_from list
as an extra step.

'-expand' Includes both indices and full paths in the call
or called_from list.

'-print', 'file' Prints a full report to file.

'-quiet' Displays only error and warning messages, and
not a summary report.

'-toponly' Examines only the files listed explicitly as input
arguments. It does not examine the files on
which they depend.

'-verbose' Outputs additional internal messages.

ftell Returning Invalid Position in Rare Cases
The ftell function is likely to return an invalid position when all of the
following are true. This is due to the way in which the Microsoft Windows C
library currently handles its ftell and fgeptos commands:
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• The file you are currently operating on is an ASCII text file.

• The file was written on a UNIX-based system, or uses the UNIX-style line
terminator: a line feed (with no carriage return) at the end of each line of
text. (This is the default output format for MATLAB functions dlmwrite
and csvwrite.)

• You are reading the file on a Windows system.

• You opened the file with the fopen function with mode set to 'rt'.

• The ftell command is directly preceded by an fgets command.

Note that this does not affect the ability to accurately read from and write to
this type of file from MATLAB.

Compatibility Considerations
This represents a change in behavior.

fwrite Saves uint64 and int64 Types
The fwrite function can now save uint64 and int64 values. Previously
fwrite supported these data types only on DEC Alpha systems. Now, it works
on all supported MATLAB platforms.

mat2str Enhanced to Work with Non-double Types
In MATLAB 7.0.1, you can use the mat2str function to convert nondouble
data types to a string that represents the input value. Type doc mat2str
for more information.

nargin, nargout Operate on Function Handles
The nargin and nargout functions now accept a either a function name or
function handle as an input argument. When called with a function handle,
nargin and nargout return the number of input or output arguments you can
pass to or receive from the function that the handle maps to.
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regexprep Now Supports Character Representations
in Replacement String
The regexprep function now supports the use of character representations
(e.g., '\t' for tab, '\n' for newline) in replacement strings. For example, the
following regexprep command replaces the | character with two horizontal
tabs:

str = 'Field 1 | Field 2 | Field 3';
regexprep(str, '\|', '\t\t')
ans =

Field 1 Field 2 Field 3

In Version 6, the same command yielded the string

Field 1 \t\t Field 2 \t\t Field 3

Logical OR Operator | in regexp Expressions Might
Yield Different Results from Previous Version
Be careful about using the logical OR (|) operator within square brackets (e.g.,
[A|B]) in regular expressions in MATLAB. The recommended way to match
“the letter A or the letter B” in a MATLAB regexp expression is to use '[AB]'.

Compatibility Considerations
If you have used '[A|B]' for this purpose in earlier versions of MATLAB, you
may get unexpected results when you run your code in version 7.0.

MATLAB versions 6.0 and 6.5 treat | as an ordinary character when it is
used between square brackets. For example, these versions interpret the
expression '[A|B]' as “match 'A', or match '|', or match 'B'.” MATLAB 7.0
correctly gives precedence to the logical OR functionality of the | operator.
Because of this change, MATLAB now interprets '[A|B]' as “match '[A',
or match 'B]'.”

You can avoid the effects of this bug fix altogether by using the recommended
syntax '[AB]' for this type of operation. This syntax returns the correct
results in all MATLAB versions.

The following example attempts to find the word Jill or Bill in the string ’My
name is Bill’. The syntax used in the expression is incorrect, but regexp in
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MATLAB 6.5 finds a match anyway because of the software bug. This syntax
does not work in version 7.0 or 7.0.1 because MATLAB now interprets the
expression as the logical OR of the two statements, '[J' and 'B]ill':

MATLAB 6.5 MATLAB 7.0.1
str = 'My name is Bill'; str = 'My name is Bill';
expr = '[J|B]ill'; expr = '[J|B]ill';
[s e] = regexp(str, expr); [s e] = regexp(str, expr);
str(s:e) str(s:e)
ans = ans =

Bill Empty string: 1-by-0

Using the recommended syntax returns the correct results in all MATLAB
versions:

str = 'My name is Bill';
expr = '[JB]ill';
[s e] = regexp(str, expr);
str(s:e)
ans =

Bill

If you want to use | in an expression as an ordinary character, precede it
with a backslash:

str = 'The | operator performs a logical OR';
expr = 'The [\$ \| \#] operator';
[s e] = regexp(str, expr);
str(s:e)
ans =

The | operator

Multiple Declarations of Persistent Variables No
Longer Supported
You can no longer declare a variable as persistent more than once within a
function.

Compatibility Considerations
If you do this, you will need to modify your code.
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Function Declaration Compatibililty with Pre-R14
M-Files
As of Release 14, the function definition line in a function M-file no longer
requires commas separating output variables. However, because this syntax
is not compatible with earlier releases, you should always include the comma
separators when writing an M-file function that you intend to run on releases
both earlier and later than Release 14.

Compatibility Considerations
See “Comma Separators Not Required in Function Declaration” on page 352
in the Release 14 release notes.
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Graphics, MATLAB Version 7.0.1 (R14SP1)
This version introduces the following new feature:

OpenGL Trouble Shooting
The opengl command now enables you to switch from hardware to
software-based OpenGL rendering. It also enables you to select various
known bug workarounds. See the opengl reference page for more information.

Compatibility Considerations

Cannot Dock Figures on Macintosh
You cannot dock figures in the Desktop, because MATLAB uses native figure
windows on the Macintosh platform.

Plotting Tools Not Working on Macintosh
The plotting tools are not supported on the Macintosh platform. This means
the Figure Palette, Plot Browser, and Property Editor do not work these
platforms. To use the MATLAB 6 Property Editor, see the propedit command.

Not All Macintosh System Fonts Are Available
MATLAB figures do not support the same fonts as native Macintosh
applications. Use the uisetfont functions to see which fonts are available
in MATLAB.

Preview Java Figures on the Macintosh
You can preview the use of Java Figure on the Macintosh by starting MATLAB
with the -useJavaFigures option.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7.0.1 (R14SP1)

This version introduces the following new features and changes:

• “FIG-File Format Change” on page 268

• “Panels, Button Groups, and ActiveX Components” on page 268

• “Comments Now Optional for Newly Generated Callback Functions” on
page 269

• “Windows XP Display of Push and Toggle Buttons” on page 269

FIG-File Format Change
GUI FIG-files that are created or modified with MATLAB 7.0 or a later
MATLAB version are not automatically compatible with Version 6.5 and
earlier versions.

• GUIs Saved from GUIDE or from the Command Line: You can check the
Ensure backward compatibility (-v6) preference in the Preferences
dialog box under General > MAT-Files. When this preference is checked,
all MAT-files are saved so as to be backward compatible with Version 6.5
and earlier versions.

• Alternative for GUIs Saved from the Command Line: If you do not want
to check the MAT-Files preference described above, but want to make
individual GUI FIG-files backward compatible, use the 'v6' argument
when you save the GUI with the hgsave function.

Compatibility Considerations
To make FIG-files, which are a kind of MAT-file, backward compatible, you
must explicitly specify that you want the backwards compatibility.

Panels, Button Groups, and ActiveX Components
Panels, button groups, and ActiveX components were introduced in
MATLAB 7.0. These components are not compatible with versions earlier
than 7.0.
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Compatibility Considerations
You should not use these components in GUIs that you expect to run in earlier
MATLAB versions.

You can export a GUI that contains a panel, button group, or ActiveX
component from GUIDE to a single M-file that does not require a FIG-file.
However, you will not be able to run that M-file in MATLAB versions earlier
than 7.0.

Comments Now Optional for Newly Generated
Callback Functions
In prior releases, GUIDE automatically generated comment lines for each
callback that you added to an existing GUI M-file. For example:

% --- Executes during object deletion, before destroying properties.
function figure1_DeleteFcn(hObject, eventdata, handles)
% hObject handle to figure1 (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

Comment lines are now optional for most callbacks. If you want the comments
to be generated automatically when you add a callback, check the new
preference Add comments for newly generated callback functions on
the GUIDE panel of the Preferences dialog box. The factory default is
checked.

If this preference is unchecked, GUIDE includes the comment lines only for
callbacks that are automatically included for the GUIDE template you chose.
No comments are included for any other callbacks that are added to the M-file.

Windows XP Display of Push and Toggle Buttons
Push buttons and toggle buttons with background colors other than the
default display differently in Windows XP.

Compatibility Considerations
For Windows XP, GUI push buttons are displayed with a white background.
If you have specified a background color other than the default, that color
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appears as a border around the push button. Unselected toggle buttons are
displayed with the specified background color, but selected toggle buttons are
displayed with a white background bordered by the background color.
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External Interfaces/API, MATLAB Version 7.0.1 (R14SP1)
New features and changes introduced in this version are described here.

Function Handles in COM Event Callbacks
MATLAB now supports function handles as callbacks for ActiveX objects. This
example passes a function handle that maps to sampev to registerevent:

cd $matlabroot\toolbox\matlab\winfun
h = actxcontrol('mwsamp.mwsampctrl.2', [0 0 200 200]);
registerevent(h, @sampev); % Click the control.

Registering Events for COM Servers and Controls
With MATLAB 7.0.1, you can register events for COM servers as well as
for COM controls.

Expanded Support for Web Services (SOAP and
WSDL)
This version expands MATLAB support for Web services, that is, Simple
Object Access Protocol (SOAP) and Web Services Description Language
(WSDL). These are some of the key enhancements:

• MATLAB now supports document style messages, in addition to the Remote
Procedure Call (RPC) style supported in version 7.0.

• MATLAB preserves the case in method, class, and object names.

• Web services functions now decode results that use Base64 encoding.

• The createClassFromWsdl function now supports WSDL files that define
multiple services.

Specifying the Search Path for Java Native Method
DLLs
The mechanism that MATLAB uses to locate native method libraries that are
required by Java has changed. MATLAB no longer uses system environment
variables to define the paths to these libraries.
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Compatibility Considerations
If you presently rely on the PATH (for Windows) or LD_LIBRARY_PATH (for
UNIX) environment variables for this purpose, you will need to use the file
librarypath.txt, as described below, in its place.

Specifying the Java Library Path
Java classes can dynamically load native methods using the Java method
java.lang.System.loadLibrary("LibFile"). In order for the JVM to locate
the specified library file, the directory containing it must be on the Java
Library Path. This path is established when MATLAB launches the JVM at
startup, and is based on the contents of the file

$matlab/toolbox/local/librarypath.txt

(where $matlab is the MATLAB root directory represented by the MATLAB
keyword matlabroot).

You can augment the search path for native method libraries by editing the
librarypath.txt file. Follow these guidelines when editing this file:

• Specify each new directory on a line by itself.

• Specify only the directory names, not the names of the DLL files. The
LoadLibrary call does this for you.

• To simplify the specification of directories in cross-platform environments,
you can use any of these macros: $matlabroot, $arch, and $jre_home.

MATLAB DDE Server Is Now Disabled By Default
To enable the DDE server start MATLAB with the /Automation option.

The outgoing MATLAB DDE commands (ddeinit,
ddeterm, ddeexec, ddereq, ddeadv, ddeunadv, ddepoke)
function normally without the MATLAB DDE server. See
http://www.mathworks.com/support/solutions/data/1-Q4728.html?
solution=1-Q4728 for more information.
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Clearing MEX-Functions
The command clear mex now clears MEX-functions, but not M- and MEX-
functions. Entering clear mex does not clear locked functions or functions
that are currently in use. It does however clear breakpoints and persistent
variables.
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This table summarizes what’s new in Version 7 (R14):

New Features
and Changes

Version
Compatibility
Considerations

Fixed Bugs
and Known
Problems

Related
Documentation
at Web Site

Yes
Details below

Yes — Details
labeled as
Compatibility
Considerations
in descriptions
of new features
and changes. See
also Summary.

Fixed bugs No

New features and changes introduced in this version are organized by these
areas:

• “Desktop Tools and Development Environment, MATLAB Version 7 (R14)”
on page 276

• “Mathematics, MATLAB Version 7 (R14)” on page 307

• “Programming, MATLAB Version 7 (R14)” on page 332

• “Graphics and 3-D Visualization, MATLAB Version 7 (R14)” on page 371

• “Creating Graphical User Interfaces (GUIs), MATLAB Version 7 (R14)”
on page 380

• “External Interfaces/API, MATLAB Version 7 (R14)” on page 386
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Desktop Tools and Development Environment, MATLAB
Version 7 (R14)

New features and changes introduced in this version are organized by these
topics:

• “Startup and Shutdown” on page 276

• “Desktop” on page 277

• “Running Functions — Command Window and Command History” on page
282

• “Help” on page 286

• “Workspace, Search Path, and File Operations” on page 289

• “Editing and Debugging M-Files” on page 295

• “Tuning and Managing M-Files” on page 301

• “Source Control Changes” on page 305

• “Publishing Results” on page 305

Startup and Shutdown

JVM Version Updated
MATLAB is now using Java (JVM) 1.4.2.
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Desktop
New features and changes introduced in this version are

• “Demo of MATLAB Desktop Added” on page 277

• “Arranging Documents Supports New Options” on page 277

• “Finding Files and Content in Files with New Tools” on page 278

• “MATLAB Shortcuts to Easily Run Group of Statements” on page 278

• “MATLAB Web Browser Added” on page 279

• “Menu Changes” on page 279

• “Keyboard Shortcuts Added to Go to Tools and Documents” on page 279

• “Drag and Drop Supported Between Desktop Tools” on page 280

• “Arranging Columns in Tools” on page 280

• “Font and Color Preferences for Tools” on page 280

• “terminal Function Removed” on page 281

• “license Function Results Modified Slightly” on page 281

Demo of MATLAB Desktop Added
If you are using the Help browser, watch the new Desktop and Command
Window video demo for an overview of the major functionality.

Arranging Documents Supports New Options
The MATLAB desktop now provides you with new options for arranging the
following types of documents:

• M-files and other files in the Editor/Debugger

• Arrays in the Array Editor

• Figure windows

• HTML documents in the MATLAB Web browser

You can dock these types of documents in the desktop, undock them from the
desktop so each is in its own separate window, or group undocked documents
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together in their tool. You can now position the documents using these
features: tile, left/right split, top/bottom split, floating, or maximized. Use the
Window menu or toolbar icons to position documents.

Docking Tools and Documents. There are now dock buttons in the
menu bars of undocked tools and documents. Click a dock button to move the
tool into the desktop, or to move the document into its tool.

Document Bar. There is now a Document Bar in tools that support
documents that you use to go to open documents. It appears when there is
more than one maximized document open in a tool. You can hide or move the
Document Bar by selecting Desktop > Document Bar menu options.

Saving Layouts. You can save desktop layouts. Select Desktop > Save
Layout and provide a name. To restore a saved layout, select
Desktop > Desktop Layout > name.

Launch Pad Removed. The Launch Pad tool was removed. Use the Start
button instead.

Adding Your Own Toolbox to Start Button. Add your own toolbox to the
Start button. Select Start > Desktop Tools > View Source Files. Click
Help in the resulting dialog box for details.

Finding Files and Content in Files with New Tools
Search for files and directories, as well as for content within files by selecting
Edit > Find Files from any desktop tool. For details, see “Finding Files and
Content Within Files” in the online documentation.

MATLAB Shortcuts to Easily Run Group of Statements
You can create and run MATLAB shortcuts, where a shortcut is an easy way
to run a group of MATLAB statements. A shortcut is like an M-file script, but
unlike an M-file, a shortcut does not have to be on the MATLAB search path
or in the current directory when you run it.

Create a shortcut by selecting Start > Shortcuts > New Shortcut and
completing the dialog box. Run the shortcut from the Start button.
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You can also create a shortcut by dragging selected statements to the shortcut
toolbar. This adds the shortcut to the toolbar, from where you can then run it.
For details, see “Shortcuts for MATLAB — Easily Run a Group of Statements”
in the online documentation.

MATLAB Web Browser Added
MATLAB now displays HTML documents it produces in a new desktop tool,
the MATLAB Web browser. You can display HTML documents in this Web
browser using the web function.

The web function now opens the MATLAB Web browser by default, instead of
opening the MATLAB Help browser. Use the web function’s -helpbrowser
option to display files in the Help browser.

Menu Changes

Debug Menu Added. You can now access debugging features from the
Debug menu of most desktop tools.

View, Window, and Desktop Menus. There is no longer a desktop View
menu, although some tools still have a View menu. The Window menu in
the desktop has changed. Use the new Desktop menu to select a layout,
and to open and close tools. Use the Window menu to access open tools and
documents, as well as to position documents. The menus and the menu items
in the desktop change, depending on the current tool selected.

Web Menu Items Moved. The Web menu was removed. Access the items it
contained from Help > Web Resources.

Keyboard Shortcuts Added to Go to Tools and Documents
There is now a keyboard shortcut you can use to go to each tool and to each
open document. For example, use Ctrl+0 to go to the Command Window,
and Ctrl+Shift+0 to go to the most recently used Editor document. See the
Window menu for the shortcuts to go to currently open tools and documents.

There have been some changes to the keyboard shortcuts you use with desktop
tools. For example, Ctrl+Tab now moves you to the next open tool or group
of tools tabbed together. In previous releases, Ctrl+Tab moved you to the
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next open document or tool. In MATLAB 7, use Ctrl+Page Down to move
to the next open document or tool in a tabbed group. For the complete list,
see “Keyboard Shortcuts (Accelerators or Hot Keys) and Mnemonics” in the
online documentation.

Drag and Drop Supported Between Desktop Tools
You can drag selected text or files between desktop tools. For example, you can

• Select text in the Editor and drag it to the Command Window, which cuts
and pastes it into the Command Window. You can use Ctrl while dragging
to copy selected text instead of just moving it.

• Select a file in the Current Directory browser and drag it to the Editor,
which opens the file in the Editor.

You can also drag selected text or files between desktop tools and external
tools and applications. For example, you can

• Select a MAT-file from the Microsoft Windows Explorer and drag it to the
Command Window, which loads the data into the MATLAB workspace.

• Select text from a page displayed in a Netscape browser and drag it to a file
in the Editor, which pastes the text into the file in the Editor.

Arranging Columns in Tools
In desktop tools that contain columns, you can drag a column to a new
position. For example, this includes the Current Directory browser, and the
Help browser Index and Search panes. Click a column head to sort by that
column. For some tools, you can click again to reverse the sort order.

When a column is too narrow to show all the information in it, position the
cursor over a long item in that column, and a tooltip displays showing the
complete content of the item.

Font and Color Preferences for Tools
Access font and color preferences for all desktop tools in the Fonts
and Colors preference panes. Select File > Preferences > Fonts or
File > Preferences > Colors. For more information, click the Help button
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in the preferences dialog box, or see “Fonts Preferences for Desktop Tools” and
“Colors Preferences for Desktop Tools” in the online documentation.

terminal Function Removed
The terminal function was removed.

Compatibility Considerations. If your code refers to the terminal function,
you need to change it.

license Function Results Modified Slightly
The data returned by the license command is now sorted in alphabetical
order and uses only lowercase characters.

Compatibility Considerations. If you rely on the data returned by license,
be sure your code works properly with these changes.
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Running Functions — Command Window and
Command History
New features and changes introduced in this version are

• “Demo of Command Window Features” on page 282

• “Tab Completion Graphical Interface Added; Removed Preference to Limit
Completions” on page 282

• “Navigate in Command Window Using Arrow Keys Via New Preference”
on page 283

• “Incremental Search Indicates Search Direction and is Now Case Sensitive”
on page 283

• “commandwindow Function Added to Open or Select the Command
Window” on page 283

• “Macintosh: Command +. Now Stops Execution” on page 283

• “Comment After Ellipsis Now Properly Highlighted” on page 283

• “Evaluate Selection from Context Menus No Longer Appends” on page 284

• “Syntax Highlighting Default Colors Modified” on page 284

• “Ctrl+C to Stop Execution is Now More Consistent” on page 284

• “Parentheses Matching Support Removed” on page 284

• “Command History Features” on page 285

Demo of Command Window Features
If you are using the Help browser, watch the new Desktop and Command
Window video demo for an overview of the major functionality.

Tab Completion Graphical Interface Added; Removed
Preference to Limit Completions
Tab completion now has a graphical interface. For example, type cos
and press the Tab key. A list of functions that begin with cos appears.
Double-click the function you want and MATLAB completes the name in the
Command Window. Alternatively, when the list of names appears, you can
type the next unique letter in the name, and the first name in the list that
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matches it is selected. Continue typing unique letters to select the name you
want, and press Enter. Press Esc to clear the list without selecting a name.

With the new interface, there is a no longer a preference allowing you to limit
the number of tab completions that display. MATLAB always displays all
possible completion.

Compatibility Considerations. If you relied on the preference to limit the
number of tab completions MATLAB displays, type more characters before
pressing Tab so fewer possible completions display.

Navigate in Command Window Using Arrow Keys Via New
Preference
There is a new preference that allows you to use arrow keys to navigate in
the Command Window instead of recalling history.

Incremental Search Indicates Search Direction and is Now
Case Sensitive
The incremental search interface now indicates the search direction. It is also
case sensitive when you enter uppercase letters in the search field.

commandwindow Function Added to Open or Select the
Command Window
Use the new commandwindow function to open the Command Window when
it is closed. For example, use this function in an M-file. Or if the Command
Window is already open, use the function to select the Command Window,
making it the active window.

Macintosh: Command +. Now Stops Execution
On Macintosh platforms, you can now use Command+. (Command key and
period key) to stop execution of a running program.

Comment After Ellipsis Now Properly Highlighted
When you include an ellipsis in a statement so that you can continue the
statement on the next line, any text you type after the ... on the same line
is considered to be a MATLAB comment and now is syntax highlighted as a
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comment. In previous releases, the syntax highlighting did not indicate the
text after the ... as a comment.

Evaluate Selection from Context Menus No Longer Appends
Evaluate selection, available from context menus for various tools, no longer
appends the selection to the statement at the prompt, but instead runs
the selection. Make a selection and press Enter or Return to append the
selection to the statement at the prompt and execute it.

Syntax Highlighting Default Colors Modified
The default colors for syntax highlighting have been modified. Unterminated
strings are now maroon, while terminated strings are now purple. This is the
opposite of previous versions. Maroon is considered to be more of an “alerting”
color, resembling the default of red for errors, which is the reason for the
change. If you prefer the colors used in previous versions, change them using
preferences — see “Syntax Highlighting Colors” in the online documentation.

In addition, arguments in statements entered using command syntax rather
than function syntax are highlighted as strings, emphasizing that variables in
command syntax are passed as literal strings rather than as their values.

Ctrl+C to Stop Execution is Now More Consistent
Stopping execution using Ctrl+C (^C) has changed. Windows and UNIX
platforms now respond similarly to Ctrl+C, and in general, stop execution
without the need for pause or drawnow statements in your M-files. For M-files
that run for a long time, or that call built-ins or MEX-files that take a long
time, Ctrl+C does not always effectively stop execution. In that event, include
a drawnow command in your M-file, for example, within a large loop. Ctrl+C
might be less responsive if you started MATLAB with the -nodesktop option.

Parentheses Matching Support Removed
Matching parentheses in the Command Window is not supported in this
version.

Compatibility Considerations. This feature was available in the Command
Window in previous versions but you cannot use it in this version.
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Command History Features

Demo of Command History Features. If you are using the Help browser,
watch the new Command History video demo for an overview of the major
functionality.

Syntax Highlighting in Command History. Entries in the Command
History tool now appear with syntax highlighting.

Tree View in Command History. Entries in the Command History now
appear in a tree view so you can minimize the length of the visible history. The
top-level nodes of the tree are the dates/times for each session, and beneath
that is the history for that session. Click the - to the left of a date/time to hide
the history entries for that session. Click the + to the left of a date/time entry
to show history entries for that session.

commandhistory Function Added to Go to Tool. Use the new
commandhistory function to open the Command History when it is closed, and
to select it when it is open.

Save Frequency Higher by Default. The default for saving the history
has changed. Now, by default, MATLAB saves the history file after five
statements have been added to the history. You can modify the frequency
using Command History preferences.
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Help
New features and changes introduced in this version are

• “Demo of New Help Browser Features” on page 286

• “Documentation Now Automatically Installed; Not Accessible from
CD-ROMs and docroot Not Supported” on page 286

• “Index Pane Adds Alphabetical Links” on page 287

• “Search Type Removed” on page 287

• “Favorites in Help Browser” on page 287

• “Display Pane Find in Page Icon” on page 287

• “Title Field No Longer Supports Web Browsing” on page 287

• “docsearch Function Added to Execute Help Browser Search” on page 288

• “help Function Provides Help for Methods and Classes” on page 288

• “web Function Now Opens MATLAB Web Browser By Default” on page 288

• “HTML Documentation Not Viewable with -nojvm Startup Option” on page
288

Demo of New Help Browser Features
If you are using the Help browser, watch the new Help and Documentation
video demo for an overview of the major functionality.

Documentation Now Automatically Installed; Not Accessible
from CD-ROMs and docroot Not Supported
Documentation is automatically installed for all the products
you install. Documentation is no longer accessible from
CD-ROMs. To access the documentation for products
not installed on your system, use The MathWorks Web site,
http://www.mathworks.com/access/helpdesk/help/helpdesk.shtml.

Compatibility Considerations. Because of this change, the docroot
function is no longer needed and will not be supported.
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Index Pane Adds Alphabetical Links
The Index pane now has an alphabetical quick index, so you can choose a
letter to see entries starting with that letter. You can still type any index term
in the text box to go directly to that term. Index entries are now shown as
links. Entries that are merely headings do not go to a specific page and do not
appear as links. As is true for all desktop tools, you can now drag columns in
the Index pane to reorder them, or click a column head to sort by that column.

Search Type Removed
In the Search pane, you no longer select the type of search. Results are
ordered so reference pages appear first, followed by headings that include the
search terms. After performing a search, click the link at the bottom of the
Search pane to look for the same term in the technical support database on
The MathWorks Web site. As is true for all desktop tools, you can now drag
columns in the Search pane to reorder them, or click a column head to sort
by that column.

Favorites in Help Browser
Add pages in the Help browser to favorites (also known as bookmarking
pages) by selecting Favorites > Add to Favorites. The Favorites Editor
dialog box opens. Accept the default entries or modify the Label and click
Save. Access favorites from the Favorites menu or from the Start menu
Shortcuts item.

Display Pane Find in Page Icon
Click the binoculars icon on the display pane toolbar to search within the page.

Title Field No Longer Supports Web Browsing
The Help browser is now used only for MathWorks documentation installed
with your products.

You can no longer enter a URL in the Title field of the display pane. Instead
run the web function to enter a URL in the Location field. Links from the
documentation to Web pages display the Web pages in the MATLAB Web
browser, not in the Help browser.
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docsearch Function Added to Execute Help Browser Search
The new docsearch function allows you to execute a full text search of the
Help browser documentation from the Command Window.

help Function Provides Help for Methods and Classes
The help function now allows you to get help for methods and classes. For
details, see specific instructions in the release notes about using help and doc
for each product, or type help help.

web Function Now Opens MATLAB Web Browser By Default
The web function no longer opens the specified URL in the Help browser by
default, but instead opens the page in the MATLAB Web browser.

Compatibility Considerations. If you want web to open pages in the Help
browser, use the -helpbrowser option.

HTML Documentation Not Viewable with -nojvm Startup
Option
If you start MATLAB using the -nojvm option, you cannot view the HTML
documentation files from within MATLAB. The docopt function no longer
supports that option.

Compatibility Considerations. This represents a change from previous
versions. You can view the HTML documentation files at the MathWorks
Web site.
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Workspace, Search Path, and File Operations
New features and changes introduced in this version are organized by these
topics:

• “Workspace Browser Enhancements and Changes” on page 289

• “Array Editor Enhancements and Changes” on page 290

• “Built-In Functions Now Treated Like Other M-Files on Search Path” on
page 291

• “savepath Function Added to Replace path2rc” on page 291

• “Search Path Functions — Other Enhancements and Changes” on page 291

• “File Operations” on page 292

• “Current Directory Browser Changes and Enhancements” on page 293

• “Visual Directory and Directory Reports in Current Directory Browser”
on page 294

Workspace Browser Enhancements and Changes

Demo of New Workspace Browser Features. If you are using the Help
browser, watch the new Workspace Browser video demo for an overview of
the major functionality.

Value Column Added to Workspace Browser. The Workspace browser
now includes a Value column where you can see the content of the variable,
or a description of the content. Click the value in the Value column to edit
the content.

Rename or Duplicate Variable in Workspace Browser. Click a variable
name (in the Name column) to rename the variable. To create a copy of a
variable, right-click and select Duplicate from the context menu.

Plotting Selected Variables from Workspace Browser. Click the plot

icon in the Workspace browser toolbar to plot the selected variable.
Choose from other applicable plots by clicking the arrow next to the plot
button. The function used to create the plot appears in the Command Window
so you can use it again later.
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Print from Workspace Browser. Click the Print button in the Workspace
browser toolbar to print a view of the current workspace.

MAT-Files Compressed by Default. MAT-files are now compressed by
default. For details on compressing MAT-files, see the “Compressed Data
Support in MAT-Files” on page 338 in the Programming release notes.

genvarname Function Added to Construct MATLAB Variable Name.
Use the new function genvarname to construct a valid MATLAB variable
name from a given candidate, where the candidate can be a string or a cell
array of strings. For details, type help genvarname.

datatipinfo Function Added to Display Information About Variable.
The new function datatipinfo(x) displays information about the variable, x.

Array Editor Enhancements and Changes

Demo of New Array Editor Features. If you are using the Help browser,
watch the new Array Editor video demo for an overview of the major
functionality.

Cell Arrays and Structures Now Supported. You can now view and edit
the content of cell arrays and structures in the Array Editor. For example,
double-click a structure in the Workspace browser to open it in the Array
Editor. In the Array Editor, double-click an element of the structure to open it
as its own Array Editor document. You can then view and edit the contents.

Plotting Multiple Elements. You can select contiguous elements in an array,

and then click the plot button on the Array Editor toolbar to plot only
the selected elements. Click the arrow next to the plot button in the toolbar
to select from other applicable plots.

Print from Array Editor. You can print an array from the Array Editor.
Select File > Print to create a print of the current variable.

Larger Arrays Supported. You can open arrays having up to 2^19 (524288)
elements, which is eight times more than the previous limit, 2^16 (65536).
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Save to MAT-File. You can save a variable to a MAT-file from the Array
Editor. Select File > Save and complete the resulting Save dialog box.

Built-In Functions Now Treated Like Other M-Files on Search
Path
MATLAB now considers built-in files to be the same as other M-files on the
search path.

Compatibility Considerations. MATLAB no longer considers built-in
functions differently from any other M-files on the search path. MATLAB now
looks for a given name first as a variable, then as an M-file in the current
directory, and finally as an M-file on the search path. Previously MATLAB
looked for a given name as a built-in function after looking for it as a variable.

If you have a function name that is the same as a MATLAB built-in function,
your function might run instead of the built-in function, whereas in previous
releases the built-in function would have run. For the built-in function to
run, remove or rename your function, or change the directory order in the
search path.

savepath Function Added to Replace path2rc
There is a new function, savepath, that saves the current search path to a
file, pathdef.m, so that you can use the same search path in future sessions.
Note that this function replaces path2rc.

Compatibility Considerations. The path2rc function has been replaced by
a new function, savepath. If you use path2rc, it will run savepath instead.
The new function, savepath, performs the same actions as path2rc did, but
uses a more intuitive name. In addition, savepath is case sensitive on PC
platforms, whereas path2rc was not. Use savepath instead of path2rc, and
replace existing instances of path2rc with savepath.

Search Path Functions — Other Enhancements and Changes

restoredefaultpath Function Added for Recover from Problems. There
is a new function, restoredefaultpath, that helps redefine the search path
file, pathdef.m, to include only files installed with MathWorks products. Use
this function to recover from problems with the path. If that fails, run
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restoredefaultpath; matlabrc

genpath Function Now Includes Empty Directories. The genpath
function now includes empty directories in the generated path string.

which Function Now Shows Built-In Functions. The which function
now displays the pathname for built-in functions, as well as for overloaded
functions when only the overloaded functions are available

File Operations

Finding Files and Content Within Files. From any desktop tool, select
Edit > Find Files. Complete the resulting dialog box to find specified files or
files containing specified text in the directories you choose. Double-click a file
in the results listing to open it. For details, see “Finding Files and Content
Within Files” in the online documentation.
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Preventing Accidental File Deletion. Use the new recycle function or
the General preference for the delete function to send files you remove
using the delete function to the Recycle Bin on Windows, to the Trash Can
on Macintosh, or to a /tmp/MATLAB_Files_timestamp directory on UNIX
systems. You can then recover any accidentally deleted files from these
locations.

Current Directory Browser Changes and Enhancements

Demo of New Current Directory Browser Features. If you are using the
Help browser, watch the new Current Directory Browser video demo for an
overview of the major functionality.
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Source Control Interface Features Accessible from Current Directory
Browser. You can access source control system features from the Current
Directory browser. Right-click a file or directory, and from the context menu,
select Source Control and then select the source control function you want
to use.

Open File Using External Application. To open a file using an external
application, select Open Outside MATLAB from the context menu.
For example, if you select myfile.doc, Open Outside MATLAB opens
myfile.doc in Microsoft Word, assuming you have the .doc file association
configured to launch Word.

Copy and Paste Directories. Using the Current Directory browser, you can
now copy and paste directories, including the entries’ contents.

Drag to Reorder Columns. As is true for all desktop tools, you can drag
columns in the Current Directory browser to reorder them, or click a column
head to sort by that column. For an item that does not fit in its column, you
can hover over it to see the full name of the item.

Current Directory Text Field Does Not Display When Current Directory
Browser is Docked. The current directory field appears in the Current
Directory browser only when the Current Directory browser is undocked from
the MATLAB desktop. When the Current Directory browser is docked in the
MATLAB desktop, use the current directory text field in the desktop toolbar.

Visual Directory and Directory Reports in Current Directory
Browser
There are new tools accessible from the Current Directory browser for tuning
and managing M-files. For details, see “Visual Directory Tool in the Current
Directory Browser” on page 301 and “Directory Reports in the Current
Directory Browser” on page 302.
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Editing and Debugging M-Files
New features and changes introduced in this version are

• “Demo of New Editor Features” on page 295

• “Opening, Arranging, and Closing Documents” on page 295

• “Visual Changes” on page 296

• “Entering Statements” on page 297

• “Create Block Comments Using %{ and %}” on page 297

• “Finding and Replacing Text” on page 298

• “Printing M-Files” on page 298

• “Breakpoints and Debugging” on page 298

• “Debugging Functions Enhanced” on page 299

• “dbstack Function Supports Nested Functions” on page 299

• “dbstatus Function Supports Conditional Breakpoints” on page 300

• “Access Tools from Editor/Debugger” on page 300

• “Rapid Code Iteration Using Cells” on page 300

• “Preferences for the Editor/Debugger” on page 301

Demo of New Editor Features
If you are using the Help browser, view the Editor new features video demo to
see highlights of the major new features.

Opening, Arranging, and Closing Documents

Drag File into Editor. You can drag a file onto the Editor to open it. For
example, drag a text file from Windows Explorer onto the Editor.

Automatically Remove Autosave Files — Preference Added.
There is now an Editor/Debugger preference you can set to automatically
remove autosave files when you close the source file. Select
Preferences > Editor/Debugger > Autosave, and under Close options,
select the Automatically delete autosave files check box.
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Toggle Between Command Window and Editor/Debugger. To move
from an Editor document to the Command Window, press Ctrl+0. To move
back to the Editor document, press Ctrl+Shift+0.

Editor Remains Open with No Files Open. When you close the last open
document in the Editor, the Editor remains open.

Automatic Reloading of Files When Changes Made Outside of
MATLAB. When a file is open in the Editor and you open that same file
outside of MATLAB and make changes to it, the Editor automatically updates
the file to includes the changes you made outside the Editor. This only applies
if you did not make any changes to the file in the Editor. If you want to
be prompted before the Editor updates the file, clear the Editor/Debugger
preference for automatically reloading files.

Open Files While Debugging Preference Moved to Debug Menu. In
the previous version, you used a preference to automatically open files when
debugging. Now, instead of using a preference, you select Open M-Files
When Debugging from the Debug menu in any desktop tool.

With this item selected, when you run an M-file containing breakpoints, the
file opens in the Editor/Debugger when MATLAB encounters a breakpoint.

Visual Changes

Syntax Highlighting for Other Languages. The Editor now supports
syntax highlighting for other languages, specifically C/C++, Java, and
HTML. Use Editor language preferences to change the colors for the syntax
highlighting.

Datatips Now Off By Default in Edit Mode. In edit mode, datatips
are now off by default. Select the preference to display them in edit mode.
Datatips display until you move the cursor. Datatips are always on in debug
mode.

Vertical Line in Files. There is now a faint line at column 75, which serves
as a useful reminder of where text would be cut off when printing the
document. Remove the line or change the column at which the line appears
using Editor/Debugger Display preferences.
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Balance Delimiters Removed. The feature Text > Balance Delimiters
has been removed.

Syntax Highlighting Default Colors Modified. The default colors for
syntax highlighting M-files have been modified. Unterminated strings are
now maroon, while terminated strings are now purple. This is the opposite
of previous versions. Maroon is considered to be more of an "alerting" color,
resembling the default of red for errors, which is the reason for the change. If
you prefer the colors used in previous versions, change them using preferences
— see “Syntax Highlighting Colors” in the online documentation.

In addition, arguments in statements entered using command syntax rather
than function syntax are highlighted as strings, emphasizing that variables in
command syntax are passed as literal strings rather than as their values.

Entering Statements

Change Case of Selected Text. To change the case of selected text, select
the text and then press

• Alt+U, U to change all text to upper case

• Press Alt+U, L to change all text to lower case

• Press Alt+U, R to change the case of each letter

Nested Function Indenting Supported. MATLAB now supports nested
functions and the Editor provides preferences regarding how to indent them.

Overwrite Mode Supported. When you press the Insert key, text entry
is done in overwrite mode and the cursor assumes a block shape. Press the
Insert key again to return to insert mode.

Create Block Comments Using %{ and %}
You can create a block comment in an M-file using any text editor, that is, you
can comment out contiguous lines of code. Type %{ on the line before the first
line of the comment and %} following the last line of the comment. The lines
in between are considered to be comments. Do not include any code on the
lines with the block comment symbols. You can also nest block comments. See
“Commenting in M-File Using Any Text Editor” for details.
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Compatibility Considerations. Because of the new block comment symbols,
if you have any files with lines that consist only of %{ and %}, they might be
misinterpreted as block comment start and end symbols, and might cause
errors in your file.

Finding and Replacing Text

Find Files and Content Within Files. You can find directories, files, and
content within multiple files. Select Edit > Find Files. For details, see
“Finding Files and Content Within Files” in the online documentation.

Incremental Search Now Indicates Direction and is Case Sensitive.
The incremental search interface has been updated. It now indicates the
search direction. It is also case sensitive when you enter uppercase letters in
the search field.

Printing M-Files
Page setup options differ slightly from previous versions.

Breakpoints and Debugging

Conditional Breakpoints Supported. You can specify conditional
breakpoints in an M-file. MATLAB only stops at the line with the breakpoint
if the condition is met. Conditional breakpoints have a yellow breakpoint
icon, which you can copy and paste to other lines.

Disable (Ignore) Breakpoints. You can disable standard and conditional
breakpoints. MATLAB ignores a disabled breakpoint until you enable it
again. A disabled breakpoint icon has an X through it.

Error Breakpoints Supported. Set error breakpoints for all files by
selecting Debug > Stop If Errors/Warnings, and then completing the
resulting dialog box. You can specify a message identifier for an error or
warning breakpoint so that MATLAB stops only if it encounters the specified
error or warning message.

298



Desktop Tools and Development Environment, MATLAB Version 7 (R14)

Debugging Functions Enhanced

Error Support Added to dbstop and dbclear. Enhancements to
debugging functions include dbstop if caught error, dbclear if caught
error, and dbclear if all error. The dbstop if all error option has
been grandfathered and will not be supported in future versions. To specify
a message identifier, use dbstop if error ID, dbstop if caught error
ID, dbstop if warning ID, and the corresponding dbclear options. The
dbstatus function has been updated to reflect the changes to dbstop and
dbclear.

dbstop Function Supports Nested and Anonymous Functions. The
dbstop function has been updated to support nested and anonymous
functions. See the dbstop reference page for details. You cannot use the
Editor/Debugger GUI to set breakpoints in anonymous functions, but must
use the dbstop function instead. Note that when you save a file in the
Editor/Debugger that contains breakpoints in anonymous functions, those
breakpoints are cleared. They are also cleared when you run an unsaved file
from the Editor/Debugger GUI, because running first saves the file.

Notation for Reporting Path Modified. MATLAB now uses a new notation
for reporting the path of functions, subfunctions, and nested functions. As an
example, A/B>C/D means directory A, file B, (sub)function C within the file B,
and nested function D within C.

dbstack Function Supports Nested Functions
The dbstack function has been updated to supported nested functions. See
the dbstack function reference page for more information.

Compatibility Considerations. If you use dbstack in M-files, you might
need to update your files because of this change. When you run dbstack and
return results to a structure, there are now three fields, whereas in previous
versions, there were only two fields. The fields are

• file, the file in which the function appears

• name, the function name within the file

• line, the line number in the function
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The file field does not contain a complete pathname, as the name
field did in previous versions. To get the complete pathname, use
dbstack('-completenames').

dbstatus Function Supports Conditional Breakpoints
The dbstatus function has been updated to support conditional breakpoints.
See the dbstatus function reference page for more information.

Compatibility Considerations. As a result there have been changes to
some of the fields in the structure returned with s = dbstatus(...). If you
use dbstatus in M-files, you might need to update your files because of this
change. For details on the new format, see the dbstatus reference page.

Access Tools from Editor/Debugger
You can access useful tools for M-files from the Editor/Debugger. From the
Tools menu, select Check Code with M-Lint, Show Dependency Report,
or Open Profiler. For details about these tools, see “Tuning and Managing
M-Files” on page 301.

Rapid Code Iteration Using Cells
In the Editor, cell features allow you to easily make changes to values in a
section of an M-file to readily see the impact of the changes. First, you define
cells in a file, then evaluate a cell or cells, iterate values in the cell, and then
reevaluate the cell(s). Cells also allow you to publish M-file code and results
to popular formats, such as HTML and Microsoft Word. For details, see
“Using Cells for Rapid Code Iteration and Publishing Results” in the online
documentation.

Demo of New Rapid Code Iteration Features. If you are using the Help
browser, watch the new Rapid Code Iteration Using Cells video demo for an
overview of the major functionality.

Compatibility Considerations. Because of the new symbols for cell
publishing, if you have any files with lines that consist only of %%, those lines
might be misinterpreted as the start of a cell. Your files will still run without
problems, but if you publish the M-files, you might need to modify those lines.
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Preferences for the Editor/Debugger

Add New Line to End of File Upon Save. There is now a preference that
allows you to add a new line to the end of a file upon saving.

Open M-Files When Debugging Preference Moved. The feature that
instructs M-files to open automatically when debugging is no longer in
preferences but is now accessible from the Debug menu in all desktop tools.

Tuning and Managing M-Files
Use these tools to fine-tune and manage your M-files, and to prepare them
for distribution to other users. New features introduced in this version are
organized by these topics:

• “Demo of New Directory Reports Features” on page 301

• “Visual Directory Tool in the Current Directory Browser” on page 301

• “Directory Reports in the Current Directory Browser” on page 302

• “Profiler for Measuring Performance” on page 304

Demo of New Directory Reports Features
If you are using the Help browser, watch the new Directory Reports video
demo for an overview of the major functionality.

Visual Directory Tool in the Current Directory Browser
The Visual Directory view of the Current Directory provides useful
information about the M-files in a directory. It can help you polish M-files
before providing them to others to use.

Click the Show Visual Directory button on the Current Directory
browser toolbar. Toe view changes — see the following figure for an example.
To return to the Classic view of the Current Directory browser, click the
button again.
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Directory Reports in the Current Directory Browser
In the Current Directory browser, select View > Directory Reports and
select the type of report to run. The report appears as an HTML document
in the MATLAB Web browser. A summary of the reports follows. For more
information, see “Directory Reports in Current Directory Browser” in the
online documentation.

M-Lint Code Check Report. The M-Lint report displays potential errors and
problems, as well as opportunities for improvement in your code. For example,
one common message is that a variable is defined but never used. You can
also produce an M-Lint report for specified files using the mlint function, or
run the M-Lint report from the Editor/Debugger or Profiler.
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TODO/FIXME Report. The TODO/FIXME report shows M-files that contain
text strings you included as notes to yourself, such as TODO.

Help Report. The Help report presents a summary view of the help
component of your M-files. Use this information to help you identify files of
interest or to help you identify files that lack help information.
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Contents Report. The Contents report displays information about the
integrity of the Contents.m file for the directory. A Contents.m file is a
file you create that provides a brief description for relevant M-files in the
directory. When you type help followed by the directory name, such as help
mydemos, MATLAB displays the information in the Contents.m file. Use the
Contents report to help you clean up and maintain your Contents.m file. If
there is no Contents.m file, use the Contents report to create one.

Dependency Report. The Dependency report shows all M-files called by
each M-file, or in other words, shows all children of each M-file. Use this
report to determine all files you need to provide to someone who wants to
run an M-file.

File Comparison Report. The File Comparison report identifies the
differences between two files in the current directory. For example, you can
easily compare an autosaved version of a file to the latest version of the file.

Coverage Report. Run the Coverage report after you run the Profile report
to identify what percentage of the file was executed when it was profiled.

Profiler for Measuring Performance

Access Profiler from Desktop or Editor/Debugger. Access the Profiler
from the Desktop menu or the Editor/Debugger Tools menu.

Profiler Summary Report. In the Profiler summary report, click a column
name to sort the report by that column.

Profiler Detail Report. In the Profiler detail report, specify options to show
busy lines (lines where the most time was spent) and to show the file listing
(the M-file code). Other options allow you to run the M-Lint Code Check
report, which provides messages for improving the file, and the Coverage
report, which indicates how much of the file was exercised during profiling.
For more information about these reports, see “Directory Reports in Current
Directory Browser” in the online documentation. After selecting an option
in the detail report, click Refresh to update the report. The performance
acceleration information in the detail report has been removed.
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Compatibility Considerations. The profile report previously supported
in MATLAB is no longer available. This was the report you generated by
running profile report or profreport. There is a new function, profsave
that replaces profreport. The profsave function saves a static version of the
HTML profile report.

Source Control Changes
In MATLAB 6.5 (R13) and MATLAB 7.0 (R14), only source control systems
that comply with the Microsoft Common Source Control standard are
supported. If there is a compliant source control system installed on your
machine, it will be listed in the Source Control options in the MATLAB
Preferences dialog.

There are several vendors who provide and interface into Revision Control
Systems (RCS), Concurrent Versions System (CVS), and other such tools
using Microsoft Source Code Control API. ComponentSoftware provides one
such interface layer.

Compatibility Considerations
This represents a change to how MATLAB interfaced with source control
systems in prior versions.

Publishing Results

Publishing to HTML, XML, LaTeX, Word, and PowerPoint
You can publish M-files to HTML, XML, LaTeX, Word, and PowerPoint
documents. The published documents can include code, formatted comments,
and results, such as graphs in Figure windows. Use cells and cell publishing
features in the Editor/Debugger. For details, see “Publishing to HTML, XML,
LaTeX, Word, and PowerPoint Using Cells” in the online documentation.

Demo of New Publishing Features. If you are using the Help browser,
watch the new Publishing M Code from the Editor video demo for an overview
of the major functionality.
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Notebook
If you currently use Notebook, consider using cell publishing from the Editor
instead, which provides more features and flexibility for most applications.

Notebook has been improved with regards to speed and stability, with a
few minor changes in operation. The improvements were available via a
Web-downloadable update to MATLAB version 6.5, and are now part of
MATLAB version 7.
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Mathematics, MATLAB Version 7 (R14)
This version introduces the following new features and changes:

New and Obsolete Functions

• “New Functions” on page 309

• “Obsolete Functions” on page 310

Nondouble Math

• “New Nondouble Mathematics Features” on page 310

• “Nondouble Arithmetic” on page 311

• “New Integer Functions — intmax and intmin” on page 312

• “New Warnings for Integer Arithmetic” on page 312

• “Warning on Concatenating Different Integer Classes” on page 313

• “Integer Data Type Functions Now Round Instead of Truncate” on page 314

• “Changes to Behavior of Concatenation” on page 315

• “Class Input for realmax and realmin” on page 315

• “Class Input for ones, zeros, and eye” on page 316

• “Class and Size Inputs for Inf and NaN” on page 317

• “New Class and Data Inputs for eps” on page 317

• “New Class Inputs for sum” on page 318

• “complex Now Accepts Inputs of Different Data Types” on page 319

• “Bit Functions Now Work on Unsigned Integers” on page 319

Matrices and Elementary Math

• “New Function accumarray for Constructing Arrays with Accumulation”
on page 319

• “Enhanced sort Capabilities and Performance” on page 320
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• “New Functions for Numerical Data Types” on page 321

• “max and min Now Have Restrictions on Inputs of Different Data Types”
on page 321

• “Mathematic Operations on Logical Values” on page 322

Linear Algebra

• “New Function linsolve for Solving Systems of Linear Equations” on page
322

• “New Output for polyeig” on page 322

• “Enhancements to lscov” on page 323

• “New Form for Generalized Hessian” on page 323

Nonlinear Methods

• “New Function quadv Integrates Complex, Array-Valued Functions” on
page 324

Trigonometry, Geometry

• “New Trigonometric Functions For Angles in Degrees” on page 324

• “Matrix, Trigonometric, and Other Math Functions No Longer Accept
Inputs of Type char” on page 325

• “New Warnings for Complex Inputs to atan2, log2, and pow2” on page 325

• “Enhanced Functions for Computational Geometry” on page 326

• “New Support for Interpolation Functions” on page 326

Differential Equations

• “New and Enhanced Functions for Ordinary Differential Equations
(ODEs)” on page 327
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FFT

• “Enhancements to Discrete Fourier Transform Functions” on page 328

• “FFT Functions Applied to Integer Data Types are Becoming Obsolete”
on page 328

Optimization

• “New Output Function for Optimization Functions” on page 329

Specialized Math

• “New Input Argument for Incomplete Gamma Function” on page 329

Other

• “Overriding the Default BLAS Library on Intel/Windows Systems” on page
330

• “New Names for Demos expm1, expm2, and expm3” on page 331

New Functions
This release introduces the following new functions:

Function Description

accumarray Construct array with accumulation

cast Cast variable to different type

expm1 Compute exp(x)-1 accurately for small values of x

intmax Largest value of specified integer type

intmin Smallest value of specified integer type

intwarning Control state of integer warnings

isfloat Determine whether input is floating-point array

isinteger Determine whether input is integer array

linsolve Solve linear system of equations
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Function Description

log1p Compute log(1+x) accurately for small values of x

nthroot Real nth root of real numbers

ode15i Solve fully implicit differential equations, variable
order method

odextend Extend solution of initial value problem for
ordinary differential equation

quadv Vectorized quadrature

Obsolete Functions
The functions listed in the left column of the following table are obsolete and
will be removed from a future version of MATLAB.

Compatibility Considerations
Use the replacement functions listed in the right column instead.

Obsolete Function Replacement Function

colmmd colamd

quad8 quadl

symmmd symamd

The following obsolete functions are no longer included in MATLAB:

fmin, fmins, icubic, interp4, interp5, interp6, meshdom, nnls,
saxis

New Nondouble Mathematics Features
MATLAB Version 7.0 supports many arithmetic operations and mathematical
functions on the following nondouble MATLAB data types:

• single

• int8 and uint8
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• int16 and uint16

• int32 and uint32

Most of the built-in MATLAB functions that perform mathematical operations
now support inputs of type single. In addition, the arithmetic operators and
the functions sum, diff, colon, and some elementary functions now support
integer data types.

Note In Version 7.0, MATLAB only supports mathematical operations
on nondouble data types for built-in functions; it does not support these
operations for M-file functions unless otherwise stated in the M-file help.

Nondouble Arithmetic
This section describes how MATLAB performs arithmetic on nondouble data
types.

Single Arithmetic
You can now combine numbers of type single with numbers of type double or
single. MATLAB performs arithmetic as if both inputs had type single and
returns a result of type single. For more information, see “Single-Precision
Floating Point” in the online MATLAB Programming documentation.

Integer Arithmetic
You can now combine numbers of an integer data type with numbers of the
same integer data type or type scalar double. MATLAB performs arithmetic
as if both inputs had type double and then converts the result to the same
integer data type.

MATLAB computes operations on arrays of integer data type using saturating
integer arithmetic. Saturating means that if the result is greater than the
upper bound of the integer data type, MATLAB returns the upper bound.
Similarly, if the result is less than the lower bound of the data type, MATLAB
returns the lower bound. For more information, see “Integers” in the online
MATLAB Programming documentation.
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New Integer Functions — intmax and intmin
Two new functions, intmax and intmin, return the largest and smallest
numbers, respectively, for integer data types. For example,

intmax('int8')
ans =

127

returns the largest number of type int8. See “Largest and Smallest Values
for Integer Data Types” in the online MATLAB documentation for more
information.

New Warnings for Integer Arithmetic
This section describes four new warning messages for integer arithmetic in
Version 7.0. While these warnings are turned off by default, you can turn
them on as a diagnostic tool or to warn of behavior in integer arithmetic that
might not be expected.

To turn all four warning messages on at once, enter

intwarning on

Integer Conversion of Noninteger Values
MATLAB can now return a warning when it rounds up a number in converting
to an integer data type. For example,

int8(2.7)
Warning: Conversion rounded non-integer floating point value to
nearest int8 value.

ans =
3

Integer Conversion of NaN
When MATLAB converts NaN (Not-a-Number) to an integer data type, the
result is 0. MATLAB can now return a warning when this occurs. For example,

int16(NaN)
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Warning: NaN converted to int16(0).

ans =
0

Integer Conversion Overflow
MATLAB can now return a warning when you convert a number to an integer
data type and the number is outside the range of the data type. For example,

int8(300)
Warning: Out of range value converted to intmin('int8') or
intmax('int8').

ans =
127

Integer Arithmetic Overflow
MATLAB can now return a warning when the result of an operation on integer
data types is either NaN or outside the range of that data type. For example,

int8(100) + int8(100)
Warning: Out of range value or NaN computed in integer arithmetic.

ans =
127

To turn all of these warnings off at once, enter

intwarning off

Warning on Concatenating Different Integer Classes
If you concatenate integer arrays of different integer classes, MATLAB
displays the warning

Concatenation with dominant (left-most) integer class may
overflow other operands on conversion to return class.

The class of the resulting array is the same as the dominant (or left-most)
value in the concatenation:
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a = int8([52 37 89; 23 16 47]);
b = int16([74 61 32; 98 73 25]);

% Combine int8 and int16 (int8 is dominant)
c = [a b];
class(c)
ans =

int8

% Combine int16 and int8 (int16 is dominant)
c = [b a];
class(c)
ans =

int16

Integer Data Type Functions Now Round Instead of
Truncate
The following integer data functions now round noninteger inputs instead of
truncating:

int8, uint8, int16, uint16, int32, uint32, int64, uint64

For example, in MATLAB 7.0,

int8(3.7)

returns

ans =
4

Compatibility Considerations
In previous releases, the same command returned 3. If you have code that
contains these functions, it might return different results in Version 7.0 than
in previous releases, in particular, results that differ by 1 after converting
floating-point inputs to an integer data type.

You can turn the following warning on to help diagnose these differences:
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warning on MATLAB:intCovertNonIntVal

See “New Warnings for Integer Arithmetic” on page 312 for more information
about this and other new warning messages.

Changes to Behavior of Concatenation
When you perform concatenation ([a, b], [a;b], and cat(a,b,dim)) on
mixed integer and other numeric or logical inputs, the left-most integer type
among the inputs is the type of the result. As a result, the other inputs might
lose values when they are converted to the integer data type. In Version 7.0,
MATLAB now returns a warning when you concatenate these mixed data
types.

For example,

[int8(100) uint8(200)]
Warning: Concatenation with dominant (left-most) integer class
may overflow other operands on conversion to return class.
(Type "warning off MATLAB:concatenation:integerInteraction" to
suppress this warning.)

ans =
100 127

class(ans)
ans =

int8

Compatibility Considerations
Concatenating an input of any nondouble numeric data type (single and
integer data type) with type char now returns a result of type char. In
previous releases, the same operation returned a result of the same type as
the numeric data type.

Class Input for realmax and realmin
You can now call the function realmax with the syntax

realmax('single')

315



Version 7 (R14) MATLAB

ans =

3.4028e+038

which returns the largest single-precision number. Similarly,

realmin('single')

returns the smallest single-precision number.

The commands realmax('double') and realmin('double') return the same
results as realmax and realmin, respectively. See “Largest and Smallest
Values for Floating-Point Data Types” in the online MATLAB Programming
documentation for more information.

Class Input for ones, zeros, and eye
You can now call ones or zeros with an input argument specifying the data
type of the output. For example,

ones(m, n, p, ..., 'single')

or

ones([m, n, p, ...], 'single')

returns an m-by-n-by-p-by ... array of type single containing all ones. zeros
uses the same syntax.

You can now call eye with this input argument for two-dimensional arrays.
For example,

eye(m, 'single')

returns an m-by-m identity matrix of type single. The command

eye(m, n, 'int8')

returns an m-by-n array of type int8.
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Class and Size Inputs for Inf and NaN
The functions Inf and NaN now accept inputs that enable you to create Infs or
NaNs of specified sizes and floating-point data types. As examples,

• Inf('single') or NaN('single') create the single-precision
representations of Inf and NaN, respectively.

• Inf(m,n,p, ...) or NaN(m,n,p,...) create m-by-n-by-p-by-... arrays of
Infs or NaNs, respectively.

See the reference pages for Inf and NaN for more information.

New Class and Data Inputs for eps
You can now call the function eps with the syntax

eps(x)

If x has type double, eps(x) returns the distance from x to the next largest
double-precision floating point number. This is a measure of the accuracy of x
as a double-precision number. eps(1) returns the same value as eps with no
input argument.

You can now replace expressions of the form

if Y < eps * abs(X)

with

if Y < eps(X)

If x has type single, eps(x) returns the distance from x to the next largest
single-precision floating point number. This is a measure of the accuracy of x
as a single-precision number.

The command

eps('single')
ans =

1.1921e-007
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returns the same value as eps(single(1)). The value of eps('single') is
the same as single(2^-23). The command eps('double') returns the same
result as eps.

See “Accuracy of Floating-Point Data” in the online MATLAB documentation
for more information.

New Class Inputs for sum
The following new input arguments for sum control how the summation is
performed on numeric inputs:

• s = sum(x,'native') and s = sum(x, dim,'native') accumulate in the
native type of its input and the output s has the same data type as x. This
is the default for single and double.

• s = sum(x,'double') and s = sum(x, dim, 'double') accumulate in
double-precision. This is the default for integer data types.

In Version 7.0, sum applied to a vector of type single performs single
accumulation and returns a result of type single. In other words, sum(x) is
the same as sum(x, 'native') if x has type single. This is a change in the
behavior of sum from previous releases. To make sum accumulate in double,
as in previous releases, use the input argument 'double'.

Compatibility Considerations
In Version 7.0, sum applied to a vector of type single performs single
accumulation and returns a result of type single. In previous releases, sum
performed this operation in double accumulation.

To restore the previous behavior, call sum with the syntax

sum(X, 'double')

or

sum(X, dim, 'double')
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complex Now Accepts Inputs of Different Data Types
The function complex now accepts inputs of different data types when you
use the syntax

complex(a,b)

according to the following rules:

• If either of a or b has type single, c has type single.

• If either of a or b has an integer data type, the other must have the same
integer data type or type scalar double, and c has the same integer data
type.

Bit Functions Now Work on Unsigned Integers
The following functions now work on unsigned integer inputs:

bitand, bitcmp, bitget, bitor, bitset, bitshift, bitxor

Instead of using flints (integer values stored in floating point) to do your
bit manipulations, consider using unsigned integers, as a more natural
representation of bit strings. Instead of using bitmax, use the intmax function
with the appropriate class name. For example, use intmax('uint32') if you
are working with unsigned 32 bit integers.

In addition, the function bitcmp now accepts the following new syntax for
inputs of type uint8, uint16, and uint32:

bitcmp(A)

bitcmp now uses the data type of A to determine how to take the bitwise
complement.

New Function accumarray for Constructing Arrays
with Accumulation
The new accumarray function enables you to construct an array with
accumulation. The following example uses accumarray to construct a 5-by-5
matrix A from a vector val. The function accumarray adds the entries of val
to A at the indices specified by the matrix ind, which has the same number of
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rows as val. If an index in ind is repeated, the entries of val accumulate at
the corresponding entry of A.

ind = [1 2 5 5;1 2 5 5]';
val = [10.1 10.2 10.3 10.4]';
A = accumarray(ind, val)

A =

10.1000 0 0 0 0
0 10.2000 0 0 0
0 0 0 0 0
0 0 0 0 0
0 0 0 0 20.7000

To get the (5,5) entry of A, accumarray adds the entries of val corresponding
to repeated pair of indices (5,5).

A(5, 5) = 10.3 + 10.4

In general, if ind has ndim columns, A will be an N-dimensional array with
ndim dimensions, whose size is max(ind).

Enhanced sort Capabilities and Performance

Improved Performance
sort performance has been improved for numeric arrays of randomly ordered
data. Although there is some performance improvement for all such numeric
arrays, you should see the greatest improvement for integer arrays and
multidimensional arrays.

Sort Direction
A new argument, mode, lets you specify whether sort returns the sorted array
in ascending or descending order.
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New Functions for Numerical Data Types
MATLAB 7.0 contains three new functions for detecting and converting data
types:

• cast enables you to cast a variable to a different data type or class

• isfloat enables you to detect floating-point arrays. isfloat(A) returns 1
if A has type double or single and 0 otherwise. isfloat(A) is the same
as isa(A,'float').

• isinteger enables you to detect integer arrays. isinteger(A) returns 1
if A has integer data type and 0 otherwise. isinteger(A) is the same as
isa(A,'integer')

max and min Now Have Restrictions on Inputs of
Different Data Types
In MATLAB 7.0, the functions max and min now have the following restrictions
on inputs of different data types:

• If any input has an integer data type, all other inputs must have the same
integer data type or type scalar double.

• If any input is of type single, all other inputs must have type double or
single.

Other combinations of inputs now return an error message. In previous
releases, inputs to max or min could have any combination of data types.

For the allowed mixed-type combinations listed above, max and min now
return results of a different data type than in previous releases:

• If one input has an integer data type, while another has type double, the
result now has the same integer data type. In previous releases, the result
had type double.

• If one input has type single, while another has type double, the result
now has type single. In previous releases, the result had type double.

You can turn on the following warning messages to diagnose any issues that
might result from this change in behavior:
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• warning on MATLAB:max:mixedIntegersScalarDoubleInputs

• warning on MATLAB:max:mixedSingleDoubleInputs

• warning on MATLAB:min:mixedIntegersScalarDoubleInputs

• warning on MATLAB:min:mixedSingleDoubleInputs

Compatibility Considerations
Combinations of inputs other than those listed above now return an error
message. Also, for these allowed mixed-type combinations, max and min now
return results of a different data type than in previous releases:

Mathematic Operations on Logical Values
Most mathematic operations are not supported on logical values.

New Function linsolve for Solving Systems of Linear
Equations
The new linsolve function enables you to solve systems of linear equations
of the form Ax = b more quickly when the matrix of coefficients A has a special
form, such as upper triangular. When you specify one of these special types of
systems, linsolve is faster than mldivide or \ (backslash) because it does
not check whether the matrix actually has the form you specify.

Note If the matrix A does not have the form you specify in opts, linsolve
returns incorrect results because it does not perform error checking. If you
are unsure of the form of A, use mldivide, or \ instead.

New Output for polyeig
The function polyeig can now return a vector of condition numbers for the
eigenvalues, when you call it with the syntax

[X,E,S] = polyeig(A0,A1,..,Ap)

At least one of A0 and Ap must be nonsingular. Large condition numbers imply
that the problem is close to one with multiple eigenvalues.
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Enhancements to lscov
The command

lscov(A,b,V)

now accepts either a weight vector or a covariance matrix for V. If you enter
lscov(A,b) without a third argument, lscov uses the identity matrix for V.

The command lscov(A, b, V, alg) now enables you to specify the
algorithm used to compute the result when V is a matrix. You can specify
alg to be one of the following:

• 'chol' uses the Cholesky decomposition of V

• 'orth' uses the orthogonal decomposition of V

The command

[x stdx mse] = lscov(...)

now returns mse, the mean squared estimate (MSE).

The command

[x stdx mse S] = lscov(...)

now returns S, the estimated covariance matrix of x.

In addition, lscov can now accept a design matrix A that is rank deficient and
a covariance matrix, V, that is positive semidefinite.

New Form for Generalized Hessian
The function hess has a new syntax of the form

[AA,BB,Q,Z] = hess(A,B)

where A and B are square matrices, and returns an upper Hessenberg matrix
AA, an upper triangular matrix BB, and unitary matrices Q and Z such that

Q*A*Z = AA
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and

Q*B*Z = BB

New Function quadv Integrates Complex,
Array-Valued Functions
The new function quadv integrates complex, array-valued functions.

New Trigonometric Functions For Angles in Degrees
The following new functions compute trigonometric functions of arguments in
degrees.

Function Purpose

sind Compute the sine of an argument in degrees

cosd Compute the cosine of an argument in degrees

tand Compute the tangent of an argument in degrees

cotd Compute the cotangent of an argument in degrees

secd Compute the secant of an argument in degrees

cscd Compute the cosecant of an argument in degrees

The following new functions compute the inverse trigonometric functions are
return the answer in degrees:

Function Purpose

asind Compute the inverse sine of an argument and return
answer in degrees

acosd Compute the inverse cosine of an argument and return
answer in degrees

atand Compute the inverse tangent of an argument and return
answer in degrees

acotd Compute the inverse cotangent of an argument and
return answer in degrees
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Function Purpose

asecd Compute the inverse secant of an argument and return
answer in degrees

acscd Compute the inverse cosecant of an argument and return
answer in degrees

Matrix, Trigonometric, and Other Math Functions No
Longer Accept Inputs of Type char
Matrix functions, such as chol, lu, and svd, and trigonometric functions, such
as sin and cos, no longer accept inputs of type char. In previous releases,
these functions simply converted char inputs to double before performing
operations on them.

Compatibility Considerations
To restore the previous behavior of these functions, create an M-file that
converts its input to double before applying the function. For example, to
restore the behavior of sin,

1 Create a directory called @char in a directory on the MATLAB path, for
example, your work directory.

2 Create an M-file with the following commands:

function s = sin(x)
s = sin(double(x));

3 Save the file as sin.m in the directory @char.

New Warnings for Complex Inputs to atan2, log2,
and pow2
The following functions now return a warning for inputs that are not real
numbers:

• atan2(y,x)

• [f,e] = log2(x)
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• pow2(f,e)

Enhanced Functions for Computational Geometry
The following functions, which perform geometric computations on a set of
points in N-dimensional space, now provide many new options:

• convhull — Compute convex hulls

• convhulln — Compute N-dimensional convex hulls

• delaunay — Construct Delaunay triangulation

• delaunay3 — Construct 3-dimensional Delaunay tessellations

• delaunayn — Construct N-dimensional Delaunay tessellations

• griddata — Data gridding and surface fitting

• griddata3 — Data gridding and surface fitting for 3-dimensional data

• griddatan — Data gridding and hypersurface fitting (dimensions >= 2)

• voronoi — Construct Voronoi diagrams

• voronoin — Construct N-dimensional Voronoi diagrams

These functions now accept an input cell array options that gives you
greater control over how they perform calculations. These functions use the
software Qhull, created at the National Science and Technology Research
Center for Computation and Visualization of Geometric Structures (the
Geometry Center). For more information on the available options, see
http://www.qhull.org/.

New Support for Interpolation Functions
The following interpolation functions now have enhanced features:

• interp1 — The command YI = interp1(X,Y,XI) now accepts a
multidimensional array Y and returns an array of the correct dimensions. If
Y is an array of size [n,m1,m2,...,mk], interp1 performs interpolation for
each m1-by-m2-by-...-mk value in Y. If XI is an array of size [d1,d2,...,dj],
YI has size [d1,d2,...,dj,m1,m2,...,mk].
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The command pp = interp1(X,Y,'method','pp') uses the specified
method to generate the piecewise polynomial form (ppform) of Y. See the
reference page for interp1 for information about the available methods.

• interp2, interp3, and interpn — You can now pass in a scalar argument,
ExtrapVal, which these functions return for any values of XI and YI that
lie outside the range of values spanned by X and Y defining the grid. For
example,

ZI = interp2(X,Y,Z,XI,YI,'method',ExtrapVal)

returns the value of ExtrapVal for any values of XI or YI that are outside
the range of values spanned by X and Y.

• ppval now accepts multidimensional arrays returned by the spline
function using the syntax

YY = ppval(spline(X,Y), XX)

Each entry of YY is obtained by evaluating spline(X,Y) at the
corresponding value of XX.

• spline — The command YY = spline(X,Y,XX) now accepts a
multidimensional array Y and returns an array of the correct
dimensions. Note that YY = spline(X,Y,XX) is the same as
YY = ppval(spline(X,Y), XX).

If spline(X, Y) is scalar-valued, then YY is of the same size as XX. If
spline(X, Y)is [D1,..,Dr]-valued, and XX has size [N1,...,Ns], then
YY has size [D1,...,Dr, N1,...,Ns], where YY(:,...,:, J1,...,Js) is
the value of spline(X, Y) at XX(J1,...,Js). There are two exceptions
to this rule:

New and Enhanced Functions for Ordinary
Differential Equations (ODEs)
MATLAB 7.0 provides two new functions for solving implicit ODEs and
extending solutions to ODEs, along with several enhancements to existing
ODE-related functions:

• ode15i, which is new in Version 7.0, provides the capability to solve fully
implicit ODE and DAE problems of the form with consistent
initial conditions, i.e., . ode15i provides an interface that is
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similar to that of the other MATLAB ODE solvers and is as easy to use. A
supporting function decic helps you calculate consistent initial conditions.
The existing functions odeset and odeget enable you to set integration
properties that affect the problem solution. deval evaluates the numerical
solution obtained with ode15i.

• odextend, which is new in Version 7.0, enables you to extend the solution
to an ODE created by an ODE solver.

• bvp4c can now solve multipoint boundary value problems. To see an
example of how to solve a three-point boundary value problem, enter
threebvp. To see the code for the example, enter edit threebvp. Enter
help bvp4c to learn more about bvp4c.

• deval can now evaluate the derivative of the solution to an ODE as well as
the solution itself. The command

[psxint, spxint] = deval(sol,xint)

returns spxint, the value of the derivative to sol.

Enhancements to Discrete Fourier Transform Functions
The new function fftw enables you to optimize the speed of the discrete
Fourier transform (DFT) functions fft, ifft, fft2, ifft2, fftn, and ifftn.
You can use fftw to set options for a tuning algorithm that experimentally
determines the fastest algorithm for computing a discrete Fourier transform
of a particular size and dimension at run time.

The functions ifft, ifft2, and ifftn now accept the input argument
'symmetric', which causes these functions to treat the array X as conjugate
symmetric. This option is useful when X is not exactly conjugate symmetric,
merely because of round-off error.

FFT Functions Applied to Integer Data Types are
Becoming Obsolete
In previous releases, the following fast Fourier transform (FFT) and related
functions cast integer inputs of type uint8 and uint16 to double, used the
double algorithm, and returned a double result:

• fft

328



Mathematics, MATLAB Version 7 (R14)

• fftn

• ifft

• ifftn

• conv2

In Version 7.0, these operations return warning messages that recommend
convert the inputs to double before applying the function, for example, by
fft(double(x)).

New Output Function for Optimization Functions
In MATLAB 7.0, you can create an output function for several optimization
functions in MATLAB. The optimization function calls the output function
at each iteration of its algorithm. You can use the output function to obtain
information about the data at each iteration or to stop the algorithm based
on the current values of the data. You can use the output function with the
following optimization functions:

• fminbnd

• fminsearch

• fzero

See “Output Functions” for an example of how to use the output function.

• N1 is ignored if XX is a row vector, that is, if N1 is 1 and s is 2.

• spline ignores any trailing singleton dimensions of XX.

New Input Argument for Incomplete Gamma
Function
The incomplete gamma function, gammainc, now accepts the input argument
tail, using the syntax

Y = gammainc(X,A,tail)
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tail specifies the tail of the incomplete gamma function when X is
non-negative. The choices are for tail are 'lower' (the default) and 'upper'.
The upper incomplete gamma function is defined as

1 - gammainc(x,a)

Overriding the Default BLAS Library on
Intel/Windows Systems

Note Intel has used aggressive optimization to compile MKL. This
optimization causes NaNs to be treated as zeros in some situations.
Calculations that do not involve NaNs are done correctly. In some calculations
that do involve NaNs, the NaNs will not propagate.

MATLAB uses the Basic Linear Algebra Subroutines (BLAS) libraries to
speed up matrix multiplication and LAPACK-based functions like eig, svd,
and \ (mldivide). At start-up, MATLAB selects the BLAS library to use.

For R14, MATLAB still uses the ATLAS BLAS libraries, however, on Windows
systems running on Intel processors, you can switch the BLAS library that
MATLAB uses to the Math Kernel Library (MKL) BLAS, provided by Intel.

If you want to take advantage of the potential performance enhancements
provided by the Intel BLAS, you can set the value of the environment variable
BLAS_VERSION to the name of the MKL library, mkl.dll. MATLAB uses the
BLAS specified by this environment variable, if it exists.

To set the BLAS_VERSION environment variable, follow this procedure:

1 Click the Start button, go to the Settings menu, and select Control Panel.

2 On the Control Panel menu, select System.

3 In the System Properties dialog box, click the Advanced tab.

4 On the Advanced panel, click the Environment Variables button.

5 In the Environment Variables dialog box, click the New button in the
User variables section.
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6 In the New User Variable dialog box, enter the name of the variable as
BLAS_VERSION and set the value of the variable to the name of the MKL
library: mkl.dll.

Multithreading Disabled in Intel Math Kernel Library (MKL)
BLAS
The Intel Math Kernel Library (MKL) is multithreaded in several areas.
By default, this threading capability is disabled. To enable threading in the
MKL library, set the value of the OMP_NUM_THREADS environment variable.
Intel recommends setting the value of the OMP_NUM_THREADS variable to the
number of processors you want to use in your application.

To set the value of this environment variable, follow the instructions outlined
in “Overriding the Default BLAS Library on Intel/Windows Systems” on page
330.

Before enabling multithreading, read the Intel Math Kernel Library 6.1
for Windows Technical User Notes that explains certain limitations of this
capability.

New Names for Demos expm1, expm2, and expm3
The demos expm1, expm2, and expm3 have been renamed expmdemo1,
expmdemo2, and expmdemo3, to avoid a name conflict with the new function
expm1.

Compatibility Considerations
If you have code that relies on these function names, you will need to change
the names in your code.
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Caution If you have saved data to a MAT-file using MATLAB Release 14
Beta 2, please read “MAT-Files Generated By Release 14 Beta2 Must Be
Reformatted” on page 336.

This version introduces the following new features and changes:

Save and Load

• “MATLAB Stores Character Data As Unicode; Making Release 14 MAT-files
Readable in Earlier Versions” on page 335

• “MAT-Files Generated By Release 14 Beta2 Must Be Reformatted” on page
336

• “Unicode-Based Character Classification” on page 337

• “Character Rendering on Linux” on page 337

• “Additional Bytes Reserved in MAT-File Header; Do Not Write To Reserved
Space” on page 337

• “Compressed Data Support in MAT-Files” on page 338

• “Saving Structures with the save Function” on page 338

Function Dispatching

• “Case-Sensitivity in Function and Directory Names; Can Affect Which
Function MATLAB Selects” on page 338

• “Differences Between Built-Ins and M-Functions Removed; Can Affect
Which Function MATLAB Selects” on page 343

• “Warning on Naming Conflict” on page 345

• “Change to How evalin Evaluates Dispatch Context” on page 345
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Functions and Scripts

• “Summary of New Functions” on page 346

• “New Function Type — Anonymous Functions” on page 347

• “New Function Type — Nested Functions” on page 349

• “Calling Private Functions From Scripts” on page 350

• “New Calling Syntax for Function Handles; Replace eval With New Syntax”
on page 350

• “Arrays of Function Handles” on page 351

• “Calling nargin and nargout with Built-In Functions” on page 351

• “Comma Separators Not Required in Function Declaration” on page 352

Changes to Specific Functions

• “getfield and setfield Not To Be Deprecated” on page 352

• “isglobal Function To Be Discontinued” on page 352

• “Recycle to Protect Files from Unwanted Deletion” on page 353

• “bin2dec Ignores Space Characters” on page 353

• “dbstop crashes Are Now Resolved” on page 353

• “Bit Functions on Unsigned Integers” on page 354

• “inmem Returns Path Information” on page 354

Specific Data Types

• “New Features for Nondouble Data Types” on page 354

• “Mathematic Operations on Logical Values” on page 354

• “Accessing Cell and Structure Arrays Without deal” on page 354

Characters and Strings

• “New Features in Regular Expression Support” on page 355
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• “Functions that Use Regular Expressions” on page 356

• “Regular Expressions Accept String Vector; No Longer Support Character
Matrix Input” on page 357

• “Cell Array Support for String Functions” on page 357

• “Additional Class Output From mat2str” on page 357

• “String Properties” on page 358

• “Using strtok on Cell Arrays of Strings” on page 358

• “Colon Operator on char Now Returns a char” on page 358

Dates and Times

• “datestr Returns Date In Localized Format” on page 359

• “Form and Locale for weekday” on page 359

• “Freestyle Date String Format” on page 359

• “Reading Date Values with xlsread; Conversion No Longer Necessary”
on page 359

File I/O

• “Comprehensive Function for Reading Text Files” on page 360

• “New Inputs and Outputs to xlsread” on page 361

• “New Inputs and Syntax for dlmwrite” on page 361

• “Change in Output from xlsfinfo” on page 362

• “Importing Complex Arrays” on page 363

• “Using imread to Import Subsets of TIFF Images” on page 363

• “Getting Information about Multimedia Files” on page 364

• “All-Platform Audio Recording and Playback” on page 364

• “FTP File Operations” on page 365

• “Web Services (SOAP)” on page 365

• “64-Bit File Handling on MacIntosh” on page 365
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Error Handling

• “Changes to Error Message Format” on page 365

• “nargchk Has a New Format for Error Messages” on page 368

• “Enabling and Disabling Warning Messages” on page 369

• “Catching Ctrl+C in try-catch Statements” on page 369

Other Topics

• “MATLAB Performance Acceleration” on page 370

• ““Using MATLAB” Documentation Is Now Three Books” on page 370

MATLAB Stores Character Data As Unicode; Making
Release 14 MAT-files Readable in Earlier Versions
Prior releases of MATLAB represented character data in memory using a
system default character encoding scheme that was padded out to 16-bits.
This was the case both in memory and in MAT-files. If this data needed to be
accessible to multiple users, each user’s system had to use the same character
encoding scheme. For those users whose default encoding scheme differed, the
exchange of character-oriented information was not possible.

In Release 14, this limitation is removed by adopting the Unicode character
encoding scheme in mxArrays and their storage in MAT-files. For more
information regarding Unicode, consult the Unicode Consortium web site at
http://www.unicode.org.

For more information on saving character data using Unicode encoding,
see “Writing Character Data” in the External Interfaces documentation.
For information on the internal formatting of MAT-files, see the "MAT-File
Format" document in the MATLAB documentation available in PDF format

Compatibility Considerations
Release 14 MATLAB writes character and figure data to MAT-files using
Unicode character encoding by default. This is now the default encoding used
by MATLAB when writing to MAT-files with the save and hgsave functions
or with the MAT-file external interface functions.

335

http://www.unicode.org


Version 7 (R14) MATLAB

Unicode encoded MAT-files are not readable by earlier versions of MATLAB.
Thus, if you save data to a MAT-file using MATLAB Release 14, and you
intend to load this MAT-file into an earlier release of MATLAB, you must
override the default encoding during the save, as explained in this section.

You can override the default encoding by using the -v6 switch with save
and hgsave:

save filename -v6
hgsave filename -v6

or, when saving with MAT functions, by setting the mode to “wL” on the
matOpen operation:

matOpen(filename, "wL");

MAT-Files Generated By Release 14 Beta2 Must Be
Reformatted
Any MAT-files that you created with Release 14 Beta 2 were written using an
internal format that is no longer supported by MATLAB.

Compatibility Considerations
If you need to import data from these files using any release besides Release
14 Beta 2, you must first regenerate the files as described in this section. You
cannot read these files using other releases of MATLAB 7.0, and attempting
to read them with MATLAB 6.5 or 6.5.1 will corrupt memory.

There are two ways in which you can regenerate your MAT-file:

• If you want to use the MAT-file with earlier versions of MATLAB,
regenerate the file using the local character set for your system. To do this,
run MATLAB R14 prerelease or MATLAB R14 Beta 2, load the MAT-file,
and rewrite the file using the command

save filename -v6

• If you want to use the MAT-file with R14 LCS or later, regenerate the
file using Unicode character encoding. To do this, run MATLAB R14
prerelease, load the MAT-file, and rewrite it using the following command
that uses the -unicode default.
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save filename

Caution The final R14 release of MATLAB does not allow you to import a
MAT-file written with Release 14 Beta 2. You will get an error if you attempt
to do this. To use a Beta 2 MAT-file with Release 14, you must first reformat
the file with MATLAB R14 prerelease as described above.

If you no longer have access to Release 14 Beta2 or the R14 prerelease, then
you must regenerate the data and save it again.

Unicode-Based Character Classification
Unicode-based character classification APIs are now provided in MATLAB.
The new character classification functions work with any locale or language
and resolve all locale-specific issues that existed in prior releases.

Character Rendering on Linux
Character data rendering has been improved for Linux operating systems
that are configured with a UTF-8 default character set.

Additional Bytes Reserved in MAT-File Header; Do
Not Write To Reserved Space
In previous releases of MATLAB, the last 4 bytes of the 128-byte MAT-file
header were reserved for use by the MathWorks. In Release 14, the last 12
bytes of this header are reserved. See the PDF file “MAT-File Format” for
more information.

Compatibility Considerations
If you have programs that write to any of the last 12 bytes of the MAT-file
header, or if they rely on the state of the 8 additional header bytes that are
reserved as of this release, you will probably need to change your code. These
bytes are now used by MATLAB. If your code writes to these bytes, MATLAB
is likely to overwrite this data. If your code reads these bytes, they might not
be in the same state as they were in previous releases of MATLAB.
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Compressed Data Support in MAT-Files
The save function compresses your workspace variables as they are saved
to a MAT-file. When writing a MAT-file that you will need to load using an
earlier version of MATLAB, be sure to use the save -v6 command. When
you use the -v6 switch, MATLAB saves the data without compression and
without Unicode character encoding. This makes the resulting file compatible
with MATLAB Version 6 and earlier.

You can also compress data when using MAT-file interface library functions
(matPut*) to write to a MAT-file by opening the file with the command matOpen
wz. See the section “Data Compression” in the MATLAB Programming
documentation for more information on this feature.

Saving Structures with the save Function
Two new syntaxes for the save function enable you to save individual fields of
a structure to a file. See the function reference for save for more information.

To save all fields of the scalar structure s as individual variables within the
file, myfile.mat, use

save('myfile', '-struct', 's')

To save as individual variables only those structure fields specified (s.f1,
s.f2, ...), use

save('myfile', '-struct', 's', 'f1', 'f2', ...)

Case-Sensitivity in Function and Directory Names;
Can Affect Which Function MATLAB Selects
Prior to this release, filenames for MATLAB functions and Simulink® models,
(M, P, MEX, DLL, and MDL files) and also directory names were interpreted
somewhat differently by MATLAB with regards to case sensitivity, depending
upon which platform you were running on. Specifically, earlier versions of
MATLAB handled these names with case sensitivity on UNIX, but without
case sensitivity on Windows.

This release addresses the issue of case sensitivity in an effort to make
MATLAB consistent across all supported platforms. By removing these
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differences, we hope to make it easier for MATLAB users to write platform
independent code.

Case Sensitivity in MATLAB 6 and Earlier
There are several rules regarding case sensitivity that were already consistent
across all platforms in MATLAB 6, and remain in effect on all platforms in
MATLAB 7. MATLAB interprets each of the following with case sensitivity
on both Windows and UNIX:

• Function names that correspond to MATLAB built-ins

• M-file subfunction names

• The names of functions imported from another language environment,
such as Java or COM

UNIX. On all UNIX platforms, including the new implementation on
MacIntosh, all function, model, and directory names were case sensitive
and required an exact match. This rule remains true for UNIX systems in
MATLAB 7.

Windows. On Windows platforms, MATLAB 6 obeys the following rules.
These rules are changing in MATLAB 7:

• Function and model names were not case sensitive.

• Directory names, including MATLAB class directory names (e.g., @MyClass)
and private directory names (e.g., prIVAte) were not case sensitive.

Case Sensitivity in MATLAB 7
MATLAB 7 removes the platform specific behaviors by adopting its UNIX
case sensitivity rules on Windows systems. MATLAB running on Windows
now gives preference to an exact (case sensitive) name match, but falls back to
an inexact (case insensitive) match when no exact match can be found.

Compatibility Considerations
There are four main conditions under which MATLAB 7 interprets directory
or function names differently in regards to case sensitivity:
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• “Two Files of the Same Name” on page 340

• “Two Method Files of the Same Name” on page 341

• “One File with an Inexact Match” on page 341

• “Private Directory Names” on page 342

In any of these cases, each described below, there is a potential for MATLAB
to select a file other than the one you had intended.

Whenever MATLAB 7 detects a potential naming conflict related to case
sensitivity, it issues a warning. If you get one of these warnings when running
a MATLAB program, you may want to modify the related code to eliminate
the warning, or you may wish to simply disable the warning. To disable this
type of warning, see “Turning Off Warnings Caused by Case Mismatch” on
page 343.

Two Files of the Same Name. Consider the situation in which there are
two or more directories on the MATLAB path that contain a function or model
file of the same name. The names of these M-files differ only in letter case:

H:\released\myTestFun.m
K:\under_test\mytestfun.m

Of these two directories, H:\released is closer to the beginning of the
MATLAB path and, thus, has priority over the other:

path = H:\released; K:\under_test; ...

On Windows Platforms —

• In MATLAB 6, executing the function mytestfun invokes
H:\released\myTestFun.m.

• In MATLAB 7, executing the function mytestfun invokes
K:\under_test\mytestfun.m and also displays the following warning:

Function call mytestfun invokes K:\under_test\mytestfun.m
however, function H:\released\myTestFun.m, that differs only in
case, precedes it on the path.
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On UNIX Platforms —

MATLAB 7 does the same as on Windows, except that the warning message
is disabled by default.

Two Method Files of the Same Name. In this case, there are two M-files
of the same name that implement methods of a MATLAB base class and
one of its subclasses:

@baseclass/my_method.m
@subclass/My_Method.m

On Windows Platforms —

• In MATLAB 6, the command my_method(subclass) invokes
@subclass/My_Method.

• In MATLAB 7, the same command invokes @baseclass/my_method
because it is an exact match.

On UNIX Platforms —

MATLAB 7 does the same as on Windows.

One File with an Inexact Match. Another situation that MATLAB now
handles differently involves just one function or model file that matches the
function being called:

H:\released\myTestFun.m

However, the name of this M-file does not match the called function
(mytestfun) in letter case.

On Windows Platforms —

• In MATLAB 6, calling the function mytestfun invokes
H:\released\myTestFun.m.

• In MATLAB 7, calling the function mytestfun invokes the same M-file but
also displays the following warning:

Function call mytestfun invokes inexact match
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H:\released\myTestFun.m.

On UNIX Platforms —

• In MATLAB 6, calling the function mytestfun results in an error.

• In MATLAB 7, calling mytestfun invokes H:\released/myTestFun.m and
generates the following warning:

Function call mytestfun invokes inexact match
H:/released/myTestFun.m.

Private Directory Names. Private functions must reside in a directory
named private that is one level down from the directory of any calling
function. As of this release, the directory name private is case sensitive on
Windows as it has always been on UNIX.

On Windows Platforms —

• In MATLAB 6, calling function myprivfun in an environment where only
a subdirectory named \PriVAte contains the M-file myprivfun.m invokes
\PriVAte\myprivfun without displaying a warning.

• MATLAB 7 does the same as MATLAB 6, except that it also displays the
following warning:

Wrong case spelling of 'private' as a directory name in
\released\PriVate\myprivfun.m.

On UNIX Platforms —

• In MATLAB 6, calling function myprivfun in an environment where only
a subdirectory named \PriVAte contains the M-file myprivfun.m results
in an error.

• In MATLAB 7, calling myprivfun in this same environment invokes
/PrivATe/myprivfun and also displays the following warning:

Wrong case spelling of 'private' as a directory name in
/released/PriVate/myprivfun.m.
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Turning Off Warnings Caused by Case Mismatch
You can disable most warnings caused by case mismatch with the following
command:

warning off MATLAB:dispatcher:InexactMatch

To disable this warning for all of your MATLAB sessions, add this command
to your startup.m or matlabrc.m file.

If you continue to get case sensitivity warnings after entering this command,
you can disable a wider range of warnings with the following command:

warning off ...
MATLAB:dispatcher:CaseInsensitiveFunctionPrecedesExactMatch

Note This latter warning alerts you when, for case sensitivity reasons,
MATLAB may have selected a different M-file from the one you had intended
to run. It is recommended that you leave this warning enabled.

Differences Between Built-Ins and M-Functions
Removed; Can Affect Which Function MATLAB Selects
MATLAB implements many of its core functions as built-ins. In previous
releases of MATLAB, there have been several significant differences between
the way MATLAB handles built-in and M-file functions. As of this release,
MATLAB handles both types of functions the same. This change affects the
following:

• “Function Dispatching” on page 343

• “Return Value from the functions Function” on page 344

• “Output from the which Function” on page 344

Function Dispatching
MATLAB now dispatches both built-in and M-file functions according to the
same precedence rules, (see “Function Precedence Order” in the MATLAB
Programming documentation). In previous releases, subfunctions, private
functions, and class constructor functions took precedence over M-functions of
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the same name, but not over built-ins. In this release, built-in functions follow
the same rules given to M-functions, and thus are lower in precedence than
the three function types named above.

This change addresses a potential problem in that changes to the internal
implementation of MATLAB functions could potentially affect the operation of
your own M-code. For example, if a new version of MATLAB were to change
an internal function from being M-based to being built-in, the function in the
new version would now be subject to different precedence rules. If one of your
M-code modules had a subfunction with the same name as this function (now
obeying the built-in rules), then this subfunction would never be called.

This release resolves this potential conflict by using the same precedence
rules for both M-functions and built-ins.

Compatibility Considerations. If any of your programs have subfunctions,
private functions, or class constructor functions that have the same name as
a built-in function that has the same function scope, MATLAB now gives
precedence to the subfunction, private function, or constructor rather than
the built-in. If this is not corrected, you may find instances where your
program calls a function other than the one you had intended. You can avoid
such problems by renaming any functions that may conflict with a MATLAB
built-in function.

Return Value from the functions Function
The MATLAB functions function returns information about a function
handle such as the function name, type, and filename. In previous releases,
functions returned the filename for a built-in function as the string

'MATLAB built-in function'

In this release, MATLAB associates each built-in function with a placeholder
file that has a .bi extension (for example, reshape.bi for the built-in
reshape function).

Output from the which Function
The which function now displays the pathname for built-in functions, as well
as for overloaded functions when only the overloaded functions are available.
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Warning on Naming Conflict
The following warning was added to identify the case when you first use a
name as a function and later use it as a variable:

Warning: File: D:\Work\MATLAB XL\theworks\my_yprime.m Line: 17
Column: 1 Variable 'getdata' has been previously used as a
function name.
(Type "warning off MATLAB:mir_warning_variable_used_as_function:
to suppress this warning.)

For example, this code generates such a warning:

X = i; % Calls the function i() to get sqrt(-1)
for i = 1:10 % uses i as a variable. This produces the warning.
... end

Change to How evalin Evaluates Dispatch Context
In Release 13 and earlier, the evalin function evaluated its input in the
specified workspace, but not the workspace’s corresponding dispatching
context. Hence, running the following example used to succeed, calling the
subfunction MySubfun but using the value of x from the base workspace:

function demo
evalin('base', 'MySubfun(x)')

function MySubfun(in)
disp(in)

When you call evalin in Release 14, MATLAB tries to find a function named
MySubfun that is accessible in the base workspace, i.e. at the command
prompt. Since MySubfun is a subfunction and therefore not in scope at the
command prompt, MATLAB errors, reporting that MySubfun is undefined.

Compatibility Considerations
There are two ways to change your existing code to work with this new
behavior. First, if your code only needs to get the value of the subfunction’s
inputs from the base workspace (as demo.m does above), and does not care
what context MySubfun is run in, then you can change your code to use evalin
only to get the values of the inputs from the base workspace, like this:
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function demo_workaround1
MySubfun(evalin('base', 'x'))

function MySubfun(in)
disp(in)

If, however, it is important that the subfunction itself be run in the context of
the base workspace, you can place a function handle to the subfunction in the
base workspace and then evaluate that:

function demo_workaround2
assignin('base', 'MySubfunHandle', @MySubfun);
evalin('base', 'MySubfunHandle(x)')

function MySubfun(in)
disp(in)

You can also substitute ’caller’ for ’base’ in the workaround code if your
original code uses evalin('caller', ...).

Summary of New Functions
These functions are new in this release.

Function Description

addtodate Modify a particular field of a date number

genvarname Construct valid variable name from string

intmax Return largest possible integer value

intmin Return smallest possible integer value

intwarning Control state of integer warnings

isfloat Detect floating-point arrays

isinteger Detect whether an array has integer data type

isscalar Determine if item is a scalar

isstrprop Determine the content of each element of a string

isvector Determine if item is a vector
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Function Description

mmfileinfo Get information about multimedia file

recycle Set option to move deleted files to recycle folder

restoredefaultpath Restore default search path

strtrim Remove leading and trailing whitespace from
string

textscan Read data from text file, convert and write to cell
array

xlswrite Write matrix to a Microsoft Excel spreadsheet

New Function Type — Anonymous Functions
Anonymous functions give you a quick means of creating simple functions
without having to create M-files each time. You can construct an anonymous
function either at the MATLAB command line or from within another function
or script.

Refer to “Anonymous Functions” in the MATLAB Programming documentation
for more complete coverage of this topic. For more information on anonymous
functions, open the M-file anondemo.m in the MATLAB Editor by typing

edit anondemo

Syntax
The syntax for creating an anonymous function from an expression is

fhandle = @(arglist) expr

where arglist is a comma-separated list of input variables, and expr is
any valid MATLAB expression. The constructor returns a function handle,
fhandle, that is mapped to this new function. Creating a function handle
for an anonymous function gives you a means of invoking the function. It
is also useful when you want to pass your anonymous function in a call to
some other function.
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Note Function handles not only provide access to anonymous functions. You
can create a function handle to any MATLAB function. The constructor uses a
different syntax: fhandle = @functionname (e.g., fhandle = @sin). To find
out more about function handles, see “Function Handles” in the MATLAB
Programming documentation.

You can use the function handle for an anonymous function in the same way
as any other MATLAB function handle.

A Simple Example
To create a simple function sqr to calculate the square of a number, use

sqr = @(x) x.^2;

To execute the function, type the name of the function handle, followed by any
input arguments enclosed in parentheses:

a = sqr(5)
a =

25

Since sqr is a function handle, you can pass it to other functions. The code
shown here passes the function handle for anonymous function sqr to the
MATLAB quad function to compute its integral from zero to one:

quad(sqr, 0, 1)
ans =

0.3333

Arrays of Anonymous Functions
To store multiple anonymous functions in an array, use a cell array.
See “Arrays of Anonymous Functions” in the MATLAB Programming
documentation.

Examples
You can find more examples of how to use anonymous functions in MATLAB
under “Examples of Anonymous Functions”.
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New Function Type — Nested Functions
You can now define one or more functions within another function in
MATLAB. These inner functions are said to be nested within the function that
contains them. You can also nest functions within other nested functions.

Refer to “Nested Functions” in the MATLAB Programming documentation
for more complete coverage of this topic. For more information on nested
functions, open the M-file nesteddemo.m in the MATLAB Editor by typing

edit nesteddemo

Writing a Nested Function
To write a nested function, simply define one function within the body of
another function in an M-file. Like any M-file function, a nested function
contains any or all of the usual function components. In addition, you must
always terminate a nested function with an end statement:

function x = A(p1, p2)
...

function y = B(p3)
...
end

...
end

Characteristics of Nested Functions
Two characteristics unique to nested functions are

• A nested function has access to the workspaces of all functions inside of
which it is nested. A variable that has a value assigned to it by the primary
function can be read or overwritten by a function nested at any level within
the primary. Similarly, a variable that is assigned in a nested function can
be read or overwritten by any of the functions containing that function.

• When you construct a function handle for a nested function, the handle not
only stores the information needed to access the nested function; it also
stores the values of all variables shared between the nested function and
those functions that contain it. This means that these variables persist in
memory between calls made by means of the function handle.
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Examples
You can find examples of how to use nested functions in MATLAB under
“Examples of Nested Functions”.

Calling Private Functions From Scripts
You can now invoke a private function from a script, provided that the script
is called from another M-file function, and that the private function being
called by the script is within the scope of this M-file function.

New Calling Syntax for Function Handles; Replace
eval With New Syntax
You can now call functions by means of their related function handles using
standard calling syntax rather than having to use feval. When calling a
function using its handle, specify the function handle name followed by any
input arguments enclosed in parentheses.

For example, if the handle to a function was stored in variable h, you would
call the function as if the handle h were a function name:

h(arg1, arg2, ...)

For the parabola function shown here, construct a function handle h and call
the parabola function by means of the handle:

function y = parabola(a, b, c, x)
y = a*x.^2 + b*x + c;

parabHandle = @parabola;

parabHandle(1.3, .2, 30, 25)

When calling functions that take no input arguments, you must use empty
parentheses after the function handle:

parabHandle()
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Compatibility Considerations
Using feval for the purpose of invoking functions via function handle is no
longer necessary and is, in fact, slower. However, for purposes of backward
compatibility, the use of feval to evaluate function handles is still supported
in this release.

Parenthesis notation on a nonscalar function handle means subscripting,
just as in Release 13, while the same notation on scalar function handles
means function call, as described above. Incompatibility can arise only if you
construct a scalar array of function handles and actually index it, necessarily
with an index of 1.

Arrays of Function Handles
Previous releases of MATLAB supported arrays of function handles. You
created such an array using the [] operator, and indexed into the array with
the () operator:

x = [@sin @cos @tan];
plot(feval(x(2), -pi:.01:pi));

In Release 14, MATLAB supports arrays of functions handles using cell
arrays. You create and index into a function handle array using the {}
operator:

x = {@sin @cos @tan};
plot(x{2}(-pi:.01:pi));

Compatibility Considerations
For purposes of backward compatibility, standard arrays of function handles
are still supported in this release.

Calling nargin and nargout with Built-In Functions
When you pass the name of a function to nargin or nargout, MATLAB
returns the number of declared inputs or outputs for that function. For
example, passing the function name 'normest' to nargin returns 2, (the
number of inputs declared in normest.m:

nargin('normest') % normest is an M-function.
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ans =
2

In this release, you can also use this feature with MATLAB built-in functions.
The following use of nargin returned an error in previous versions of
MATLAB because norm is implemented as a built-in function. In this release,
nargin returns the number of inputs declared by the norm function:

nargin('norm') % norm is a built-in function.
ans =

2

The same applies to nargout.

Comma Separators Not Required in Function
Declaration
As of Release 14, the function definition line in a function M-file no longer
requires commas separating output variables. This now makes the function
definition syntax the same as the syntax used when calling an M-file function:

function [A B C] = myfun(x, y)

Compatibility Considerations
This new syntax is not valid in MATLAB versions earlier than Release 14.
When writing an M-file that you expect to run on versions both earlier and
later than R14, be sure to separate any output variables in the function
definition line with commas:

function [A, B, C] = myfun(x, y)

getfield and setfield Not To Be Deprecated
There are no plans to remove the getfield and setfield functions from the
MATLAB language, as stated in the release notes for MATLAB Release 13.

isglobal Function To Be Discontinued
Support for the isglobal function will be removed in a future release of
MATLAB. In Release 14, invoking isglobal generates the following warning:
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Warning: isglobal is obsolete and will be discontinued.
Type "help isglobal" for more details.

Recycle to Protect Files from Unwanted Deletion
To protect yourself from unintentionally deleting any files that you want
to keep, use the new recycle function to turn on file recycling. When file
recycling is on, MATLAB moves all files that you delete with the delete
function to either the recycle bin (on the PC or Macintosh) or a temporary
folder (on UNIX). When file recycling is off, any files you delete are actually
removed from the system.

You can turn recycling on for all of your MATLAB sessions using the
Preferences dialog box. (Select File > Preferences > General.) Under
the heading Default behavior of the delete function, select Move files
to the Recycle Bin.

bin2dec Ignores Space Characters
The bin2dec function now ignores any space (’ ’) characters in the input
string. Thus, the binary string '010 111' now yields the same result as the
string '010111'.

In Release 13, bin2dec interpreted space characters as zeros:

bin2dec('010 111')
ans =

39

In this release, bin2dec ignores all space characters:

bin2dec('010 111')
ans =

23

dbstop crashes Are Now Resolved
In previous versions, a MATLAB session would terminate prematurely when
attempting to execute certain P-code files if you had set a debugger breakpoint
in the function represented by that file. For example, an attempt to run Guide
would terminate your MATLAB session if you had used the dbstop function
to set a breakpoint in the corresponding M-file:
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dbstop in guide
guide

This bug has been fixed in this release enabling you to debug these files
successfully.

Bit Functions on Unsigned Integers
MATLAB bit functions now work on unsigned integers. Instead of using flints
(integer values stored in floating point) to do you bit manipulations, consider
using unsigned integers. See “Bit Functions Now Work on Unsigned Integers”
on page 319 in the MATLAB Mathematics release notes.

inmem Returns Path Information
The inmem function now returns not only the names of the currently loaded
M- and MEX-files, but the path and filename extension for each as well. Use
the -completenames option to obtain this additional information:

inmem('-completenames')

New Features for Nondouble Data Types
The section “New Nondouble Mathematics Features” on page 310 describes
new features affecting the nondouble (single and integer) data types. These
changes affect single and integer arithmetic operations, and also conversion
of single and double data types to integers.

Mathematic Operations on Logical Values
Most mathematic operations are not supported on logical values.

Accessing Cell and Structure Arrays Without deal
In many instances, you can access the data in cell arrays and structure fields
without using the deal function. Here is an example that reads each of the
cells of a cell array into a separate output:

C = {rand(3) ones(3,1) eye(3) zeros(3,1)};

Use either of the following to access the cells in C:
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[a,b,c,d] = deal(C{:})
[a,b,c,d] = C{:}

Here is an example that reads each of the fields of a structure array into a
separate output:

A.name = 'Pat'; A.number = 176554;
A(2).name = 'Tony'; A(2).number = 901325;

Use either of the following to access the name field:

[name1,name2] = deal(A(:).name)
[name1,name2] = A(:).name

New Features in Regular Expression Support
This version of MATLAB introduces the following new features in regular
expression support:

• Multiple Input Strings — You can use any of the MATLAB regular
expression functions with cell arrays of strings as well as with single
strings. Any or all of the input parameters (the string, expression, or
replacement string) can be a cell array of strings.

• Selective Outputs — To select what type of data you want the regexp and
regexpi to return (string indices or text, token indices or text, or token
data by name) use one or more of the six qualifiers for these functions.

• Lookaround Operators — Lookahead and lookbehind operators enable you
to match a pattern only if it is preceded, or followed, by another pattern.

• New Logical Operators — New operators for grouping, inserting comments,
and finding alternative match patterns

• New Quantifiers — Lazy quantifiers match a minimum number of
characters in a string. Possessive quantifiers do not reevaluate parts of the
string that have already been evaluated

• Element Grouping — Group elements together using either (...) to group
and capture, or (?:...) for grouping alone

• Named Capture Grouping — Capture characters in a token and assign
a name to the token

355



Version 7 (R14) MATLAB

• Conditional Expressions — Process a string in different ways depending
on a stated condition

• New Character Representations — New symbolic representations such as
\e for escape, or \xN for a character of hexadecimal value N, are available
in this release.

• Default Tokenizing — The regexprep function now tokenizes by default.
There is no longer a 'tokenize' option

Refer to “Regular Expressions” on page 171 in the MATLAB Programming
documentation.

Functions that Use Regular Expressions
The who, whos, save, load, and clear functions now accept regular
expressions as input. This feature enables you to be more selective concerning
which variables they operate on.

For example, this statement saves to a MAT-file only those variables with
a name that either starts with the letters A or B, or contains ten or more
characters:

save('mydata.mat', '-regexp', '^[AB].', '.{10,}');

If the workspace contains the following four variables, two of the four meet
the requirements of the regular expression:

whos
Name Size Bytes Class

A_stats 10x5 400 double array
X23456789 1x1 12 char array
ab 3x1 536 struct array
longerVariableName 1x4 8 char array

When you perform the save operation and then check the contents of the
MAT-file, you see that the variables with names that either start with A or
have at least ten characters were saved:

save('mydata.mat', '-regexp', '^[AB].', '.{10,}');
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whos -file mydata.mat
Name Size Bytes Class

A_stats 10x5 400 double array
longerVariableName 1x4 8 char array

Refer to the reference pages for these functions for more information and
examples.

Regular Expressions Accept String Vector; No Longer
Support Character Matrix Input
You can now pass a vector of strings in a cell array to any of the MATLAB
regular expression functions (regexp, regexpi, and regexprep).

Compatibility Considerations
Because this is the preferred method of passing a string vector, MATLAB no
longer supports using character matrices for this purpose.

Cell Array Support for String Functions
You can now pass a cell array of strings to the strfind function. MATLAB
searches each string in the cell array for occurrences of the pattern string,
and returns the starting index of each such occurrence.

Additional Class Output From mat2str
The statement str = mat2str(A, 'class') creates a string with the name
of the class of A included. This option ensures that the result of evaluating
str will also contain the class information.

Change the 16-bit integer matrix to a string that includes 'int16'. Next,
evaluate this string and verify that you get the same matrix that you started
with:

x1 = int16([-300 407 213 418 32 -125]);

A = mat2str(x1, 'class')
A =
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int16([-300 407 213 418 32 -125])
x2 = eval(A);

isa(x2, 'int16') && all(x2 == x1)
ans =

1

String Properties
Use the new isstrprop function to see what parts of a string or array of
strings are alphabetic, alphanumeric, numeric digits, hexadecimal digits,
lowercase, uppercase. white-space characters, punctuation characters, contain
control characters, or contain graphic characters.

For example, to test for alphabetic characters in a two-dimensional cell array,
use

A = isstrprop({'abc123def';'456ghi789'}, 'alpha')
A =

[1x9 logical]
[1x9 logical]

A{:,:}
ans =

1 1 1 0 0 0 1 1 1
0 0 0 1 1 1 0 0 0

Using strtok on Cell Arrays of Strings
You can now use the strtok function on a cell array of strings. When used
with a cell array of strings, strtok returns a token output that is also a cell
array of strings, each containing a token for its corresponding input string.

See the strtok reference page to see an example of how this works.

Colon Operator on char Now Returns a char
Applying the colon operator to inputs of type char now returns a result of
type char. For example,

'a':'g'
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ans =

abcdefg

Compatibility Considerations
In previous releases, the same operation returned a result of type double. You
may need to change your code if it relies on type double being returned.

datestr Returns Date In Localized Format
The statement str = datestr(..., 'local') returns the date string in a
localized format. See the datestr reference page for more information.

Form and Locale for weekday
The weekday function now takes two new inputs that control the output
format. These arguments enable you to get a full or abbreviated day name,
and a local or US English output.

Freestyle Date String Format
When converting between serial date numbers, date vectors, and date strings
with the datenum, datevec, and datestr functions, you can specify a format
for the date string from the “Free-Form Date Format Specifiers ” table shown
on the datestr reference page.

Reading Date Values with xlsread; Conversion No
Longer Necessary
There are two changes that affect importing date information from Excel
with the xlsread function:

• “Date Information Returned as Cell Array of Char” on page 359

• “Conversion of Date Values Is No Longer Necessary” on page 360

Date Information Returned as Cell Array of Char
Prior to this release, xlsread imported date information from an Excel file
and returned the results as a double. In Release 14, xlsread returns this
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information as a cell array containing data of class char. The reason for
this is that MATLAB now imports Excel files using an Excel COM server.
Excel returns dates is as strings, and there is really no indication that what
is returned is a date.

Compatibility Considerations. You will need to change your program code
to accept a cell array of type char instead of an array of double when using
xlsread to import date information from Excel.

Conversion of Date Values Is No Longer Necessary
When reading date fields from a Microsoft Excel file using earlier versions of
MATLAB, it was necessary to convert the Excel date values into MATLAB
date values. This was necessary because Excel and MATLAB calculated date
values based on a different reference date. This is explained in the section,
“Handling Excel Date Values” in the function reference for xlsread.

With MATLAB 7.0, you no longer have to do this conversion because xlsread
now imports dates as strings rather than as numerical values.

Compatibility Considerations. If your existing code converts Excel date
values to MATLAB values, you will need to remove this step so that you end
up with the correct results.

Comprehensive Function for Reading Text Files
The new textscan function reads data from an open text file into a cell array.
MATLAB parses the data into fields and converts it according to conversion
specifiers passed to textscan in the argument list.

The textscan function is similar to textread but differs from textread in
the following ways:

• The textscan function offers better performance than textread, making it
a better choice when reading large files.

• With textscan, you can start reading at any point in the file. Once the file
is open, (textscan requires that you open the file first), you can seek to any
position in the file and begin the textscan at that point. The textread
function requires that you start reading from the beginning of the file.
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• Subsequent textscan operations start reading the file at the point where
the last textscan left off. The textread function always begins at the start
of the file, regardless of any prior textread.

• textscan returns a single cell array regardless of how many fields you
read. With textscan, you don’t need to match the number of output
arguments to the number of fields being read as you would with textread.

• textscan offers more choices in how the data being read is converted.

• textscan offers more user-configurable options.

New Inputs and Outputs to xlsread
The table below shows new input and output arguments to the xlsread
function. See the function reference for xlsread for more information. With
the exception of the basic input argument, these arguments are supported
only on computer systems capable of starting Excel as a COM server from
MATLAB.

New Input
Arguments Description

-1 Opens the Excel file in an Excel window, enabling you
to interactively select the worksheet to be read and
the range of data to import from the worksheet.

range Reads data from the rectangular region of a worksheet
specified by range.

basic Imports data from the spreadsheet in basic import
mode.

New Output
Argument Description

rawdata Returns unprocessed cell content in a cell array. This
includes both numeric and text data.

New Inputs and Syntax for dlmwrite
The dlmwrite function now has several new input arguments plus an optional
attribute-value format in which to enter these arguments. You can now enter
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input arguments to dlmwrite in an attribute-value format. This format
enables you to specify just those arguments that you need and omit any
others. This new syntax for dlmwrite is

dlmwrite('filename', M, attribute1, value1, ...
attributeN, valueN)

The former syntax for dlmwrite is still supported for arguments that were
available in earlier versions of MATLAB.

The table below shows new input arguments to the dlmwrite function. You
must specify these new arguments using the attribute-value format. See the
dlmwrite function reference for more information.

Attribute Value

delimiter Delimiter string to be used in separating matrix
elements

newline Character(s) to use in terminating each line

roffset Offset, in rows, from the top of the destination file
to where matrix data is to be written

coffset Offset, in columns, from the left side of the
destination file to where matrix data is to be
written

precision Numeric precision to use in writing data to the file

For example, to export matrix M to file myfile.txt, delimited by the tab
character, and using a precision of six significant digits, type

dlmwrite('myfile.txt', M, 'delimiter', '\t', 'precision', 6)

Change in Output from xlsfinfo
xlsfinfo now returns the names or all worksheets in an Excel file instead of
just the ones with numbers in them (as in Release 13).
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Importing Complex Arrays
The csvread, dlmread, and textscan functions import any complex number
as a whole into a complex numeric field, converting the real and imaginary
parts to the specified numeric type. Valid forms for a complex number are

Form Example

–<real>–<imag>i|j 5.7-3.1i

–<imag>i|j -7j

Using imread to Import Subsets of TIFF Images
When using the imread function with the 'PixelRegion' parameter, you
can now read in portions of an image stored in TIFF format. Specify a cell
array containing two vectors, ROWS and COLS, for the value of this parameter.
Each vector can either be a two-element vector specifying the extent of the
region, [START STOP], or a three-element vector that enables downsampling,
[START INCREMENT STOP].

When used with tiled images, 'PixelRegion' subsetting can improve memory
usage and performance because it only reads in the tiles that encompass the
region. For example, in the following figure, if you specify the region defined
by the box, imread would only read in tiles 1, 2, 4, and 5.
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Getting Information about Multimedia Files
MATLAB now includes a function, named mmfileinfo, that returns
information about the contents of a multimedia file. The file can contain
audio data, video data, or both.

This function is only available on Windows platforms.

All-Platform Audio Recording and Playback
The MATLAB audiorecorder and audioplayer functions can now be used
on Windows and UNIX platforms. These functions were previously only
available on Windows systems.

Note The audiorecorder and audioplayer objects are now implemented as
MATLAB objects on all platforms. The methods supported by these objects
are overloaded functions. You must use standard MATLAB function calling
syntax to call methods of these objects; you cannot use dot notation.
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FTP File Operations
From within MATLAB, you can connect to an FTP server to perform remote
file operations. For more information, see the ftp reference page.

Web Services (SOAP)
MATLAB can now consume Simple Object Access Protocol-based (SOAP) Web
services with the createClassFromWSDL function. For more information, see
“Using Web Services in MATLAB” in the online documentation.

64-Bit File Handling on MacIntosh
The release notes for MATLAB Release 13 should have included MacIntosh in
the list of those platforms that support 64-bit file handling. This support is
available on the following platforms:

• Windows

• Solaris

• Linux 2.4.x

• HP-UX 11.0, 9000/785

• Macintosh

Changes to Error Message Format
The last two lines of MATLAB error messages have changed for Release 14.
Error messages now

• Display functions and subfunctions differently than in R13.

• Display nested functions.

• Call out the error in a string that you can use as input to other functions,
like dbstop.

• Have a hot link to the source of the error.

Each of these changes is discussed below. Examples show the errors generated
by both the previous release (V6.5) and current release (7.0) of MATLAB for
the purpose of comparison.
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Display of Functions and Subfunctions
MATLAB now calls out the source of the error using a consistent format. One
of the features of this format is that you can place the string of the message
into other MATLAB commands. See “Using the Error Message String as
Input to Other Functions” on page 367.

Errors Generated by the Primary Function. Errors generated by the
primary function of an M-file are displayed as shown below. In version 7.0,
the path is not shown in most cases (private functions are one exception).
Filename extension is also not shown. The failing line number is shown on
third line.

In MATLAB V6.5 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> B:\MATLAB_V70\work\errmsgtest.m
On line 11 ==> strcmp('aa','bb','cc');

In MATLAB V7.0 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> errmsgtest at 11
strcmp('aa','bb','cc');

Errors Generated by a Subfunction. Errors generated by a subfunction
of an M-file are displayed in the previous release and current release of
MATLAB as shown below. Comments for primary functions apply here as
well. Also, the name of the failing subfunction follows the > character instead
of being put in parentheses.

In MATLAB V6.5 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> B:\MATLAB_V70\work\errmsgtest.m (subFun1)
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On line 17 ==> strcmp('aa','bb','cc');

In MATLAB V7.0 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> errmsgtest>subFun1 at 17
strcmp('aa','bb','cc');

Error Messages Display Nested Functions
This example shows an error that comes from a nested function (nestFun2)
called by another nested function (nestFun1). It uses the following syntax,
where the > character follows the name of the primary function and precedes
the names of any nested functions.

fun>nestfun1/nestfun2/etc at lineno.

In MATLAB V6.5 —

Nested functions are not supported prior to version 7.0.

In MATLAB V7.0 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> errmsgtest>nestFun1/nestFun2 at 6
strcmp('aa','bb','cc');

Using the Error Message String as Input to Other Functions
You can copy the text of the line that calls out the source of an error and
use this string as input to some of the MATLAB debugging functions. The
example shown below uses the string in a call to the dbstop function.

Copy the text that begins after

Error in ==>
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In MATLAB V6.5 —

This feature is not supported prior to version 7.0.

In MATLAB V7.0 —

??? Error using ==> strcmp
Too many input arguments.

Error in ==> errmsgtest>nestFun1/nestFun2 at 6
strcmp('aa','bb','cc');

Copy and paste text of this error message into the dbstop command:

dbstop errmsgtest>nestFun1/nestFun2 at 6

Hot Link to the Source of an Error
Error messages now contain a blue-underlined hot link to the failing line
of the M-file being executed.

Compatibility Considerations
If any of your programs rely on specific text in the types of error messages
described here, you may have to modify your program code.

nargchk Has a New Format for Error Messages
When the nargchk function detects an error condition, it returns information
on the error in either a string or a MATLAB structure. Use one of these two
command syntaxes to specify which format to return. If neither is specified,
nargchk returns a string:

msgstring = nargchk(minargs, maxargs, numargs, 'string')
msgstruct = nargchk(minargs, maxargs, numargs, 'struct')

The return structure has two fields: the message string, and a message
identifier . When too few inputs are supplied, these fields are

message: 'Not enough input arguments.'
identifier: 'MATLAB:nargchk:notEnoughInputs'
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When too many inputs are supplied, the structure fields are

message: 'Too many input arguments.'
identifier: 'MATLAB:nargchk:tooManyInputs'

Enabling and Disabling Warning Messages
The following message, which MATLAB appended to all warning messages in
the previous release, is no longer displayed.

(Type "warning off <msgid:msgstr>" to suppress this warning.)

Use the off and on options of the warning function to control the display of
all or selected warnings. This example disables a selected warning, and then
enables all warnings:

% All warnings are enabled by default.
A = 5/0;
Warning: Divide by zero.

% Disable the most recent warning
[msgstr msgid] = lastwarn;
warning('off', msgid);

% Try it again. This time there is no warning.
A = 5/0;

% Enable all warnings
warning('on', 'all')

% Verify that the warning is reenabled.
A = 5/0;
Warning: Divide by zero.

Catching Ctrl+C in try-catch Statements
In previous releases of MATLAB, typing Ctrl+C while executing the try part
of a try-catch statement resulted in the program branching to the catch part
of that statement. In this release, typing Ctrl+C is purposely not caught by
try-catch statements.
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The reason for this change is that, under certain circumstances, this behavior
in try-catch statements was found to adversely affect internal MATLAB code.
In these cases, this resulted in MATLAB code catching the Ctrl+C rather
than responding appropriately to it by terminating the current operation.

MATLAB Performance Acceleration
Release 13 introduced a new performance acceleration feature built into
MATLAB. Enhancing performance in MATLAB is an ongoing development
project that continues to show significant improvements in the performance of
MATLAB programs.

The Performance Acceleration documentation written for Release 13 included
suggestions on specific techniques to make the most of this feature. In
this release, many of those techniques are no longer necessary. This
documentation has been replaced with more general suggestions on how to
improve the performance of your programs.

“Using MATLAB” Documentation Is Now Three Books
Due to the increasing size of the printed “Using MATLAB” manual, we have
divided it into three separate printed books in version 7.0 to make it more
manageable. The titles for these books (and their corresponding headings
in the MATLAB Help Browser) are

• Desktop Tools and Development Environment

• Mathematics

• Programming

The online structure of this documentation is very similar to what it has been
in previous releases, although some topics are now covered more thoroughly.
We hope that you find this new format easier to use.
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Graphics and 3-D Visualization, MATLAB Version 7 (R14)
If you are using the Help browser, view the Graphics new features video demo
to see highlights of the new features.

This version introduces the following new features and changes:

• “Plotting Tools” on page 371

• “Code Generation” on page 372

• “Data Exploration Tools” on page 372

• “Annotation Features” on page 372

• “Plot Objects” on page 373

• “Group Objects” on page 375

• “Linking Graphics Object Properties” on page 375

• “New Behavior for Hold Command” on page 375

• “Enhancements to findobj” on page 375

• “New Ancestor Function Returns Object’s Ancestry” on page 375

• “New Axes Properties” on page 376

• “New Figure Properties” on page 376

• “New Rootobject Property” on page 377

Plotting Tools
If you are using the Help browser, watch the new Plotting Tools video demo
for an overview of the major functionality.

The following list links to new or redesigned plotting tool features.

• “Anatomy of a Graph” — figure toolbars that provide data exploration,
plot editing, and annotation tools

• Interactive Plotting Tools — overview of plotting tools

- Figure Palette

- Plot Browser
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- Property Editor

Related functions:

• plottools

• figurepalette

• plotbrowser

• propertyeditor

Code Generation
You can save a graph as an M-file that contains the code to regenerate the
graph. See “Generating an M-File to Recreate a Graph” for more information.

Data Exploration Tools
The following list links to the documentation for the data exploration tools.

• Data Cursor — displaying data values interactively

• Zooming — 2-D and 3-D zoom tools

• Panning — repositioning you view of the graph

• Rotate 3D — interactive rotation of 3-D views

• Camera Toolbar — mouse-controlled 3-D view manipulation.

Annotation Features
The following list links to the documentation for annotation features and
properties of the annotation objects.

• Overview of annotation features

• Rectangles and ellipses

- Rectangle properties

- Ellipse properties

• Textbox annotations

- Textbox properties
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• Lines and Arrows

- Line properties

- Arrow properties

- Textarrow properties

- Doublearrow properties

• Adding a Colorbar to a graph — new positioning options and colormap
modification.

colorbar — new command options

• Adding a legend to a graph — new positioning and appearance options

legend — new command options

• Pinning — attaching annotation objects to a point in the figure

• Aligning and Distributing graphics objects

See the annotation function for information on programmatic access to
annotation objects.

See “Annotation Objects” for an overview of this type of graphics object.

Plot Objects
Plot Objects are composite graphics objects that simplify the modification
of graphs that employ them. The following list links to reference pages for
modified graphing functions and to property descriptions of the new plot
objects.

See “Plot Objects” for an overview of this type of graphics object.

Functions That Use Plot Objects

• area

• bar

• contour

• errorbar
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• plot, plot3, loglog, semilogx, semilogy

• quiver, quiver3

• scatter, scatter3

• stairs

• stem, stem3

• surf, and mesh group
Note that all of the above functions have a 'v6' optional argument that
causes each function to return the core graphics objects that were created in
previous releases. See the reference pages for more information.

Plot Objects

• areaseries

• barseries

• contourgroup

• errorbarseries

• lineseries

• quivergroup

• scattergroup

• stairseries

• stemseries

• surfaceplot

Refreshing Data Source Properties
The refreshdata function enables you to take advantage of the XDataSource,
YDataSource, and ZDataSource plot objects properties to update graph data
when workspace variables change values.

See “Example — Specifying a Data Source”in the MATLAB Graphics
documentation for more information.
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Group Objects
Group objects enable you treat a number of objects as one, with respect to
certain properties.

See “Group Objects” on page 375 for an overview of this type of graphics object.

Group Object Functions

• hggroup

• hgtransform

• makehgtform

Linking Graphics Object Properties
You can link the corresponding properties of graphics objects so that changing
any one object’s properties makes the same change to all the linked objects.

See linkprop and linkaxes for more information.

New Behavior for Hold Command
The hold command has a new option all. This option holds the plot and
the current line color and line style so that subsequent graphing commands
do not reset the ColorOrder or LineStyleOrder property values to the
beginning to the list.

Enhancements to findobj
The findobj function now supports logical operators and regular expressions.
See the findobj reference page for more information.

New Ancestor Function Returns Object’s Ancestry
The ancestor function enables you to determine an object’s direct parent,
as well as its complete ancestry. This is particularly useful when you want
to determine whether an object is contained in a uipanel or hggroup, for
example, and need the handle of the container object or the top-level figure.
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New Axes Properties
You can control the behavior of an axes within a resized figure using the
following new axes properties.

• OuterPosition — The boundary of the axes including the axis labels,
title, and a margin. For figures with only one axes, this is the interior
of the figure.

• ActivePositionProperty — Specifies whether to use the OuterPosition
or the Position property as the size to preserve when resizing the figure
containing the axes.

• TightInset — The margins added to the width and height of the Position
property to include text labels, title, and axis labels.

See “Automatic Axes Resize” for more information.

New Figure Properties
There are three new figure properties described below.

Figure KeyPressFcn Property
The figure KeyPressFcn property now supports an event structure that
returns information about the key press event. See the KeyPressFcn
description for more information.

DockControls and WindowStyle Properties
Figures now have a DockControls property that determines if the Desktop
menu appears on the figure. Setting dockable to on causes the menu to be
displayed, the default setting of off prevents the menu from being displayed.
You can always dock and undock the figure by setting the figure WindowStyle
property.

Note that, depending on your preference settings, the figure might first be
grouped into a Document window, which can then be docked in the Desktop.

See “Docking Figures in the Desktop” for more information.
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New Rootobject Property
The MonitorPosition property enables you to get the position (width, height,
and location) of multiple monitors connected to your computer.

New Dialog for Exporting Figures
You can export MATLAB figures to a variety of standard file formats using
the Export Setup dialog. To display the dialog, select Export Setup from
the figure File menu.

Export Setup provides easy access to the graphics properties that affect
exported figures. For example, it enables you to control the size of the figure,
the font size and type, whether to use line styles or solid lines, and so on.

You can save your own export setting as an export style, or you can use
predefined options optimized for PowerPoint and MSWord.

The following picture shows the major components of the Export Setup dialog.
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Compatibility Considerations

Plotting Tools Not Working on Macintosh
The plotting tools not supported on the Macintosh platform. This means the
Figure Palette, Plot Browser, and Property Editor do not work these platforms.
To use the MATLAB 6 Property Editor, see the propedit command.

Using -nojvm Option Prevents Plotting Tools Use
If you use the -nojvm option when starting MATLAB, the plotting tools are
not available.
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MATLAB 6 Version Property Editor
The MATLAB 6 Property Editor is being replaced by a new Property Editor,
which is available in this release. However, you can still access the MATLAB
6 Property Editor by issuing the following command.

propedit(object_handle,'v6')

Without the v6 argument, propedit displays the new Property Editor. See
the propedit function for more information. Note that the Property Editor
might not work with all objects.

Cannot Dock Figures on Macintosh
You cannot dock figures in the Desktop, because MATLAB uses native figure
windows on the Macintosh platform.

Not All Macintosh System Fonts Are Available
MATLAB figures do not support the same fonts as native Macintosh
applications. Use the uisetfont functions to see which fonts are available
in MATLAB.
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Creating Graphical User Interfaces (GUIs), MATLAB Version
7 (R14)

This version introduces the following new features and changes:

• “New Container Components” on page 380

• “ActiveX Controls” on page 381

• “New Toolbar Component” on page 381

• “Menu Editor Enhancements” on page 382

• “Layout Resize Behavior” on page 382

• “Key Press Detection” on page 383

• “Edit Text Box Scroll Bar” on page 383

• “Setting Uicontrol Focus” on page 383

• “Multiple Selection in uigetfile” on page 384

• “Program Suspension Time-Out” on page 384

• “Standard Dialog Box Push Buttons” on page 384

• “New Syntax for uigetfile and uiputfile” on page 384

• “Frames Not Available in GUIDE Layout Editor” on page 385

New Container Components
MATLAB 7.0 introduces two new container components,

• Panel — Groups components

• Button group — Groups components and manages exclusive selection
behavior for radio buttons and toggle buttons.

These components are available in the GUIDE Layout Editor and via the
functions uipanel and uibuttongroup.

A container component can be the child of a figure or another container. In
general, containers can have as children the same components as figures,
including other containers. However, they cannot have menu bars, toolbars,
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or ActiveX controls as children. The Position property of the child of a panel
or button group is interpreted relative to the panel or button group. If you
move the panel or button group, the components it contains automatically
move with it and maintain their positions.

Panel properties and button group properties enable you to control the color,
size, border, and position of the panel or button group, assign a title, and
specify a context menu. In general, panels and button groups have many of
the same properties as uicontrol objects.

For information about working with panels and button groups in GUIDE, see
the following topics in the Creating Graphical User Interfaces collection of
the MATLAB documentation.

Compatibility Considerations
You can export a GUI that contains a panel or button group from GUIDE to a
single M-file that does not require a FIG-file. However, you will not be able to
run that M-file in MATLAB versions earlier than 7.0.

ActiveX Controls
GUIDE now enables you to insert an ActiveX control into your GUI if you
are running MATLAB on Microsoft Windows. When you drag an ActiveX
component from the component palette into the layout area, GUIDE displays
a dialog in which you can select any registered ActiveX control on your
system. When you select an ActiveX control and click Create, the control
appears as a small box in the Layout Editor. You can then program the
control to do what you want it to.

See “MATLAB COM Client Support” in the online MATLAB documentation
and ActiveX Controls in the GUIDE documentation to learn more about
ActiveX controls.

New Toolbar Component
A new function, uitoolbar, enables you to add a toolbar to a figure. You can
add your own pushtools and toggletools to the toolbar with the uipushtool
and uitoggletool functions.

381



Version 7 (R14) MATLAB

Uipushtool properties enable you to provide a callback that responds to a
mouse click. Uitoggletool properties enable you to provide callbacks that
respond to the tool being set on, off, or toggled to either position. Properties
for both uipushtools and uitoggletools provide for tooltip strings, separators,
and truecolor images to display on the tools. In general, uitoolbar,
uipushtool, and uitoggletool objects have many of the same properties
as uicontrol objects.

Menu Editor Enhancements
The GUIDE Menu Editor now enables you to:

• Choose a keyboard accelerator for a menu item from a pop-up menu.

• Set an item’s Enabled property on or off when the menu is first opened. If
the property value is off, the item appears dimmed and the user cannot
select it.

• Open the Property Inspector where you can change all uimenu properties.

• Display the callback subfunction in an editor. If the callback does not yet
exist, GUIDE creates it before displaying it.

The Menu Editor is now better synchronized with other GUIDE tools:

• Property changes made in the Menu Editor or in the Property Inspector are
immediately reflected in the other.

• uimenu objects in the Menu Editor now also appear in the Object Browser. If
you select a uimenu object in either, it is automatically selected in the other.

• If a component is selected in the Layout Editor and you select a menu item
in the Menu Editor, the component is deselected in the Layout Editor.

See Menu Editor in the MATLAB documentation for more information.

Layout Resize Behavior
In the GUIDE Layout Editor, components you have placed in the layout
area now maintain their visual position relative to the upper left corner of
their parent container (figure, panel, or button group) when you resize the
container in the Layout Editor. However, the values of the Position property
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are determined relative to the lower left corner, and these values will change
accordingly when you increase or decrease the height of the container.

Key Press Detection
A new uicontrol callback property, KeyPressFcn, specifies a key press
callback function with which you can detect a key press when the callback’s
uicontrol object has focus. If no uicontrol has focus, the figure’s key press
callback function, if any, is invoked. This property is available in the
uicontrol function and in GUIDE.

If you specify the KeyPressFcn property as an M-file, the callback routine can
query the figure’s CurrentCharacter property to determine what particular
key was pressed and ,thereby, limit the callback execution to specific keys.
If you specify the KeyPressFcn property as a function handle, the callback
routine can retrieve information about the key that was pressed from its
eventdata structure argument.

As an example, you can use this property to enable a user to press Enter,
rather than the space bar, after giving focus to a uicontrol push button. Use
the push button’s key press callback function to determine if the user pressed
the Enter key. If it was the Enter key, call the push button callback.

See the Uicontrol Properties for more information.

Edit Text Box Scroll Bar
For uicontrol editable text fields, i.e. the Style property is set to 'edit',
if Max-Min>1, then multiple lines are allowed. For multi-line edit boxes, a
vertical scroll bar enables you to scroll the text. You can also use the arrow
keys to scroll.

Setting Uicontrol Focus
The uicontrol function now enables you to transfer focus programmatically
to a specified uicontrol object. The syntax uicontrol(uich) transfers focus
to the uicontrol object with handle uich.
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Multiple Selection in uigetfile
The uigetfile function can now create a dialog that enables the user to
select and retrieve multiple files using the Shift and Ctrl keys. You can
turn this capability on or off using the new 'MultiSelect' parameter. The
default setting is off.

Program Suspension Time-Out
A new uiwait argument, timeout, enables you to specify the number of
seconds after which program execution will resume, unless uiresume is called
first or the specified figure is deleted. For example,

uiwait(h,5)

causes the suspended program to resume execution, if it has not already,
after five seconds.

Standard Dialog Box Push Buttons
For standard dialog boxes with more than one uicontrol push button, you
can now give focus to another button while retaining the default button. Focus
is denoted by a border or a dotted border, respectively, in UNIX and Microsoft
Windows. The default button has a shadow.

In such a case, if the user presses the space bar, the button with focus gets
the key press and can choose to execute its own callback or the callback of the
default button. If the user presses Enter, the default push button gets the
key press and its callback executes. This code provides an example.

ButtonName=questdlg('What is your wish?', ...
'Genie Question', ...
'Food','Clothing','Money','Money')

New Syntax for uigetfile and uiputfile
The uigetfile and uiputfile syntax that enables you to position dialog
boxes that are used to retrieve and save files is changed. The new syntaxes
are uigetfile('FilterSpec','DialogTitle','Location',[x y]) and
uiputfile('FilterSpec','DialogTitle','Location',[x y]). Previously,
the syntaxes were, uigetfile('FilterSpec','DialogTitle',x,y) and
uiputfile('FilterSpec','DialogTitle',x,y)

384



Creating Graphical User Interfaces (GUIs), MATLAB Version 7 (R14)

Compatibility Considerations
You are encouraged to change to the new uigetfile and uiputfile syntax.
The earlier syntaxes continue to be valid but may be removed in a later
release.

Frames Not Available in GUIDE Layout Editor
The frame component no longer appears in the GUIDE Layout Editor
component palette. It has been replaced by the panel and button group
components. See “New Container Components” on page 380 for information
about these new components.

Compatibility Considerations
GUIDE continues to support frames in those GUIs that contain them, but it is
recommended that you replace them with panels or button groups.
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External Interfaces/API, MATLAB Version 7 (R14)
New features and changes introduced in this version are organized by these
topics:

• “Importing and Exporting” on page 386

• “ActiveX and COM” on page 387

• “MATLAB Interface to Java” on page 394

• “General Features” on page 395

Importing and Exporting

Saving Character Data with Unicode Encoding
The save function now saves character data to a MAT-file using Unicode
character encoding by default. You can use your system’s default character
encoding scheme instead by specifying the -v6 option with save.

Compatibility Considerations. MAT-files saved in MATLAB version 7.0
without using the new -v6 flag will not be readable in previous versions of
MATLAB.

Saving Data in Compressed Format
The save function now saves data to a MAT-file in a compressed format by
default.

Large File I/O for MEX-Files
MATLAB supports the use of 64-bit file I/O operations in your MEX-file
programs. This enables you to read and write data to files that are up to
and greater than 2 GB (2^31-1 bytes). Note that some operating systems or
compilers may not support files larger than 2 GB.

See “Large File I/O” in the External Interfaces documentation for more
information.
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ActiveX and COM

Automatic Registration of Automation Server on Installation
When installing previous versions of MATLAB, system administrators
also had to run MATLAB at least once on each machine to register the
Automation server. In MATLAB 7.0, the MATLAB installation software does
the Automation server installation for you.

Support for Multiple COM Type Libraries
MATLAB now fully supports importing additional type libraries from within
an IDL file. Any COM object that depends on an imported type library is
now handled correctly.

COM Interface Supports Custom Interfaces
MATLAB now supports custom interfaces to a server component in
configurations where MATLAB is the client controlling an ActiveX control,
or an in-process or out-of-process server. For those COM components that
implement one or more custom interfaces, you can list the interfaces in
MATLAB using the new interfaces function:

h = actxserver('ComponentA.CustomObject')
h =

COM.componenta.customobject

customlist = interfaces(h)
customlist =

ICustomObject1
ICustomObject2

Once you select the custom interface that you want, use the invoke function
to get a handle to it:

c1 = invoke(h, 'ICustomObject1')
c1 =

Interface.componenta_Type_Library.ICustomObject1_Interface

You can now use this handle with most of the COM client functions to access
the properties and methods of the object through this custom interface. For
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example, to list the methods available through the ICustomObject1 interface,
use

invoke(c1)

Add = double Add(handle, double, double)

CustomMethod1 = HRESULT CustomMethod1(handle, int32)

CustomMethod2 = HRESULT CustomMethod2(handle, int32)

TripleAdd = [double, double] TripleAdd(handle, double, double)

method3 = [string, int32, string, string] method3(

handle, int16, int32, double, string)

outin = [double, double, double, double] outin(

handle, double, double)

strings = string strings(handle, string)

You can read more about this feature in the section, “Getting Interfaces to the
Object” in the External Interfaces documentation.

COM Data Type Support for Scripting Languages
In previous versions of MATLAB, a COM client program written in VBScript
could not retrieve numeric data from or write data to the workspace of a
MATLAB client. This was because VBScript does not support the SAFEARRAY
data type used by MATLAB to pass numeric data to and from the server
workspace using the GetFullMatrix and PutFullMatrix functions.

Release 14 adds two new functions, GetWorkspaceData and
PutWorkspaceData, that pass data using the variant data type, a type that
is supported by VBScript. You can use these new functions to pass either
numeric or string data to any workspace in the COM server running MATLAB.

Refer to “Exchanging Data with the Server” in the External Interfaces
documentation.

Additional ProgIDs for Latest MATLAB Version
There are three additional COM programmatic identifiers (ProgIDs) in
MATLAB 7.0:

MATLAB.Autoserver
MATLAB.Autoserver.Single
MATLAB.Autoserver.7
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Using any of these identifiers with the actxserver function guarantees that
the MATLAB server you create always runs the latest version of MATLAB
(version 7.0).

Note These new ProgIDs do not replace the MATLAB.Application identifier
used in previous versions of MATLAB. You can continue using this ProgID,
but there is no guarantee that actxserver will create a server running
MATLAB 7.0.

Connecting to an Existing MATLAB Server
Instead of having to create new instances of a MATLAB server, clients can
connect to an existing MATLAB automation server using the GetObject
command. This sample Visual Basic program connects to a running MATLAB
automation server, returning a handle h to that server. It then executes a
simple plot command in the server:

Dim h As Object

' Call GetObject (omit first argument).
Set h = GetObject(, "matlab.application")

' Handle h should be valid now. Test it by calling Execute
h.Execute ("plot([0 18], [7 23])")

Graphical Interface to Listing Available ActiveX Controls
The actxcontrollist function enables you to see what COM controls are
currently installed on your system. Type

list = actxcontrollist;

and MATLAB returns a list of each control, including its name, programmatic
identifier (or ProgID), and filename, in the output cell array.

Refer to “Finding Out What Controls Are Installed” in the External Interfaces
documentation.
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Graphical Interface to Creating ActiveX Controls
The simplest way to create a control object is to use the actxcontrolselect
function. This function displays a graphical interface that lists all controls
installed on the system and creates the one that you select from the list.

The actxcontrolselect interface has a selection panel at the left of the
window and a preview panel at the right. Click on one of the control names
in the selection panel to see a preview of the control displayed. (If MATLAB
cannot create the control, an error message is displayed in the preview panel.)
Select an item from the list and click the Create button.

Refer to “Creating Control Objects Using a Graphical Interface” in the
External Interfaces documentation.

New Functions for the MATLAB COM Interface
There are five new COM client functions.
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Function Description

actxcontrollist List all currently installed ActiveX controls

actxcontrolselect Display graphical interface for creating an ActiveX
control

interfaces List custom interfaces to a COM server

iscom Determine if input is a COM or ActiveX object

isinterface Determine if input is a COM interface

There are three new COM server functions. When invoked by a MATLAB or
Visual Basic client, these functions execute in the server associated with the
specified handle parameter.

Function Description

Feval Evaluate MATLAB function call in the server

GetWorkspaceData Get data from server workspace

PutWorkspaceData Store data in server workspace

See the function reference pages in the External Interfaces Reference
documentation for more information.

COM Interface Supports Dot Syntax in Commands
You can now use a simpler form of syntax when invoking either MATLAB
COM functions or methods belonging to COM objects. In this dot syntax (as it
is referred to in the MATLAB documentation), you specify the object name, a
dot (.), and then the name of the function or method you are calling. Enclose
any input arguments in parentheses after the function name. Specify output
arguments to the left of the equals sign:

outputvalue = object.function(arg1, arg2, ...)

For example, Release 13 syntax for invoking the addproperty function on a
COM object with handle h was

invoke(h, 'addproperty', 'Position');
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You can now perform the same operation using

h.addproperty('Position');

The get and set operations are even simpler:

** R13 SYNTAX ** ** R14 SYNTAX **
x = get(h, 'Radius'); x = h.Radius;
set(h, 'Radius', 50); h.Radius = 50;

Refer to “Invoking Commands on a COM Object” in the External Interfaces
documentation.

Enumeration in COM Method Arguments
In addition to supporting enumeration for the properties of a COM object,
MATLAB now supports enumeration for parameters passed to methods of a
COM object. The only restriction is that the type library in use must report
the parameter as ENUM, and only as ENUM.

Refer to “Specifying Enumerated Parameters” in the External Interfaces
documentation.

Event Handling for COM Servers
In addition to handling events from ActiveX controls, MATLAB now handles
events fired by Automation servers as well. Use the same event handling
functions that you have been using for events from controls.

Function Description

eventlisteners Return a list of events attached to listeners

events List all events, both registered and unregistered, a
control or server can generate

isevent Determine if an item is an event of a COM object

registerevent Register an event handler with a control or server
event
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Function Description

unregisterallevents Unregister all events for a control or server

unregisterevent Unregister an event handler with a control or server
event

Refer to “Responding to Events from a COM Server” and in the External
Interfaces documentation.

Callbacks to COM Event Handlers Written as Subfunctions
Instead of having to maintain a separate M-file for every event handler
routine you write, you can consolidate some or all of these routines into a
single M-file using M-file subfunctions.

Refer to “Writing Event Handlers Using M-File Subfunctions” in the External
Interfaces documentation.

Event Handlers Can Be Function Handles
In this release, you can now implement ActiveX event handlers as function
handles.

Optional Input Arguments to COM Methods
When calling a method that takes optional input arguments, you can skip any
optional argument by specifying an empty array ([]) in its place. The syntax
for invoke with the second argument (arg2) not specified is as follows:

invoke(handle, 'methodname', arg1, [], arg3);

See the section, “Optional Input Arguments” in the External Interfaces
documentation for more information.

Display of Interface Handles
MATLAB has changed the way it displays a COM interface in this release.
For example, the string used to represent an interface in MATLAB 6.5 was

[1x1 Interface.excel.application.Workbooks]
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MATLAB 7.0 represents this same interface with the following string:

[1x1 Interface.Microsoft_Excel_9.0_Object_Library.Workbooks]

Compatibility Considerations. You may need to change any code that
depends on the previous behavior.

MATLAB Interface to Java

Java Interface Adds Dynamic Java Class Path
MATLAB loads Java class definitions from files that are on the Java class
path. The Java class path now consists of two segments: the static path, and a
new segment called the dynamic path.

The static path is loaded from the file classpath.txt at the start of each
MATLAB session and cannot be changed without restarting MATLAB. This
was the only path available in previous versions of MATLAB. Thus, there was
no way to change the Java path without restarting MATLAB.

The dynamic Java class path can be loaded at any time during a MATLAB
session using the javaclasspath function. You can define the dynamic
path (using javaclasspath), modify the path (using javaaddpath and
javarmpath), and refresh the Java class definitions for all classes on the
dynamic path (using clear java) without restarting MATLAB. See the
function reference pages for more information on how to use these functions.

The javaclasspath function, when used with no arguments, displays both
the static and dynamic segments of the Java class path:

javaclasspath

STATIC JAVA PATH

D:\Sys0\Java\util.jar
D:\Sys0\Java\widgets.jar
D:\Sys0\Java\beans.jar

.

.
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DYNAMIC JAVA PATH

User4:\Work\Java\ClassFiles
User4:\Work\Java\mywidgets.jar

.

.

You can read more about this feature in the sections, “The Java Class Path”
and “Making Java Classes Available to MATLAB” in the External Interfaces
documentation.

Locating Java Native Method DLLs with File librarypath.txt
Previous versions of MATLAB required that you set a system environment
variable to enable Java to locate the shared libraries supporting any native
methods you need to use. This environment variable was PATH on Windows
systems, and LD_LIBRARY_PATH on UNIX systems. This is no longer necessary.

Now you can enter the names of those directories that contain native method
libraries in a new file called librarypath.txt using one line per directory.
The librarypath.txt file resides adjacent to the similar file classpath.txt
in the $matlab/toolbox/local directory.

General Features

New mx Functions
New functions mxIsInt64 and mxIsUint64 return true if an mxArray
represents its data as signed or unsigned 64-bit integers respectively.

Identifying Dependencies When MEX-Files Do Not Load
If MEX-files don’t load on the PC the error message is not informative. The
dependency walker is a very useful tool distributed with MSVC. It is also
freely available from http://www.dependencywalker.com.

Recompile MEX-Files on GLNX86 and Macintosh
In Release 14, MATLAB uses C++ exception handling. MEX-files built prior
to R14 did not support C++ exceptions.
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For example, write a C MEX-file that just calls mexErrMsgTxt. If you build
this with a release prior to Release 14 and run it, the program aborts
MATLAB. If you build this with Release 14 and run it, MATLAB will handle
the exception correctly.

Compatibility Considerations. On GLNX86 and Macintosh systems, all
MEX-files that can throw errors need to be recompiled for R14.

Shared Libraries Now In /bin/$ARCH
Shared libraries previously residing in directory $MATLAB/extern/lib/$ARCH
are now in $MATLAB/bin/$ARCH.

Compatibility Considerations. You may need to change any code that
depends on the previous behavior.
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Compatibility Summary for
MATLAB

These tables summarize new features and changes that might cause
incompatibilities when you upgrade from an earlier version, or when you
use files on multiple versions. Details are provided with the description of
the new feature or change.

• “Version 7.5 (R2007b) Compatibility Summary for MATLAB” on page 398

• “Version 7.4 (R2007a) Compatibility Summary for MATLAB” on page 401

• “Version 7.3 (R2006b) Compatibility Summary for MATLAB” on page 404

• “Version 7.2 (R2006a) Compatibility Summary for MATLAB” on page 407

• “Version 7.1 (R14SP3) Compatibility Summary for MATLAB” on page 409

• “Version 7.04 (R14SP2) Compatibility Summary for MATLAB” on page 411

• “Version 7.01 (R14SP1) Compatibility Summary for MATLAB” on page 413

• “Version 7 (R14) Compatibility Summary for MATLAB” on page 415
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Version 7.5 (R2007b) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area New Features and Changes with Version Compatibility Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of these
new features or changes:

• “Windows Startup Changes” on page 7

• “Changes to Look of Buttons in Desktop and Other Tools” on page 11

• “Demos and Help Browser Contents Now Include New Category for
Links and Targets” on page 12

• “Help on Selection Enhanced in Command Window and Editor” on
page 15

• “Run/Continue Button Changes” on page 18

• “Line Endings Removed for Files Provided with MATLAB for
Windows; Impacts Viewing in Notepad” on page 21

• “Stand-Alone Editor Will Not Be Included in Next Version” on page 24

Math See the Compatibility Considerations subheading for each of these
new features or changes:

• “finite Function Deprecated” on page 27

• “Library for LAPACK and BLAS Symbols Separated” on page 28

• “Colon Operations on Characters Return Character Type Data” on
page 29

• “Matrix Generating Functions No Longer Accept Complex Inputs”
on page 29

Data Analysis None
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Area New Features and Changes with Version Compatibility Impact

Programming See the Compatibility Considerations subheading for each of these
new features or changes:

• “New Internal Format for P-code” on page 33

• “Change to Error Message from Anonymous Function” on page 34

• “New Message In Response to Ctrl+C” on page 35

• “hdfread Errors Instead of Warns on I/O Failures” on page 36

• “Results From tempname Are More Unique” on page 36

• “iptcheckstrs and iptcheckinput Functionality Now Available with
MATLAB” on page 37

• “Windows Current Working Directory Corrected” on page 37

• “Removal of freeserial Function” on page 40

Graphics and 3-D
Visualization

See the following release notes or their Compatibility Considerations
subheading for each of these new features or changes:

• “Datatips Are Now Saved to FIG-Files” on page 41

• “The “v6” Option for Creating Plot Objects is Obsolete” on page 44
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Area New Features and Changes with Version Compatibility Impact

Creating GUIs See the Compatibility Considerations subheading for each of these
new features or changes:

• “Functions Being Removed” on page 48

External Interfaces See the Compatibility Considerations subheading for each of these
new features or changes:

• “Support for 64-bit mxArrays” on page 50

• “Fortran MEX-Files Will Require mwSize and mwIndex” on page 51

• “Rebuild MEX-Files Created with MATLAB Versions Earlier Than
V7 (R14)” on page 52

• “Discontinued Compiler Support” on page 53

• “Changes to Applications Built with Borland 5.5 or 5.6 C Compilers”
on page 54

• “Changes to Dynamic Data Exchange (DDE) Documentation” on
page 55

• “Documentation for Obsolete Functions To Be Phased Out” on page 56

400



Version 7.4 (R2007a) Compatibility Summary for MATLAB

Version 7.4 (R2007a) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area New Features and Changes with Version Compatibility Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of these
new features or changes:

• “Double-Clicking Associated File Type in Windows Explorer Now
Opens File in Existing MATLAB Session” on page 59

• “Changes to Startup Directory (Folder) and Startup Options for
MATLAB on Windows” on page 60

• “JVM for Windows Updated” on page 63

• “Confirm Exit Preference to be Enabled by Default in Future Version”
on page 64

• “Tabs for Tools Replaced by Title Bars” on page 70

• “Macintosh—Some Key Bindings in Command Window Changed”
on page 73

• “Include Search Database for Your Own Help Files” on page 74

• “Video Tutorials Now Accessed Via Web Site” on page 74

• “Search Path Changes” on page 75

• “Stand-Alone Editor No Longer Opens By Default; To Be Removed
in a Future Version” on page 76

• “M-Lint Detection of Missing End-of-Line Semicolons Enhanced” on
page 78

• “Macintosh—Some Key Bindings in Editor/Debugger Changed” on
page 79
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Area New Features and Changes with Version Compatibility Impact

Math See the Compatibility Considerations subheading for each of these
new features or changes:

• “rand Function Uses the Mersenne Twister Algorithm as Default”
on page 81

• “Divide By Zero and Log Of Zero Warnings Off By Default” on page 83

• “mode of Empty Array Now Returns NaN” on page 83

• “Change to Syntax for Setting BLAS Library Version on Linux” on
page 84

Data Analysis None

Programming See the Compatibility Considerations subheading for each of these
new features or changes:

• “Using whos -file on Objects with Overloaded size or class Methods”
on page 89

• “mat2str Returns Correct Output for Strings” on page 90

• “Warning Generated by try-catch” on page 90

• “Functions Not Callable If in Directory Under Class Directory” on
page 92

• “ispuma Function Deprecated” on page 93

Graphics and 3-D
Visualization

See the Compatibility Considerations subheading for each of these
new features or changes:

• “Movies No Longer Play During Loading” on page 94

• “Ghostscript Printing Software Upgraded” on page 95

• “Property Inspector Now Categorizes Graphic Object Properties” on
page 95
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Area New Features and Changes with Version Compatibility Impact

Creating GUIs See the Compatibility Considerations subheading for each of these
new features or changes:

• “GUIDE No Longer Copies Callbacks When You Duplicate
Components” on page 98

• “GUIDE M-File-Defined handles Structure Fields No Longer Become
Permanent” on page 98

• “UNIX: File Dialog ’Location’ Property Is Obsolete” on page 99

• “Functions Becoming Obsolete” on page 99

External Interfaces See the Compatibility Considerations subheading for each of these
new features or changes:

• “MEX-Files in MATLAB for Intel-based Macintosh ” on page 101

• “MEX-Files in MATLAB for 64–bit Solaris SPARC” on page 101

• “MEX-Files Built in MATLAB R11 or Earlier Must Be Rebuilt” on
page 102

• “Fortran Compatibility Considerations” on page 104

• “Discontinued Compiler Support” on page 104
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Version 7.3 (R2006b) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area
New Features and Changes with Version Compatibility
Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Redirect Output on UNIX Now Sends Errors to Shell” on page
111

• “M-Lint Preferences Added and Now Appear on M-Lint Panel”
on page 112

• “New Look and Feel on Linux and Solaris Platforms” on page 114

• “Invalid info.xml File on Path Now Generates an Error” on page
114

• “Exact Phrase and Wildcard Searching Added; Change to Search
Database” on page 115

• “File Comparison Directory Report Removed; Replaced by File
Comparison Tool” on page 121

• “M-Lint Code Check Report Enhancements and Changes” on
page 121

• “mlint Message IDs Changed and %#ok Syntax Enhanced” on
page 121
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Area
New Features and Changes with Version Compatibility
Impact

Mathematics See the Compatibility Considerations subheading for each of
these new features or changes:

• “max and min Now Use Magnitudes and Phase Angle for
Complex Input” on page 125

• “FFTW Upgraded to Version 3.1.1 in MATLAB” on page 127

• “Future Obsolete Functions” on page 128

• “Obsolete Functions” on page 128

• “notebook Setup Arguments Removed” on page 123

• “max and min No Longer Return Warning Messages for Inputs
with Different Data Types” on page 129

Data Analysis None

Programming See the Compatibility Considerations subheading for each of
these new features or changes:

• “Saving to MAT-Files Larger than 2 GB” on page 131

• “New Reserved MATLAB Keywords” on page 133

• “Enhancements to Display Generated by whos” on page 133

• “save Compression and Unicode Options Removed” on page 135

• “Warning Generated by try-catch” on page 136

• “Case-Sensitivity Warning Removed” on page 137

• “fprintf(0,...) Now Throws an Error” on page 137

• “Assigning Nonscalar Structure Array Fields to a Single Variable”
on page 138

• “Comma Separators Not Required in Function Declaration” on
page 139
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Area
New Features and Changes with Version Compatibility
Impact

Graphics and 3-D
Visualization

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Version 6 Property Editor Has Been Removed” on page 140

• “New Desktop Printing GUI” on page 141

• “Customizing Zoom, Pan, and Rotate3D Data Explore Modes”
on page 142

Creating GUIs See the Compatibility Considerations subheading for each of
these new features or changes:

• “Functions Are Now Obsolete” on page 144

• “Colored Buttons on Windows XP” on page 144

External Interfaces See the Compatibility Considerations subheading for each of
these new features or changes:

• “Sparse Arrays on 64-bit Systems” on page 147

• “New MAT-File Format Based on HDF5” on page 148

• “-V5 Option to MEX to Be Removed” on page 149

• “Location of mex.bat File Changed” on page 149

• “Changes to Compiler Support” on page 149

• “Actxcontrol Command Now Validates ProgID” on page 149
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Version 7.2 (R2006a) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area
New Features and Changes with Version Compatibility
Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Installation Directory Structure on Windows” on page 153

• “Preferences Reorganized and New Keyboard Pane Added to
Support Command Window and Editor/Debugger” on page 154

• “Tab Completion — Tab Now Completes Function and Variable
Names” on page 157

• “Go Menu Added; Bookmark and Go To Items Moved from Edit
Menu to Go Menu” on page 158

• “Cell Mode On by Default — Shows Cell Toolbar and Possibly
Horizontal Lines and Yellow Highlighting; Cell Information Bar
and Button Added” on page 161

• “M-Lint and mlint Enhancements and Changes” on page 164

• “Visual Directory View Removed from Current Directory
Browser” on page 165

• “PVCS Source Control System Name Change” on page 166

Mathematics None

Data Analysis See the Compatibility Considerations subheading for each of
these new features or changes:

• “Linux 64 Platform Fully Enabled for Time Series Tools” on page
169

407



Compatibility Summary for MATLAB

Area
New Features and Changes with Version Compatibility
Impact

Programming See the Compatibility Considerations subheading for each of
these new features or changes:

• “Using avifile and movie2avi on Windows XP 64” on page 170

• “Regular Expressions” on page 171

• “MATLAB Warns on Invalid Input to str2func” on page 173

• “Changes to Character Encoding in File I/O” on page 173

Graphics and 3-D
Visualization

• “Pasting Cut or Copied Graphic Objects Can Create an Axes”
on page 177

Creating GUIs See the Compatibility Considerations subheading for each of
these new features or changes:

• “Treatment of & in Menu Label Is Changed” on page 179

External Interfaces See the Compatibility Considerations subheading for each of
these new features or changes:

• “MEX-Files Built with gcc on Linux Must Be Rebuilt” on page 181

• “MEX-Files in MATLAB for Windows x64” on page 182

• “Compaq Visual Fortran Engine and MAT Options File Renamed”
on page 183

• “Options Files Removed for Unsupported Compilers” on page 183

• “Obsolete Functions No Longer Documented” on page 184
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Version 7.1 (R14SP3) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area
New Features and Changes with Version Compatibility
Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Windows -nodesktop No Longer has Menu Bar and Toolbar; Use
Function Equivalents Instead” on page 193

• “Preferences Directory Added for R14SP3; Supplements R14
Directory” on page 195

• “info.xml File Automatic Validation; Shows Warnings for Invalid
Constructs” on page 197

• “Hyperlink Color Preference Moved” on page 198

• “Demos Run in Command Window as Scripts and Their Variables
Now Created in Base Workspace” on page 199

• “echodemo Function Added to Replace playshow function” on
page 200

• “Visual Directory View to be Removed” on page 201

• “HTML File Indenting Feature Added as the Default” on page 203

• “Notebook Setup Changes; Some Arguments Removed” on page
205

• “Word Versions Supported by Notebook; Word 97 No Longer
Supported” on page 206

Mathematics See the Compatibility Considerations subheading for each of
these new features or changes:

• “New Functions” on page 207

Data Analysis None
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Area
New Features and Changes with Version Compatibility
Impact

Programming See the Compatibility Considerations subheading for each of
these new features or changes:

• “New Functions” on page 213

• “Modified Functions” on page 214

• “isfield Function Supports Cell Arrays; Results Might Differ from
Previous Version” on page 215

• “Seconds Field Now Truncated; Results Might Differ” on page
218, “Built-in Functions No Longer Use .bi; Impacts Output of
which Function” on page 218, “New Warning About Potential
Naming Conflict” on page 219

Graphics and 3-D
Visualization

None

Creating GUIs See the Compatibility Considerations subheading for each of
these new features or changes:

• “Plans for Obsolete Functions” on page 221

External Interfaces See the Compatibility Considerations subheading for each of
these new features or changes:

• “New File Extension for MEX-Files on Windows” on page 224

• “New Preferences Directory and MEX Options” on page 226

• “Compiler Support” on page 227

• “Import Libraries Moved” on page 227

410



Version 7.04 (R14SP2) Compatibility Summary for MATLAB

Version 7.04 (R14SP2) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area
New Features and Changes with Version Compatibility
Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of
these new features or changes:

• “JVM Updated” on page 232

• “Subfunction Help Syntax Changed” on page 233

• “Bug Fixes and Known Problems Now on Web; No Longer Found
Via Help Search” on page 233

• “Workspace Browser Preference Panel Removed” on page 234

• “Preference for Editor/Debugger Dialog Moved” on page 235

• “Register Project Feature Added; Add to Source Control Behavior
Changed” on page 236

• “Cell Publishing: File Extension Changes” on page 236

• “Notebook Support for Word 97 to be Discontinued” on page 237

Mathematics See the Compatibility Considerations subheading for each of
these new features or changes:

• “max and min on Complex Integers Not Supported” on page 238

Programming See the Compatibility Considerations subheading for each of
these new features or changes:

• “xlsread Imported Date Format Changes” on page 240

• “Nonscalar Arrays of Function Handles to Become Invalid” on
page 241

• “Assigning Nonstructure Variables As Structures Displays
Warning” on page 241
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Area
New Features and Changes with Version Compatibility
Impact

Graphics and 3-D
Visualization

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Cannot Dock Figures on Macintosh” on page 245

• “Plotting Tools Not Working on Macintosh” on page 245

• “Not All Macintosh System Fonts Are Available” on page 245

• “XDisplay Property Setable on Motif-Based Systems” on page 245

Creating GUIs None

External Interfaces None

412



Version 7.01 (R14SP1) Compatibility Summary for MATLAB

Version 7.01 (R14SP1) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area
New Features and Changes with Version Compatibility
Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Constructing Java Classpath Now Uses librarypath” on page 251

• “Notebook Support for Word 97 to Be Discontinued” on page 256

Mathematics See the Compatibility Considerations subheading for each of
these new features or changes:

• “Different Results When Solving Singular Linear Systems on
Intel Systems; Inconsistent NaN Propagation” on page 259

• “funm Returns Status Information; New Output Might Result In
Error” on page 260

Programming See the Compatibility Considerations subheading for each of
these new features or changes:

• “datevec Support of Empty String Argument” on page 262

• “ftell Returning Invalid Position in Rare Cases” on page 262

• “Logical OR Operator | in regexp Expressions Might Yield
Different Results from Previous Version” on page 264

• “Multiple Declarations of Persistent Variables No Longer
Supported” on page 265
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Area
New Features and Changes with Version Compatibility
Impact

Graphics and 3-D
Visualization

See the Compatibility Considerations subheading for each of
these new features or changes:

• “Cannot Dock Figures on Macintosh” on page 267

• “Plotting Tools Not Working on Macintosh” on page 267

• “Not All Macintosh System Fonts Are Available” on page 267

• “Preview Java Figures on the Macintosh” on page 267

Creating GUIs See the Compatibility Considerations subheading for each of
these new features or changes:

• “FIG-File Format Change” on page 268

• “Panels, Button Groups, and ActiveX Components” on page 268

• “Windows XP Display of Push and Toggle Buttons” on page 269

External Interfaces See the Compatibility Considerations subheading for this new
feature or change:

• “Specifying the Search Path for Java Native Method DLLs” on
page 271
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Version 7 (R14) Compatibility Summary for MATLAB
For other versions, see the “Compatibility Summary for MATLAB”.

Area New Features and Changes with Version Compatibility Impact

Desktop Tools
and Development
Environment

See the Compatibility Considerations subheading for each of these
new features or changes:

• “terminal Function Removed” on page 281

• “license Function Results Modified Slightly” on page 281

• “Tab Completion Graphical Interface Added; Removed Preference to
Limit Completions” on page 282

• “Parentheses Matching Support Removed” on page 284

• “Documentation Now Automatically Installed; Not Accessible from
CD-ROMs and docroot Not Supported” on page 286

• “web Function Now Opens MATLAB Web Browser By Default” on
page 288

• “HTML Documentation Not Viewable with -nojvm Startup Option”
on page 288

• “Built-In Functions Now Treated Like Other M-Files on Search Path”
on page 291

• “savepath Function Added to Replace path2rc” on page 291

• “Create Block Comments Using %{ and %}” on page 297

• “dbstack Function Supports Nested Functions” on page 299

• “dbstatus Function Supports Conditional Breakpoints” on page 300

• “Rapid Code Iteration Using Cells” on page 300

• “Profiler for Measuring Performance” on page 304

• “Source Control Changes” on page 305
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Area New Features and Changes with Version Compatibility Impact

Mathematics See the Compatibility Considerations subheading for each of these
new features or changes:

• “Obsolete Functions” on page 310

• “Integer Data Type Functions Now Round Instead of Truncate” on
page 314

• “Changes to Behavior of Concatenation” on page 315

• “New Class Inputs for sum” on page 318

• “max and min Now Have Restrictions on Inputs of Different Data
Types” on page 321

• “Matrix, Trigonometric, and Other Math Functions No Longer Accept
Inputs of Type char” on page 325

• “New Names for Demos expm1, expm2, and expm3” on page 331
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Area New Features and Changes with Version Compatibility Impact

Programming See the Compatibility Considerations subheading for each of these
new features or changes:

• “MATLAB Stores Character Data As Unicode; Making Release 14
MAT-files Readable in Earlier Versions” on page 335

• “MAT-Files Generated By Release 14 Beta2 Must Be Reformatted”
on page 336

• “Additional Bytes Reserved in MAT-File Header; Do Not Write To
Reserved Space” on page 337

• “Case-Sensitivity in Function and Directory Names; Can Affect Which
Function MATLAB Selects” on page 338

• “Differences Between Built-Ins and M-Functions Removed; Can Affect
Which Function MATLAB Selects” on page 343

• “Change to How evalin Evaluates Dispatch Context” on page 345

• “New Calling Syntax for Function Handles; Replace eval With New
Syntax” on page 350

• “Arrays of Function Handles” on page 351

• “Regular Expressions Accept String Vector; No Longer Support
Character Matrix Input” on page 357

• “Colon Operator on char Now Returns a char” on page 358

• “Reading Date Values with xlsread; Conversion No Longer Necessary”
on page 359

• “Changes to Error Message Format” on page 365
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Area New Features and Changes with Version Compatibility Impact

3-D Graphics and
Visualization

See the Compatibility Considerations subheading for each of these
new features or changes:

• “Plotting Tools Not Working on Macintosh” on page 378

• “Using -nojvm Option Prevents Plotting Tools Use” on page 378

• “MATLAB 6 Version Property Editor” on page 379

• “Cannot Dock Figures on Macintosh” on page 379

• “Not All Macintosh System Fonts Are Available” on page 379

Creating GUIs See the Compatibility Considerations subheading for each of these
new features or changes:

• “New Container Components” on page 380

• “New Syntax for uigetfile and uiputfile” on page 384

• “Frames Not Available in GUIDE Layout Editor” on page 385

External Interfaces See the Compatibility Considerations subheading for each of these
new features or changes:

• “Saving Character Data with Unicode Encoding” on page 386

• “Display of Interface Handles” on page 393

• “Recompile MEX-Files on GLNX86 and Macintosh” on page 395

• “Shared Libraries Now In /bin/$ARCH” on page 396
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